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PART 1: ON1 PHOTO RAW 2026 OVERVIEW

ON1 Photo RAW 2026 is a complete photo editing solution, built around a full-featured photo organizer, a 
sophisticated raw processing engine, and modern image enlargement technology. It is infused throughout 
with modern AI-based, machine learning technology, all designed to make your photo editing and 
organization efficient and worry-free.

With Photo RAW, you can apply quick edits and stylized effects to your photos, remove noise easily with 
NoNoise AI, sharpen out-of-focus details with TackSharp AI, and perform expert portrait retouching with 
Portrait AI. Nearly all of your edits can be made globally or locally to specific regions of a photo, and, with 
the Brilliance AI feature, you can take this to a whole new level, using AI-powered color, tone, noise, and 
detail adjustments to uniquely interpret all of your photos, delivering results that reflect the original vision 
for your photograph. 

The app also includes generative AI features that enhance the content-aware capabilities of both the Crop 
and Generative Erase tools. These options let photographers extend canvases more naturally and remove 
large distractions, like people or cars, while filling in missing details with realistic results.

Photo RAW 2026 adds powerful enhancements to its masking engine, generating more accurate masks 
quickly and easily. These include one-click subject and background mask creation, and improved AI-based 
edge quality, which creates more natural selections for details like hair, branches, and other fine edges.

Photo RAW’s Super Select AI tool lets you point to an area of a photo—subject, background, sky, people, 
or other objects—and automatically apply effects, sky replacements or other adjustments to those specific 
areas. The Mask AI feature lets you apply effects and local adjustments to specific areas automatically, 
while still preserving your ability to tune the masks further. You can even create presets that will only be 
applied to specific regions of any photo, without having manually to create complicated masks or layers.  
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For more complex projects, Photo RAW includes layering functionality for compositing and blending images 
quickly and easily. You can also combine a series of photos into beautiful panoramas, stunning HDR images, 
and perfectly focus-stacked photos with the click of a button, or use the time-lapse feature to create 
flicker-free movies from hundreds of still images. You can even use many of the image-processing plugins 
created for Adobe Photoshop in your ON1 Photo RAW 2026 workflow. And, if you would like to use Photo 
RAW as a plug-in with other photo applications, the Photo RAW MAX 2026 version has plug-ins for photo 
editors from Adobe, Apple, Phase One, Affinity and more (see page 304). 

With all of this, Photo RAW lets you work in a fully non-destructive workflow: you can import, sort and 
view raw photos in Browse, and finish them in the Edit module without having to worry about saving your 
edits. The next time you open your photo, all of your settings will be remembered, and you can easily 
change settings, add new ones, or start over from scratch, all without having to save additional versions of 
your photo. Photo RAW 2026 is even non-destructive when working with such non-raw formats as JPEG, 
Photoshop (PSD), PNG and TIFF.

When you’re done editing, you can use Photo RAW’s Resize AI technology to perform industry-standard 
image enlargement on your photos—with full printing capabilities. Resize AI offers two new generative AI 
models with advanced super-resolution technology to create the highest quality photo enlargements of any 
resizing tool on the market.

And, when Photo RAW 2026 is used in conjunction with the optional ON1 Cloud Sync service, you can 
capture, view and edit your photos across multiple computers and mobile devices without worrying about 
their location. You can share presets and extras like backgrounds and textures, between two computers.

What’s new in ON1 Photo RAW 2026
Edit module masking enhancements include:

• One-Click Subject and Background Masks: Instantly 
isolate subjects or backgrounds (page 125).

• Mask Layers: Combine or subtract multiple masks per 
layer or filter. (page 125)

• Improved AI Edge Quality: Cleaner, more natural 
selections for details like hair, branches, and other fine 
edges. 

Other Edit module additions/enhancements:

• Updated Transform pane in Develop adds horizontal 
and vertical options and scaling to fit the photo’s aspect 
ratio (page 159).

• Negative Mode in Develop transforms color and black-
and-white negatives with a click (page 151).

• Dock or float the Properties window (page 93) and 
the Layers pane (page 214) where you want.

• Support for Grayscale images. With Photo RAW 2026, you can produce high-quality 
masks with one click, and can have multiple mask layers 
for a filter, local adjustment or layer.
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Enhancements to the Effects module include:

• New Depth Lighting filter lets you quickly adjust foreground and background lighting (page 
185).

• Three new creative filters: Double Exposure (page 186), Split Field (page 194), and 
Motion (page 191).

• Starting points: Set Effects up with the filters you want to use, every time.

• Streamlined Add Filter window lets you view only the filters you care about.

New Resize AI models provide the highest quality enlargements of any app.

• Highest Quality Model: A state-of-the-art 
generative AI model that restores fine details, 
removes noise, and delivers superior sharpness.

• Standard Model: Optimized for speed and batch 
jobs, perfect for high-volume workflows and older 
GPUs.

Getting Help
You can find an extensive collection of video 
tutorials and help documents in the Help 
section of the ON1 website (on1help.zendesk.
com). This is the best and quickest way to dig 
into the entire ON1 workflow and discover 
new techniques that will help you with your 
photo editing and organizing. There, you can 
search our Knowledge Base for frequently 
asked questions, common issues and more. 

Inside ON1 Photo RAW 2026, you can use 
the Learning Hub to directly display videos for 
getting started with the app, search the ON1 
online help system—including with and online 
chat assistant—and the ON1 Shop, where 
you can purchase add-ons and courses for 
Photo RAW. If you’re a member of the ON1 
Plus community, you’ll also find access to Plus 
content and loyalty reward downloads.

The Learning Hub is accessible via the Help 
menu or from the Help icon at the bottom of 
the left bumper panel.  

The latest Resize AI models provide the most advanced 
super-resolution technology of any app.

The Learning Hub is available directly from within ON1 Photo RAW 2026, and 
includes links to videos (which can be played directly in the Hub window), ON1’s 
online help system, and the ON1 store.

https://on1help.zendesk.com/hc/en-us
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System Requirements

MINIMUM RECOMMENDED

OPERATING SYSTEM macOS 13
Windows 11 x86 or ARM 
current maintenance releases, 64 bit only

macOS 15 and above
Windows 11 x86 or ARM 
current maintenance releases, 64 bit only

PROCESSOR Windows: Four-core (minimum) or eight-core (recommended) Intel or AMD processor, 
2GHz or faster, with SSE 4.2 or Neon.

macOS: Four-Core Intel® processor or Apple Silicon (minimum) or M2 Apple Silicon or 
greater processor (recommended.

RAM 8 GB (16GB if shared with the GPU) 16 GB or more

HARD DRIVE 6 GB for installation 6 GB for installation and SSD drive

DISPLAY Windows: DirectX 12, DirectML, Vulkan 
1.1, and OpenGL 4.2 compatible video 
card with 4GB VRAM, 1920x1080 
resolution (at 100% scale factor)

macOS: Metal, Vulkan 1.1, and OpenGL 
4.2 compatible video card with 4GB 
VRAM, 1920x1080 resolution (at 100% 
scale factor)

Windows: DirectX 12, DirectML, Vulkan 
1.1, and OpenGL 4.2 compatible video 
card with 8GB VRAM, 1920x1080 
resolution (at 100% scale factor)

macOS: Metal, Vulkan 1.1, and OpenGL 
4.2 compatible video card with 8GB 
VRAM, 1920x1080 resolution (at 100% 
scale factor)

MOBILE APP Apple iPhone/iPad with iOS 16 or higher;
Android phone or tablet with 64-bit Android 11 or higher

current maintenance releases, 64 bit only

INTERNET A high-speed internet connection and active account for ON1 Cloud Sync, activation, 
auto-update checking, content downloads, and tutorials.

SUPPORTED OPTIONS Supports pressure-sensitive tablets for controlling brush size and/or opacity, and 
external control devices (such as those from LoupeDeck and El Gato). Supports ICC/
ICM profiles for camera input, display, soft-proofing, and printing. Hardware display 
calibration tool is recommended.

Photo RAW 2026 also supports many plugins designed for use with Adobe 
Photoshop.

OPTIONAL APPLICATION 
INTEGRATION (PHOTO 
RAW MAX ONLY)

Photoshop CC 
Photoshop Elements 2020 and above
Photoshop Lightroom Classic 
Apple Photos
Affinity Photo
Corel Paint Shop Pro
Capture One
current versions for all

LANGUAGES 
SUPPORTED

English, German, Spanish, French, Japanese, Korean, Simplified Chinese, Russian, 
Portuguese, Italian, Dutch

In addition to working as a standalone editing and organizational app, ON1’s Photo RAW MAX version can 
operate as a plugin to Adobe Photoshop, Lightroom, Photoshop Elements, Capture One and other photo 
editing apps. For information on using Photo RAW MAX as a plugin, see page 304.
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Installation
To install ON1 Photo RAW 2026, double-click the Installer icon and allow it to guide you. Before installing 
or updating, close any previous versions of ON1 products that might be open.

NOTE: If you have Adobe Lightroom Classic CC installed on your Windows 
or Mac system, the Installer will add a Lightroom plugin for migrating your 
Lightroom catalog to Photo RAW. See “Moving Your Lightroom Catalog to 
Photo RAW” on page 317 for information on this process.

FREE TRIAL VERSION

ON1 Photo RAW 2026 can also operate as a fully featured trial version for 30 days from when you first 
launch it. This gives you time to evaluate the product and see if it fits your needs. To install Photo RAW 
as a trial, click on the Free Trials label in the Application Manager, and click on the Install button. The 
Application Manager will display the number for days left in your trial; to purchase Photo RAW, click on the 
Buy button in the Free Trials section.

MAC INSTALLATION LOCATION
On a Mac, the application is installed in the ON1 Photo RAW 2026 folder in the Applications folder. 

If a previous version of ON1’s Photo RAW is found, it will be maintained or replaced based on your 
preference during installation.

Support files are installed into /Library/Application Support/ and ~/Library/Application Support/ folders.

WINDOWS INSTALLATION LOCATION
The application is installed in the ON1 Photo RAW 2026 folder in the \Program Files\ON1\ directory. 

If a previous version of ON1’s Photo RAW is found, it will be maintained or replaced based on your 
preference during installation.

Support files are installed into \ProgramData\ON1\.

UPGRADING FROM PREVIOUS VERSIONS

If you have earlier versions of ON1 Photo RAW on your computer, the installation process will move over 
any cataloged folders, albums, and metadata presets. 

BACKING UP YOUR PHOTO RAW CONFIGURATION

ON1 Photo RAW 2026 includes a back-up and restore function for most of the app’s settings, presets, 
extras, all edits, made to any image and much more (your photos are not backed up, however). To learn 
more about this feature, see “Backing up Your Work in Photo RAW” on page 304. 
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Launching ON1 Photo RAW 2026

MAC

Navigate to the ON1 Photo RAW 2026 folder, which is inside the Applications folder in the macOS Finder. 
Double-click the ON1 Photo RAW 2026 application icon to launch the product.

You can add ON1 Photo RAW 2026 to your dock for easy access by clicking and holding the icon in the 
dock and selecting the Keep In Dock option. If you use Launchpad it can be found there as well.

WINDOWS 10

Open the Start screen by pressing the Window key. Select ON1 Photo RAW 2026.

If you selected the “Add Icon to Desktop” option during installation you can also access ON1 Photo RAW 
2026 from there.

VIEWING YOUR ACCOUNT INFO ONLINE

In addition to the Application Manager, you can log into your ON1 user account area (www.on1.com/login/) 
at any time to download the software, see the number of computers you have registered, and make basic 
changes to your account information, including your email address, password, and notifications.

If you have issues related to installing or activating Photo RAW, please contact ON1 customer support, 
which can be reached by clicking on the ON1 website’s Support tab (on1help.zendesk.com).

Uninstalling ON1 Photo RAW 2026
To uninstall Photo RAW, first deactivate your product: open ON1 Photo RAW 2026 and select Sign Out… 
from the Help menu. This will allow you to transfer your license to another computer.

On a Mac, go to the Applications/ON1 Photo RAW 2026/Documentation folder, and double-click on the 
Remove ON1 Photo RAW 2026 application.

On a Windows computer, go to Control Panels, and under Programs select ‘Uninstall a program.’ In the list 
that comes up select ON1 Photo RAW 2026 and then click on the Uninstall button.

https://on1.com/login/
https://on1help.zendesk.com
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Working with Files
ON1 Photo RAW 2026 can view and open the following file types, in RGB color or grayscale mode, at 
either 8 or 16 bits per pixel:

• Raw files from most major camera manufacturers (file extension varies by manufacturer)

• DNG

• PSD (Photoshop)

• PSB (Photoshop Large Document)

• TIFF

• JPEG and JPEG XL

• PNG

• HEIC

• ARQ (Sony pixel-shift format)

•	 ONPHOTO (ON1 Photo format) 

Photo RAW can export files in PSD, PSB, TIFF, JPEG, JPEG XL, DNG and PNG format.

ON1 Photo RAW 2026 uses your camera manufacturer’s raw format as the default format when editing 
your photos. Photo RAW’s non-destructive editing capabilities let you view your raw files—or any other 
supported file type from the list above—in Browse, and work on them in the Edit module without having to 
create any intermediary files. There are no multiple versions of images cluttering up your directory; Photo 
RAW remembers the edits you’ve made to your photos and applies them non-destructively to your original.

This means is that there is no need to “open” the files to edit them; you just work with them as desired, 
and ON1 Photo RAW 2026 will remember your edits as you travel across the modules, even when you are 
working with a layered photo. You’ll only need to save them in a different form when you wish to export or 
share them in non-raw formats, or when you wish to work with the Resize module.

On the left bumper (left) are the module selectors for going 
between Browse and Edit, along with the More pop-up menu. 

The More menu (center) has links to all of Photo RAW’s primary 
functions. Some of the items might be grayed out, depending upon 
the number of photos selected in the Browse window.

You can select the Window menu’s ”Show Right Bumper” to display 
Photo RAW ‘s legacy icons (the two items on the right) for many of 
the items in the More menu. The bumper is hidden by default in 
ON1 Photo RAW 2026.
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NOTE: ON1 Photo RAW 2026 can also view and catalog most standard video 
formats inside the Browse module. While you cannot play or edit video from 
within Photo RAW, you can perform file management tasks and edit metadata. 
Double-clicking on a video file in Photo RAW will launch the default video 
player for your computer.

ON1 Photo RAW 2026 Modules
Photo RAW 2026 has three modules: Browse, Edit, and Resize. Each module focuses on one task, giving 
you access to just what you need to get that task done. Browse handles file-management operations, Edit 
performs non-destructive pixel editing—in a layered workflow, if you choose—and Resize is used to enlarge 
images, primarily for printing to large-format printers.

Browse is the default module, used to navigate through your drives and cloud services to find images. It can 
also import photos and perform specialized photo-combination tasks: assembling panoramas, creating high-
dynamic range (HDR) and focus-stacked images, and building time-lapse movies from a sequence of photos. 

When you take an image from Browse to the Edit module, Photo RAW 2026 works in a non-destructive 
manner, preserving your edits as you work. When you return to Browse, you’ll see your edits applied in all 
of the various viewing modes. (Thumbnail, Detail, Filmstrip, Compare and Map.

Within the Edit module are five tabs, Develop, Local, Effects, Sky Swap AI, and Portrait AI. Each tab has a 
specific area of functionality: Develop for basic editing, Effects for stylization, Sky Swap for replacing skies 
in an image, Portrait for retouching portraits, and Local for targeted editing of specific areas in your images.

When working in the Resize module, the end result is a new, scaled file, usually intended for printing, Resize 
creates a copy of the image (generally saved in the .PSD format) and saves that to the same directory as 
your original image.

THE MODULE SELECTOR

The Module Selector is on the left side of the screen by default, visible at all times. At the top of the 
selector are icons for Browse and Edit. Clicking on one of those icons will take you to that module.

Underneath the Browse and Edit icons is the More menu, which lets you go to any specific component 
of Photo RAW with a single click. These items include links to Resize AI; the different Edit module tabs 
(Develop, Local, Effects, Sky Swap, Portrait); Layers, Pano, HDR, Focus and Time, for time-lapse. Note that 
some of the More menu items might be grayed out, depending upon how many files are selected in Browse. 
The More menu is covered in detail on page 22.

Previous versions of Photo RAW had the module selector on the right side of the main window, and 
included the Resize icon and icons for printing, sharing or exporting an image or group. (see “Output and 
Sharing” on page 232) If you would like to display the right-side icons, choose “Show Right Bumper” from 
the Window menu in Browse. Selecting “Show Bumper Labels” from the Window menu will add text labels 
underneath each of the items, similar to older versions of Photo RAW.
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Using Photoshop Plugins with Photo RAW
ON1 Photo RAW 2026 has the capability to run many plugins created for use with Adobe Photoshop, even 
if you don’t have Photoshop installed on your system. When you process an image in the Edit module, and 
want to run it through a plugin, you are creating a new layer in your image document.

To set up Photo RAW to use Photoshop plugins, you open Photo RAW’s Preferences and click on the Plug-
ins tab. There, you can open Photo RAW’s default folder for Photoshop plugins and copy the plugins to 
that location, or you can select a secondary folder that contains plugin files, by clicking the Choose button. 
You’ll have to restart Photo RAW for the plugins to become available; once active, you can open a photo in 
the plugin by choosing Filters from the Layers menu in the Edit module. Photo RAW will launch the plugin; 
once you’re done, and the plugin returns the edited photo to Photo RAW, it will appear as a new layer, 
where you can apply any of the Edit module’s functions.

To learn about working with the Layers feature in Photo RAW, see page 213.

WHICH PHOTOSHOP PLUGINS WORK WITH PHOTO RAW?

When checking to see if a Photoshop plugin is suitable for use in Photo RAW, note the following 
exceptions: 

• Photo RAW does not support Photoshop automation plugins. That includes plugins that 
create layers or change the canvas size such as interpolation applications.

• It also does not support Photoshop panels.

Even without those exceptions, we cannot guarantee that all Photoshop plugins will work properly with 
ON1 Photo RAW. You should test each added plugin to make sure that it functions as intended. A current 
list of supported plugins can be found in the Help section of the ON1 website (on1help.zendesk.com).

NOTE: ON1’s Photo RAW MAX version can operate as a plugin to Adobe 
Photoshop, Lightroom, Photoshop Elements, Capture One and other photo 
editing apps. For information on using Photo RAW MAX as a plugin, see “Using 
ON1 Photo RAW MAX as a plugin to external applications” on page 304.

https://on1help.zendesk.com
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Extras

ON1 Photo RAW 2026 supports a number of additional file types that can be used in various modules. 
These files are called Extras, and the file types include:

• Presets for use within the Edit module.

• Paper presets (type and size) for use within Resize.

• Backgrounds that can be imported and used with Photo RAW’s Layers feature.

• Borders than can be imported and used in Layers and Effects.

• Textures that can be imported and used in Layers and Effects.

• Look-up tables (LUTs) for use with Effects’ LUTs filter.

• Custom brush shapes, which are generally saved as black-and-white TIF files. Photo RAW can 
also import brush shapes saved in the Adobe Brush Preset format (.abr).

• Sun flares, which can be imported and used with Effects’ Sun Flare filter.

• Watermarks, image files (transparent PNGs) that can be used with Export and Print.

• Skies, replacement skies for use with Photo RAW’s Sky Swap AI feature in the Edit module.

ON1 includes a number of extras in the product when you install Photo RAW, and you can create your own, 
or add extras downloaded from the ON1 website. You can use the Extras Manager to import and manage 
your own extras, creating categories for each type, and deleting extras that you no longer want.

HOW TO IMPORT EXTRAS

To import extras, choose Manage Extras from the File menu in Browse and Edit, then follow these steps:

1.	 Select the type of extras you wish to import from the list of tabs at the top. You can only 
import extras of one type at a time.

The Extras Manager is used to import (and remove) everything from presets to replacement skies, watermark files and 
more.
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2.	 Click on the Import button in the footer of the left column. A dialog box will open; select the 
files to import. If you want to import an entire folder, open the folder, select the first file, 
then shift-click on the last file. Click Import when your selection is complete.

3.	 Select a category for your extras to live in. This is where you will be able to find it inside 
ON1 Photo RAW 2026. When importing presets, you can select from a preexisting category 
or create a new one (which will show up in the Presets list). For other extra types, the first 
time you import, you’ll need to create a new category; after that, any time you import that 
type, you can choose that original category, or you can create another one. 

When your extras have been imported, they will be displayed in the a appropriate Extras Manager category.

NOTE: Most extra types mentioned here will have a corresponding Import 
button in their respective panes or windows. (For example, watermarks in the 
Export panel, or skies in the Sky Swap AI pane, and so on.) Clicking the Import 
button in these instances will open the Extras Manager. To import backgrounds 
and custom brushes, choose Manage Extras from the File menu.

Organizing presets

The Presets tab of the Extras Manager gives you additional options for working with large groups of 
presets inside Develop and Effects. When you are using the Presets tab, you’ll see ‘+’ and ‘-’ buttons, which 
let you add or delete categories to the list of your presets. 

You can also add subfolders to any of the Presets categories, which can help organize and manage large 
collections of presets. You can use drag-and-drop to move existing categories into another, or you can add 
a category subfolder to an existing category by clicking on the category and then clicking on the ‘+’ button 
in the Extras Manager window. (When you are importing presets, Photo RAW gives you the opportunity to 
add presets to any category folder or subfolder.)

The Presets section of the Extras Manager will also let you export presets, for sharing with other users, or 
to save seldom used presets for archiving purposes. To export a complete category, click on the category in 
the list on the left side of the window and click on the Export button. This will export a folder that contains 
a single .ONpreset file, which includes all of the presets from that category. If you would like to export a 
single preset, click on the preset from the list on the right side of the window and click Export.

What type of images can I import as Extras?

Here is a breakdown of the different file types that can be used with the various extras categories:

• Backgrounds and textures may be JPEG, TIFF, or Photoshop files.

• Border files must have a large central area that is transparent, so only files that support 
transparency, such as PNG, can be imported as borders.

• LUTs can be in either .3DL or .CUBE format.

• For custom brushes, Photo RAW can import Photoshop-compatible brushes saved as black-
and-white TIF files, or files saved in Photoshop’s .abr file format.
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• Sun flare files are usually JPEG files with a black background.

• Since most watermarks are overlays on top of an image, those files are usually PNGs with 
areas of transparency, although JPGs can also be used.

• Sky-replacement images may be any image file that Photo RAW can open, including JPEG, 
TIFF, or Photoshop files, although the most common types are JPG or TIFF. (See “Replacing 
Skies with Sky Swap AI” on page 200.)

NOTE: If you download an .ONPreset or .ONP file (for use with Develop or 
Effects), you can simply double-click on it to install it. For more information, see 
the Presets section of this guide, starting on page 133.

USING EXTRAS WITH LAYERS IN THE EDIT MODULE

You can view and add extras to any open document in the Edit module by adding a new layer. Just click 
Layer > Add Layer from the File menu to open up a file browser window on-screen, where you can choose 
installed extras or any file from your computer. For more on this, see “Working with Layers” on page 213. 

USING EXTRAS IN EFFECTS

You can access your imported borders, textures, LUTs and sun flares in Effects, as you would any of the 
default extras installed with Photo RAW. To use them follow these steps:

1.	 Open an image in Effects.

2.	 In the Filter Options pane, add the filter type you wish to work with from the Add Filter 
button (Borders, Textures, LUTs, or Sun Flare).

3.	 From the Category pop-up, select a category you have imported. User-added extras 
categories will appear at the bottom of the category list.

4.	 Choose an extra from the imported category.

NOTE: Each filter will have a different method for choosing its extras. Specific 
information on the different filters can be found in the Effects section of this 
guide: page 180 (Borders), page 84 (LUTs), page 196 (Textures), and page 
195 (Sun Flare). For information on working with custom brush shapes, see 
“Using Custom Brushes to Add Overlays To Photos” on page 164.

USING OTHER EXTRAS: WATERMARKS AND SKIES

Imported watermark files will be displayed in three locations: in the Logo section of the Watermark panes 
in Photo RAW’s Export (see page 253) and Print (see page 264) functions, as well as in the My Extras tab 
when you add a new layer to a document in the Edit module (see page 213).
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When you add replacement skies to the Extras Manager, each category that you added will be added to 
the Sky category list at the top of the Sky Swap AI pane. All skies in that category will be listed in the Skies 
pop-up menu under the Sky category menu. 

HOW TO DELETE EXTRAS

You can remove imported extras using the Extras Manager. Follow these steps:

1.	 Open the Extras Manager in any module (File > Manage Extras).

2.	 Click on the extras type that contains the content you wish to remove. This will display 
categories within that type.

3.	 To delete an entire category, select in the left column and click on the Delete button in the 
footer of the left column.

4.	 To delete individual extras, select them in the right column and click on the Delete (‘—’ in the 
Presets tab) button in the footer of the right column.

Deleting extras is permanent and cannot be undone.

NOTE: If you are using Photo RAW as a subscription, the Cloud Sync option will 
sync all of your imported extras between your licensed computers. See “Using 
ON1 Cloud Sync with Photo RAW” on page 75 for more about this service.



ON1 Photo RAW 2026 User Guide	 Part 1: Overview	 14

Customizing ON1 Photo RAW 2026
Photo RAW has a number of parameters you can change within the app, including the creation of custom 
keyboard shortcuts; customization of various panes; setting the interface’s font size; and how the app 
works with a mouse scroll wheel.

KEYBOARD SHORTCUTS

You can customize ON1 Photo RAW 2026’s hotkeys 
via the Keyboard Shortcuts window. This window 
lets you view and change the shortcuts for any tool, 
tool option, module, or menu item inside Photo RAW. 
You can assign shortcuts to menu items that don’t 
yet have a shortcut, build multiple sets of shortcuts 
as preset styles, and create a summary of your 
shortcuts that can be viewed in any web browser.

To view or change Photo RAW’s hotkeys, choose 
Keyboard Shortcuts from the Edit menu in any 
module. By default, the shortcuts will be displayed, 
organized hierarchically by the following groups: 

• Modules, commands for switching 
between Photo RAW’s different modules.

• Develop, for applying tone and color 
adjustments directly from the keyboard 
while you are working in the Edit module. 
(See “Adjusting Tone & Color settings 
via hotkeys” on page 127 for details on 
working with this feature.) 

• Tools, for the 18 tools available in the Edit 
module.  

• Tool Options, for the brush and mask 
viewing options available in any masking 
tool’s Options Bar.

• Menu, which includes all of Photo RAW’s menu items in each module. 

You open each group by clicking on the triangle to the left of the group name, or you can use the search 
field at the top of the Keyboard Shortcuts window to search for a command in any of the groups (right). 

NOTE: Some keyboard shortcuts cannot be changed. These include menu 
commands used by the operating system (Cut, Copy, Paste), and the Browse 
module shortcut (G). Also, you can’t use the Escape, Return/Enter, or Delete 
keys as a shortcut.

The Keyboard Shortcuts window displays a list of modifiable commands 
and operations in five distinct groups. The search field at the top of the 
window lets you quickly find commands based on keywords.
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Each command that has an assigned key will display that key in the Shortcut column. The Shortcut field 
will be empty for any command that doesn’t have an assigned key, and any field with a grayed-out shortcut 
means that you cannot modify that command’s keys.

Modifying hotkeys

The Default preset style’s hotkeys cannot be 
modified, but you can create your own set of 
shortcuts by double-clicking on any command 
you wish to add or change. You’ll be asked if you 
want to create a new preset. Clicking Yes will let 
you name the new preset style, and Photo RAW  
will make a duplicate of the Default set.

At this point, you can change any existing 
hotkeys, or add your own to commands that 
don’t have them, by double-clicking in the 
Shortcut field for that command. The field will be 
highlighted, and you can press the key or key 
combination you wish to use. If that key is used by 
another command, a dialog will inform you of 
that, and giving you the option of either keeping 
the existing hotkey/command combination, or 
changing it to the new command.

When you change a default shortcut to a new key combination—even for commands and options that didn’t 
initially have a shortcut—a Reset arrow will appear to the right of the Shortcut field. Clicking the icon will 
reset the command to its original state, from the Default preset style.

To delete a shortcut, double-click in the Shortcut field and press the Delete key. 

The Summarize button at the top of the Keyboard Shortcuts window will create an HTML table of the 
current set of hotkeys. You’ll be asked where to save the file, and double-clicking on it will open that table 
in your default web browser, where you can view or print the list. 

You can return to the original Photo RAW shortcuts by clicking on the pop-up menu at the top of the 
Keyboard Shortcuts window, and choosing Default from the list of preset styles. That menu can also be 
used to create a new preset or to delete an existing one that you created. The Default preset cannot be 
removed, however.

When you add or change a hotkey the first time, Photo RAW will prompt you to 
create a new preset style, which makes a duplicate of the Default preset. You 
can switch between preset styles—including back to Photo RAW’s Default 
set—by using the pop-up menu at the top of the Keyboard Shortcuts window.

If you try to add a shortcut key combination that is already in use, Photo RAW 
will let you know, and give you the option of keeping (Cancel) or removing (OK) 
the other command/shortcut.
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CUSTOMIZING THE DISPLAY AND ORDER OF TABS AND PANES

You can show or hide and rearrange certain 
aspects of Photo RAW’s interface via the Tab 
option pop-up menu, which is found in the 
primary photo information panes at the top of 
the right panel in the app (in both the Browse 
and the Edit modules); in the Edit module’s tabs; 
or in the Properties window (or pane).

To view the menu, hover over the end of the top 
pane in the panel, which will display the Tab 
options icon, represented by three, evenly 
spaced vertical lines. Clicking on the icon will 
display a list of the separate panes that make up 
the group. By default, all five panes (Nav, Levels, 
Info, History and Snapshots) are displayed. 
Selecting any of the items in that list will hide 
that pane. To restore a hidden pane, go to the 
Tab options menu and select it again.

In addition to showing and hiding certain panes, 
you can also rearrange the order of the visible 
tabs in the group. Click and hold the mouse on a 
tab you wish to move and slide it right or left to 
reorder the tab.

Photo RAW’s Properties feature has a similar Tab 
option icon that lets you hide one of the tabs 
(Blending, Masking or Text) from view. This icon is 
visible in either of the Properties display options: 
window or pane in the right panel.

In addition to displaying or hiding tabs, many 
of the panes in the Browse module have the 
capability to hide that pane from view via both 
the Window menu or the pane options menu. 
For example, you could hide the Tethered Shooting or the Metadata pane by clicking on the pane options 
icon and selecting Hide from the pop-up menu, or by unchecking the pane via the Window menu. Hidden 
panes can be restored by selecting them from the Window menu.

NOTE: For information on the panes at the top of the Photo panel in Edit, see 
“Navigator, Levels, Info, History and Snapshots” on page 90. The Properties 
window is discussed in detail starting on page 93. The Browse panes are 
discussed starting on page 36 (left side panes) and page 44 (right-side 
panes).

The Tab options pop-up menu is displayed when you hover over the end of 
the top pane in Photo RAW (circled in red, top). Clicking on the icon will 
display a pop-up of the separate panes; selecting one of the items in the 
list will remove (or add) that item from the pane. This function is also 
available in the Edit Module’ tabs, letting you rearrange the tab order, or 
hiding infrequently used tabs (like Portrait, shown below).

Reordering the top panes is easy: click and hold the mouse on a 
tab you wish to move, and drag right or left (top). When you let 
go of the mouse button, the tabs will be in a new order.

Many panes inside the Browse module have an option to hide that pane, which 
can be helpful to minimize the Photo RAW interface. All panes can be shown again 
from the Window menu.
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CHANGING PHOTO RAW’S FONT SIZE

By default, Photo RAW prioritizes the main workspace to focus on photos, using a small font size to display 
panel names, labels, file names any other basic text. You can adjust the default font size to one of three 
settings, Small, Medium or Large, by choosing the General tab of Photo RAW’s Preferences window. Select 
the option from the Font Size pop-up, and restart Photo RAW to have the effect take place. 

USING PHOTO RAW WITH A SCROLL WHEEL

When you are using ON1 Photo RAW 2026 with a mouse that has a scroll wheel, there are number of 
different options available throughout the app, on both Mac and Windows.

Throughout the app, the scroll wheel has the following general options:

• Using the scroll wheel will pan up and down in the current window. In Browse’s Thumbnail 
view, it will scroll the window. In most other views, using the scroll wheel with the cursor 
over the preview area will pan the image on screen up and down. Holding the Shift key down 
and scrolling will pan left or right.

• Hold Option (Mac) or Control (Windows) with the scroll wheel to zoom in or out of an image.

In the Edit module, when working with any tool that has a brush size and feather option, press Command-
Option (Mac) or Control-Alt (Windows) and scroll to change the brush size. To change the feather, press 
Option-Shift (Mac) or Alt-Shift (Windows).

If you would like the scroll wheel solely for adjusting the brush size, click the “Only Adjust Brush Size with 
Scroll Wheel” option in Photo RAW’s General Preferences window (see page 291).

Photo RAW has three options for displaying type in the main workspace, Small (left), Medium (middle), and Large (right). To change the size, go to the 
General tab of the Preferences window, and pick the new option from the Font Size window. The change will take effect the next time you launch the 
app.
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PART 2: ORGANIZING WITH BROWSE
ON1 Photo RAW 2026’s Browse module is a powerful and incredibly fast photo browser and manager. It 
gives you one place to find, view and manage your images, no matter where they are located.

Browse is an ideal environment for performing quick sorts and edits after a shoot: You can import, then 
view, your photos immediately without having to wait for a long cataloging or preview-creation process. 
You can rate, add keywords and flags, create albums, and even remove photos, all from within Browse. And, 
with Keyword AI, Photo RAW can automatically analyze your photos in the background, suggesting new 
keywords on the fly, providing options to search your photo library in entirely new ways.

Browse also has a sophisticated indexing system, designed to let you get access to your favorite folders of 
images quickly; just add a folder to the My Catalogs pane, and it will index your photos in the background, 
giving you increased search capabilities and even faster access to your most important photos. 

When using the ON1 Cloud Sync service (see page 75), you can easily share a cataloged folder or album 
with other computers of yours (a laptop, for example) and any of your mobile devices. 

Browse also lets you apply any editing presets from the Edit module directly to an image or group of 
images. You can copy edits made on one photo and paste them onto another, or even a group of photos.

The following is a list of Browse’s key features:

• Find your photos fast, wherever they are—local or network drives and cloud-based services—
with the Search Bar, and save frequently used searches as smart albums or filter presets.

• Manage duplicates or similar photos (and more) quickly with the Smart Organize feature.

• Import your photos from your camera, memory card or other device.

• Use Keyword AI to generate keywords automatically based on photo content, bypassing the 
often time-consuming task of manually tagging photos, so that you can find them easily later.

• Add any other metadata—from creator to keywords and GPS—quickly to a group of photos, 
and use metadata templates to apply often-used metadata information during the import 
process.

• Catalog important folders of photos, to get the fastest access to your most important photos 
across multiple sources, while still preserving your folder hierarchies and locations.

• View and cull photos from a shoot in four different views: Grid, Filmstrip, Detail and Compare 
views. Use the Map view to see where you shot your photos, or to add location information.

• Stack groups of photos of similar type or style to reduce the clutter and streamline the 
manner in which your photos are viewed.

• Dual-display capability that lets you work more efficiently. See Grid view on one display, and 
Detail view on another, or use this mode to present photos on a TV or projector.

• Apply Edit module presets to a single image or group, or sync edits across a group. Or apply 
ON1’s Brilliance AI to your photos directly from with in Browse.

• Build panoramas and high dynamic range (HDR) images directly from within Browse, and 
blend multiple photos at different focus distances to increase depth-of-field.

• Create flicker-free time-lapse videos from sequences of raw images.
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• Connect your Nikon or Canon camera and capture photos directly, with full manual camera 
support, using tethered-shooting mode.

• Quickly find photos based on their creation date, or any combination of metadata 
information, including time of day, camera/lens type, file type and more.  

• Create albums from a selection of photos, or use advanced searching methods to create 
“smart” albums that dynamically update based on metadata. You can also set an album to be a 
‘target’ to help with the culling process.

• Copy, move, delete and rename files.

• Sort, flag, rate or color code your images.

ON1 Browse Main Screen Overview

The Browse module has three main sections: the Catalogs/Browse/Presets panel on the left side of the 
screen, the Preview window in the center, and the Photo Info panel on the right side. The main components 
of Browse module include:

A.	Module Selector/More Options/Shortcuts: The top left panel includes icons for switching 
between Browse and the Edit module; a More button that lets you perform basic operations 
in Browse; and shortcuts to the Getting Started, Smart Organize and Albums, as well as to 
your most common photo storage locations. (See “Using Shortcuts” on page 22.)
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B.	 ON1 Cloud Sync/Cataloged Folder Progress/Open and Close Left Panel: Accesses the ON1 
Cloud Sync status window (when available) and the Cataloged Folder Progress windows. The 
icon at the bottom opens and closes the left panel. (See “Using ON1 Cloud Sync with Photo 
RAW” on page 75 for more on the syncing service.)

C.	 My Catalogs/Browse/Presets Panels: Switch between the cataloged folders panel, local 
drives and cloud sources, and Edit module presets by clicking on the tabs.

D.	Cataloged Folders/Favorites and Local Drives: Displays your cataloged folders (shown) or 
local disks and favorite folders, depending upon which tab has been selected.

E.	 Cloud Sync: Shows all ON1 Cloud Sync devices.

F.	 Albums Pane: This pane is for creating albums, also known as collections of images. Albums 
can be grouped into subfolders for easy organization. You can  set any album to be the target 
album, which lets you quickly and easily add any photo in Browse during the culling process.

G.	Smart Albums Pane: This pane includes collections of dynamically built albums based on 
criteria set in the Search Bar.

H.	Dates Pane: Search for photos based on the capture date. 

I.	 Recent Pane: This keeps track of recently opened files and folders.

J.	 Tethered Shooting Pane: This lets you connect your Nikon or Canon camera to your 
computer; you can capture images directly from the camera to ON1 Photo RAW.

K.	 View Selector/Preview Size: Switch between Grid, Detail, Filmstrip, Compare and Map 
views. The Preview slider adjusts the thumbnail size (Grid view) or the size of the currently 
viewed photo (all other views).

L.	 Search Location: Part of the Search Bar, this lets you choose where you’re searching on disk.

M.	Preview: The window where you view your images in thumbnail or detail view. 

N.	Breadcrumbs Bar: Shows the path of the selected image or folder in the Preview area; the 
pop-up lets you go back up the current folder tree, select another folder from recent items or 
your Favorites. To the right of the bar is the count of both the currently selected items in the 
preview area and the number of items in the folder or search operation.

O.	Search Bar criteria: Select criteria when using the Search Bar to find items in your library.

P.	 Sort/Smart Album/Smart Organize/Saved Searches: From left, the Sort icon lets you adjust 
the sort order of the current view; saves the current search operation as a Smart Album; 
opens the Smart Organize window; and lets you choose from a previously saved search, or 
the save the current search. 

Q.	Info Pane: This section will give you detailed metadata about your image when available. 
(Also displays Navigator and Histogram panes when in Filmstrip, Detail and Compare modes.)

R.	 Brilliance AI: This pane lets you apply the Edit module’s Brilliance AI feature to photos within 
Browse.

S.	 Metadata Pane: This pane will show your metadata for the selected image.

T.	 AI Keywords List: Displays a list of suggested AI-generated keywords for the current photo.

U.	EXIF/IPTC/Location Info: Displays additional detailed information about the selected file.

V.	 Keyword List: All keywords found in your image catalog.

W.	Reset All: Removes all edit adjustments made in Edit from the selected image or group of 
images.  
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Workflow Basics in Browse
ON1 Photo RAW 2026 provides a great deal of flexibility in how you wish to work with your photos. You 
can browse for existing photos in folders that are connected to your computer (including cloud services like 
Dropbox, Google Drive and Microsoft OneDrive). You can also import photos directly from your camera or 
other device. And, once you’ve found a photo (or photos) you wish to work on, moving to the Edit module is 
a single click away. 

If you store your photo library in a specific location on an internal or external hard drive (or multiple drives), 
you can have Photo RAW index those folders. This process ‘catalogs’ the photos, reading their metadata 
and building previews, letting you navigate and access your photo library much more quickly than if you 
were to simply look at a random folder of images. Cataloging a folder doesn’t move or change your photos; 
it just makes it easier for you to find and work with them inside Photo RAW.

Getting Started window

The first time you launch Photo RAW, Browse displays a Getting Started window, designed to help you get 
working quickly. This window has three options:

• Edit a Single Photo: clicking this button will give you the MacOS or Windows file-selection 
dialog, where you can navigate to a specific photo. Once you’ve chosen an image, Photo RAW 
will open that photo directly within the Edit module (starting with the Develop tab). You have 
access to all the editing tools, and when you’re done editing, you’ll be asked to save a copy 
of the edited version of your photo. (See “Working in the Edit Module” on page 83 for 
information on editing photos.)

• Browse a Folder: this button will open the file-selection dialog for your computer. There, you 
can navigate to a specific folder of photos. Clicking the Open button in that dialog will display 
that folder’s photos in the Browse Preview area.

• Catalog Your Photos: clicking this button will let you choose a folder to be cataloged by 
Photo RAW. This folder (and any subfolders of photos within it) will be added to the My 
Catalogs pane. (See “Cataloged Folders” on page 37 for info on creating cataloged folders.)

The Getting Started window is designed to help you get working quickly with ON1 Photo RAW 2026.
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The Getting Started window can be accessed at any time by clicking the ‘+’ button in the Shortcuts section 
on the left side of the Browse window (see “Using Shortcuts” on page 22), or via the Help menu. 

NOTE: If you wish to use the full non-destructive editing capabilities of Photo 
RAW when working on your photos, do not use the Edit a Single Photo option. 
Instead, inside Browse, find the photo you wish to edit, select it, and click on 
the Edit module selector on the right side of the main window. (See “Using 
Photo RAW as a Raw Editor” on page 85 for more about non-destructive 
editing and why it might be important to your workflow.)

USING SHORTCUTS

The Shortcuts selector on the left side of the Browse panel is a list 
of icons designed to give you quick access to a number of commonly 
used system destinations or Browse functions. It can be displayed 
or hidden, depending upon your preference, by choosing the Show 
Browse Shortcuts from the Window menu. 

From top to bottom, the icons represent the Getting Started window; 
your Desktop, your default Browse location, which can be set in the 
General Preferences tab (see page 291); cataloged folders; local 
drives; albums; the Smart Organize window, and ON1 Cloud Sync 
devices. Clicking on one of the icons will either display the shortcut’s 
contents in the Preview window (Desktop, Pictures, Cataloged 
Folders, Local Drives, Cloud Services, Albums, Cloud Sync), or will 
open a specific function window in Photo RAW (Getting Started, 
Smart Organize).

By default, the Pictures shortcut uses your My Pictures folder (Windows) or Pictures (Mac). You can change 
the default location in the General section of the Preferences window (see page 291).

THE MORE MENU

Above the Shortcuts section is the More button, which contains a group of 
additional options for Photo RAW. Clicking on the button displays a menu that 
includes the following items:

• Develop: Switches to the Develop tab with the currently selected 
photo (see page 147)

• Local adjustments: Switches to the Local tab with the currently 
selected photo (see page 162).

• Sky Swap AI: Switches to the Sky Swap tab with the currently selected 
photo (see page 200).

• Portrait AI: Switches to the Portrait tab with the currently selected 
photo (see page 205).

Clicking on the More button 
gives you additional options for 
functions inside Photo RAW.
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• Effects: Switches to the Effects tab with the currently selected photo (see page 
167).

• Resize AI: Switches to the Resize module with the currently selected photo (see 
page 233).

• Merge to Layers (multiple photos only): Takes the currently selected photos and 
opens them as a new composite file in the Layers portion of the Edit module (see 
page 213).

• Merge to HDR (multiple photos only): Takes the currently selected photos and 
opens them in the HDR Merge window (see page 225).

• Merge to Panorama (multiple photos only): Takes the currently selected photos 
and opens them in the Panorama Merge window (see page 222).

• Merge to Focus Stack (multiple photos only): Takes the currently selected photos 
and opens them in the Focus Stack window (see page 228).

• Merge to Time Lapse (multiple photos only): Takes the currently selected photos 
and opens them in the Build Time Lapse window (see page 230).

• Export: Takes the currently selected photo or photos and opens Photo RAW’s 
Export window (see page 253).

• Print: Takes the currently selected photo or photos and opens Photo RAW’s Print 
window (see page 264).

• Share: Takes the currently selected photo or photos and lets you share them to 
SmugMug, or, on MacOS, to various locations on your Mac (see page 232).

Selecting any of these items will perform the action described above; note that some of these 
options will take you out of the Browse module.

Earlier versions of Browse had a series of icons on the right side of the main screen that 
accessed the same items found in the More menu. If you would like to display that set (shown 
in the screen shot on the right), select “Show Right Bumper” from the Window menu.

Working in the Preview Area
The Preview window is the largest part of the Browse workspace. Here, you can view folders of images 
(including all images synced via ON1 Cloud Sync) in either thumbnail or detail view, based on the folders, 
albums or filters you have chosen via the Browse panel. There are five main views in the Preview window:

• Grid, which displays a grid of thumbnails of your images. 
This view also displays folders, letting you go up and 
down a folder hierarchy quickly. You can also change the 
information displayed in each cell in the grid.  
Shortcut key: G

• Photo (also known as Detail), which you get by double-
clicking on a thumbnail. You can view this image in either 
‘fit to window’ view, or can zoom in to see more detail. 
Shortcut key: E

The View pop-up at the bottom left side of the main 
Browse window displays the four detail-oriented 
view options.

The right 
bumper can be 

turned on or 
off via the 

Window menu.
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• Filmstrip, which displays a strip of images from a folder or album at the bottom of the screen. 
The currently selected image displays in the preview area above the strip; use the arrow keys 
to move through the folder, or click on an image in the filmstrip to view it in the preview area. 
Similar to Detail view, the Filmstrip mode lets you view the current image in ‘fit to window’ 
and zoom views. Shortcut key: F

• Compare, which lets you view a group of photos in separate panes inside the preview area. 
You can zoom in on one or all of the selection, and lock the panning so that, as you move 
around one photo, the others move with it. Using Compare, you can quickly find the best 
images in a sequence, whether it be for composition, sharpness, facial expressions or more. 
Shortcut key: C

• Map, which can be used to display locations for photos that have GPS-based location data, or 
to search for locations that can then be applied to a photo or group of photos. Shortcut key: M

You can change the viewing mode between the different views by clicking on the view selector at the 
bottom of the window, or by using the shortcut keys listed above. 

NOTE: You can use your mouse’s scroll wheel in Browse’s view modes to help 
navigate and to zoom in and out. See page 16 for more information.

USING THE BREADCRUMBS BAR

At the bottom of the main window in Browse and Edit is the Breadcrumbs 
Bar, which displays name of the currently selected photo and the folder 
in which it resides. If you are in Grid view, the bar will have the number of 
selected photos and the total number of photos in the folder. In all other 
views (Photo, Filmstrip, Compare, Map, and in the Edit module), the bar 
displays the order number of the current photo in the folder (based on the 
current sort order) and the total number of photos in the folder.

Clicking on the downward-facing triangle presents a pop-up menu with 
three sections: the path of the current folder (to the root of the drive), the 
list of your favorite folders (see “Favorites” on page 38), recent folders, 

The Breadcrumbs bar displays the name of the current folder location and the number of photos in the folder. In Grid view, the bar shows the 
number of selected photos. In all other viewing modes (including those in the Edit module), the name of the current photo is listed, as well as 
its order in the folder.
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and recent files. Regardless of the viewing mode you are in, selecting any item from those sections will take 
you to that folder, displaying the first photo in the folder. If there are no photos in that folder, Photo RAW 
will display a “No Photos Found” label in the preview area.

ALTERNATIVE VIEW MODES

In all of Browse’s preview modes you have three options for viewing the contents of the current window:

• Photo RAW’s default is a resizable, movable window.

• Full Screen Mode, which can be found in the Window menu, will expand the main window 
to fit the contents of the current display. The menu bar is hidden, but it can be viewed by 
moving the mouse cursor to the top of the screen. This mode can be toggled on and off by 
pressing Option-Control-F (Windows) or Command-Control-F (MacOS).

• Full Screen Preview, also found in the Window menu, will display the currently selected 
photo full-screen, without any of the other interface elements. You can use the arrow keys 
on the keyboard to move from photo to photo. This option is helpful when you wish to view 
a selection of photos as large as possible without any distractions. (This mode can also be 
turned on by pressing Shift-F (MacOS only).)

Using Photo RAW to display slideshows

You can create on-the-fly, full-screen slideshows to display groups 
of photos inside Browse. Select a group of photos in the preview 
area, and choose Quick Slideshow from the Window menu. The 
slideshow will loop until you stop, by pressing the Esc key.

The Quick Slideshow submenu has options for the amount of time 
between slides and whether to display a fade transitions between 
slides or have no transition at all. 

FAST PREVIEW MODE

Sometimes, when you get back to your computer after a shoot, you want to be able to go through a large 
number of photos quickly, looking for your best shots. ON1 Photo RAW’s Fast Preview mode lets you do 
just that. Select Fast from the View menu’s Preview Quality option, and you can jump from photo to photo 
quickly with minimal lag between shots.

If you are more concerned about color accuracy than speedy previews, select Accurate from the Preview 
Quality option in the View menu. ON1 Photo RAW will generate a full-resolution preview of your photo, 
using the photo’s embedded color profile. This will take a few seconds, depending upon the size of the raw 
file you’re working with, but you will get a better sense of the actual color in the photo.

Persistent Thumbnail Cache

When you go through a folder of photos, Browse caches thumbnails and preview images as well as 
extracted metadata. This will make it faster the second time you browse a folder. It also stores user-added 
or adjusted metadata such as ratings, labels, keywords, captions, rotation and GPS data, among others. You 
can adjust the size of the cache and the storage location of the cache in the System tab in Photo RAW’s 
Preferences window (see page 298).
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FOCUS AND CLIPPING VIEWS

When you’re viewing photos with an eye toward selecting the best images in a group for editing, you 
generally want to look at issues with both exposure and sharpness. To help you with this, Photo RAW 
offers two viewing aids that are available in both the Browse and Edit modules: Clipping and Focus Mask 
overlays. In the Browse module, you can display these overlays in Detail, Filmstrip and Compare modes; in 
the Edit module, the overlays can be displayed in any of the tabs.

Clipping

Clipping occurs when the shadow and highlight tones in an image 
are suddenly cut off to completely white or black, rather than fading 
smoothly. (Large expanses of white pixels in a photo are often 
referred as ‘blown’ highlights, and can be distracting.) One of the 
benefits of shooting in raw format is that, while many photos will 
have areas of pure white or black when originally viewed on-screen, 
there is still recoverable data in the raw image. The Clipping overlay 
can help determine how big a problem you might have with a photo, 
and how easy (or difficult) it will be to fix. 

To display the Clipping overlay temporarily, press the J key; to 
turn it on permanently, choose View > Show Clipping, or press Alt 
(Windows) or Option (Mac) J on your keyboard.

The Clipping view overlay displays areas that have either pure white or pure black in them. Areas with a 
blue overlay indicate pure black pixels, while the areas with a red overlay indicate pure white pixels.

Focus Mask

It can often be difficult to view the sharpness in a photo without 
zooming in to 100% or more, and if you have a lot of photos from 
a shoot, it can be a bit tedious to check focus at that level. Photo 
RAW’s Focus Mask overlay can help winnow your shots down to the 
sharpest ones.

To turn on Focus Mask, choose View > Show Focus Mask, or 
press Shift-Alt/Option J. The sharpest areas in your image will be 
represented by a bright green overlay. As you move from photo 
to photo in a folder, you’ll be able to tell whether you have an 
acceptable level of sharpness where you need it by the strength 
of the overlay. The mask will continue to be displayed even as you 
zoom in on a photo.

You can view either the Clipping or Focus Mask at any one time; you 
cannot see both views at the same time.

Clipping view displays pure white pixels with a red 
overlay, and pure black pixels with a blue overlay.

The Focus Mask option displays areas of sharpness 
with a bright green overlay.
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WORKING IN GRID VIEW

Grid view displays thumbnails of folders and images you have selected using the Folder or Albums panes. 
There are many operations you can perform from inside Grid view, including:

• Use the breadcrumbs to navigate (the ‘<’ button goes up one folder).

• Select your image while in Grid view and open the photo in one of the editing tabs.

• Adjust thumbnail size using the on-screen slider or use “-/+” keys on your keyboard.

• Choose Show Subfolder Contents from the View menu when you want to view the contents 
of all subfolders (this only works when you are viewing cataloged folders).

Changing the thumbnail display options

You can change the display characteristics of each thumbnail cell 
in Grid view, via the Thumbnail View Options command, which 
is in Browse’s View menu (and available when you right-click on 
any thumbnail in the grid). The Thumbnail View Options window 
has two sections, one for choosing the appearance of each 
thumbnail, the other for the information labels associated with 
each thumbnail.

In the Appearance section, the Size option sets the size of the 
top and bottom label text (Small or Large); the Fitting options let 
you set the image thumbnail so that all of the image is displayed 
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(Fit) or that it fills the frame of the thumbnail (Fill); and the Theme option lets you choose a Dark or Light 
appearance.

The Labels section lets you adjust the displayed data for the top (right and left sides) and the bottom 
labels in each thumbnail, and how each label is displayed—all the time, or only when you mouse over the 
thumbnail. You can also choose whether to display the rotation arrows and edit badges (which indicate that 
the image has been edited inside Photo RAW), as well as preview images for folders viewed inside Browse.

By default, the labels are set up to display the ratings and label information on the top left, the favorites 
state (like, empty, reject) on the top right, and the bottom displays the filename. You can however, set any 
of the three label locations to display any of more than 20 pieces of metadata, including filename, camera 
and lens information, exposure and ISO, capture date, ratings, image dimensions, and much more.

NOTE: Most of the available fields in the Thumbnail View Options are also 
visible in the Metadata panel. See page 45 for more information.

Sorting photos in Grid view

When working in Grid view, you can sort the thumbnails in a number of different ways by choosing the Sort 
By pop-up at the top of the window. The sorting options include: date captured or modified; color label; file 
name, type, or size; and rating. 

At the bottom of the Sort pop-up are settings for 
sorting the view in ascending or descending order. If 
you have a custom sort order, choosing these options 
will change the view in the opposite order.

You can also create a custom sort order by dragging 
thumbnails inside the grid window; click and drag the 
thumbnail so that the outline sits between two images. 

Once you change the order of images this way, the 
Sort pop-up will change to Custom, and Photo RAW 
will remember the sort order for that folder until you 
change it. (Custom sorting also works—and the custom 
order remembered—when you’re viewing albums.)

Metadata viewing in Grid view

When you have the Photo panel open on the right side of the screen in Grid view, Photo RAW will display 
the Info pane at the top, which includes summary information about the selected photo, and the Metadata 
and Keyword panes, which let you view, edit and adjust many of the metadata fields for the current photo. 
When you have multiple items selected, the panes will display the information for the primary item in the 
selection (represented with a heavier outline in the grid); adding keywords or other editable metadata 
(author, location data or descriptions, for example) will apply those items to the entire selection. See page 
44 for more on the Photo panel and its operation.  

To reorder a photo in Grid view, drag it between the two photos where 
you want it to be placed.
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WORKING IN PHOTO (DETAIL) VIEW

In Photo view—also known as Detail view—you get a full-screen version of your photo. When you go to 
this view, your images will be displayed in Fit mode, showing the entire image. You can click on the image 
to zoom in to 100%. This is useful for judging small details and sharpness. Single-clicking on a image that is 
magnified will return back to Fit mode. You can click and drag a magnified image to look around. Your zoom 
mode is maintained as you move from image to image so you can compare the same spot in several frames.

When you view an image in Photo view and have the right-hand Photo panel open (as shown above), the 
Levels, Navigator (Nav) and Info panes will be visible as tabs at the top of the panel on the right. Clicking on 
the label will display that tab’s data. In the Navigator pane you can reposition the preview and change the 
magnification amount. The Levels pane displays a composite histogram of the image being displayed. You 
can also view and adjust the rating and flag labels for the current image, either via the keyboard or via the 
Info pane. (See “The Photo Panel” on page 44 for details on the Nav, Levels and Info panes.)

You can also apply Brilliance AI to a photo in Photo view (as well as in Filmstrip and Compare views), and 
you can add author, keyword, description and other information via the Metadata and Keyword List panes. 
Moving to the next image in the current folder is achieved by using the arrow keys on your keyboard.

In Detail view, you can zoom to 100% to check small details and sharpness in a photo, view its histogram, and even apply a preset, all without having to leave 
Browse.
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WORKING IN FILMSTRIP VIEW

Filmstrip view presents a large version of your current image in the preview area, displaying other photos 
from the current view in a strip of thumbnails at the bottom of the screen. The photos are sorted by the 
current sort order, which can be changed via the Sort pop-up above the strip.

The current image is represented by a blue rectangle in the filmstrip, and you can use the arrow keys to 
move from photo to photo, or you can scroll with your mouse and click on a photo to display it in the 
preview. (You can also rate and flag images inside this view.)

When you view an image in Filmstrip view and have the right-hand Photo panel open (as shown above), the 
Levels, Navigator (Nav) and Info panes will be visible as tabs at the top of the panel on the right. Clicking on 
the label will display that tab’s data. In the Navigator pane you can reposition the preview and change the 
magnification amount. The Levels pane displays a composite histogram of the image being displayed. You 
can also view and adjust the rating and flag labels for the current image, either via the keyboard or via the 
Info pane. (See “The Photo Panel” on page 44 for details on the Nav, Levels and Info panes.)

NOTE: Filmstrip view is also available as a view in Photo RAW’s Edit and 
Resize modules. In Edit, you can rate and flag photos, using the same keyboard 
shortcuts, and move from image to image for editing. In Resize, Filmstrip view 
lets you batch-process multiple images.

Filmstrip view is similar to Detail view, but displays a strip of photos from the current folder (or album). You can easily move to another photo by using the 
right and left arrow keys, or by scrolling and clicking with your mouse.
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WORKING IN COMPARE VIEW

Compare mode is for those times when you shoot a sequence of photos of the same type of scene—a 
portrait session, a wedding, a landscape series, for example—and wish to narrow that group down to 
find your best ones. With Compare, you can select a group of photos, view them side-by-side to check 
composition, zoom in simultaneously to check focus, and rate your favorites and remove the rejects.

To use Compare mode, you can choose one of two methods:

• Select a group of images you wish to compare in either Grid or Filmstrip view. To select a 
group of contiguous photos (ones next to each other in order), simply click on the first one 
you wish to compare, then hold down the Shift key and click on the last photo. If you want to 
add noncontiguous photos, click on the first photo, then use the Command (Mac) or Control 
(Windows) key and click on each subsequent photo you wish to compare. When you have 
your selected photos, press the C key, or click on the Compare icon in the View Selector at 
the bottom left of the Browse window.

• You can also select photos directly in Compare mode: press the C key or click on the 
Compare icon in the View Selector at the bottom left of the Browse window. In the strip at 
the bottom of the window, you can select the photos in the same manner as the first option, 
by clicking on the first photo in a sequence, and Shift-clicking on the last, or by using the 
Command (Mac) or Control (Windows) key to select noncontiguous photos from a group.

When you enter Compare, you will see your selected photos in a grid in the Preview area, fit to show the 
entire photo. The currently selected photo will have a blue box around it, while the other items in the 

Compare mode displays selected photos as panes inside the preview area. The photo highlighted with a blue box is the current selection. Clicking in that pane will 
zoom the photo; if the Lock pan/zoom box is checked (above the filmstrip), then all of the compared photos will zoom with it.
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selection will have a light gray box around them. You can switch the primary selection by using the arrow 
keys on your keyboard, or by clicking inside the pane you wish to make primary. 

If you click once inside the current selection, the photo will zoom in to show greater detail; if you click and 
hold the mouse button down, you can pan across or down your photo, so you can check for things like 
detail, sharpness or facial expressions. (Clicking a second time inside the pane will reduce the photo to fit all 
of it in the pane.) 

To see the detail across the group of selected photos, click on the Lock pan/zoom dot above the filmstrip. 
Now, when you click on an area inside the primary photo, all of the photos will zoom simultaneously to the 
same location of your click. And, if you click and drag inside the primary photo, all of the selected photos 
will pan along with the primary. To pan one photo—which can be useful if the field of view was different 
than the rest—click on that photo to make it the primary selection, then hold down the Shift key and click 
and drag inside that pane. If you do this and wish to get back to the original zoom position, click on the 
Sync button next to the Lock pan/zoom setting, and it will reset the zoom view to the same place in each 
compared photo.

Use the spacebar if at you want to zoom between fit and 100% on the selected photo in the grid. Toggling 
the spacebar between views does not “lock” and will not sync with other photos even if Lock is turned on.

If you wish to remove a 
photo from the group, 
select it (by clicking on it 
or by pressing the left or 
right arrow keys) and press 
the / (slash) key on your 
keyboard. The photo will be 
removed from the Compare 
window, and the remaining 
photos will resize to best fill 
the available space in the 
window. (You can also add 
additional photos to the 
Compare window by using 
the selection techniques 
mentioned above.)

When using Compare, you can rate or flag a photo, apply a preset and add other metadata. These functions 
will only be applied to the primary selected photo (outlined in blue). There are two exceptions:

• Using the Sync settings button on the far right side of the Browse window, underneath the 
Info pane. Clicking on that will sync all of the Edit settings between the primary selection and 
all of the items being compared.

• Using the Create Album or Add to Album commands from the Albums menu: this adds all of 
the currently selected photos to either the new album (when you check the Add Selected 
Items button) or to the chosen album. This feature can be helpful when you have a group of 
images that you would like to keep for a client or to further segment a series.

Zooming into a photo, and panning to the common areas of concern, you can easily determine which photo is 
sharp enough for your needs.



ON1 Photo RAW 2026 User Guide	 Part 2: Organizing with Browse	 33

WORKING IN MAP VIEW

Photo RAW’s Map view provides a simple mechanism to add GPS information to a photo, by searching 
for a place on a web-based map, or to view the location of a photo that already has location information 
embedded in its metadata. An internet connection is required to add or view map data.

The Map display has three controls: the buttons in the upper left corner of the map, to switch between 
Street, Satellite and Outdoors (topographic) views; a search area, which lets you look for a place (cities, 
counties, roads); and the controls on the lower left, which let you zoom in or out of the current map view. 
To move around the current view, click and drag inside the window. The filmstrip displays other photos in 
the current folder. To move between photos you can use the arrow keys, or you can use the mouse to 
select a new photo.

To view the location of any GPS-tagged photo on a map, 
select the photo and click on the Map view icon at the 
bottom of the main Browse window.

To add GPS data to a photo, select a photo or group of 
photos and click on the Map view icon at the bottom of the 
screen. There you can search for a location via the search 
bar. Once you have the desired area, right-click on the map 
to add a location for the photo (or photos) in that spot. If 
the position is correct, click inside the pop-up box to set the 
pin. 

If you would like to choose a different point instead, right-click in another location. 

Right-clicking on a spot on the map will generate this pop-up. To 
confirm the location, click in the box; otherwise, you can 
right-click elsewhere to choose a different location.
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Once added, Photo RAW will enter that position in the GPS field of the Metadata panel. 

Photo RAW can also look up standard location information — city, 
state, country — from the GPS coordinates in a photo, and populate 
that information in the Location tab of the Metadata pane (shown 
on the right). To do this, click on the photos you wish to update and 
choose Set Location from GPS Coordinates from the Photo menu. 
(See “Metadata Pane” on page 45 for more information.)

STACKING PHOTOS

To help with the organization of your photo library, Browse lets you group photos into collections of 
‘stacks.’ Stacks can be whatever you wish them to be, for example:

• Photos that are visually similar, have similar subjects, or similar poses;  

• A bracketed set of images for use with focus stacking or HDR generation; or

• A series of photos that are used to build a panorama.

The only restriction on a stack is that the photos must reside in the same folder.

To create a stack, select the photos that you wish to group together, right-click on one of them and choose 
Group into Stack from the Stacks pop-up, or press Command-G (Mac) or Control-G (Windows). Photo RAW 
will group the photos together and collapse the stack, using the superselected photo (with a darker blue 
outline) as the ‘cover’ for the stack. The stack will have a badge in the upper left with a number 
representing the number of photos in the stack. You can click the badge to expand the stack, and click it 
again to collapse it (see below).

When a stack is closed, the number of photos in the stack is represented by a badge in the upper left corner of the thumbnail (top). 
Clicking on the badge will expand the stack, displaying the hidden photos (bottom); the badge now displays what number the photos is in 
the stack.
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You have a number of options when working with stacks — including automatically generating stacks from a 
selection or a folder — all of which are available from the Stacks contextual pop-up menu presented when 
you right-click on an image in Browse.

• Group into Stack: Groups the currently selected photos into a 
stack.

• Unstack: Takes the currently selected stack and unstacks it, 
removing the stack from Photo RAW.

• Collapse/Expand Stack: Collapses or expands (if it is collapsed) 
the current stack.

• Expand All Stacks: Expands all the stacks in the current folder.

• Collapse All Stacks: Collapses all the stacks in the current 
folder.

• Set to Top: When a single image is selected within a stack, this 
will set it to the top of the stack, removing the previous photo.

• Add to Stack: Adds photos to an existing stack. When a stack is selected (and collapsed), hold 
down the Command (Mac) or Control (windows) keys and click on the photo (or photos) that 
you wish to be in that stack. 

• Remove from Stack: Removes a selected photo (or photos) from the stack it resides in.

• Automatic Stacking: Builds stacks automatically from a selection of photos based on visual 
similarity and/or time between shots.

Stacks are visible and operational in all of Browse’s views, with the exception of Photo (Detail) view, as well 
as within the Edit module’s Filmstrip view.

The Stacks menu options are available from 
the contextual (right-click) pop-up menu.

The Auto Stacking window lete you creat stacks automatically based 
on two criteria, visual similarity or the time between shots.
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My Catalogs, Browse and Presets Panels
On the left side of the Browse window are three tabs, My Catalogs, Browse and Presets. My Catalogs 
and Browse are designed to let you organize and find your photos quickly and easily, while the Presets 
panel lets you apply Edit module presets to your photos directly in the Browse module. (See “Applying Edit 
Module Presets in Browse” on page 69.) To move between the panels, click on the appropriate tab at the 
top of the panel. You can hide the left panel by clicking on the Show/Hide Panel icons at the bottom left 
and right sides of the panel. (Pressing the Tab key will show and hide both panels simultaneously.)

DIFFERENCES BETWEEN MY CATALOGS AND BROWSE TABS

The top panes in the My 
Catalogs and Browse panels 
contain different views of your 
folders and other sources, most 
of which are designed to help 
you with file-related tasks. 

The My Catalogs pane lists all 
of your cataloged folders and 
your registered ON1 Cloud 
Sync devices, as well as the 
Albums, Smart Albums, Dates, 
Recent, and Tethered Shooting 
panes. 

The Browse panel includes 
a Favorites pane, which lets 
you add and access frequently 
visited folders; it also includes 
a configurable list of cloud 
storage services. The remainder of the panel includes Local Drives, Albums, Recent, and Tethered Shooting.

NOTE: Earlier versions of ON1 Photo RAW combined the Cataloged 
Folders and Local Drives tabs into a single Browse panel. If you prefer that 
arrangement, check the Legacy Browse tab option in the General Preferences 
screen. (See “General Settings” on page 291.)

Navigating Sources

To view the contents of any folder in the Cataloged Folders or Local Drives panes, click on the folder name. 
This will display the photos and subfolders within the selected folder inside the Preview area. To view the 
contents of a subfolder, either click on the subfolder inside the Folders pane, or double-click on it in the 
Preview area. (You can use the breadcrumbs bar at the top of the Preview area to navigate back to the top 
of your folder system.)

The My Catalogs view (above left) displays your cataloged folders and ON1 Cloud Sync devices you have 
registered, while the Browse view (above right) displays folders designated as Favorites (for quick access), 
attached local drives and any cloud storage services you have installed on your computer.
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TIP: Any pane in Photo RAW, in any module, can be collapsed by clicking 
anywhere in the pane’s title bar. 

CATALOGED FOLDERS

A cataloged folder is a shortcut for your favorite or most-used folders of photos. A folder designated as 
cataloged is cached in the background to improve the speed of loading those folders (and any subfolders) 
and their photos. Cataloged folders are ideal for portfolios, your favorite photos, or for your primary library 
of photos. Cataloged folders are necessary (with one exception) when using the Search Bar to search for 
photos across multiple folders (see “Finding and Filtering Images with the Search Bar” on page 59).

You can make any available folder a cataloged folder 
by clicking on the ‘+’ button at the top of the Cataloged 
Folders pane; by right-clicking on a folder in the Preview 
area of the Browse panel and choosing Make Cataloged 
Folder from the pop-up menu; or by choosing Add 
Cataloged Folder from the File menu. The cataloging 
process is designed to work in the background, so it 
doesn’t affect other work you do in any Photo RAW 
module. (You’ll see a small progress indicator to the right 
of the folder as this process happens.)  

When you catalog a folder, the Catalog Properties 
window opens. You will be prompted to choose the size 
of the previews that are generated during the cataloging 
process, and whether you wish to publish the folder to 
ON1 Cloud Sync. The three thumbnail options are:

• Standard, which extracts the image metadata 
and EXIF thumbnail and creates a high-quality thumbnail and a fit-screen-sized preview.

• Medium, which extracts metadata, EXIF thumbnail and creates a high-quality thumbnail.

• Embedded, which extracts metadata and the EXIF thumbnail only, using that until a high-
quality preview is required.

For most purposes, you’ll want to choose the default preview size, Standard. If, however, you are working 
with a system that has disk space restrictions, or have a network connection to your cataloged folder, 
choose either Medium or Minimal. 

Other options in the Catalog Properties window include:

• Scan Frequency: determines how often Photo RAW will scan the folder for new, changed or 
removed photos and folders within that cataloged folder. 

• Keyword AI: sets the level of AI-keywording for that folder. (See “Keyword AI” on page 
47.)

• Publish to Cloud Sync: lets you select whether that folder’s contents get synced to the ON1 
Cloud or not, and if published, whether you want the original or an editable proxy to be 
uploaded to the cloud. (See “Using ON1 Cloud Sync with Photo RAW” on page 75.)

The Catalog Properties window.
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A cataloged folder that has been published to ON1 Cloud Sync will display the Cloud Sync icon next to the 
folder name. 

You can change the settings for each catalog folder by right-clicking on it in the Cataloged Folders pane and 
choosing Catalog Properties from the pop-up menu. To remove a cataloged folder, right-click on the folder 
in the pane and choose Remove Cataloged Folder. To unpublish it from ON1 Cloud Sync, right-click the 
folder and choose Unpublish from ON1 Cloud Sync.

Adding photos to existing cataloged folders

You can add photos from any location inside Browse to 
an existing cataloged folder via the Copy to My Catalogs 
option. To use this feature, you must already have at least 
one cataloged folder. Then, when working in Browse, select 
the photo or photos you wish to add, and choose Copy to 
My Catalogs from the File menu, or via the folder icon (with 
a ‘+’ button) to the right of the search bar at the top of the 
Browse window. (You can also right-click on a photo and 
choose Copy to My Catalogs from the pop-up menu.)

Inside the Copy to My Catalogs dialog box, you can choose 
which cataloged folder you wish to copy the photos, can 
add them to a new subfolder, and choose whether to move 
the photos or copy them. If you are copying to a folder that 
has been published with ON1 Cloud Sync, those photos will 
automatically be synced to the cloud.

Moving the files is only available when you are moving the 
photos to a new location on the same drive; otherwise, a 
copy of the file is made in the new location.

FAVORITES

Photo RAW’s cataloged folder feature is useful for 
keeping your primary photo library organized, but there 
might be times when you have a group of folders that 
you frequently access, but that you do not wish to have 
cataloged. (One common instance might be a folder where 
you export temporary images for social media or other 
uses.) In these cases, the Favorite folders option can be 
helpful. Any folder you designate as a favorite will appear 
in this area, along with cloud-based storage services like 
Google Drive, Dropbox and OneDrive.

To add a folder to the Favorites pane, you can click the ‘+’ button in the Favorites pane. You’ll get 
your system’s file/folder selection window. Navigate to the folder you wish to add, then click Open. 
Alternatively, you can navigate to your chosen folder in Browse and drag the folder onto the ‘+’ icon in the 
pane, or right-click on the folder and choose Add to Favorites from the pop-up menu.

The Copy to My Catalogs dialog box lets you copy or move 
selected photos into your existing cataloged folders.

The Favorites pane lets you add frequently accessed folders that 
might be used for temporary or other applications.
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Cloud storage services

Browse supports cloud storage services from Dropbox, Google Drive, and Microsoft OneDrive. These 
services—when installed on your computer and other devices—keep local copies of your images on your 
computer, and Browse can find and monitor these locations automatically. 

During the installation process, ON1 Photo RAW 2026 automatically looks for the default installation 
locations for these services. If you do not have one of these services installed, and wish to remove it, right-
click on the service name in the Favorites pane and choose Remove from Favorites from the pop-up menu. 
If you add one of these services after installing Photo RAW, click the ‘+’ button at the top of the pane, and 
locate the folder via your computer’s file-selection window. 

LOCAL DRIVES

Browse automatically recognizes any disk (volume) inside 
or attached to your computer. This includes internal and 
external hard drives, optical drives, thumb drives, digital 
camera memory cards, digital cameras, any devices that 
support USB Mass Storage, and network-attached services 
(including mapped volumes on Windows).

Disks appear in the Local Drives pane below the Favorites 
section, with a hard drive icon next to them. Keep in mind 
that some disks, like optical drives, are often read-only. 
You will be able to view a copy of a photo, but will be 
prompted to save the image to a new location if you wish 
to edit it.

ALBUMS PANE

The Albums feature lets you organize or keep track of photos 
on a project, event or even a broader category like a portfolio. 
Albums are created by selecting images manually and adding 
them to a new (or existing album) by dragging and dropping 
photos onto the pane. You can nest albums together to 
help manage your collections, and all albums created can be 
published to ON1 Cloud Sync, which are indicated by the Cloud 
Sync icon to the right of the album name. (Any albums created 
on other Cloud Sync devices will be displayed in the Albums 
pane on all of your connected computers.)

Creating an album

Click the ‘+’ icon in the pane and choose Create Album… from the pop-up menu. You can also create an 
album by selecting photos and dragging them onto the ‘+’ icon in the Albums pane.

The New Album dialog box gives you options for adding an album name, whether you wish to add the 
selected photos to the new album, and whether you wish to set the album as a Target Album (see below for 
more information on target albums).
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If are using ON1 Cloud Sync, there will also be an option to publish the album to the ON1 Cloud. Click the 
box and choose either Editable Preview or Originals from the pop-up menu. Which option you choose will 
depend upon your intent, and your storage 
availability. See page 75 for more information 
about Cloud Sync.

Adding photos to an existing album

There are multiple ways to add photos:

• Dragging and dropping a photo on the 
album name.

• Selecting a photo or group of photos, right-clicking on the photo and choosing Add to Album 
from the pop-up menu.

• Choosing Album > Add to Album and picking the destination album from the menu.

• You can also copy a photo and paste it into an album: click on a photo, choose Edit > Copy, 
then click on the album in the Albums pane, and choose Edit > Paste.

Removing photos from an album

To remove a photo (or photos) from an album, and press Shift-Delete, choose Remove from Album from the 
Album menu, or right-click on the photo and choose Remove from Album from the pop-up menu.

Delete an album

To delete an album, right-click on the album name and choose Delete.

Using the Target Album feature

To help with culling or other organizational tasks, you 
can designate any single album in Photo RAW as a target 
album. This lets you add photos to an album on the fly by 
pressing the ‘B’ key in any of Browse’s views.

You can only have one target album at a time; to change 
the current target to a new album, select the Set Target 
Album option when creating an album, or right-click on an 
existing album and choose Set Target from the pop-up menu.

Publishing and unpublishing an album from ON1 Cloud Sync

You can publish any existing album to ON1 Cloud Sync by right-clicking on the album name and choosing 
Publish to ON1 Cloud Sync. Right-clicking and choosing Unpublish from ON1 Cloud Sync will remove that 
album from your synced devices, but leave it on the device from which it was originally shared.

NOTE: ON1 Cloud Sync albums can only be unpublished from the device that 
they were created on, but you can delete any published album from any ON1 
Cloud Sync device. Doing this will remove that album from all of your devices. 
See “Using ON1 Cloud Sync with Photo RAW” on page 75 for more detail.

Target albums are represented with a target icon and the ‘+’ symbol 
at the end of the album’s name. To use a different target album, 
right-click on the new album and choose Set Target Album from the 
pop-up menu. To remove the current target, right-click on the 
name and choose Unset Target from the menu.
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Changing the album thumbnail preview

To change the preview thumbnail of an album, double-click on the album name. Select a photo you would 
like to use for the preview, right-click on it and choose Set Album Preview from the pop-up menu.

Nesting albums

To create a set of nested albums, create a blank album by clicking on the + icon in the Albums pane. You can 
easily add sub-albums to that new master album set by dragging and dropping albums onto the new one in 
the Albums pane. When you click on the master album, Browse will display the albums that are part of that 
collection in a folder-style view. Double-clicking on an album icon will display the contents of that album. 
To view all the images in a nested set, choose Show Subfolder Contents from the View menu.

To move a sub-album from a master album to the top Albums level, drag and drop it out of the master, or 
right-click on the sub-album name and choose Move to Top.

If you drag an album onto an existing album that already contains images, you will see the top-level album’s 
images at the root level, along with any sub-albums.

NOTE: Nested albums cannot be used with ON1 Cloud Sync. If you move a 
synced album into a nested album folder, Photo RAW will remove that album 
from the cloud.

When you click on a nested album set, Browse displays the sub-albums. Double-clicking on a sub-album will open that album. If you wish to view all of the 
images in a nested album set, click the Show Subfolder Contents button from the View menu.
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SMART ALBUMS

Smart albums are a dynamic album type that 
created from the results of a custom search 
operation built with the Search Bar (see “Finding 
and Filtering Images with the Search Bar” on page 
59). When you use the Search Bar to create a 
filtered set of photos in your collection, such as 
“all photos that have been rated three stars or 
greater after June 2018,” and you have saved that as a search, you can then also save that search as a smart 
album. When you click on the smart album, Photo RAW will perform that search in real time.

You can apply a color label, rename or delete smart albums by right-clicking on the album name. If you wish 
to change the smart album criteria, select it, then use the Search Bar to reset your search options, and choose 
Update Smart Album with the current settings from the pop-up menu on the far right of the Search bar.

NOTE: Nested albums and smart albums cannot be published to Cloud Sync.  

DATES PANE

Photo RAW’s Dates pane offers a quick way to look for 
cataloged images based on when they were taken. Using 
a simple timeline interface, you can drill down into your 
photo library by year, month and day. It makes searching 
for birthday and holiday photos a snap.

Opening the Dates pane, you’ll see a list of years, with the 
current year at the top (only years that have photos taken 
during them will be present in the list). Clicking on a year 
will show you all of the photos taken during that year. 
Clicking on the triangle to the left of the year will display a 
list of all the months that have photos in them, and you can 
keep drilling down to the day level. Drilling down to any 
level in the pane—year, month, day—will show all photos 
taken during that period.

The Dates pane works only with cataloged folders.  
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TETHERED SHOOTING

The Tethered Shooting pane lets you remotely control many Nikon 
and Canon cameras connected to your computer via USB, and capture 
images from the camera to your computer. Tethered shooting is used for 
shooting and saving images in a studio setting, displaying your images 
immediately on your computer’s display. It is an excellent way to make 
adjustments to lighting and composition in the studio.

To get started with tethered shooting, connect your camera to your 
computer with the appropriate USB cable (your camera’s manual should 
have information on the cable required, if the camera didn’t come with 
one). Turn the camera on, then, in the Tethered Shooting pane, turn the 
pane on by clicking the button to the left of the pane’s name. 

Photo RAW will search for a connected camera and, if found, it will open Photo RAW’s Import window. In 
the panel on the right side of that window, you can choose a number of options for saving your tethered 
shots, including file name and location, metadata, any Develop or Effects settings, and time adjustments. 
(See “Importing Photos into Browse” on page 54 for an explanation of panes in the Import window.)

Once you have chosen your tethered 
import settings, click the Start Shooting 
button at the bottom right of the Import 
window, which will close the window. 
The Tethered Shooting pane will now 
have the model of your camera selected, 
with the current shot settings in the 
table at the bottom of the pane. The 
settings are, from left to right and top 
to bottom, shutter speed, aperture, 
ISO, camera shooting mode (Manual, 
Aperture/Shutter Priority), exposure 
compensation, and white balance. Any 
setting that has a drop-down will let you 
change that setting.

Clicking the Fire button in the pane will take a shot with the current camera settings, and will save it to 
the location you chose in the Import Settings window. If you’re in Grid View, the image will appear at the 
beginning of the end of the thumbnail grid, depending upon how your sort order is set up. If you’re in Detail 
or Filmstrip view, the tethered image will appear in the Preview area.

When you are finished with a shoot, turn the Tethered Shooting pane off by clicking the button next to the 
pane’s title, turn your camera off, and disconnect it from your computer.

NOTE: ON1 Photo RAW 2026’s Tethered Shooting feature currently supports 
most Canon and Nikon digital SLR cameras. Check ON1’s support website 
(on1help.zendesk.com) for a list of supported cameras.

https://on1help.zendesk.com/
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RECENT

The Recent pane keeps track of recently opened files 
browsed folders. Files are listed in order of last opened. You 
can access your most recent files in this pane by clicking on 
the one you want and it will appear in the preview window. 

You can clear the list by pressing the ‘x’ icon in the title bar.

NOTE: You can show or hide most of the panes in the My Catalogs, Browse 
and Presets tabs. See for “Customizing the display and order of Tabs and 
Panes” on page 16 for details.

The Photo Panel
The panel on the right side of the screen contains information relative to the currently selected image in 
the Preview area, and includes three sections: Nav, Levels, and Info.

THE NAVIGATOR PANE (DETAIL AND FILMSTRIP VIEWS ONLY)

This pane presents a thumbnail view of the current 
image. The white square region marks the image area 
that is visible in the preview pane. You can pan your 
image by clicking and dragging inside the square.

At the bottom of the Navigator pane are several zoom 
buttons representing percentage zoom views (100%, 
50% and 25%). Click on one of the buttons to change 
the view. Fit zooms to fit the current canvas size, while 
100 zooms to 100%, displaying the actual pixels.

THE LEVELS PANE (DETAIL AND FILMSTRIP VIEWS ONLY)

This pane gives you a color chart of the shadow, 
midtone and highlight areas based on an image’s RGB 
values (commonly known as a histogram). This is useful 
to show areas within the image that may be clipping. 
Clipping is when your image contains pure blacks or 
white and can signify loss of highlight or shadow detail.

The left side of the histogram represents the shadows, 
while the right represents the highlights. At the top 
of each end is a triangle. If the triangle is lit, there is 
clipping on that side of the histogram. If you click on 

The Navigator pane

The Levels pane
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the arrows, you will activate the clipping overlay on your image, which displays the areas that are clipped. 
Those areas with a blue overlay are pure black, while the areas with the red overlay are pure white. You can 
turn the clipping view off again by clicking on one of the triangles. You can also temporarily enable clipping 
view by holding down the J key at any time. (Clipping can be turned on or off permanently by pressing Alt 
(Windows) or Option (Mac) and the J key.) The clipping view is useful when you are making adjustments to 
the brightness and contrast of your image.

The Levels pane also displays the RGB values under the cursor at the bottom of the pane.

INFO PANE (ALL VIEWS)

The Info pane displays common metadata and other information for the currently selected image in a large, 
easy-to-read format. This metadata includes:

• Camera make and model

• Lens focal length

• Capture date and time

• File type

• ISO

• Shutter speed

• Aperture

• Exposure compensation

• Image dimensions

• File size

• Rating, color label and like status

If any of the metadata fields are unavailable they will be left blank. You can also adjust the star rating, color 
label and flag for the current photo directly from within the Info pane.

NOTE: The Settings Applied option found in the Info pane in previous versions 
of Photo RAW is now displayed in the Layers pane inside Edit (see page 220).

BRILLIANCE AI PANE (BROWSE)

The Brilliance AI pane lets you apply the Edit module’s 
Brilliance AI to your photos. Brilliance AI provides 
intelligent color and tone adjustments, automated 
application of NoNoise AI and Portrait AI, and automatic 
local adjustments.

To apply Brilliance AI, select a photo or group of photos 
and click the control circle to the left of the pane’s title 
and adjust the parameters as desired. You can apply 
Brilliance AI to individual photos, groups of photos, 
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or even folders of photos, adjusting the parameters for each type of image you have. Any Brilliance AI 
operations performed in Browse will be displayed in the Edit module, where you can further fine-tune your 
edits.

Brilliance AI is discussed in detail starting on page 148.

METADATA PANE

The Metadata pane displays all of the available 
metadata information about a photo in one 
place. Some of this is embedded metadata from 
your camera, while other elements can be added 
manually, or, with the Keyword AI feature, you 
can have Photo RAW 2026 scan your photos 
and suggest keywords based on their contents, 
making it easy to find photos based on a wide 
variety of data types.

The Metadata pane consists of the following 
sections:

A.	Preset: Lets you apply a saved 
metadata preset (see page 51) 
to your image, which can include 
any changeable metadata found 
throughout the pane.

B.	 Basic: Includes location and name of 
the selected photo, and any albums 
the photo might reside in. You can 
enter author information and a 
description. (The Author field is tied to 
the IPTC Creator field.)

C.	 Keyword section: Add keywords 
manually and modify existing 
keywords.

D.	AI Keywords: Automatically generated 
keywords based on image data and AI 
semantics.

E.	 EXIF: When the label is clicked, the 
pane displays EXIF information for the 
current photo (see page 23).

F.	 IPTC: When the label is clicked, the 
pane displays IPTC information for the 
current photo (see page 23).

G.	Location: When clicked, the pane 
displays location data for the current 
photo.
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KEYWORD AI

Photo RAW 2026’s Keyword AI feature is designed to 
take the pain out of creating keywords manually for each 
of your photos. By scanning your photos and suggesting 
keywords based on the contents of a photo, location 
information, and much more, you can find images quickly, 
even if you have never entered any keywords on your 
photos. Photo RAW can ‘see’ hundreds of objects and 
regions, identify locations, find people, and understand 
photographic properties, all of which then become 
searchable terms to help find photos faster.

You have full control over the keywording process inside 
Photo RAW. You can generate keywords manually on 
any or all photos, or automatically when using cataloged 
folders. If you work with other photo apps and want your 
AI-generated keywords to be embedded into a photo’s 
metadata, Photo RAW gives you both automated and 
manual options to perform this task.

Manual keyword generation

You perform AI keyword generation manually by selecting 
a photo, a group of photos, or a folder in Browse, and then 
clicking the Scan button in the AI Keywords section of 
the Metadata pane. (You can also right-click on a photo, 
selected group, or a folder and choose Scan from the pop-up menu.)

When you click the Scan button, Photo RAW will generate the keywords and display them in the AI 
Keywords section. You can keep the generated keywords in the section, or add specific AI keywords to the 
main Keywords area by hovering over the keyword and clicking the Up arrow to add it. To remove a specific 
keyword, click on the ‘x’ button. To add all AI keywords, click the Add All button.

Automated keyword generation with cataloged folders

Automated keywording of photos is available when working with 
cataloged folders. When you create a cataloged folder, the Catalog 
Properties window lets you set whether the photos on that folder 
will be automatically scanned or not. There are three options in 
the Keyword AI menu of the Properties window:

• Off: Photo RAW will not scan the folder for keywords.

• Basic: Photo RAW will perform basic keyword scanning, 
including the folder name, photographic properties, 
primary areas in a photo, and some subject-based object 
detection (people, animals, cars, etc.).

• Honor Preferences: When scanning, Photo RAW will use 
the full settings specified in the Keyword AI preferences 
tab (see page 48).

Once a photo has been scanned by Keyword AI , you can manually 
add the appropriate AI-generated keywords to the main Keywords 
section of the Metadata pane. You can also have Photo RAW 
automatically embed the keywords so that they are visible to other 
photo apps (see page 48).

When you create a cataloged folder, you can set Photo 
RAW to run Keyword AI automatically.
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By default, the photos in all of your all of your cataloged folders are scanned at a Basic level. And, once you  
have set a cataloged folder to generate AI keywords, any photos added to that folder will be automatically 
keyworded, depending upon the setting of the Scan Frequency in Catalog Folder Options window (see 
page 37 for complete details on working with cataloged folders).

NOTE: ON1 Photo RAW 2026 performs nearly all of its Keyword AI scanning 
entirely on your computer; the exception is when it performs reverse lookup of 
GPS coordinates for location information. At no point are your photos uploaded 
to the cloud or shared by Keyword AI.

Embedding AI keywords

By default, Photo RAW does not automatically embed AI keywords into the metadata associated with a 
photo. All AI-generated keywords — whether generated automatically or manually — are displayed in the AI 
Keywords section of the Metadata pane, and they are associated with that image inside Photo RAW. And, 
when searching for any text in Browse’s Search Bar (see page 59), Photo RAW will also search the AI 
Keywords section of the pane.

If you would like to make sure that a photo’s keywords are associated with it outside of Photo RAW, you 
must ‘embed’ the keywords into the photo’s metadata. You can do this manually by selecting a photo (or 
group of photos) and choosing Embed Metadata from the Photo menu in Browse. Doing this will keep all 
keywords of any type embedded in the photo, and they will be visible in any other app that properly reads 
metadata, such as Lightroom, Capture One, Affinity Photo and more. 

To automatically embed the AI keywords into the metadata of your photos, there are two options, 
depending upon the file type:

• For Raw files, turning the “Write Keyword 
AI Results to XMP” option on in Photo 
RAW’s Preferences > Keyword AI tab will 
automatically add all AI-generated keywords 
to the Keywords section in the Metadata 
pane, and will write those keywords to an 
XMP sidecar file in the photo’s directory. That 
sidecar file can be read by most popular image 
editors and cataloging apps and preserves 
keywords, ratings, and other metadata 
associated with a photo.

• For non-Raw files, turning on the 
“Automatically Embed Metadata” option in 
Browse’s Photo menu will embed AI keywords 
in all photos as they are scanned. 

Turning off the “Write Keyword AI Results to XMP” or 
the “Automatically Embed Metadata” settings will only 
affect AI keyword scanning from that point forward. The 
metadata for any previously scanned photos or folders — 
including the addition of AI keywords — will remain intact.

Turning the Write Keyword AI Results to XMP setting on in 
Preferences will automatically copy all of the AI-generated keywords 
to the Metadata pane’s Keywords section, and those keywords will 
get written to the XMP sidecar file associated with that photo.  
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Fine-tuning Keyword AI search parameters

You have a few options for fine-tuning the specifics of what Photo RAW searches for when creating 
AI-generated keywords; these options can be set in the Keyword AI tab of the Preferences window. There, 
you can choose what type of data you want to include when Photo RAW is scanning your cataloged 
folders. These options include location data, photographic properties, histogram properties, face, age and 
gender information, and specific objects and regions. When you make changes to the Keyword AI tab, you’ll 
need to restart Photo RAW for them to take effect. Note that changing these options will not change the 
AI keywords that have already been generated.

Reading AI keywords into other apps from Photo RAW 

Most of the popular photo editing and organizational apps have a mechanism for reading and writing 
metadata to files. When importing photos tagged with Keyword AI into Lightroom or Capture One, for 
example, those apps will recognize keywords (and other metadata) you have added in Photo RAW and save 
them within their catalog structure. 

If you want to use Keyword AI on photos that have been cataloged by other apps, open the folder 
containing those photos in Browse. You should see any existing keywords or other compatible metadata, 
and you can scan and generate AI keywords and embed them back into the files via the method shown 
above. When you’re done and back in your originating editor, you will have to read the updated metadata 
back into that app. Lightroom has a flag that will indicate that the metadata for a photo has been changed; 
you can click on that photo (or all photos with that flag) and choose Read Metadata from File from the 
Metadata menu. Capture One has a similar command, available from the Image menu, but it doesn’t have an 
easy way to determine if the metadata has changed.

You can adjust the Keyword AI scan parameters via Photo RAW’s Preferences window. You can also turn the 
automatic keyword scan off, if you prefer, although you can always manually scan for AI keywords from the 
Metadata pane’s Scan button.
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ADDITIONAL METADATA OPTIONS

The bottom of the Metadata pane has three sections for viewing or adding specific types of information to 
your photos:

• EXIF (Exchangeable Image File 
Format) displays all of the data 
embedded by your camera. 
Depending upon the camera, 
some of all of this information 
will be displayed, and many of 
the fields are editable. 

• IPTC (International Press 
Telecommunications Council) is 
an industry-standard metadata 
format, and offers much more 
detailed metadata information 
than EXIF. It historically has 
been used by journalists and 
stock photographers to catalog 
and tag photos, as well as 
add copyright information, 
captions, and other data. 
(The Creator IPTC field and 
the Author field in the main 
Metadata pane share the same 
text; data written into one is 
automatically added to the 
other.)

• Location includes GPS 
information, as well as 
country, state/province and 
city information. Photo RAW 
can automatically look up this 
information for any photo 
that has GPS coordinates, via 
the Set Location from GPS 
Coordinates item in the Photo 
menu.

To open any (or all) of these sections, 
click on the label. Clicking again on the label will hide that section from view. 

When you enter text into any field in the EXIF, IPTC or Location pane, Photo RAW will add that information 
to the currently selected image. You can change the metadata in multiple images at the same time by 
selecting them all, then changing any of the fields in the pane.

The three additional metadata sections are for IPTC, EXIF and Location data.
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Metadata templates

With Photo RAW, you can create metadata templates that apply common information to your images, such 
as copyright, author, contact information, your website and more. These preset templates can be applied 
directly in the Metadata pane, as well as via the Import feature (see “Importing Photos into Browse” on 
page 54).

Saving a metadata template is easy: you can either go to an 
image that has the basic metadata items you wish to use, 
or you can select an image without metadata and add your 
common items to the Metadata pane. Once you have the 
metadata set, click on the Preset drop-down menu at the top 
of the pane and choose Save New Preset. The Save Preset 
dialog will appear on-screen, and you can choose which 
metadata fields you wish to save as part of the template. 
For example, while you might wish to save the copyright and 
contact information as part of your preset, you might not 
want to apply keyword, GPS or description data to a group 
of images. 

You can update a metadata template by selecting the preset 
in the pane, then changing the appropriate fields as desired, 
and then choosing Update Preset with Current Settings from 
the Preset drop-down. To delete a metadata preset, first 
choose the preset from the drop-down menu, then choose Delete Preset from the menu. 

Embedding metadata

Metadata you add in Browse is stored in industry-standard XMP sidecar files for raw files. This facilitates 
the transfer of metadata to any application that supports XMP. When you edit an image, create a copy of 
an image for editing or use the ‘Send to’ command, the metadata is embedded into the file automatically 
(with the exception of raw files). You can manually embed your metadata into images using the Embed 
Metadata command from the Photos menu. This will open each image you have selected, update the 
metadata and re-save it. This is supported for TIF, PSD, PSB and JPG files; raw and PNG files do not 
support direct embedding of metadata.

Reading metadata

Sometimes, when you’ve been sharing raw images across machines or with others, the metadata 
information might get ‘lost,’ or is different than your original metadata. In these instances, choose Read 
Metadata from the Photo menu, which will grab the metadata from the file or the XMP file (for raw files).

Changing a photo’s capture date

You can change the capture date of a photo (or a group of photos) by selecting Edit Capture Date from 
the Photo menu. In that window, you can adjust the date to a specific date and time, adjust for time zone 
changes, and to the raw file’s embedded capture time. 

The Save Metadata Preset dialog lets you choose which 
metadata fields get saved to a preset from the currently 
selected image.
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KEYWORD LIST PANE

As you add cataloged folders or browse through folders 
of non-cataloged photos inside ON1 Photo RAW 2026, 
any keywords you have added—to any photo—are stored 
in an internal database. That list of keywords is visible in 
the Keyword List pane, and from there, you can search 
for established keywords and display those photos from 
your cataloged folders, manage the keyword list, and 
apply keywords to new images. And, to help manage 
your keywords, Photo RAW 2026 will also let you create 
subcategories of keywords (see “Using hierarchical 
keywords with Photo RAW” on page 53).

If you double-click on a keyword in the list, Photo RAW 
will search your cataloged folders for that keyword, 
and display the results in the Preview window. In this 
search, Photo RAW is actually performing a search in the 
Advanced Search pane, so you can refine your search 
there, if you wish to add additional filter criteria. (If you 
would like to search the current folder only, choose the 
Filter Current Photos option in the Advanced Search 
pane.)

You can assign keywords to an image in any of Browse’s 
views. Click on the button to the left of a keyword in the 
Keyword List, and Photo RAW will apply that keyword to the currently selected image or images. (You can 
also enter keywords into the Add Keywords field in the Metadata pane.)

Right-clicking on a keyword gives you a pop-up menu with a list of options you can perform:

• Assign Keyword to Selected Photos: adds that keyword to the current selection.

• Remove Keyword from Selected Photos: removes that keyword from the selection

• Add Keyword: Lets you create a new keyword, with the option to save that keyword as a 
subcategory of the currently selected keyword.

• Edit Keyword: lets you rename the selected keyword, and applies the new keyword to all of 
the cataloged and known photos that used it.

• Delete Keyword: Removes that keyword from the cataloged and known photos that use it.

• Find Cataloged Photos with Keyword: Displays (in grid view) all of the photos in your 
cataloged folders that use the selected keyword.

Refining the Keyword List

Because the list of keywords can be extremely long, you can use the pane’s search field to look for 
keywords: as you start to type in the field, Photo RAW will display a list of keywords that contain the 
letters you’ve typed. Once you’ve narrowed your search, you can select a keyword from the list (shown, 
right), and perform any keyword operations detailed in the previous section.

The Keyword List includes any keywords you’ve ever used, but you 
can filter the list by typing into the search field at the top of the 
pane. Double-clicking on an item in the pane will display all of the 
photos that have that keyword.



ON1 Photo RAW 2026 User Guide	 Part 2: Organizing with Browse	 53

Using hierarchical keywords with Photo RAW

In addition to standard keywords, ON1 Photo RAW 2026 
also supports the creation and use of hierarchical keywords. 
This option lets you “nest” keywords within a top-level 
keyword, which can be helpful to manage and categorize 
keywords. 

For example, you might want to use a master keyword for 
states that you’ve visited—“California,” “Nevada,” “Oregon,” 
etc.—and use sub-keywords for places within the state, like 
“Death Valley,” “Joshua Tree”, “Valley of Fire” and others. 

Hierarchical keywords are displayed in the Keyword pane 
with a small right arrow to the left of the top-level keyword. 
Clicking on the arrow will display the sub-keywords for that 
master, with the number of images with that keyword on the 
right side. As is the case with standard (i.e. non-hierarchical) 
keywords, you can double-click on any of the nested 
keywords to show all of the photos in your cataloged folders that use that keyword.

To create a keyword hierarchy, first create your master keyword by clicking on the gear icon at the top 
of the Keyword List pane and choosing Add Keyword. Enter the name of the top-level keyword and click 
Apply. (If you have photos selected, and don’t want to add the new keyword to those images, uncheck the 
“Add to Selected” box before clicking Apply.)

To create a new nested keyword, right-click on the master keyword and choose Add Keyword from the 
pop-up. The dialog box should now give you a check box to nest the new keyword inside the top-level 
keyword, as well as to add the new keyword to any selected photos.

If you wish to create new hierarchies from existing keywords, it is best to first create your master keyword, 
and then drag any existing keywords onto that master. 

NOTE: You can show or hide most of the panes in the Photo panel. See for 
“Customizing the display and order of Tabs and Panes” on page 16 for 
details.

Hierarchical keywords can help with keyword management, 
and can be extremely useful when you wish to use primary and 
secondary categories for such image categories as locations, 
people, types of shoots, and so on.

To create a hierarchical keyword set, create the top-level keyword by choosing Add Keyword from the Keyword List pop-up. Then, right-click the 
top-level keyword and choose Add Keyword. There, you will have the option to nest the new keyword inside the top-level keyword. 
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Importing Photos into Browse

ON1 Photo RAW’s Import function lets you quickly grab photos directly from your camera, memory card, 
phone, tablet, or other source location (like a portable hard drive loaded with images from the field). 

To import photos, connect your camera, card or other device and choose Import from Browse’s File menu. 
The Import window opens, with the following options:

A.	 Import Options Bar: Lets you choose the source (camera, memory card, or other device), 
eject the device after importing, and to bypass images that have already been imported. You 
can also choose options for selecting all photos or none of them.

B.	 Preview window: Displays the images to be imported. By default, all photos are included; 
click the check mark in the corner of any image to remove it from the import process.

C.	 Thumbnail size: Adjusts the size of the thumbnails in the preview area. 

D.	Preset selector: Applies an import preset—which can include any of the settings from the 
import panel on the right—to the currently selected images.

E.	 Destination: This pane sets the location of the imported images, as well as a secondary folder 
that you can use to store a copy of your photos saved as a backup to another location. (See 
page 55 for details on using this pane.)

F.	 Rename: This pane lets you rename the imported files, with options for custom text, 
serialization, and image metadata. (This pane uses the same token-based renaming function 
and presets found in the Rename Files dialog; see page 57 for more.)

G.	Add Metadata: Lets you add assorted metadata to the imported images, ranging from 
keywords, copyright information and more. To access the complete IPTC metadata fields, 
click the More drop-down; you can also add GPS coordinates and a description via this  
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section of the pane. You can use existing metadata presets (or create your own in this 
window) to apply consistent metadata across multiple imports; simply enter the data you wish 
to include and choose Save New Preset from the Preset menu in the pane. (See “Metadata 
templates” on page 51 for more on metadata presets.)

H.	Photo Settings: This pane lets you apply any Edit module presets to the imported images. 
(These settings are not permanent; you can adjust or reset the adjustments via the Settings 
menu. See “Presets” on page 133 for more.)

I.	 Edit Capture Date: Use this pane when you wish to change the capture date of imported 
images. The Adjust Time Zone setting can be helpful if you forget to change your camera’s 
clock when you travel across multiple time zones.

J.	 Cancel/Import: Cancel closes the import window, cancelling your session; Import brings your 
photos in based on your chosen settings.

Once you have adjusted your import settings and 
selected the images for import, click on the Import 
button to perform the operation. While your photos 
are being imported, you’ll see a progress bar displayed 
in the lower right side of the Browse window. If your 
import location is a cataloged folder, the new images 
will be indexed automatically in the background.

DESTINATION PANE OPTIONS

Destination is the only pane in the Import window that you 
have to set up when importing images. It has a number of 
different options for where you wish to import images:

• Use the Folder pop-up to choose the destination 
for your import. Recently used destinations will be 
in the list, or you can choose a different folder.

• To put your imported images into a new folder—
one that you name—inside the primary import 
location, enter the name of the new subfolder in 
the Put in Subfolder field. Photo RAW will create 
that folder and import the images to that location.

• Turning on the Secondary Folder option will copy 
the imported images to another folder connected 
to your computer (using the parameters in the Put 
in Subfolder and Generate Subfolders settings, if 
used). It is intended for people who wish to back 
up their photos onto another drive or location. 
Use the pop-up menu to determine the backup 
location; any previously used folders will be listed 
in the menu.

• Use the Generate Subfolders option if you would like to use image metadata or import count 
information to create customized subfolders during import. This option uses the same token-
based function used in the Rename pane; see “Renaming Files and Folders in Browse” on 

While Photo RAW is importing images from a camera or card, you’ll see 
a progress indicator at the bottom of the Browse window.
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page 57 for specifics on using these tokens. For example, you could have imported photos 
automatically organized by two levels of folders, one by year, and inside each year, folders for 
each month. When images are imported, Photo RAW will place each image in the appropriate 
location based on the settings in this field, creating the folder if it doesn’t exist.

Each time you import images, Photo RAW will display your previous settings.

BYPASSING DUPLICATE FILES DURING IMPORT

The Don’t Import Duplicates option is helpful for those times when you re-
use a card in the field, but don’t delete the photos from it.

Each time you use the Import function, Photo RAW keeps a record of every 
imported photo’s filename and capture time. When you add a card to import, 
the app checks its import database, and if it finds a duplicate, it will uncheck 
it in the Import window, and display an “Already Imported” icon to the right 
of the checkbox.  

Photo RAW saves the original filename and time metadata, so the Don’t 
Import Duplicates option works even if you use the Rename option to 
rename the photos on import. And, if for some reason you wish to re-import 
a photo, you can click the selection check mark to re-import it.

SAVING IMPORT SETTINGS AS A PRESET

Photo RAW makes it easy to save often-used import settings as a preset: things like copyright and other 
metadata, file-naming conventions, import locations and more. To save an import preset, adjust the 
information and settings in any of the panes on the right of the Import window, and choose Save New 
Preset from the pop-up. Thereafter, when you choose the preset, it will apply those saved settings to the 
current import job. If you wish to change a setting for an existing preset, select the preset, make your 
changes in the panels and choose Update Existing Preset from the preset selector’s pop-up menu.

Photo RAW remembers the last-used import preset when you choose Import from the File menu.

Managing Files and Folders in Browse

CREATING A NEW FOLDER

You can create a new folder from the right-click contextual menu in the preview area or selecting Add 
Subfolder in the Edit menu. This will create a new folder inside the selected folder; if you have files selected 
in the preview area, you also will get the option to move or copy the selected images into the new folder.

DELETING A FOLDER

To delete a file or folder, click on it and press the Delete key or right-click and select ‘Delete’ from the 
contextual menu. Then, confirm that you wish to move the file to the trash. If you have multiple files and or 
folders selected it will move them all to the trash. If you make a mistake you can use the Undo command, 
although some files, like those on a network volume, are deleted immediately and cannot be undone.

With the Don’t Import Duplicates 
option on, any photo that has already 
been imported will be deselected.
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COPYING AND MOVING FILES AND FOLDERS

You can copy and move files and folders in the ways you are accustomed to on your computer. You can 
select files and folders and use the Edit > Copy command to copy them to the clipboard and then Edit > 
Paste to paste them to new location, inside or outside of Browse. You can use this to copy a file or folder 
from one place to another or to attach an image to an email for example.

You can also use the familiar drag-and-drop functions to copy or move files and folders. Dragging and 
dropping a file or folder will move it if it is on the same drive or copy it to another drive. You can drag and 
drop in and out of Browse module.

NOTE: Due to the non-destructive nature of Photo RAW 2026’s workflow, 
copying a photo and pasting it outside of Photo RAW will paste the original file. 
If you wish to incorporate any Edit module changes, use the Export or Quick 
Export commands to get a version of the photo with your edits.

SHOW IN FINDER/SHOW IN EXPLORER

To view a file or folder in the Finder (MacOS) or Explorer (Windows), right-click on an image or folder in the 
Preview area and choose Show in Finder or Show in Explorer from the pop-up menu.

CHANGING A FOLDER’S THUMBNAIL PREVIEW

By default, Photo RAW chooses an image from a folder to use as the preview thumbnail for that folder. 
To change this, double-click on the folder icon and select a photo you would like to use as the thumbnail. 
Right-click on the photo and choose Set Folder Preview from the pop-up menu. 

RENAMING FILES AND FOLDERS IN BROWSE

Browse offers two methods for renaming files or folders inside ON1 Photo RAW 2026: single file and 
batch. 

To quickly rename a single file or folder, click on it 
in most Browse views and choose Rename File from 
the Edit menu, or right-click on the item and choose 
Rename File from the pop-up menu. This will display 
a window where you can type in a new name for the 
item. Clicking OK will rename that file or folder.

Batch-renaming groups of files or folders

To rename multiple items in Browse as a batch, select them in the current view and choose Rename File 
from the Edit menu or the right-click contextual menu. Photo RAW will display the Rename window, which 
offers an array of options for renaming files based on custom text and image metadata.

Renaming a single file or folder.
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In batch-rename mode, the Rename window has a central text entry field, where you can add any custom 
text you wish all of the renamed files to have. You can also insert a set of tokens (via a pop-up menu) that 
will be added to the renamed files. These tokens are in four main groups:

• Filename, which includes options for 
using the original filename, number 
suffix (taken from the image as 
recorded by the camera) and enclosing 
folder name.

• Date/Time, which includes a list of 
date (year, month, day) and time data 
that can be combined in various ways.

• Sequence, which adds an incremented 
number to each renamed file in the 
batch, as well as the total number of 
files in the batch. Each of these token 
sets include options for leading zeros in the resultant filename. 

• Metadata, which lets you add specific EXIF and IPTC metadata to the filename.

NOTE: A complete list of the tokens used in the Rename window, with 
explanations, can be found on “Export” on page 253, in the Export section of 
this guide.

To build a rename sequence using tokens, click on the Add Token button, and choose the appropriate token 
from the pop-up menu. The token will be added as a shaded item in the text field, and the Example item 
above the text field will show a sample of a renamed file using the current set of tokens and custom text. 
To change an existing token, click on the down arrow on the right of the token, which will display the full 
set of tokens. To delete a token, double-click on it and press the Delete key.

Custom text can be added anywhere in the entry field. You can click the cursor at the beginning or end 
of a token (or in-between tokens) and add spaces, dashes, underscores and any other text you wish to be 
included in each renamed file.

Because the Rename process is not undoable, make sure you use the Example field to check that your text 
and token combinations give you the filenames you expect for your batch process, and adjust as needed. 
When you’re sure, click Apply, and Photo RAW will rename all of the files.

The Presets pop-up menu at the top of the Rename window includes a set of common batch combinations 
that you can use as a starting point. You can also create your own batch-rename presets: build the rename 
options you wish, and choose Save New Preset from the bottom of the Presets menu. You can also update 
an existing preset and delete presets from this menu.

NOTE: The Rename window remembers the parameters of your last operation, 
which can be helpful for creating presets.

When renaming multiple files or folders, Photo RAW ‘s batch-rename feature lets 
you use complex combinations of custom text and image metadata. You have the 
capability to save your custom rename settings as a preset to reuse at other times.
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Finding and Filtering Images with the Search Bar

Browse’s search bar is designed to help you find photos in your photo library 
based on a extensive variety of criteria specific to photos and the metadata 
embedded in them. You can search based on any text associated with a photo; 
likes, labels and star ratings; dates, including creation and modification dates, 
time of day and seasons; keywords (including AI-generated keywords); and nearly 
any piece of metadata, from camera body and lens information to aperture, ISO 
settings, and much more. 

Search options are flexible: they can be applied to the current folder view or 
album, or they can search any or all of your cataloged folders. You can also save 
any search as a preset style, so you can use it again in the future, or you can save 
your search (of cataloged folders only) as a Smart Album that is available in the 
My Catalogs panels.

The search bar is always available at the top of the 
main Browse window. By default, Search is turned 
off, but you can turn it on by clicking on any of the 
four buttons in the center of the bar:

• Text: Searches for text associated with a photo. By default, it will search all text options, but 
you can use the menu to filter by a photo’s description, filename, keywords or title.

• Attribute: Searches for files based on likes/dislikes, ratings, color labels, and file type.

• Faces: Searches for photos with one, two or a group of faces, as well as age categories (Baby/
Toddler, Child, Teenager/Young Adult, Adult, and Elderly) and gender. These options will only 
find photos that have been scanned by the Keyword AI process, and when the Find Faces 
option is turned on in the Preferences’ Keyword AI tab (see page 301).

• Metadata: Let you create complex searches based on a broad set of metadata criteria and 
conditions. See page 61 for more information about the search fields available and using 
the different operators to create complex searches. 

To turn on option on, click on the button in the Search bar; to turn it off, click on the button again. You can 
also use combinations of the various options to create complex searches.

Browse’s search bar is dynamic: as you adjust the options in the window, the selection of photos that 
meet your criteria and other settings will be displayed in Browse’s main window, in Grid view. If you add or 
remove criteria, change the source folders, the thumbnail grid will update.  

To stop the current search and return to the previous view, click None in the Search bar. 

Browse’s Search Bar, shown here with a complex search of all cataloged folders.

The Search pop-up at the left 
side of the bar lets you choose 
where in your photo library 
you wish to search.

The Search Bar has four tabs that let you search for photos in your library, 
using a broad array of options.
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SEARCH BAR OPTIONS

The pop-up menu on the far left of the search bar instructs Browse where to search. The menu lets you 
choose between the photos in the current view (the default option); cataloged folders (all, or a specific 
folder): all photos that Browse knows about (cataloged, favorites, and images in any folders you’ve viewed). 
When you have Current Photos selected as a source, the pop-up will have a Lock Search Across Folders 
option; choosing this will keep using the search criteria as you move from folder to folder.

To the right of the search options are three icons:

• Sort: This sorts the photos in the current 
view. The sorting options include: date 
captured or modified; color label; file name, 
type, or size; and rating. You can also create 
a custom sort order by dragging thumbnails 
inside the grid window; click and drag the 
thumbnail so that the outline sits between two images.

• Create Smart Album: When searching across cataloged folders, you can save a custom search 
as a smart album (see page 42).

• Smart Organize: This opens the Smart Organize window, where you can search for duplicate 
photos, photos of similar appearance, or photos taken at similar times or places (see page 
64).

SAVING SEARCH CRITERIA

You can save your searches to reuse at other times via the Save Styles menu at the far right of the Search 
bar. Set your search to the state where you would like to save it, and choose Save New Style from the 
menu. If you make changes to your chosen style and would like to incorporate those changes into the style, 
choose Update Style with Current Settings from the same menu. You can also rename and delete styles 
from this menu.

If your search is specific to cataloged folders, you can also save those searches as a Smart Album, either by 
clicking on the Smart Album icon in the Search bar, selecting Save as Smart Album from the pop-up menu in 
the Search bar.

SETTING THE SEARCH CRITERIA

The Search Criteria section consists of two parts: the matching options, and the criteria the search is 
using to find photos. The Match options set how you wish the search criteria to be filtered, based on three 
options: choosing photos that meet all of the current criteria, those that meet any of the criteria, or those 
that match none of the criteria.

You build the search options by adding criteria from the Add Field pop-up, using as many criteria as you 
wish to achieve your chosen search results. When you add a field, the default is Everything, which searches 
every piece of text-based metadata in your photos. You can change it by choosing another field from the 
pop-up menu. If you wish to remove a criterion you’ve added, click the ‘x’ on the right side of the item.

The icons on the right side of the search bar let you sort the current 
results, create a smart album, or refine the current search with the 
Smart Organize feature. The pop-up on the far right of the search bar 
lets you save a custom search for later use.
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METADATA SEARCH FIELDS 

The Metadata option includes 20 primary categories of search criteria, many of which have additional 
subcategories. The categories, and what they search for, are:

• Album — whether a photo is in an album or not (Smart Albums are not supported).

• Camera — searches for specific camera and lens metadata used to take a photo, including 
aperture, shutter speed, ISO, focal length, camera name, and more.

• Cloud Sync — whether or not an item has been synced with ON1 Cloud Sync

• Color Label — photos with a specific color label (icon and text name); can search for multiple 
labels as well (i.e. Red and Green).

• Date — capture date, edited date or time of day (morning, afternoon, evening, night) of a 
photo.

• Description — searches the contents of the Description field in the Metadata pane

• Edited — searches for photos that have had adjustments applied in the Edit module; includes 
any adjustments in specific modules—Develop, Effects, Local Adjustments, Portrait, Sky 
Swap—as well as Layers, NoNoise, cropping, retouching, Liquefy tool, and text additions.  

• Everything — searches for any text-based data (filename, keywords, metadata information) 
associated with a photo.

• File Type — searches for specific image and video file types. Image formats include RAW, 
TIFF, PNG, JPEG, PSB, PSD, DNG, ONPHOTO, and HEIC. Video formats include M4V, MOV, 
AVI, WMV, MPEG, and MTS.

• Filename — filename or the folder path that the photo resides within.

• IPTC — searches IPTC-specific fields—as shown in the Metadata pane—including Copyright 
Status, Creator/Author, Job Identification, and Title. 

• Keyword AI — only searches for AI-generated keywords, as well as whether there are 
keywords attached to an image or not.

• Keywords — searches for applied keywords, as well as whether there are keywords attached 
to an image or not.

• Likes — photos set with Like (icon with a filled-in heart), Dislike (‘X’ icon) or Not Set (empty 
heart).

• Location — draws from Location information section of the Metadata pane, can also search 
for photos with or without GPS data.

• Object Type — whether a file is a Photo, Version (see page 72 for information on versions), 
or Video.

• Rating — photos with a star rating set.

• Season — searches date information for photos shot during Spring, Summer, Winter, or Fall; 
includes Northern and Southern Hemisphere options.

• Shared — searches for photos that have been shared to SmugMug.

• Size — searches for photos based on size information, including file size on disk, height and 
width, long and short edge, number of megapixels, and orientation (landscape, portrait, 
square).
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Search field operators

Each search field has an operator option and a subject field. Fields where the subject field is a list of items—
Edited, File Type, Likes, Object Type, and Shared—have a simple, “is/is not” binary set of operators. Search 
fields that have a text- or numeric-based subject field will have additional operators that let you refine the 
search in very specific ways:

• “is/is not” will look for the exact match of the subject in the search field.

• “contains/does not contain” will look for matches that at least include the subject in the 
search field.

• “starts with/ends with” will look for matches where the text of the subject field is at the 
beginning or the end of the target. This is most often used when searching filenames, but it 
also is available in any metadata subject that has a text entry.

• “is empty/is not empty” is used to determine whether the contents of a metadata field 
contain information or not, and can be helpful when finding which photos in your library 
don’t have GPS information, or a color rating. 

• “is greater than/is less than” is used when the subject field being searched for contains 
numeric data. This operator is commonly used when searching ratings, but can be used in 
many other search types, especially with camera-specific metadata. Secondary options, “is 
greater than or equal/is less than or equal,” are also available.

• “is in the range” is used to find numeric or date-based metadata that resides within a 
specified range.

Date-specific fields have a few additional operators, including:

• “is/is not in the last” finds photos taken in the last number of specified days.

• “is today/yesterday” finds photos taken on the current day or the previous day.

• “is in the last week/month/year” finds photos taken in the range specified by the chosen 
operator.
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• “is repeated annually” will find all photos taken on a specific day, regardless of the year. This 
can be useful for finding photos taken on holidays, birthdays, and other recurring events.

Creating complex searches

While many of your searches might be simple ones—like finding photos from a certain date range, or ones 
with a specific keyword or rating—the real power of Advanced Search lies in its capability to perform 
complex, multilevel searches. You can use a many search criteria in the Search Bar as you wish to achieve 
the desired results.

For example, to search for photos taken in the past year with a 24-70mm lens and that have been edited in 
Effects, you’d use the following criteria:

Or, if you wanted to look for raw photos from 2010 to 2015, with an ISO above 3200, that might benefit 
from Photo RAW’s NoNoise, you could use the following criteria:

With the above search, you might have a lot of photos that could use NoNoise’s noise reduction, and save 
the search as a style so you can perform it again at later date. Adding the Editing criterion, “NoNoise is not 
True” will remove any NoNoise-applied photos from the search results, letting you focus on images that 
could still benefit from NoNoise.

You can even have multiple instances of the same search field with different search options, although in 
most cases you’ll need to make sure that you have Meet Any of the Search Criteria set in the Match pop-up. 
For example, if you wished to find all RAW files and all DNG files, you would add two instances of the File 
Type criterion, one for each type, and change the Match pop-up to “Any of the following rules.” 
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Using Smart Organize to Manage Duplicates and More
Photo RAW’s Smart Organize feature is designed to 
help you get an unwieldy photo library under control. 
When you have a large library that contains thousands 
of photos, it can be difficult to find duplicates, or to 
manage images that are similar in appearance or date 
and time. Or sometimes, you wish to group photos 
from HDR brackets, slices for building panoramas, 
or photos to be focus stacked. Not only can Smart 
Organize find duplicates, but it can find and group 
photos that have similar appearance, location or time. 
It can help you cull your library to find just the best 
photos in a series.

To access Smart Organize, click on the icon in the 
Shortcuts list or choose Smart Organize from the File menu. This will open the start-up window, which has 
two sections, Search Options and File Info. The top of the Search Options pane lets you choose which part 
of your photo library you wish to search:

• The contents of the current view in Browse 
(Current Photos);

• All of your cataloged folders;

• A specific folder selected via your operating 
system’s file/folder selection dialog box; or 

• Any one of your individually cataloged folders.

The second portion of the Search Options pane lets you choose which search mode to use. There are four 
search types:

• Duplicate Photos. This option looks for potential duplicate images, based on name, date 
taken, file size, and dimensions.

• Similar Appearance. This option uses machine learning to find photos that are similar to each 
other, looking at similar tones and colors. This makes it easy to group and sort through series 
of photos, such as portraits of different people.

• Same Time. Selects photos that were shot in the same general time frame. When you wish to 
group panorama slices or HDR brackets, you can use this option to group sets of images. 

• Same Place. Uses GPS data to display photos taken in the same general vicinity of each other. 

Clicking the Find button will perform the search, and open the Smart Organize Results window, as shown 
on the following page.

NOTE: When working with large collections of photos, Smart Organize can 
take quite a bit of time to display results.
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THE SMART ORGANIZE RESULTS WINDOW

The Smart Organize results window contains the following elements:

A.	Results: the total number of photos found, and the number of sets.

B.	 Group heading: displays the group number and the number of photos marked in that group.

C.	 Preview area: displays search results as grid of thumbnails, by group. 

D.	View Selector: zoom factor (top left); switch between Grid and Compare views (bottom left); 
file path for the currently selected photo.

E.	 Reject/Delete and Auto Mark settings. 

F.	 Group-specific options: let you create a new subfolder with the selected images: reject/
delete marked photos in the group: and Skip the group and remove it from the window.

G.	Search Options: includes the original search type, but you can also perform a new search by 
selecting items from the pop-up menus in the panel.

H.	Info Panel: displays EXIF and size information for the currently selected photo. Works 
identically to the standard Info panel in ON1 Photo RAW 2026 (see page 45)

I.	 Close buttons: Reject/Delete All Marked closes the window and does either deletes/rejects 
the marked photos in all groups; Done closes the window without making any changes.
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Working through the search results

When you perform a search with Smart Organize, the results window is organized into groups, based on 
the search mode you chose. Groups can consist of a pair of photos, or larger numbers, based on your library 
and the type of search. You can use the view slider of the window to make the thumbnails larger or smaller, 
and you can view the photos in Grid or Compare modes (see page 18 and page 31, respectively), 
which work in the same manner as those views in the main Browse window. 

The idea behind the results window is that you’ll work group by group, evaluating the photos in that group, 
and making decisions on the group’s contents based on the type of search you originally made. Photos that 
you wish to do something with—remove in one form or place into subfolders—you apply a checkmark to. 
Then, you’ll move on to the next group. The top section of each group has the following items:

A.	Group Information: Displays the number of the current group (out of the total number of 
groups) and the number of photos marked in the group. You can also use the right and left 
arrows on the left side of the bar to move to another group.

B.	 New Subfolder: Creates a subfolder with the marked photos in the group.

C.	 Reject/Delete All: This will apply the reject flag or delete all of the photos in the group, based 
on the Reject Mode option chosen at the top of the search results window.

D.	Reject/Delete Marked: This will apply the reject flag to, or delete all of the marked photos in 
the group, based on the Reject Mode option chosen.

E.	 Skip Group: Removes the group from the results, without making any changes.

In each group, you mark photos you want to deal with—ones you wish to reject/delete or move to a 
subfolder—with the checkbox in the upper corner of that photo’s thumbnail. You can select multiple photos 
in a group, and when you choose one of the actions, it will apply to the checked photos. Clicking on the 
New Subfolder, Reject/Delete All, or the Reject/Delete Marked buttons will apply that action to the group 
and remove the group from the results list. Clicking on the Skip Group button will remove that group from 
the results window and not make any changes to those photos.

When you’re using Smart Organize to look for and group photos—for HDR, panoramas, focus stacking, or 
other organizational uses, use the New Subfolder option. Mark the photos that you wish to group, and click 
on the New Subfolder button. You’ll be prompted for a folder name; enter the name and click OK. Photo 
RAW will move the marked photos to that new folder. 

NOTE: If the marked photos do not reside in the same folder the New 
Subfolder button will be grayed out.

Using Auto Mark

When you have the Auto Mark option checked at the top of the results window, Photo RAW will mark the 
photos in each group that it believes should be checked, based on criteria found in the Auto Mark tab of 
the Preferences window. This tab can be opened in the search results window by clicking on the gear icon 
to the right of the Auto Mark checkbox.
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The Auto Mark preferences tab displays a collection of 10 criteria—file type, editing status, various image 
metadata items, and more—that you can set, and that Photo RAW will utilize when performing a Smart 
Organize search. For example, you can choose to prefer Raw files over ONPhoto, JPG or PSD files, and, 
when creating each group, Photo RAW will mark—or not in the case of finding duplicate files—the 
appropriate images.

Auto Mark is intended to be an aid in 
helping you select and mark photos, 
especially when you’re dealing with large 
groups of photos. It doesn’t, however, 
automatically delete or reject photos; 
in each found group, you can choose to 
accept its recommendations, change them, 
or ignore them completely and skip that 
group. If you prefer to mark images in 
groups by yourself, simply turn the Auto 
Mark option off at the top of the results 
window.

Adjusting your search options

If you would like to perform a different search than the one 
currently displayed in the Smart Organize results window, 
you can do so via the Search Options pane on the left side 
of the results screen. The top of that pane has pop-ups for 
the search locations and the four search types (duplicates, 
appearance, time and location). However, there are two other 
options you can change, depending upon the type of search 
operation you are making.

In all four search types, the bottom of the pane has a menu 
with three options related to the aspect ratio and size of the 
photos selected. You can choose to refine the selection to 
files of the aspect ratio, the same pixel dimensions, or none. 

When you are searching for photos based on similarity, time 
or location, an Advanced section will be visible in the Search Options pane. The three Advanced options 
(and which search type they work with) are: 

• Matching Level (Find Similar): This slider adjusts the results of grouped photos. The smaller 
the number, the less they have to match to be grouped. 

• Time Gap (Group by Time): This lets you adjust the time in between shots by which you wish 
images to be grouped.

• GPS Distance (Group by Location): Sets the range (in meters) by which location-based photos 
are grouped.

When you have set the parameters of your new search, click the Search button, and Smart Organize will 
generate a new results window.



ON1 Photo RAW 2026 User Guide	 Part 2: Organizing with Browse	 68

Editing Photos in Browse
While most of ON1 Photo RAW 2026’s image-editing power is found within the Edit module, you can 
perform many editing tasks on photos inside Browse. This includes changing metadata, labels and ratings, 
but you can also apply Brilliance AI (shown on page 45) or Edit module presets to an image or group of 
images directly from within Browse (see page 69). You can even copy Edit module settings from one 
photo and paste them onto other photos directly within Browse. These operations are also available to any 
photos shared via ON1 Cloud Sync.

RATINGS, LABELS AND LIKES

Using a standard rating and label system, it is easy to sort and cull your favorites from the throw-away 
shots. Browse offers three ways, aside from keywords and subfolders, to mark and group similar images. All 
of these methods may be set several ways: from the Photo menu, the right-click contextual menu, clicking 
the badges on the image thumbnail or in the footer of Image view. There are also keyboard shortcuts 
associated with each classification option.

• Star ratings: Set from zero to five stars. Photographers 
often use five stars for their favorite images and one star 
for images they don’t want to keep, but you can use this 
system in whatever way works best for you. You can adjust 
the rating using the 1 through 5 keys on the keyboard. You 
can also clear the stars on any image with the ` (backquote 
or grave) key.

• Color labels: There are five color labels as well. Color 
labels are a great way to mark sub-sets of images for 
special handling. You can set the color ratings by pressing 
the following keys: 6 (red), 7 (yellow), 8 (blue), 9 (green), 0 
(purple).

• Likes: A common need for photographers is to mark their 
favorite images and the ones they want to delete. This is best accomplished with the Like 
classification. There are three options: Like (icon with a filled-in heart), Dislike (‘X’ icon) and 
Not Set (empty heart). By default, images are in the Not Set category until you change them. 
You can set your Liked images with the P keyboard shortcut, Dislikes with the X key, and clear 
settings with the U key.

Both star ratings and color labels are industry standards. When you use these tools, the settings are 
stored in the metadata and will be available in other photo editors and managers, like Lightroom. (Likes are 
proprietary and will only appear in ON1 Photo RAW 2026.)

TIP: You can change the information displayed in the image thumbnails via the 
Thumbnail Options function. See “Changing the thumbnail display options” on 
page 27 for more.

An example of a photo in Grid view with a ratings, 
color and favorite attached.
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Use Auto Advance when culling your photos

Photo RAW’s Auto Advance feature—which can be turned on or off via the Photo menu—was designed to 
help you rank a group of images quickly: with Auto Advance turned on, apply a rating, color label or flag to 
an current image and Photo RAW will make the change and automatically move to the next image.

APPLYING EDIT MODULE PRESETS IN BROWSE

ON1 Photo RAW 2026 has a preset system that lets you save your complete settings from the Edit module. 
These presets are always available in Browse, so you can apply your favorite presets quickly and easily to a 
photo or a group of photos.

To apply a preset to an image, click on the Presets panel. There you will see any built-in presets supplied by 
ON1, as well as any presets you might have created or installed yourself. The panel is divided into 
categories, like B&W Films and Cinema. Click on a category to open it and show that category’s presets.

To see a larger representation of what your selected photo will look like, click 
the Quick View Browser icon in the preset category’s title bar. That will display 
an overlay window with all of the presets in that category.

To apply a preset to a photo, simply click on the preset in either the Category 
preset browser or in Quick View Browser mode. Presets applied in Browse are 
not cumulative; after you’ve applied one preset, clicking on another preset will 
remove the previous one and apply the new one. (If you have applied edits in 
either Develop or Effects, those modules’ settings will be erased if the preset 
has settings in those modules.)

You can easily add a preset to any photo (or group of photos) in Browse, in any Preview mode (Grid, Detail, Filmstrip or Compare). Just click on the 
Presets tab, navigate to the category you wish to use, and click on the preset thumbnail to apply. If you don’t like the look, you can Undo, or choose 
another preset. You can also use the fade slider to reduce the amount of the effect.

The Presets panel has a broad range 
of preset types, all of which can be 
applied in the Browse module.
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Because Photo RAW is non-destructive, going to any of the Edit module tabs will display all of the settings 
applied by the preset. Once in Edit, you can adjust the settings, switch preset, or make any other editing 
changes.

To remove a preset from a photo, click on the photo and choose Reset All Settings from the Settings menu. 
You can also remove individual settings made in either the Develop or Effects tabs, if you prefer.

(For more detailed information about how to create and edit presets, see “Presets” on page 133.)

NOTE: If a photo has had a preset applied in Browse, 
or has otherwise been edited in one of Photo RAW’s 
editing tabs, you will see a small badge with a ‘+/-’ icon 
in the lower-right corner of the thumbnail. These badges 
are visible in the Grid, Filmstrip and Compare views. (See 
the image on the right for detail.)

COPYING SETTINGS AND SYNCHRONIZING EDITS

In addition to applying presets, you can copy all of 
the existing edits made in one photo and paste them 
directly onto other images in the Browse module. This 
includes every editing operation you can perform in 
the Edit module. There are two primary methods for 
doing this—Copy/Paste and Sync—but they achieve 
the same end goal: it’s more a matter of preference in 
which operation you choose.

To copy the edit settings from an image, click on 
the source file and choose Settings > Copy Settings. 
Then, click on the new image and choose Settings > 
Paste Settings. A window will appear, giving you the 
option of applying any or all of the edits on the original 
photo, or you can select which edits—everything from 
individual settings in Develop’s Tone and Color pane, 
to masks, cropping, and text if used—you wish to paste 
into the new photo. (You can also select a group of 
photos and paste the edit settings onto the group.)

The Copy/Paste Settings commands can be useful 
when you wish to paste settings across a number of 
photos in different folders. As long as your Browse 
session is active, Photo RAW will remember the last 
copied settings, and you can paste them onto other 
photos as you wish.

With the Sync Settings command, select the image you 
want to use as your source. Then, holding down the 
Shift key (if you are selecting an image or group that 

In the Apply Settings window, you can apply nearly all Edit module 
operations to another image or group of images. Filled circles to the 
left of a setting mean that the setting will be applied; click the circle if 
you don’t wish that setting to be applied.
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is contiguous with the source), or the Command (Mac) or Control (Windows) key, and click on the image(s) 
that you wish to apply the source file’s edits. Your selection should have the source image highlighted in 
blue, and the target images highlighted in gray. If that is correct, choose Sync Settings from the Settings 
menu. The Apply Settings window will open, and you can follow the same procedure to synchronize your 
edits across the group of photos.

Sync All Settings

To sync everything from a source photo to another photo or group of photos Settings > Sync All Settings 
will bypass the Apply Settings window. Select your source and destination photos and select the command. 
Everything—including cropping, text and masks—in the source image will get synced.

RESETTING EDITS IN BROWSE

Any edits you have made with ON1 Photo RAW 2026 can be completely reset from within the Browse 
module. This includes photos you might have pasted or synchronized settings onto inside Browse, or 
anything done within the Edit module.

The Settings menu offers eight options for erasing edits made to a photo:

• Reset All Settings: This removes all adjustments made to a photo in the Edit module. (This 
option can also be accessed from the Reset All button at the bottom of the Browse window.) 

• Reset Develop Settings: Removes only the settings applied in the Develop tab.

• Reset Effects Settings: Removes only the settings applied in the Effects tab.

• Reset Sky Settings: Removes only the settings applied in the Sky tab.

• Reset Portrait AI Settings: Removes only the settings applied in the Portrait tab.

• Reset All Retouching Tools: Resets any retouching applied anywhere in the Edit module.

• Reset Local Adjustments: Removes all local adjustment layers.

• Reset Liquify Tool: Resets any application of the Liquify tool in the Edit module.

• Reset Crop: Returns the image to its original, uncropped size.

• Reset Text: Removes any text blocks.

You can undo any of these changes immediately after making them.

NOTE: The Reset settings options—as well as the Copy/Paste and Sync 
options—are not available when you are working with layered photos in Browse. 
You can, however, Copy and Paste settings between layers in the Edit module.

SEND TO

Browse lets you send images you are viewing to other 
applications for editing. This is done via the Send to 
option, which is available from the right-click contextual 
menu or the Edit menu. Browse detects common photo 
managers or editors and lists the latest installed version:
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• Adobe Photoshop

• Adobe Lightroom Classic

• Adobe Photoshop Elements

You can set up any application you want to send your photos 
to. Simply select the Send to Other Application option. Then 
select the application you want to send your photos to. The 
application will be remembered and listed with your other 
Send to options. (For example, if you use an email client you 
can add it to easily email photos.)

When you send an image to another application, you will be 
presented with the Edit in dialog box from ON1 Photo RAW 
2026. There you’ll have the option to send either the edited 
photo or the original, unedited image. If you choose to send 
a copy, you’ll have options for choosing the file type, color 
space, bit depth and resolution. If you use the same set of 
options every time, you can check the “Don’t ask me again” box in the window, and you won’t be prompted 
again. (To change this setting, go to the Files tab in Photo RAW’s Preferences (see page 294).)

VERSIONS

ON1 Photo RAW’s Versions feature lets you create a ‘virtual’ copy 
of an image, which you can edit in a completely different manner 
than the original file, but without actually duplicating the image. 
This lets you easily try different preset treatments, crops, and 
retouching operations on a copy of the same image without having 
to lose any work—or see your disk space increase. 

Creating a version is easy: in any of Browse’s view modes, choosing 
Create Version from the Settings menu (or choosing Command-’ 
or Control-’) will create a new version of the currently selected 
(or viewed) photo. A copy of the image will be created next to 
the existing one in your library, with a ‘v1’ added to the filename. 
(Additional versions will be numbered sequentially.)

A version acts like most images inside Photo RAW. You can open it 
in any of the Edit module tabs; crop or make any adjustments with all of Photo RAW’s tools and filters; and 
you can edit its metadata independently of the original. You can even export a versioned photo or use it in 
Resize (Photo RAW creates a rendered file in those instances). You can not create a version of an .onphoto 
file that has layers in it, however. You must first flatten the image inside the Edit module. (See “Working 
with Layers” on page 213 for more.)

In Grid view, versioned photos will have a small square badge split into light and dark triangles.

The Edit In dialog, with the Copy Options section expanded.

A versioned photo will have a ‘v1’ (or higher) attached 
to the end of the filename, and a small badge, split 
into dark and light triangles, in the lower right corner 
of the thumbnail.
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Using ON1 Photo RAW 2026 with two displays

You can use Photo RAW’s Dual Mode feature to display a second copy of your photos in an added browser-
style window. Here, you can view folders of images as thumbnails, and navigate through them, while 
displaying the full-size images in the primary window. This can help your productivity when you have an 
additional monitor connected to your computer, reducing the need to switch between Grid and Detail, 
Filmstrip or Compare view. It can also be useful when you wish to present photos on a projector or TV, and 
don’t want to display the entire Photo RAW application window.

Dual Mode only works with the Browse and Edit modules. In Browse, you can choose how you wish the 
second window to act, either displaying in Grid view, with the primary window working in the three other 
primary view modes (Photo, Filmstrip or Compare), or vice versa. As you navigate images in the Grid, the 
other window will display the currently selected image.

When in the Edit module, the second window works solely in Grid view, displaying thumbnails of the 
current folder. If you click on another image in the grid, that image will be presented in the main window. 

TURNING DUAL MODE ON

To use this feature, chose Dual Mode > Show from the Window menu. The first time you use Dual Mode, 
the second window will open on your primary display. Simply drag the window to your secondary display, 
and from that point on, Photo RAW will remember the location of the second window. (When the window 

Photo RAW’s Dual Mode lets you open a new browser-style window, which can be placed on a second display, or be used to present on a TV or projector.
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is placed in the second display, you can choose Dual Mode > Full Screen Mode from the window menu to 
have the window fill the entire screen.)

The icons at the bottom of the secondary window are a subset of the main application window: in Browse, 
you will see options for Grid, Photo and Compare views; in Edit, only the Grid view icon will be visible. The 
Size slider can change the size of thumbnails (in Grid view) or the zoom level (in Detail and Compare view).
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Using ON1 Cloud Sync with Photo RAW
ON1 Cloud Sync is an optional cloud storage service and sync technology that lets you 
capture, edit, and access photos seamlessly between multiple computers and mobile 
devices. The service is designed to share photos when you’re using the subscription 
versions of ON1 Photo RAW 2026 and ON1 Photo RAW for Mobile. Cloud Sync also lets 
you sync custom presets and extras between two installations of Photo RAW.

There are two storage options for ON1 Cloud Sync accounts, 200GB and 1TB, and multiple methods for 
signing up. If you have purchased an ON1 Photo RAW subscription, it will automatically be available in both 
Photo RAW or ON1 Photo RAW for Mobile after you have signed in to your ON1 account. 

From ON1 Photo RAW 2026, photos are published and synced to the ON1 Cloud via cataloged folders 
or albums, and you can choose to publish photos either as editable previews or in their original format 
(including raw). See “ON1 Cloud Sync File Formats” on page 77 for specifics on the different file types 
and why you would use one over the other.

When you’re using ON1 Photo RAW for Mobile on your smartphone or tablet, all photos on that device are 
published to the cloud in their original format, and reside in a single folder called Local Photos. (You can 
also create albums with ON1 Photo RAW for Mobile.)

VIEWING YOUR ON1 CLOUD SYNC STATUS

In the lower right section of the left sidebar is the ON1 Cloud Sync status icon, which has a small colored 
dot—in one of four colors—that indicates the status of ON1 Cloud Sync on the current computer. The 
indicator colors are:

• If there are no uploads or downloads in process, and the connection to the ON1 
Cloud is on, the dot will be green.

• When Photo RAW is in the process of uploading or downloading images or other 
information from the cloud, the dot will be blue.

• If there is a problem with the internet connection, you aren’t logged in, or if you are running 
low on available space, the dot will be red.

• It will be gray if you do not have an ON1 Cloud Sync account.

Clicking the status icon will bring up your ON1 
Cloud Sync dashboard (shown on the right). This 
window shows the status of any current uploads, 
your available cloud storage, and includes links to 
the iOS and Android versions of the ON1 Photo 
Mobile app. Clicking on the Account button 
will take you to your account page on the ON1 
website. The Learn button displays a window with 
information on how to get started with ON1 Cloud 
Sync.

The Turbo button is used to speed uploads; it will 
take as much processing power as it can to sync photos, to the limit of your upload bandwidth.
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VIEWING OTHER ON1 CLOUD SYNC DEVICES IN BROWSE

When you have shared ON1 Cloud Sync devices, you can see a list of them by clicking on the ON1 Cloud 
Sync icon in the Shortcuts bar on the top left side of the Photo RAW window. 

ON1 Photo RAW 2026 will display your connected devices in the preview area as folders in Grid view. 
Clicking on one of those folders will open with a list of that device’s synced photos. For mobile devices, you 
will see a single folder, Local Photos, which contains all of the photos that are on that device. For Windows 
and Mac computers, you will see a list of all cataloged folders from that device. 

You can view and edit any of the photos on a synced device from within ON1 Photo RAW 2026, and you 
can drill down into the folders in the same manner you would for any other folder in Photo RAW. You can 
sort the photos, add them to new or existing albums, adjust metadata and add keywords to them. 

Clicking on the ON1 Cloud Sync icon at the bottom of the Shortcuts bar on the left will display a list of your connected devices. Each 
device will appear as a folder. Mobile devices will display a single folder, called Local Photos, while any Mac or Windows computer will 
display a list of the cataloged folders synced with the ON1 Cloud Sync service.

Photos synced to the ON1 Cloud from other devices will have a badge when you are viewing a folder or album in Browse’s Grid view. If the 
synced photo is an editable preview, it will have the Sync badge in the lower right corner of the thumbnail (image left, above). If it is an 
original, it will also have a badge with an ‘OG’ label (center). And, if the photo has been edited, you will also see the ‘+/-’ label (right).
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When viewing photos in Grid view, you can tell if a photo is synced from another device by the small Cloud 
Sync badge in the lower right portion of the thumbnail. If the photo in question is an original — as opposed 
to an editable preview — there will also be a badge with the initials ‘OG.’ These badges will be displayed on 
all published folders, devices and albums when you are working in Grid view.

ON1 CLOUD SYNC FILE FORMATS

With ON1 Photo RAW 2026, you have the option of publishing photos to the ON1 cloud in one of two 
formats, the original photo, or an editable preview, which uses a proprietary compressed-raw file format 
developed by ON1. This editable preview can be up to 75% smaller than the original raw file, while 
preserving the original’s tone and color fidelity. Using this option lets you keep more of your photos in the 
cloud, and, with either format, you can still edit a photo on one device, and your edits will be synced back 
to the originating computer, so that your original file is updated with those edits (and any other metadata 
changes you might have made).

As noted, the savings in storage space can be quite great. Use these basic guidelines for photo storage 
options:

• With a camera that creates 30MB raw files, you should be able to store more than 5,500 
raw originals in the cloud with a 200GB ON1 Cloud Sync service plan, and more than 27,000 
photos with the 1TB plan.

• If you are shooting JPGs with that same camera, we estimate that you would be able to store 
more than 20,000 JPG originals with the 200GB plan, and more than 100,000 photos on the 
1TB plan.

• If you chose to upload editable preview files instead of originals, you should be able to store 
more than 33,000 photos in the cloud with the 200GB plan, and more than 160,000 with the 
1TB storage plan.

Remember, while you can store photos in the ON1 Sync cloud using either format, and in any combination, 
your originals are always stored securely on the device that created or imported them. 

NOTE: Photos taken or imported with the ON1 Photo RAW for Mobile app are 
always uploaded in their original format. 

When to choose one sync format over another

In most cases, if you are working on two computers (a desktop and laptop, for example), working with 
editable previews should be more than sufficient for most workflow requirements. You can edit and update 
any metadata, including ratings, keywords and more, and work within all of the tabs in the Edit module. The 
fidelity and tonal range of the preview files is excellent, and all of your edits will be applied to the originals 
on the other device. 

You should sync folders and albums as originals when you want to work with an original photo on another 
computer. There are four primary reasons for this: you wish to create layered files; build HDR, panorama 
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or focus-stacked composites; resize a photo with the Resize module; or you wish to print a photo at the 
highest-possible quality. 

In these instances, if you have an original photo on another ON1 Cloud Sync device, you can download 
a copy of that original from the cloud to your current computer by right-clicking on the photo in Browse 
and choosing Download Original from the pop-up menu. If the original version is in the cloud, you will be 
prompted to save the copy in a location on your computer. 

Depending upon your intent, you can delete this copy later, or save it back to a published folder or album. 
For more information on these instances, see “Using Layers with Synced ON1 Cloud Files” on page 221, 
“Using Resize with ON1 Cloud Sync Files” on page 265, and “Printing photos from ON1 Cloud Sync 
devices” on page 232.

Managing sync options in Photo RAW

Photos published to ON1 Cloud Sync are managed in ON1 
Photo RAW 2026 at the folder or album level. What this 
means is that you can set up different folders or albums to 
sync as editable previews or originals, and you can change 
this option at any time by right-clicking on the folder or 
album and choosing the Sync Options item from the pop-
up menu. 

It is worth noting that you cannot change the sync option for individual photos: it can only be done at the 
album or folder level. You can however, selectively change the sync option for the subfolders in a cataloged 
folder.

BASIC CLOUD SYNC WORKFLOW WITHIN PHOTO RAW

As noted in the sections on cataloged folders (page 37) and 
albums (page 39), publishing photos from ON1 Photo RAW 2026 
is straightforward. When creating an album or cataloged folder, you 
have the option to publish and sync those photos as either originals 
or previews, or you can wait until a later time and publish them by 
selecting the item and choosing Publish to ON1 Cloud Sync from 
the pop-up menu. By default, when you publish via the pop-up, 
Photo RAW will upload editable previews to the cloud, but you can 
change this via the Sync Options menu item, as described in the 
previous section.

When you’re working with any photos that are based on a remote 
Cloud Sync device, regardless of whether it was created on a 
computer with Photo RAW or with ON1 Photo RAW for Mobile, 
you will be able to perform any changes to metadata, or make any 
edits in the Edit module, and those changes will be synced back to 
the original file on the original device. This doesn’t matter if the file 
in the cloud is an editable preview or an original.

Syncing presets and extras with Cloud Sync

You can also sync your Photo RAW presets and imported extras 

You can publish (or unpublish) an album or cataloged folder at any 
time by right-clicking on the item name and choosing Publish/
Unpublish to ON1 Cloud Sync from the menu.

To change the publishing status of an album or folder, 
right-click on the item and choose the appropriate 
format from the Sync Options pop-up menu.
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between your licensed computers with Cloud Sync. This option can be turned on or off via the Sync Presets 
checkbox in the Cloud Sync Preferences pane (see page 300).

CLOUD SYNC, PHOTO RAW AND PHOTO RAW FOR MOBILE

On mobile devices, which includes both smartphones and tablets, the 
ON1 Photo RAW for Mobile app acts as a camera — with full raw-capture 
support — and an import device, which can add your photos immediately 
to ON1 Cloud Sync. ON1 Photo RAW for Mobile also has a subset of 
Photo RAW’s Edit module built into it. You can shoot photos with your 
phone, edit them using ON1 Photo, add them to existing Cloud Sync 
albums and they will automatically be shared to the cloud for viewing and 
editing. 

All of the photos shot and imported onto a mobile device with ON1 Photo 
RAW for Mobile are captured to a location on your device called Local 
Photos, which is what you see when you look at a mobile device in the 
ON1 Cloud Sync pane in ON1 Photo RAW 2026. 

There are five tabs in the ON1 Photo Mobile app:

• Local Photos, which displays the photos on that device;

• Cloud Sync, which displays your synced devices, and lets you 
drill down into them to view the photos on those devices;

• Albums, which displays synced ON1 Cloud Sync albums, and lets 
you create your own synced albums directly from your mobile 
device;

The ON1 Photo Mobile app, available for both iOS and Android phones and tablets, is designed to share and edit your mobile photos, and access and edit photos on 
your other ON1 Cloud Sync devices. The app has five tabs, a Local Photos container, which is where your photos from that mobile device reside; ON1 Cloud Sync, 
which lets you access the photos from other shared devices; Albums, which displays existing Cloud Sync albums (and lets you create new albums); Import, which 
lets you import photos from your device’s camera roll or folders; and Camera (shown below), which is a full-featured smartphone camera capable of capturing raw, 
HEIC or JPG photos.

The Camera module in ON1
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• Import, which can import photos from your device’s camera roll or other folders; and

• Camera, a full-featured, pro-level camera capable of capturing photos in raw, HEIC or JPG 
format, and syncing them immediately to the ON1 cloud.

ON1 Photo Mobile uses the same RAW processing engine developed for ON1 Photo RAW, and has a non-
destructive raw editor built into the app. The basic editing controls 
are similar to those found in the Develop tab of Photo RAW’s Edit 
module: there are adjustments for Exposure, Contrast, Shadows, 
Midtones, Highlights, Whites, Blacks, White Balance, Noise, and 
Sharpening. The app also includes five filters from the Edit module’s 
Effects tab.

Viewing photos in ON1 Photo RAW for Mobile

You can view all of your photos — local or synced from the cloud 
— in ON1 Photo RAW for Mobile via standard gestures and taps. 
Tapping on an album, for example will display a grid of that album, 
and you can pinch two fingers together and apart to change the grid 
size. Tap on a photo to view it in Detail view, and pinch to zoom in. 

Photo Management and Editing

When you wish to share or edit a photo with ON1 Photo Mobile, tap 
on it from any Grid view screen. This will display the photo in Detail 
view with the photo’s name, and three icons at the bottom of the 
screen: one for sharing the photo, one for editing, and the other to 
delete the current photo (this only applies to photos that reside in 
that device’s Local Photos folder).

Sharing options include saving a copy of the photo to your camera 
roll, or to be shared via your device’s social media sharing options. 
The sharing window includes sizing options (medium, large, and full-size) for your exported photo.

Editing photos with the app is similar to editing photos in Photo RAW, although ON1 Photo RAW for 
Mobile doesn’t have all of the tools and filters found in the desktop app. ON1 is committed over time to 
bring the mobile app as close to parity with the desktop version as possible.

Tapping the Edit icon at the bottom center of the screen will display six editing functions (plus reset) 
underneath the photo:

• Crop: resizes and levels your photo.

• Tone: for applying Brilliance AI, 
adjusting exposure, contrast, 
highlights, shadows, midtones, and black points, as well as for adding structure, applying 
dehaze, sharpening and noise reduction.

• Super Select AI tool: Tap regions in the photo and apply local adjustments and effects to 
them.

• Presets: ON1 Photo RAW for Mobile includes a variety of presets in multiple categories, 
letting you achieve a great look with one click.

ON1 Photo RAW for Mobile includes edtiing presets 
for quickly applyiongf a specific look to your photos.
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• Effects: lets you apply nine of Photo RAW’s Effects filters: Black & White, Color Adjustment, 
Curves, Dynamic Contrast, Film Grain, HDR Look, Glow, Split Tone, and Vignette.

• Local Adjustments: In the same way that Photo RAW lets you apply targeted adjustments to 
portions of a photo, ON1 Photo RAW for Mobile has a Local Adjustments module, where you 
can fine tune portions of your photos, with the same masking tools found in the desktop app.

• Retouching Tools: includes the Perfect Eraser and Clone tools to fix blemishes, dust spots 
and more.

• Reset: The rightmost icon will reset all of your edits, returning your photo to its original state.

For more information about the various editing options available in ON1 Photo RAW for Mobile, and how 
they relate to the ON1 Photo RAW 2026 editing engine, see “About the Edit Module” on page 84. 

Mobile editing limitations with synced photos

While ON1 Cloud Sync and ON1 Photo RAW for Mobile have been designed to provide a seamless editing 
experience between desktop and mobile devices, there are two instances where you might run into an 
situation where you can view, but not edit a synced file inside ON1 Photo RAW for Mobile:

• When you’ve edited a synced ON1 Cloud photo with Photo RAW using any Effects filter that 
is not present in ON1 Photo RAW for Mobile.

• Any .onphoto file cannot be edited with ON1 Photo Mobile. This includes HDR, panorama 
and focus-stacked composites, as well as layered files.

Any photo synced with ON1 Cloud Sync that has not had editing adjustments made to it can be edited with 
any ON1 Photo RAW 2026 or ON1 Photo Mobile device, whether the photo in question is an original or 

When you’re viewing a photo in ON1 Photo Mobile, tapping the center icon at the bottom of the screen will take you into Editing mode, where you 
can apply standard editing functions, including Brilliance AI (center), or Effectsfilters stacked as they would be in the desktop version of Photo 
RAW.
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an editable preview. And all ON1 Cloud Sync photos will be visible on all Cloud Sync devices, regardless of 
their originating format.



PART 3: 
WORKING IN 

THE EDIT MODULE
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ABOUT THE EDIT MODULE
ON1 Photo RAW 2026’s photo-editing power is found in the Edit module, which consists of five distinct 
editing functions, each separated into tabs:

• Develop is where you perform basic, global editing operations, such as adjusting tone and 
color, removing noise and repairing motion blur and camera shake—with ON1’s NoNoise AI 
and TackSharp AI technology—plus tools for perspective correction and easy conversion of 
black-and-white and color negatives. It is the perfect place to begin editing your photos. It’s 
all topped off with the Brilliance AI feature, which streamlines your editing and instantly 
makes almost any photo look great, while still providing the non-destructive editing that is 
the hallmark of Photo RAW. (See page 147.)

• Local Adjustments are designed to apply basic, targeted edits to parts of your photos, letting 
you perform traditional photo-editing tasks—like dodging and burning—with ease. You can 
also add custom brush overlays to an image via the Local Adjustments tab. (See page 162.)

• Effects is the stylization center of Photo RAW, with 37 filters that can be stacked in any 
order, all with extensive blending and masking options. And, with Photo RAW’s Mask AI 
technology, you can apply Effects filters solely to specific regions in a photo with a single 
click. (See page 167.)

• Sky Swap AI lets you replace boring skies quickly and easily. Sky Swap AI automatically masks 
out the sky in your photo, letting you replace it with any of more than 100 included skies. You 
can even import your own skies directly from within the tab. (See page 200.) 

• Portrait AI uses machine-learning algorithms to automatically find and retouch all the faces in 
a photo, apply smoothing, reduce blemishes, and brighten eyes and teeth. (See page 205.)

To help you fine tune the edits on your images, Photo RAW has 20 tools that perform everything from 
cropping (with AI-based expansion options) and transformation to one-click creation of subject and 
background masks, Tools like the Generative Eraser — designed to help you remove large distractions from 
a scene — and the enhanced Perfect Eraser, which provides automatic detection and removal of common 
distractions like sensor dust and power lines. Tools like Super Select AI make the selection and application 
of Effects filters or local adjustments easy: point and click at an area of a photo and apply an adjustment in a 
single operation.

Switching between the different tabs in the Edit module is as simple as clicking on the appropriate tab. 
While you work on an image, all of your settings in each tab are saved while you edit. All edits you make to 
an image are preserved non-destructively, and you can go back to any image at any time and make changes 
or corrections to it. 

Photo RAW 2026’s Edit module also includes a Layers pane, which lets you stack multiple images together 
to achieve sophisticated composites that aren’t available in many standalone photo editors. You can add 
text as a layer to your photos, with full control over font type, size and placement. And, because the Edit 
module is entirely non-destructive when you use Photo RAW as a standalone app, you can re-edit your 
compositions without worry. (See “Working with Layers” on page 213 for more.)

ON1 Photo RAW 2026 also includes a robust preset system that lets you save settings made in any of the 
editing tabs, along with some of the retouching tool operations and masks—including AI-generated masks—
for applying to other photos. Editing presets can be applied in the Edit module, or in Browse, and, like all 
other elements of Photo RAW 2026, are re-editable. (Presets are discussed in detail on page 133.)
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In addition to presets, you can copy and paste Edit module settings from one file to another, or synchronize 
the edits on one photo to a group of photos. These operations can all be performed in any of the editing 
modules, as well as in Browse, adding to ON1 Photo RAW 2026’s extreme flexibility. (See “Copying settings 
and synchronizing edits” on page 140 and “Applying Edit Module Presets in Browse” on page 69.)

If you are using the ON1 Cloud Sync service, your synced photos are editable in Photo RAW, regardless of 
device. All of your edits will be synced back with the photos on their originating device, and will be fully re-
editable in Photo RAW. The primary exception to this is when you are using Layers, which must be stored 
on the device that created the layered file. See “Using Layers with Synced ON1 Cloud Files” on page 221 
for a more detailed description of the workflow for Layers and ON1 Cloud Sync.

Generative AI Technology and Photo RAW 2026
Photo RAW 2026’s Crop tool and the Generative Eraser utilize generative AI technology that can run locally 
on your computer or via a cloud-based option through Stability AI (which requires an open connection 
to the Internet to run). These tools allow photographers to enhance images with speed and precision, 
and while generative AI isn’t perfect, it does offer exciting opportunities for creativity and efficiency in 
photography.

The Generative Eraser is an evolution of the Perfect Eraser, and is ideal for removing large distractions 
from your photos. However, this doesn’t mean it will be suitable for everything. We still recommend the 
non-destructive Healing Brush for small or simple retouching tasks, which works well in many everyday 
situations. When dealing with more challenging tasks like removing photobombers, bystanders, signs, 
braces, cars, etc., the Generative Eraser excels. 

The workflow is slightly different, as generative AI doesn’t produce the same result when identical input 
is given repeatedly. Therefore, the results must be saved rather than replayed like other non-destructive 
settings. The output from the Generative Eraser is applied to a new copy of the layer you’re working on, 
allowing you to retry as much as you like to achieve the desired result.

Generative Crop as the next step beyond content-aware crop. It’s an option when you use the crop tool 
to expand the canvas beyond the original photo, allowing you to recompose the shot if necessary. It’s like 
zooming out after the fact. The results from Generative Crop far surpass the quality of content-aware crop. 
Like the Generative Eraser, its results are created on a new layer copy.

GENERATIVE AI PROCESSING OPTIONS

Photo RAW has two primary AI diffusion models for use with the Generative Eraser and the Canvas 
Extension option in the Crop tool. If you wish to run the processes locally, you can choose ON1’s Local Gen 
AI; alternatively, you can use a cloud-based service from Stability.ai, the creators of Stable Diffusion.

To use Local Gen AI on your system, you’ll need a modern GPU with at least 4GB of VRAM. These GPUs 
include the RTX 1070, 2060, 3050, and 4060 or better for NVIDIA or the Radeon 570, 5300XT, 6400, or 
7600 for AMD, all with the latest drivers installed. Apple Silicon systems with 16GB or more RAM will work 
as well. Running these features locally instead of in the cloud protects your privacy since no photos go 
there. It also allows us to provide generative AI features without requiring a subscription. Keep in mind that 
diffusion models are typically run in the cloud on large servers equipped with specialized GPUs designed 
for AI processing. To make these models functional on standard Mac or PC gamer-level GPUs, we’ve had to 
scale them down. While they should generally yield acceptable results, they may not be as precise as some 
cloud-based solutions. 
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You can also sign up for an account with Stability via their consumer portal, DreamStudio, at dreamstudio.
ai. Signing up is free; you receive 25 free credits when you sign up, and you are given a unique key that is 
assigned to your account, which you enter into Photo RAW. Each tool usage currently costs 3–4 credits, 
and credits were priced at one cent (US) at the time of this writing. Any time you use Stabilty to generate 
content, you must have a connection to the internet.

The Stability integration can sometimes yield different results, which may be better in some cases, and 
it can also be faster depending on your hardware specifications. Stability’s terms of service protect your 
privacy.

Selecting the AI model to use

Each time you use either the Canvas Extension 
option (Crop) or the Generative Eraser, you have the 
option of choosing which model to use, Local Gen AI 
for processing locally or Stability.ai, for cloud-based 
processing. Select it from the Canvas Extension 
pop-up in the Crop tool or the Gear menu in the 
Generative Eraser Tool Options bar. The first time you 
choose Stability AI, you need to enter your Stability 
key into the Key field; Photo RAW will retain the key 
for future sessions.

Information on the Crop tool can be found on page 
97; the Generative Eraser is discussed starting on 
page 119.

NOTE: Anyone can use the Stability AI model with Photo RAW 2026; if your 
system cannot meet the requirements to use Local Gen AI, and you do not wish 
to use Stability, you can select the Local NonGen AI option in the model pop-up 
for either the Crop or Generative Eraser tools.  In general, your results won’t be 
close to either of the other two models, but they may be acceptable for certain 
types of photos.

You change the AI model in the Tool Options bars for the Crop and 
Generative Eraser tools. When you select the Stability AI model for the 
first time, you need to paste your Stability key into the Key field, after 
that, it will be stored in Photo RAW for future use.. 

https://dreamstudio.ai
https://dreamstudio.ai
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Using Photo RAW as a Raw Editor
ON1 Photo RAW 2026 offers true non-destructive raw editing capabilities. This means you can view your 
images in the Browse module, click to open a raw file in any part of the Edit module and apply edits—
including cropping, healing and local adjustments—and Photo RAW will always be working with your 
original file. At any point, you can go back to Develop, Effects, Sky Swap AI, Local Adjustments or Portrait 
AI and change any or all settings you have made. What’s more, when you’re working with layers, Photo 
RAW will save your work in a non-destructive format as well, using a Photo RAW-specific ‘onphoto’ file 
format. This format retains all layer and editing information, and, when you wish to export a composited 
image for sharing or other uses, you can easily export it in any format supported by Photo RAW.

THE EDITING PIPELINE IN ON1 PHOTO RAW 2026

There are many editing operations you can make to a raw file (or other supported file format) with ON1 
Photo RAW 2026, from broad global adjustments for exposure and color, to the application of effects, to 
cropping and retouching, the addition of local adjustments to sections of a photo. Because there has to be 
some structure of how edits are applied to a raw file, it might be helpful to understand the order in which 
edits are applied to a raw file. Whenever you view an edited image without additional layers, this is the 
order in which ON1 Photo RAW 2026 applies edits:

1.	 The original, base image is always at the bottom of the stack. 

2.	 Since retouching—operations like removing dust spots, editing blemishes or skin 
imperfections—is often the first thing many photographers do to their images, Photo RAW 
applies these operations first. This way, all subsequent edits will incorporate these changes.

3.	 Next are most settings applied in the Develop tab. This includes the application of color 
profiles, global exposure, color correction, sharpening and noise reduction (unless NoNoise 
AI and/or TackSharp AI is used, in which case those settings are applied to the base image).

4.	 Local adjustments made to an image are applied next.

5.	 Any Transform operations are applied after local adjustments. 

6.	 Edits made in the Portrait tab are applied next.

7.	 Any filters applied in the Effects tab are applied last.

8.	 Text layers sit above the image stack. 

9.	 Finally, any cropping or rotation information made to an image is applied to the file.

When working with multiple layers, steps 1 through 7 are applied for each layer, with the bottom layer at the 
bottom of the ‘stack’, and the topmost layer at the top. After all the layers’ edits have been applied, Photo 
RAW adds any text, followed by cropping and rotation information, to complete the document pipeline.

You do not have to edit your photos in this order; this is just the way in which Photo RAW 2026 applies the 
edits you make to an image. You might find a dust spot, for example, only after changing exposure settings 
in Develop or applying a filter in Effects. You can then use the Perfect Eraser to remove the spot and 
continue with your editing, and Photo RAW 2026 will apply it at the proper place in the stack.
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ON1 Edit Module Main Screen Overview

Edit provides you with an easy-to-use work space for editing your photos. Below is an overview of the main 
window sections of the Edit module:

A.	Tool well: Tools for working within the Edit module.

B.	 ON1 Cloud Sync Status/Left Panel: Shortcuts to ON1 Cloud Sync status and to open and 
close the left (Presets/Filters) panel.

C.	 Presets/Filters panel: List of all installed presets (by category). When working in the Effects 
tab, a Filters panel is visible as well. 

D.	Preset/Filter Search: Searches presets (and filters, when working in Effects) by name.

E.	 Window options and Preview size: Switch between Grid (returns to Browse), Photo and 
Filmstrip views, and sets the zoom view for the current photo.

F.	 Tool Options bar: Options and settings for currently selected tool. When working in a tool 
group (like Mask), the other tools in that group are selectable.

G.	Preview Window: Displays the current photo in detail view.

H.	Breadcrumbs Bar: Displays the name and path of the current photo and the number of 
photos in the current folder; the pop-up lets you choose another folder to view. 

I.	 Preview option toggles: First icon displays the original (unedited) version of the current 
photo; the second icon turns the current mask on and off. The mask pop-up lets you choose 
the mask overlay mode.
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J.	 Photo Information panes: Navigator, Levels (histogram), Info, History, Snapshots.

K.	 Properties pane: Contains tabs for setting blending modes, masking options, and text layer 
specifics. (Can also be comfigured to display as a pop-up window. See page 93.)

L.	 Layers pane: Add, edit and manage layers here.

M.	Edit tabs: Tabs for accessing the Develop, Local Adjustments, Portrait AI, Sky Swap AI, and 
Effects. Clicking on each tab brings up the settings for that tab.

N.	Reset/Revert/Save bar: Resets all Edit module settings for the current photo; Reverts all 
edits made during the current session on the current photo; Saves the photo’s edits and 
returns to Browse.

The look of the Edit module in ON1 Photo RAW 2026 is similar to that of Browse, with slight variations that 
are specific to photo-editing tasks. The left side of the window contains a tool well with Edit-specific tools, 
and a Presets pane (when using the Effects tab, you will also see a Filters tab alongside Presets).

The right side of the screen contains the same panes at the top—Navigator, Levels/Histogram and Info—as 
well as a History pane, the Layers panel, and tabs for the four editing areas inside Edit: Develop, Effects, 
Portrait and Local. Clicking on a tab will bring up the options and settings for that area. When viewing 
images, you can work in either Photo or Filmstrip view, each view works the same as they do in Browse 
(See “Working in the Preview Area” on page 23 for more).  

Photo RAW provides several ways to navigate and view your image in the Edit module’s Preview window:

• By default, your image is presented in Fit view, which displays the image within the preview 
area, and the Zoom tool is selected. Clicking on the image with the Zoom tool will zoom in 
to 100%, and the cursor will change to the Hand tool. You can move around your image by 
clicking and dragging in the preview area. Clicking once will take you back to Fit view.

• You can also zoom in and out via the View menu and the Navigator pane. The Navigator pane 
displays a bounding box around the area currently on-screen, and you can reposition what is 
displayed in the preview area by clicking and dragging the box around the pane. Clicking on 
one of the buttons at the bottom of the Navigator pane will automatically zoom to Fit, 100%, 
50% or 25% views. (The buttons are visible in the Zoom tool’s Options bar.)

• When the preview zoom is larger than the viewable area, holding down the spacebar will 
display the Hand tool if any editing tool is selected. Clicking and dragging while holding the 
spacebar will reposition your image at the current view level.
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Navigator, Levels, Info, History and Snapshots
At the top of the control panel on the right of the main window are the Navigator, Histogram, Info, History, 
and Snapshot panes. These tools are for inspecting and viewing details of your image, for looking at the Edit 
adjustments made during a session, and for saving a snapshot of an editing session in a specific place.

THE NAVIGATOR PANE

This gives you a thumbnail view of your image 
as it is displayed in the current view. The white 
square region marks the image area that is 
visible in the preview pane, and you can pan 
your image by clicking and dragging inside the 
square. (The pane will also update when using 
the Hand/Zoom tools.)

NOTE: You can also use your mouse’s scroll wheel to pan and zoom inside 
your photos. See “Using Photo RAW with a Scroll Wheel” on page 16 for 
specifics.

THE LEVELS PANE

This gives you a color chart of the shadow, 
midtone and highlight areas based on the image 
RGB values (commonly known as a histogram). 
This is useful to show areas within the image 
that may be clipping. Clipping is when your 
image contains pure blacks or white and can 
signify loss of highlight or shadow detail.

The left side of the histogram represents 
the shadows, while the right represents the 
highlights. At the top of each end is a triangle. If the triangle is lit, there is clipping on that side of the 
histogram. If you click on the arrows, you will activate the clipping overlay on your image, which displays 
the areas that are clipped. Those areas with a blue overlay are pure black, while the areas with the red 
overlay are pure white. You can turn the clipping view off again by clicking on one of the triangles. You can 
also temporarily enable clipping view by holding down the J key at any time. The clipping view is useful 
when you are making adjusts to the brightness and contrast of your image. (See “Focus and Clipping Views” 
on page 26, for more information about using the clipping view.)

The Histogram pane also displays the RGB values under the cursor at the bottom of the pane.
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THE INFO PANE

The Info pane displays metadata for the current 
image in an easy-to-read format. This metadata 
includes camera make and model; lens focal 
length; capture date and time; file type; ISO 
setting; shutter speed; aperture; and exposure 
compensation.

The Info pane also displays file-specific data, 
including image dimensions and resolution. If 
any of the metadata fields are unavailable they 
will be left blank.

NOTE: The Settings Applied section found in earlier versions of Photo RAW 
now resides in the Layers pane. See “Viewing Edit module settings for a layer” 
on page 220.

THE HISTORY PANE

Photo RAW has a robust Undo capability, which 
is helpful when you wish to back up a few steps 
during the editing process. When you want to go 
back further, it can be tedious to keep pressing 
Command/Control-Z. That’s where the history 
pane can be extremely useful. It displays every 
adjustment made during an editing session. 
From the History pane, you can scroll through 
your edits, all the way back to the state of your 
photo when you opened it for editing.

As you work, the History pane tracks all of your edits, adding each change you make to the top of the pane. 
History displays not only the adjustment, but in many cases will display the settings of sliders in the various 
panes and filters. 

You can scroll through the list, and, if you click on an item, Photo RAW will “roll back” your edits to the spot 
you clicked. You can click up and down in the list, and, as long as you don’t make any changes, the entire 
Edit history is preserved. If you roll back to an edit and make a change, the History pane “resets” from that 
point on, losing any of the edits you made after the point you rolled back.

History is not saved across editing sessions; it is designed to help you refine the edits made during an 
editing session. If you go back to Browse, open another image for editing from the Filmstrip, or switch to 
Resize, the History pane resets. If you would like to save your edits based on a specific editing state, use 
the Snapshots feature, described below.
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TIP: If you click on an item in the History pane, and you wish to step up or 
down in the adjustment history from that point, you can use the Undo/Redo 
commands to quickly go through the list. If you are happy with your edits, click 
back on the top item in the History pane to preserve the state of the photo.

THE SNAPSHOTS PANE

Photo RAW’s Snapshots function lets you save a 
photo’s editing “state” at any point in the editing 
process, so that it can be returned to at a later 
time. When you create a snapshot, it saves 
all of the current photo’s edits as they are in 
that moment. Once saved, you can get back to 
that state in the editing process at any time by 
clicking on the snapshot’s name in the pane. You 
can also create multiple snapshots and move 
from state to state by clicking on the appropriate 
snapshot in the list. 

Snapshots can be useful when you wish to save and compare different applications of effects, such as 
comparing color vs. black-and-white treatments. They’re also helpful when you’re not quite sure about 
where to take an edit, and you want to ensure that you can get back to a specific point in the editing 
process.

Snapshot basics

The top of the Snapshot pane for each photo will always have an item called “Original,” which is the original 
state of the photo as it was first opened in the Edit module. In addition, at the conclusion of every Edit 
module session for that photo, Photo RAW will automatically save the final editing state as a snapshot, with 
the date and time you closed the photo, and an “(Auto Save)” label at the end of the snapshot name. 

To create your own snapshot, go to the Snapshots tab and click the New Snapshot button. A window will 
open asking you to name the snapshot; by default, it will be the current date and time, but you can enter 
any descriptive text you would like. There is no limit to the number of snapshots you can create.

When you wish to return to the editing state defined by a specific snapshot, click that item in the Snapshots 
pane. You can also move from snapshot to snapshot, which can be helpful for comparing edits. To then get 
back to where you were at before you clicked a snapshot, choose Undo, or, if you’ve applied a number of 
edits from that snapshot state forward, you can use the History pane to roll back to the pre-snapshot state. 
(Alternatively, you could create a new placeholder snapshot, which would preserve that state, and return to 
it later.) 

Managing snapshots

There are a few snapshot-management options available, which can be called up by right-clicking on any 
item in the Snapshots pane. These options include:

When you create a snapshot, you are saving the state of a photo’s edits as it was 
at that point in the editing process. Clicking on a snapshot in the pane will return 
you to that state at any time.
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• New Snapshot: creates a new snapshot with the current editing state.

• Delete Snapshot: removes the snapshot permanently from the pane.

• Rename Snapshot: renames the snapshot; this 
includes autosaved snapshots, although Photo 
RAW preserves the (Auto Save) label.

• Update Snapshot with Current Settings: saves 
the current editing state to the selected snapshot, 
overwriting the previously saved state.

• Create Version from Snapshot: creates a new, 
virtual copy of the photo, using the snapshot’s 
editing state (see “Versions” on page 72 for more on this feature).

NOTE: You can show or hide most of the panes in the Edit module’s right-side 
control panel. See for page 16 for details.

 The Properties Window
The Properties window is used for setting blending modes and masking options throughout the Edit 
module; and for manipulating Text layers in the Layers pane. By default, it works as a window, but it can 
also be configured to act as a pane in the Edit module’s control panel.

Right-clicking on an item in the Snapsh`ots pane gives you a list 
of management options for that snapshot.

Page: 15
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The Properties window is closed by default, but opens when you click on the blend mode icon, when you 
create or click on a mask, or when you click on or create a text layer. 

NOTE: For information on using the blending modes, see page 175; the 
Properties window’s masking options are detailed on page 126; text layers are 
discussed on page 216.

Configuring the Properties Window

You can configure the Properties window’s visibility in a number of ways, via the Windows > Properties 
submenu in the Edit module:

• The Show submenu option turns the pop-up window (or nested pane) on or off. When set to 
off, the pane will be hidden, but will reappear once a masking tool has been selected.

• The Nest submenu option relocates the Properties window to a pane in either the left side 
or the right side of the Edit module. Leaving both Nest options unchecked will float the 
Properties window.

• The Auto Collapse option collapses either the window or pane to just the tab headings 
(Blending, Mask, Text). Positioning your mouse over any of the tabs displays the entire pane. 

NOTE: The Layers pane can also be configured to float or nest on each side of 
the Photo RAW screen (see page 214 for details). 

The Properties window (and the Layers pane) can be configured so that it resides in either the left or the right side panels. If you want a floating window, 
uncheck the Left Side and Right Side options in the Window menu.
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The Tool Well
The Edit module has 20 tools that are accessible via the Tool Well on the left side of the screen. Some 
tools—Crop, Transform, Super Select AI, and View—are self-contained within the tool icons. Others—Mask, 
Retouch, and Liquify—are nested within a tool group and are accessible via the Tool Options bar at the top 
of the screen when you click on one of those tool icons.

• Crop Tool: Trims an image to your desired size or 
ratio. Also supports genenerative expansion via 
ON1’s Local Gen AI technology. Shortcut key: C

• Transform (Move) Tool: Moves and changes the 
size and rotation of your layer. Shortcut key: V

• Super Select AI Tool: Lets you select regions in 
an image by clicking on them and then applies 
Effects filters or local adjustments automatically 
to those regions. Shortcut key: K

• Masking Brush (Mask group): Mask large similar 
areas quickly. (Includes Perfect Brush option.) 
Shortcut key: B

• Gradient Mask (Mask group): Applies a selective 
gradient as a mask in any filter (or to the entire 
stack). Shortcut key: M

• Quick Mask AI Brush (Mask group): Similar in 
operation to the Super Select AI tool, this tool 
generates masks by clicking on regions in a photo. 
Shortcut key: W

• Quick Mask Brush (Mask group): Create high-quality masks with only a few strokes as 
guidance. Shortcut key: Command-Option-Shift W (Mac); Control-alt-Shift W (Windows)

• Line Mask Tool (Mask group): Create masks using straight lines, with the capability to add 
curves and adjust mask points on the fly. Shortcut key: Shift-P

• Refine Brush (Mask group): Lets you refine an existing mask’s edges, to help mask difficult 
areas, such as hair. Shortcut key: N

• Chisel Brush (Mask group): Removes fringes from the edge of a mask. Shortcut key: Shift-H

• Blur Brush (Mask group): Blurs the edges of a masked area to help it blend more naturally. 
Shortcut key: L

• Healing Brush (Retouch group):  Non-destructively removes distractions from a photo using 
content-aware fill technology. Shortcut key: Q

• Generative Eraser (Retouch group): Uses ON1’s Local Gen AI technology to remove large 
distractions from a photo. Shortcut key: Option-Shift-Q

• Perfect Eraser (Retouch group): Removes distractions from a photo; includes automatic dust 
spot and power line removal options. Shortcut key: Shift-Q

• Retouch Brush (Retouch group): Removes blemishes like dust spots and acne. (Includes 
Perfect Brush option.) Shortcut key: R

• Clone Stamp (Retouch group): Paints over an area from another area. Shortcut key: Shift-S
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• Push Tool (Liquify group): Lets you push or warp areas of your photo with a brush in a 
manner similar to finger-painting. Shortcut key: Shift-L  

• Bloat Tool (Liquify group): Warps the brushed area and slightly enlarges that region. Shortcut 
key: Option-L  

• Pinch Tool (Liquify group): Warps the brushed area and slightly shrinks that region. Shortcut 
key: Shift-Option-L  

• View Tool: Adjusts the magnification of the image in the Preview area, and lets you move 
around the Preview window. Shortcut key: Z

NOTE: The Text tool found in earlier versions of Photo RAW has been 
removed from the 2026 version. Text operations are now created via the Layers 
panel, as a new Text layer type. See page 216 for complete information on 
how to work with text in Photo RAW. 

ACCESSING AND USING TOOLS

To access a tool, click on the tool or use the 
shortcut key for that tool. When selected, the 
cursor will change, and you will see the tool icon 
and a set of options for the tool in the Tool Options 
bar above the Preview window. (The tool will be 
highlighted in your system’s accent color.)

If the selected tool is part of a tool group, the first 
tool in the pair is the primary tool for that group: 
Masking Brush for the Mask group, Healing Brush for the Retouch group, and the Push tool for the Liquify 
group. Other tools in that group will be visible in the drop-down menu next to the primary tool. 

ADJUSTING TOOL SIZING PARAMETERS

When using tools that have Size and Feather options, you have multiple ways to adjust those parameters:

• In the Options Bar for each of those tools, you can use the slider in the Size and Feather 
fields to increase or decrease the amount.

• You can use the left and right bracket keys on your keyboard — ‘ [ ‘ and ‘ ] ’ — to adjust the 
size; additionally, hold down the Shift key to adjust the feather. 

• You can also use your mouse’s scroll wheel (see page 16). Press Command-Option (Mac) 
or Control-Alt (Windows) and scroll to change the brush size. To change the feather, press 
Option-Shift (Mac) or Alt-Shift (Windows).

• You can also use your pressure-sensitive tablet, if you have one. Settings to turn that option 
on will be found in the Tool Options bar’s Gear menu for the tool.

The options bar for the tool groups—like the Masking Tool group shown 
here—will display the primary tool (Masking Brush in this instance) for the 
group. To select a different tool in the group, click the drop-down menu and 
select that tool. 

Each tool in Photo RAW—with the exception of the View tool—has an Options Bar, where you can adjust the settings for that tool. Shown here are the 
options for the Retouch Brush.
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Standalone Tools
The standalone tools, Crop, Transform, Super Select AI, and View, each perform a single task inside ON1 
Photo RAW 2026.

CROP TOOL

This tool lets you crop your image, and is fully non-destructive in the Edit module. The tool can 
suggest a crop based on a chosen aspect ratio, and also has a generative expansion option that 
lets you expand the photo canvas, filling the edges of a photo’s frame with realistic detail.

To crop an image without content-aware fill, select the Crop tool from the Tool Well, which will display the 
crop overlay. Select any preset crop ratio you would like to use from the Options bar — the default is 
Freeform, which lets you crop in whatever size or ratio you would like. Choosing a preset size (like 4x6) will 
display the crop overlay at that chosen aspect ratio.  

Adjust the corner handles of the crop overlay to get the area you wish. (The area outside the crop box 
appears darkened for guidance.) You can resize and move the image inside the crop box. When you are 
satisfied with your settings, press the Apply button in the Options bar or press Enter.

To move the image inside the crop box, simply click and drag inside the box. You can also nudge the image 
using the arrow keys on your keyboard. To resize the crop box, click and drag on any of the handles. 
Clicking on a corner handle allows you to adjust two sides at the same time; clicking on a side handle allows 
you to adjust that side. If you hold the Shift key down while adjusting the size, the box’s proportions are 
maintained. To rotate the crop box, move outside a corner until the tool changes to rotate.

The Crop interface, with a Rule of Thirds overlay and the Aspect pop-up open.
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To straighten an image, you can use the Leveling Tool, which is found in the Tool Options bar when the 
Crop Tool is active. Click on it, and drag the tool across an element in your image that should be level.

AI Auto Crop and Level

To the right of the Aspect pop-up menu is the AI Auto 
Crop and Level button. To use it, select an aspect ratio and 
click the button. Photo RAW will analyze the photo and 
automatically crop and level it for you at the chosen aspect 
ratio, and the button will turn blue. If you don’t like the crop, 
you can override it, or choose an alternative aspect ratio.

AI Auto Crop and Level operations can be saved in a preset (see page 133), or via the Copy Settings 
command (see page 140), which lets you apply the auto crop aspect ratio to a group of photos.

NOTE: If the Freeform aspect ratio is selected when you click the AI Auto Crop 
and Level button, Photo RAW will use the photo’s original aspect ratio.

Expanding your crop with Local Gen AI

Using Local Gen AI (or Stabilty AI), you can use generative AI to expand the boundaries of a photo, building 
new content based on the characteristics of the photo. Select the Canvas Extension option in the Crop’s 

To use AI Crop and Level, choose an aspect ratio, and click the 
AI button. Photo RAW will suggest a crop and the button will 
turn blue.

When you select the Canvas Extension option in the Tool Options bar, you can extend the canvas beyond the boundaries of 
the existing photo, using ON1’s Local Gen AI (or Stability AI). Drag the crop border out from the photo, click Apply, and 
Photo RAW will fill the area based on the characteristics of the edges in the photo.
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Tool Options bar, and extend the crop frame outward from the boundaries of the photo in the direction you 
wish to expand. When you click Apply, Photo RAW will generate the extended area and create a new layer 
with the results. If you would like to try a different expansion, you can either use the Undo command, or, if 
you would like to keep the old expansion, hide the expanded layer, select the base (original) layer, and redo 
the cropping operation.

See “Generative AI processing options” on page 85 for information on the different generative models, 
system requirements, and why you would want to use one or the other in certain situations.

Crop overlays

When you select the Crop tool, Photo RAW has the option to display 
guidelines as an overlay on top of your photo. These overlays can be 
used as compositional aids for cropping. Photo RAW includes a number 
of overlays that you can display during a crop session, and they can be 
accessed from the overlay pop-up menu in the Tool Options bar when 
the Crop tool is active. There are seven options — Rule of Thirds, Grid, 
Diagonal, Triangles, Golden Ratio, Golden Spiral, and None — and you can 
easily go back and forth between them as desired while cropping. 

In addition to overlay type, there are two other sets of options in the 
pop-up menu: 

• You can choose to have the overlay displayed all the time 
during a crop session, or to have Photo RAW only display the 
overlay when your cursor is in the preview area of the workspace.

• When working with the Triangles or the Golden Spiral overlays, the Flip Overlay options will 
be visible, letting you flip the orientation of the overlays horizontally (Golden Spiral only) or 
vertically (Golden Spiral and Triangles).

Crop Tool Options Bar:

• Overlay pop-up: Selects a crop overlay, sets overlay visibility, and flips the overlay.

• Aspect pop-up: Lets you choose aspect ratios, from Freeform constrained or custom preset 
ratios.

• AI Crop and Level button: Automatically crops and levels your photo, based on the current 
aspect ratio.

• Width: Sets the width of the crop box.

• Swap Dimensions: Swaps the width and height. Handy for rotating the crop box.

• Height: Sets the height of the crop box.

• Leveling Tool: Click and drag this tool across an element in your image that should be level.

• Angle: See and adjust the angle of rotation.

• Rotation tools: Rotates the photo 90° clockwise or counterclockwise.

• Canvas Extension: Selects a model (Local Gen AI or Stability AI) to expand the canvas size, 
filling the edges of the photo with new detail, using generative AI.
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• Reset: Resets the crop area to the size of your original photo.

• Cancel: Cancels the crop application.

• Apply: Applies the crop.

Creating custom crop sizes

In addition to the preset crop 
ratios provided, you can create 
your own custom crop sizes. 
The bottom of the crop preset 
pop-up menu has a Custom 
submenu, which lists all of 
your custom ratios. To add a 
size, choose Manage Custom 
Sizes from the submenu. To 
add a new ratio, click the Add 
button, then enter a name, and 
the width and height ratio you 
wish to create (the units will always be “ratio” when you create a custom preset for the Crop tool). You can 
add as many as you’d like and click OK. The new crop ratios will appear in the Custom submenu.

NOTE: The Crop tool in the Edit module is non-destructive, while the one in 
Resize works destructively. Both modules can create custom crop presets, but 
the tool in Edit works solely as a crop ratio and has the label “ratio” in the Units 
column. If you change one of those preset sizes from “ratio” to a specific unit of 
measurement in Resize (such as “inches”) it will no longer be visible in the Edit 
module’s Crop tool Custom pop-up.

TRANSFORM (MOVE) TOOL

The Transform tool is a layer-specific tool, used to manipulate the contents of a layer. It works 
even if the only layer you have is the base photo layer. A layer may be repositioned, sized or 
rotated using the Transform Tool. When the tool is selected, handles will appear on the edges 
of the selected layer. You use these handles to manipulate the image. When you are done, 

click the Apply button in the Tool Options bar.

The Transform tool is layer-dependent, and each document layer can have its own transform operations. 
It is useful when compositing photos, or applying backgrounds and textures in a multi-layered file. The 
Transform tool is disabled when using Photo RAW as a plug-in.

Repositioning a layer

To reposition a layer, simply click and drag inside the transform box. You can also use the keyboard arrow 
keys to nudge a layer one pixel in any direction.

The bottom of the preset pop-up (above left) has a list of custom crop ratios that you can use in addition to 
the preset ratios. You can create your own presets via the Manage Custom Sizes submenu option, which 
opens the Custom Document Size Presets window (above right).
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Resizing a layer

To resize a layer, click and drag on any of the transform handles. Clicking on a corner handle allows you to 
adjust two sides simultaneously. Clicking on a side handle allows you to adjust that side. If you hold the 
shift key down while adjusting the size, the proportions of the layer are maintained. If you hold down the 
Option (MacOS) or Alt (Windows) key while resizing, your image will resize from the center instead of from 
the edge. You can hold down Shift-Option (or Shift-Alt) to resize proportionally from the center.

You can type in the size you desire in the Tool Options bar (see below) in the width and height fields. You 
can also size a layer to fill the canvas automatically by pressing the Fill button in the Options Bar.

Rotating a layer

To rotate a layer, move the Transform Tool just outside a corner transform handle. Notice that the tool 
cursor changes to a rotate cursor. Now click and drag to rotate the layer. You can also use the opt (alt) left 
and right arrow keys to rotate a layer when the transform tool is selected. To rotate the layer quickly in 90 
degree increments, you can use the rotate left and rotate right buttons in the Tool Options bar.

Flipping a layer

You can flip a layer either horizontally or vertically by pressing the flip buttons in the Tool Options bar.

When you have completed your transforms you need to commit the changes. You can do this by pressing 
the Apply button that appears in the Tool Options bar or by pressing the Enter key. You can cancel a 
transform by pressing the Cancel button in the Tool Options bar or by pressing the Escape key.

Restoring a layer after a move

The Reset All command inside the Edit module will not reset transforms made with the Move tool. To reset 
your layer to its original, non-transformed state, click the Move tool and adjust any rotation you might have 
made, as well as any flip operations. Then choose the Fit to Canvas button. 

Transform Tool Options Bar

• Width: Changes the width of the layer, in pixels.

• Height: Changes the height of the layer, in pixels.

• Scale: Proportionally scales the layer, in percentage.

• Rotation: Rotates the layer, by degrees.

• Rotate Left/Right buttons: Rotates the layer 90° clockwise or counterclockwise.

• Flip Horizontal/Vertical buttons: Flips the horizontal or vertical axis.

• Fill Canvas button: Scales the layer contents to fit the document size. 
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SUPER SELECT AI TOOL

The Super Select AI tool is a specialized selection tool that lets you make multiple selections 
and automatically apply local adjustments or Effects filters to the selected area.

To use this tool, select it from the Tool Well. Super Select AI will quickly analyze the regions in 
the photo and, as you move your cursor around the photo, Photo RAW will display the various regions in 
your photo as blue overlays. Clicking on a region will create a selection and leave the selected area blue. If 
there are additional regions you wish to select, hover over the new area and click. To remove a selection, 
click on it a second time.

When you have completed your selection, choose an option from the Apply pop-up menu in the Tool 
Options bar, or right-click on the photo to get the same menu. From the menu, you can choose to add either 
a Local adjustment or an Effects filter that you wish to be applied to the selection. If you have Show Styles 
Flyout turned on, you will also see the different styles for the Local adjustments and Effects filters. 

As you mouse over the menu, Photo RAW will display the effects of each option in real time on your photo. 
When you select an option, Photo RAW will create that local adjustment or filter — in either the Local or 
Effects tabs — and apply the adjustment to the chosen selection and remove the current selection. 

If you would like to add another adjustment to the photo, you can make a new selection and choose the 
effect you with to apply. When you are finished adding adjustments, click the Done button; the Super 
Select AI tool will be deselected, and Photo RAW will choose the Zoom tool.

Using the Super Select AI tool, we selected the back wall in the photo (shown in the inset upper right), then applied an 81A photo filter to the selection to 
warm the photo up. We also selected the asparagus and applied a Vibrance + local adjustment to it, to make it pop a bit more.
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The Mode menu in the Super Select AI Tool Options bar has two options: Paint or Erase. Paint is used to 
create the selection, use the Erase option to remove areas from the selection.

While the masks created by the Super Select AI are generated automatically, they operate like any other 
mask created in Photo RAW. This means you can use any of the other masking and mask-refinement tools 
to adjust and refine the finished masks. (See “Masking Basics” on page 124 for more.)

Super Select AI Tool Options bar

• Apply: For choosing the local adjustment style (Local tab) or the Effects filter and style to be 
applied. 

• Mode: Sets the masking mode for selections when using the Super Select AI tool. Paint In 
means that the local adjustment or filter will be applied to the selection; Paint Out means that 
the adjustment or filter will be applied to all areas in a photo except for the selection.

• Feather: After you have added an adjustment or filter (by clicking on the Add button), this 
option will apply a feather to the edges of the selection.

• Show Styles Flyout: When checked, the pop-up menu will show the Styles associated with 
that local adjustment or filter.

• Done: Quits the tool and selects the Zoom tool.

VIEW (ZOOM) TOOL

This is the default tool selected when opening an image in the Edit module. It adjusts the 
magnification of the image in the Preview window. With the Zoom tool selected, click in 
the Preview window to zoom in and center the image at the location clicked. Hold down the 
Option/Alt key to display the Hand tool, which lets you pan around the magnified image. You 

can also double-click the Zoom tool in the Tool well to set the image to 1:1 (or 100%) magnification view, 
which shows every pixel. This is best when examining small details.

The View tool has no tool options bar; you can adjust the zoom level via keyboard shortcuts (Command/
Control + or Command/Control - ) or the Preview Size selector at the bottom of the main window.
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Masking Tools
The Mask tool group has a total of eight tools, designed to help create and refine selections. Depending 
upon the complexity of the masks you are trying to create and manipulate, you will often use multiple tools 
to get achieve the perfect mask. 

We go into much more detail later in the guide, but, at its simplest level, a mask shows or hides the effect 
of the filter or adjustment. Masks have no color: they are grayscale, and the tones range from pure white 
to pure black. A mask that is completely white displays the entirety of the effect being used, a mask that 
is completely black hides that effect. Shades of gray are in effect the opacity of the mask. Darker shades 
reduce the effect, lighter shades let more of it through. For more complete information on masking and 
mask refinement, see “Masking Basics” on page 124.

MASKING BRUSH
The Masking Brush is one of two tools used for masking filters in Effects and creating masks in 
Layers. Selected, the Masking Brush cursor looks like two concentric circles, one representing 
the inner hard edge of the brush, the other, the soft outer, feathered edge of the brush. At the 
center of the brush is either a plus or minus. The plus means that you are painting “in” a filter’s 
effect, while minus means the brush mode is set to paint out.

Masking Brush Tool Options Bar

The first icon is for the Masking Brush Options. Clicking on that displays a pop-up menu that contains all of 
the options available for the tool (see page 105 for more). The five remaining items in the options bar are 
the most common tasks used with the Masking Brush, and include:

• Brush Size: You can control the size of the brush using the Size pop-up. Use a small brush at 
high magnification for precise work, and a large brush at fit to screen for general work.

• Feather: You control the amount of feathering—or hardness—of the brush by using the 
Feather pop-up in the Tool Options bar. The feather has a range from 1 to 100 percent. Use a 
small feather at high magnification for precise, hard-edged work and a large, soft-edged brush 
in Fit to screen mode for general work. You can visually see your feather by watching the 
outer concentric circle of the brush tool. 

• Opacity: This controls the transparency of the brush, and ranges from 1 to 100 percent. You 
use a high opacity to paint quickly and hide large areas. You use a lower opacity for blending 
areas together or for subtle work. You can also control the opacity with a pressure-sensitive 
tablet, or by pressing Option (Mac) or Alt (Windows) and one of the number keys on your 
keyboard. Each number represents an opacity percentage from 10% (1) to 100% (0).

TIP: Think of the opacity as the shade of gray you are painting onto your mask. 
White in a mask represents 100% of an effect and black (0%) represents no 
effect, and opacity settings in between will show a percentage of the effect.
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• Paint Mode: There are two modes, Paint and Erase, and they control whether you are 
painting in (restoring the effect) or painting out (hiding the effect), respectively. You can tell 
your current mode by looking at the plus or minus icon in the center of the brush. If the icon 
is minus, you are painting out (Erase), and if the icon is a plus, you are painting in (Paint). You 
can change the mode in the Tool Options bar, by pressing the X key, or 
by holding down the Option (Mac) or Alt (Windows) key temporarily. 
	 To invert the mask (turn it from black to white), in order to paint a 
filter’s effect into your image choose Invert Mask from the Mask 
Properties window.

• Perfect Brush: The Perfect Brush incorporates an automatic edge-
detection technology to help create precise selections and masks. 
When you turn the option on—by clicking on the Perfect Brush icon 
in the Options bar—the Masking Brush collects the colors under the 
center of the brush and applies the effect only to those colors. This 
protects the adjustment from being applied across edges, such as tree 
branches. 

MASKING BRUSH OPTIONS MENU

The Masking Brush Options pop-up menu has six sections, Styles, Properties, 
Shape, Perfect Brush, Manual Spacing and Pressure:

Styles

The Style pop-up lets you save the current brush state for use at another time. 
Selecting a saved item will open that saved brush’s characteristics.

Properties

The properties section mirrors the Size, Feather, and Opacity options in the 
main tool options bar, as well as the current Paint Mode setting. Two additional 
options are also available, Flow and Angle:

• Flow: The rate at which the brush is applied, up to the Opacity setting. 
With a low flow number, as you brush back and forth, the brush color 
will build up to the Opacity setting. At 100, the brush stroke is applied 
at the Opacity setting. 

• Angle: This sets the angle of the current brush shape. For the default, 
round brush shape, this setting has no effect; it is more useful when working with custom 
brush shapes (see below). You can also rotate the brush shape by pressing Shift-Option (Mac) 
or Shift-Control (Windows) and the left or right bracket keys (‘[‘ or ‘]’).

Shape

The Shape menu displays a list of all custom brush shapes in your library. The top item in the list is the 
default, round brush, which is the standard brush for working with masks in the Edit module. Custom brush 
shapes can be useful when you want to create specialized creations or enhanced photos: you can paint in 
stamps, watermarks, and other shapes in the Edit module’s Local Adjustments tab. 
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For example, you could use a custom cloud brush to add interest to a lackluster sky, or you could create 
your own watermark and apply it precisely.

For more on using custom brushes in Photo RAW, see “Using Custom Brushes to Add Overlays To Photos” 
on page 164.

Perfect Brush

You can tune Photo RAW’s Perfect Brush settings via the Threshold and Transition options: 

• Color Threshold: This option lets you control the balance between keep and drop colors, 
based on the area you are working on. For example, you may want the Perfect Brush to be 
very precise and only paint away very similar colors, while at other times you want it to paint 
away a broad range of colors in the same neighborhood.

• Transition: This slider controls the feather of the Perfect Brush based on color. To create a 
soft edge, increase the transition. To create a harder edge, decrease the transition amount.

Manual Spacing

When checked, this sets the spacing of the brush tip as you apply a stroke. This is primarily used when 
painting with custom brushes. See “Using Custom Brushes to Add Overlays” on page 164 for information 
on how to use this setting. 

Pressure options

Photo RAW supports pressure-sensitive tablets with the Masking Brush. You can enable pressure sensitive 
controls for the brush size, brush opacity, or both simultaneously. To turn this support on, click on the gear 
icon in the Tool Options bar. You can activate pressure sensitivity for both size and opacity by clicking the 
appropriate buttons in the drop-down menu.

GRADIENT MASK

The Gradient Mask is used for blending masks and layers by creating radial, gradient and 
reflected gradient mask shapes. It works in a similar manner to the Adjustable Gradient tool 
in the Local Adjustments pane. The mask goes from dark to light in tone, applying more of the 
adjustment where the gradient is lighter, and less of the adjustment where the gradient’s tone 

is dark. The most common use of gradient masks is to darken the sky in an image, while preserving the 
brightness of the foreground, similar to using a gradient filter on your camera lens, or to adjust the effect of 
a filter mask in Effects.

To apply a standard gradient to a filter in Effects, a local adjustment, or a layer, click on the Gradient Mask 
in the Tool well, then click in the image roughly where you wish the gradient to go. You’ll see the outline 
of the gradient, which is called a bug. You can use the handles on the bug to move your gradient around, 
increase or decrease the length of the gradient, or rotate it. You can also create (and delete) multiple 
masking bugs.

You can change the gradient shape via the Tool Options bar: in addition to the standard dark-to-light 
horizontal gradient, you can also create a circular gradient and a reflected gradient, which is like the 
horizontal gradient, but goes from black (no effect) at the outer edges to white (full effect) in the center.
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Gradient Mask Tool Options

• Preset: The preset pop-up includes six settings for the bug’s mask (vignette, strong vignette, 
top down, bottom up, and linear left and right), and changes the current bug (if there is one) 
to match the preset.

• Shape: The shape pop-up controls the shape of the 
bug. In addition to the standard Gradient and the 
Reflected Gradient, there are two radial shapes: 
Center, which puts the light tones at the center 
and the dark tones on the outside of the mask, 
and Edges, which sets the gradient in the opposite 
direction.

• Opacity: Sets the maximum density of the mask.

• Color Range: When enabled, this detects the color under the gradient and applies the mask 
to only that color range. The higher the number, the wider the range of color that is selected.

• Add: Adds a new gradient using the current settings.

• Delete: Deletes the current gradient.

• Reset: Resets the mask on the layer completely. This removes all gradients and clears any 
brushing that has been done.

Manipulating a gradient mask

Once you’ve added a gradient to an image, you can 
modify it easily by accessing the following parts of the 
gradient overlay:

• To move a gradient, click on the large circle 
at the center of the gradient and drag.

• To resize a radial gradient, click and drag on 
the solid line.

• To adjust the feather (or hardness) of the 
mask, click and drag along the dashed line.

• To rotate the mask, click on the smaller 
circle near the center of the gradient and 
drag it up or down.

Working with multiple masking bugs

You can have up to six masking bugs per layer. Each bug is re-editable. To add another masking bug, press 
the Add button or click outside of the current bug while the Gradient Mask tool is selected.

Only one masking bug may be adjusted at a time. You will see the overlay controls for the active bug while 
your mouse is over the preview area. Inactive bugs are marked with a small circle; to select an inactive bug 
clicking on this small circle marker.

The Preset (left) and the Shape (right) options for the 
Gradient Mask tool.
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Masking bugs are subtractive. Each bug hides more and more of the current layer. When masking bugs 
overlay each other they may hide more of the layer too. You can always use the Masking Brush to override 
and paint back in areas hidden by the masking bugs.

QUICK MASK AI BRUSH

The Quick Mask AI brush is functionally similar to the Super Select AI tool, but it is intended to 
create selections for the current filter, local adjustment, or layer — all it does it create a mask 
for that item. It does not create a new filter pane or local adjustment layer.

To use the Quick Mask brush, first create a filter in Effects, a local adjustment layer in the Local Tab, or the 
master layer mask, select the tool, and move your cursor over the photo. As you move around the photo, 
Photo RAW will display the various regions in your photo as blue overlays; clicking on a region will create a 
selection and change the overlay for that area to blue. If there are additional regions you wish to select, 
hover over the new area and click. To remove a selection, click on it a second time.

The Quick Mask AI Options bar has two options: Paint or Erase. Paint will apply the final adjustment to the 
selection you created with the tool, while Erase will apply the adjustment to the areas to the inverse of the 
selection (i.e. the areas that have not been selected). Clicking the checkmark button will create the mask 
and select the Refine Brush so you can fine-tune the mask.

While the masks created by the Quick Mask tool are generated automatically, they function like any other 
mask created in Photo RAW. This means you can use the other masking tools to adjust and refine the 
finished masks. This also includes the Mask Control options found in the Masking tab of the Properties 
window (see “Masking Basics” on page 124 and “Mask Options and the Refine Mask menu” on page 
128).

The Quick Mask AI brush is designed to be used when you have created a filter pane in Effects, a local adjustment in the Local tab, or 
a separate layer in Photo RAW. Here, a Sunshine filter has been applied to this image. To keep the sky from being affected by the 
filter, we have used the Quick Mask AI brush to select the sky and chosen Erase from the options bar to mask out the sky. Clicking 
Done will create a mask with the sky removed, 
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Quick Mask AI Brush Options bar

• Mode Selector: Paint means that the mask will be applied to the selection; Erase means that 
the adjustment or filter will be applied to all areas in a photo except for the selection.

• Cancel: Cancels the operation, deselecting the tool and selecting the Zoom tool.

• Done: Creates the mask and selects the Refine brush.

QUICK MASK BRUSH

Powered by machine learning, the Quick Mask brush creates high-quality masks with just a few 
strokes. To use it, you paint areas you want to keep in green and areas you want to drop in red. 
Photo RAW analyses the color, tone and texture of the marked regions to learn what you want 
to make out and then automatically finds the edges and creates the mask for you. Use it with 

layers to replace skies or with filters to selectively apply them. 

You can use this tool on a filter in Effects, a local adjustment, or on a layer. If you wish to use it on a filter, 
to mask some of the filter’s effects out of your photo, add the filter in Effects, and select the Quick Mask 
Brush. To use it on a layer, select the layer. In both cases, you’ll follow these steps:

1.	 First, you need to give the tool guidance as to what you want to keep and drop. This is done 
by loosely painting over the regions in your photo. There is no need to precisely paint the 
entire photo: just a few representative strokes of red and green are all that are needed. Paint 
with Drop mode—which is the default brushing mode—over the portions of your image that 
you want to remove. These brushstrokes will appear in red. Then change the tool’s mode to 
Keep (via the Tool Options bar, or by holding the Option/Alt key) and paint over the areas 
you want to keep. These strokes will show up as green.
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2.	 Now press the Apply button in either the Tool Options bar or the Original Quick Mask HUD. 

This will generate a temporary mask to preview the results. Areas that are filled with red will 
be masked out, areas in green will remain. Keep in mind the edges will appear rough at this 
point and will be smoothed out when you generate the final mask.

3.	 If the preview results look good, press the Done button in the Tool Options bar or the 
Original Quick Mask HUD. If there are areas that are incorrect, you can continue to improve 
the results by adding more Keep and Drop strokes. Press Apply each time to preview the 
improved results. When you press Done, the edges are refined with high precision and ON1 
Photo RAW switches to the Refine Mask tool.

Once you click on the Done button, Photo RAW will create the finished mask (shown here as a red overlay), applied to the 
current filter. You can manipulate the mask further with any of the refine mask tools.
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Quick Mask Brush Options Bar 

• Mode Selector: Paint means that the mask will be applied to the selection; Erase means that 
the adjustment or filter will be applied to all areas in a photo except for the selection.

• Brush Size: Controls the size of the brush. Use a small brush at high magnification for precise 
work, and a large brush at fit to screen for general work.

Further settings for the Quick Mask brush can be found by clicking on the gear icon in the Tool Options bar. 
There, you can set the following options (shown right): 

• Pressure Adjusts Size: This option lets you control the size of the brush using a pressure 
sensitive tablet. The harder you press, the larger the brush becomes up to the current setting 
of the size slider.  

• Refine Edge: Applies the Refine Mask brush 
automatically to the edge of the resulting mask, 
creating a more natural transition. This the default and 
is recommended for most photos.

• Show HUD: This displays the Quick Mask Brush’s 
HUD dialog, which provides guidance on how to use 
the tool.

• Overlay: Sets the transparency of the red and green 
mask overlays on top of your image. A setting of 100 
displays only the mask; the default is 50.

LINE MASK TOOL

The Line Mask tool lets you create masks by 
drawing straight lines in your image, with the 
added flexibility of letting you adjust each 
individual line segment into curves to better 

fit the object you want to mask. Masks created with this 
tool are re-editable, can be copied and pasted like any 
other mask inside Photo RAW, and you can have multiple 
Line Mask selections for each mask. 

To start, you click and drag along the outline of the area 
you wish to mask. Clicking your mouse button (or with a 
pen and tablet) adds a point to the line; you can continue 
to click along the edges of your desired selection, and 
the tool will add points along the way. These points will 
be represented by a small square. When you’re finished, 
hover your cursor over the first point and click on it to 
close the path created by the tool. This will close the selection and change the cursor to a paint bucket icon; 
click inside the area and Photo RAW will create and the display the mask. 

The Quick Mask Brush HUD gives displays instructions for 
using the tool. You can turn the HUD off via the Gear 
menu in the tool options bar.

When you complete the mask area by clicking on the original point, 
the cursor will change to a paint bucket icon. Clicking in the area will 
generate the mask..
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Once you’ve closed the mask, you can adjust the feather and opacity of the mask, and you can further 
adjust the points on the line in the following ways:

• You can click on any point in the selection and move it by dragging it.

• If you hover (or click) on a point, you’ll see a circle appear between that point and the 
previous point on the line. This circle can be dragged in all directions to curve the line to 
better fit the object you are masking.

• Add a point by holding down the Shift key and clicking on the line.

• You can delete any point by right-clicking on it and choosing Delete Point from the pop-up. 

• You can delete the entire mask by choosing Delete Line Mask from the pop-up menu.

While you’re creating the mask, the curve option is always available for the current point; move the cursor 
back over the line before the point and the circle will appear. You can then drag the curve in or out, and 
when you’re done, move the cursor and click on the next place you wish to add a point.

When you’ve made your adjustments to the selection, you can click the Done button in the Tool Options 
bar to quit the tool, or you can create another mask. 

To re-edit the mask at a later time, select the filter, layer, 
or adjustment layer that has the mask attached to it and 
choose the Line Mask tool. When you move your cursor 
over the area that contains the mask, the mask’s outline 
will appear in light blue. Click anywhere on the outline, 
and the mask’s points — both square and circle — will 
appear, and you can adjust it as you see fit, even the 
Opacity and Feather settings.

Line Mask Tool Options Bar

• Mode Selector: Paint means that the mask will be applied to the selection; Erase means that 
the adjustment or filter will be applied to all areas in a photo except for the selection.

• Opacity: Controls the opacity, or transparency of the finished mask, from 1 to 100 percent. 
At 100 percent, all of the effect will be displayed in the mask area; as the opacity level drops, 
more of the layer underneath the mask will be visible.

• Feather: Controls the hardness of the mask edge. The feather has a range from 1 to 100; 
1 being a hard edge across the boundaries of the mask, 100 being a soft, wide edge that 
‘feathers’ the transition between the masked and unmasked boundaries. 

• Delete: Removes the currently selected line mask.

• Done: Saves the current line masks ad closes the tool, returning Photo RAW to the View Tool.

The curve option—visible when you hover over a point in the 
selection—lets you fine tune the line to make it better fit the object 
you’re masking. (Shown here exaggerated for effect.) 
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REFINE BRUSH

This tool, one of the most versatile in Photo RAW, can be used to clean up intricate areas and 
the borders along a mask. It is helpful for cleaning up a mask created with the Masking Brush, 
the Super Select AI tool, or other masking tools, or for creating a new mask entirely. 

When you paint with the Refine Brush, the brush strokes are displayed as a red overlay, and when you let 
up off the mouse button, Photo RAW will work to make the mask edge better defined. 

Refine Brush Tool Options

• Mode: Controls the refinement mode, either Paint Out, which refines to remove from the 
mask, Paint In, which refines to add to the mask, or Auto, which determines the best way to 
refine the mask edge. Paint Out is recommended in most cases.

• Size: This adjusts the size of the brush. Select a brush size that is just larger than the 
intersection of the subject and background. Avoid using oversized brushes it will take longer 
to process and may yield lower quality results. You can use your mouse’s scroll wheel to 
adjust the size of the brush as well (see page 16). The Refine Brush’s maximum size is 500 
pixels.

• Method: Lets you choose the refinement algorithm and settings based on the subject of the 
masked area. There are five method types, plus a user-defined setting that is created when 
you adjust any of the individual parameters found in the Gear menu:

• Original: Uses the refinement algorithm found in earlier versions of Photo RAW 
(referred to as Mode 1 in the gear menu).

• Hair/Branches: Optimized for fine detail, like hair, branches 
and other subjects.

• Hard Edges: Best method for refining masks with distinct 
edges between masked and unmasked areas.

• Diffuse Edges: Works best on areas where edge detail is not 
as well-defined.

• Noisy Images: Works well on photos that have higher 
degrees of noise in them.

The Gear menu includes a setting for controlling the size of the Refine Brush with pressure. It also can be 
used to adjust any of the refine methods in the Method menu. The parameters include:

• Mode (1 or 2): As noted above, Mode 1 is the Refine Brush algorithm used in previous Photo 
RAW versions; it remains useful in many masking situations. Mode 2 uses the new (2023) 
version of the Refine algorithm.

• Sensitivity (0-100): Refers to the edge sensitivity; low for diffuse edges, high for hard edges. 
(Works only with Mode 2)

The Method pop-up.
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• Locality (0-30): This parameter varies the search for similar scene 
materials; higher values expand the search zone along the brush 
edges. (Mode 2 only)

• Smoothness (0-100): Represents post-processing smoothing of 
the refine results. Higher numbers mean smoother edges. (Mode 2 
only)

• Noise (0-100): This is a post-processing-based noise filter; use 
higher values with noisier images. (Works with both Mode 1 and 2)

When you change any of the parameters in the Gear menu, those results 
will be applied to the User Defined settings, and will be saved until you 
change them again. In general, however, most of your masking refinement 
work with the Refine Brush should be found in one of the five primary 
Method options.

Working with the Refine Brush

One of the biggest issues with masks is the transitions between edges, or in areas where one of the  
primary masking tools will miss some fine detail. You’ll notice these transitions when you apply an effect or 
adjustment to a masked area, and there will be halos on the mask edges, or areas where the effect should 
be applied, but isn’t. The Refine Brush, and, on occasion, the Chisel and Blur tools, can be used to help you 
fine-tune your masks and better transitions, ultimately creating more realistic masks. 

The Refine Brush is often the first place you’ll want to go when working with masks that could use some 
tuning. Some of the most common operations include:

• You can paint along the edges of a mask that might have areas where the mask isn’t complete, 
or where the transitions between masked and unmasked areas could be smoother. 

• You can paint over large areas of a masked area where there might be fine edges that could 
use further refinement, like trees or hair.

• You can also “encircle” an area in a photo where you wish to add to or subtract from a mask, 
or even create a new mask altogether. 

For simple areas where you wish to refine an edge that has some halos or is otherwise a bit less than ideal, 
set the brush size a bit larger than the area you wish to tune set the appropriate method, and brush over 
the edge. This is shown in the enlarged area below. 

In the photo above, a local adjustment on the sky, masked with Mask AI, left some ugly halos along a treeline. Using the Refine Brush, set to the 
Diffuse Edges method, smoothed the transition properly, making for a better mask. (Effect exaggerated for demonstration purposes.) 
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With tree branches, hair and other areas of fine detail, you can paint over the entire area that you wish the 
mask to refine, as shown in the following graphic.

The Refine Brush’s “encircling method” lets you add to 
or subtract from an existing mask, or you can use it to 
create your own mask. To do this, use the brush to draw 
an outline around the object you wish to select and mask. 
What happens next depends upon what your intent is, and 
whether there is already a mask in the local adjustment or 
Effects filter you are currently working with:

• If there is a mask already created, and you wish to 
remove the stroked area, choose Paint Out before 
applying the brush. If you wish to add to the 
existing mask, choose Paint In.

• If there is no mask already present in the 
adjustment or filter, using the Refine Brush and 
drawing around an object or area will create a 
mask of the encircled space.

For more information about masking inside Photo RAW, see 
“Masking Basics” on page 124. 

The Refine Brush is a great choice for adjusting masks with fine details that are often obscured when building masks with some of Photo RAW’s 
primary masking tools. In the screen shots above, you can see the mask of a tree generated automatically with the Mask AI pop-up in a local 
adjustment layer (left). The tree’s interior branches are completely masked. Selecting the Refine Brush, with the Method set to Hair/Branches, we’ve 
painted broad strokes in and around the area where the branches are (center). Photo RAW then refines the mask so that the branches are properly 
masked against the sky, making for a much more realistic mask.

The encircling method.
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CHISEL BRUSH

The Chisel brush works to remove fringes or halos along the hard edges of a mask; just 
click and drag along the edges of a mask you wish to refine. Fringes are common when the 
background to be removed is brighter than the foreground. The chisel works like a chisel or 
plane in a wood shop: It removes just a sliver along the edges, and, because it only works on 

the edges, you don’t have to be too careful when using it.

Chisel Brush Options

• Mode: Select remove or add from the mask edge

• Size: Adjusts the size of the chisel tool. Feel free to use a large chisel to make brushing fast. 
The size of the chisel does not affect how much is chiseled off.

• Amount: Controls the amount of pixels that will be removed or added during each stroke.

TIP: Double-clicking on the Chisel icon applies the chisel to the entire mask.

BLUR BRUSH

The Blur brush softens edges of the mask where you paint; all you need to do is run the tool 
over the edges you wish to blur. Softening the edges on blurred or semi-transparent subjects 
like hair can make them blend with a new background in a more realistic manner. 

Blur Brush Options

• Mode: Remove/Add/Normal lets you adjust what part of the mask edge to blur. Remove blurs 
and lightens the mask, Add blurs and darkens the mask, Normal blurs both light and darks.

• Size: Adjusts the size of the blur tool. Feel free to use a large size to make brushing fast. The 
size of the brush does not affect the blur amount.

• Amount: Controls the amount of blur. Use a low amount to maintain detail.

TIP: Double-clicking on the Blur icon applies the blur to the entire mask.
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Retouching Tools
The Retouch tool group has a four tools, the Healing Brush, Prefect Eraser, Retouch Brush, and Clone 
Stamp, each of which have different options for removing distractions from your photos. The Healing Brush 
is a non-destructive tool, which means that you can adjust each individual application of the tool at any 
time. The remaining tools are destructive, in that you cannot remove individual operations, although you 
are able to reset all retouching operations from the Settings menu at any time (see “Resetting edits” on 
page 141).

HEALING BRUSH

The Healing Brush is a tool for removing distractions like dust spots, power lines and unwanted 
people from your photos, using sophisticated content-aware fill technology. Like the other 
retouching tools, you can apply the brush to multiple portions of an image. Unlike the other 
tools, however, the Healing Brush is fully non-destructive: each area you apply the brush to is 

individually editable (and removable).

To use the brush, paint over 
a distraction and a matching 
area of your photo will be 
blended on top to replace 
it, using content-aware 
technology. You’ll see two 
circular markers: red, which 
is the area that has been 
removed, and green, which 
is the area that was used to 
fill the source. Each marker 
is movable by clicking and 
dragging; sometimes, you’ll 
want to try a different area 
to match to your source. 
Non-active markers will be 
displayed as gray squares 
until you click on them. (Press 
the Delete key to remove the 
current area.)

The Healing Brush has four modes, Heal, Stamp, Copy and Move. Each mode has a different approach:

• Heal mode applies content-aware matching from a nearby area to mask the object or area 
being painted out.  

• Stamp mode acts like the Clone Stamp tool (see page 121), applying the actual pixels from 
the area used to mask the object out; unlike that tool, however, this option is non-destructive.

• Copy mode is similar to the Heal mode, except that it makes a copy of the brushed area or 
object instead of masking it out.

Areas that use the Healing Brush will be displayed as a gray marker. Clicking on a specific marker will display 
the source and area used to fill the source. You can then readjust its placement, or delete the area.
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• Move mode is similar to Copy mode, except that it masks the brushed area and moves the 
original area to a new location.

Healing Brush modes cannot be changed once they have been applied; if you wish to change the 
application in an area, you must select the old marker, choose Delete from the Tool Options bar, set the 
new mode, and re-brush the chosen area.

Healing Brush Options

• Brush Size: Adjusts the overall size of the brush.

• Brush Feather: Adjusts the hardness of the brush. 

• Brush Opacity: This adjusts how strong the retouching is. Use 100% to completely remove an 
imperfection. Use a lower opacity to soften it.

• Mode: sets the type of healing that will be applied when brushing — Heal (content-aware), 
Stamp (pixel-exact), Copy (content-aware) or Move (content-aware).

• Overlay: Sets the display of the markers designating retouched areas. Auto displays all the 
markers in the photo, with the current marker highlighted in red and green, and the others as 
gray. Selected will only display the current marker (in red and green); the other markers will 
only be visible as you move over the photo with your mouse.

• Visualize Dust: Changes the view to a high-contrast overlay, to help view sensor dust spots 
more easily.

• Pressure Adjusts Size (gear icon): If you have a pressure-sensitive tablet, you can adjust the 
size of the brush according to the pressure. Click the button to activate.

Transforming retouched areas

As noted, all applications of the Healing Brush are 
non-destructive, meaning that you can adjust the 
source and destination areas for each marker, and 
you can delete markers by clicking on the appropriate 
market and choosing Delete from the Tool Options 
bar (or by pressing the Delete key).

You can also transform individual destination markers 
in a photo by holding down the Option/Alt key (Mac/
Windows) and hovering over the area. When you do 
this, a box will appear over the currently selected 
destination marker. You can resize the selection 
by adjusting the handles on the box; to resize 
proportionally, hold down the Shift key. You can also 
rotate the selection by clicking outside the box and 
pressing the mouse key, or you can flip the selected 
area vertically or horizontally by clicking the icons 
underneath the box.

When you hold down the Option or Alt key and hover over the currently 
selected Healing Brush marker, a box appears, which lets you adjust the 
size, rotation and orientation of the marker. When used in conjunction 
with the Healing Brush’s Copy or Move modes, you can easily duplicate 
and transform individual subjects within your frame, as shown by the 
copy of the pronghorn above..
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PERFECT ERASER

The Perfect Eraser can be used to remove distracting elements and blemishes from your image. 
It uses a content-aware algorithm that replaces the pixels with a natural-looking result within 
the boundaries that are painted. It also has specialize options for automatically removing dust 

spots and power lines from a photo.

Use the tool to paint over an area you wish to remove, covering the entire area. A red overlay appears 
where you paint. If the first attempt does not give you a perfect result, paint over it again and it will 
improve with each pass. You can also fine tune the area after by using the Retouch Brush (see below).

Perfect Eraser Options

The Perfect Eraser’s Tool Options bar consists of five options; brush size, buttons for removing dust and 
power lines, a dust-spot overlay, and pressure-sensitive tablet support.

The default brush size for the Perfect Eraser is 125 pixels; you can make this bigger or smaller by clicking 
on the Brush Size in the Tool Options bar, or by pressing the right or left bracket keys on your keyboard. 
The maximum brush size is 500 pixels.

Clicking the Reduce Dust button will automatically scan the current photo for dust spots, removing obvious 
ones from the photo. By default, the Reduce Dust operation does not act aggressively, so as not to remove 
some items that might be questionably be dust or natural phenomenon. This means you might still find 
some dust spots in your photo.

Clicking the Reduce Power Lines button will scan the current photo looking for clear examples of power 
lines, and will remove them from the scene.

The Visualize Dust item displays a high-contrast overlay to help find and eliminate sensor dust spots. 

If you have a pressure-sensitive tablet, select the Pressure Adjusts Size item, which is in the gear icon. 
The gear icon also includes a Legacy option, which is solely used to preserve compatibility with previous 
versions of Photo RAW.

 GENERATIVE ERASER

The Generative Eraser uses ON1’s Local Gen AI technology to remove larger distractions from a 
photo than can be removed with the other retouching tools. 

Use the tool to paint over the areas you wish to remove, covering the entire area of the object. A 
red overlay appears where you paint. When you have painted over all the areas you wish to have removed, 
click the green Generate Content button in the Tool Options bar. Photo RAW will analyze the areas and 
replace them with seamless areas that fit into your photo.

When you use the Generative Eraser, Photo RAW creates a new layer with all of the changes you make. 
When you close the file and return to Browse, your file will be saved in the .onphoto format; your original 
image remains at the bottom of the layer stack.
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Generative Eraser Options

• Brush Size: Adjusts the overall brush size of the eraser.

• Mode Selection: The Generative Eraser defaults to Paint, which you use to paint over the 
subject that you wish to remove; use Erase before you generate content to refine a subject 
selection, or to remove that subject completely from the removal process.

• Distractions: Selects all of the people, wires or vehicles in a photo. 

• Quick Mask AI Brush (puzzle icon): Select regions in a photo for removal using the Quick 
Mask AI Brush. Click to invoke the tool, then click the puzzle icon to add the selections to the 
current grouping (see page 108 for the specifics of using this brush).

• AI Model (gear icon): Selects the Local Gen AI, Local NonGen AI, or Stability AI model.

• Generate Content: Removes the selections and replaces them with generated content. The 
button then changes to Retry if you wish to try again. (The Undo command will step you back 
to the selection group, if you wish to adjust your selection.)

There are three additional options, Clear, Cancel and Apply, which can be found 
on the far right of the options bar. Clear wipes out the current mask (objects 
selected for removal). Cancel quits the Generative Eraser session without 
applying the generated content (if you had generated it) and selects the Zoom 
tool. Apply applies the generated content and saves it to a new layer in the current photo.

You can use a combination of tools to select multiple objects for removal. For example (shown below), you 
could use the Distractions option to select all the people in a photo; click the Erase button and paint over 
any people you with to keep in the scene; and use the Quick Mask AI Brush to select additional objects for 
removal. When you’re done, click the Generate button to perform the removal. 
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RETOUCH BRUSH

Use the Retouch Brush to remove small imperfections like dust or blemishes. Just dab the brush 
on areas that contain spots or other imperfections, such as acne, sensor dust, power lines and 
more. The tool looks at the neighboring areas in your image and fills in the brushed area with an 
area of similar color and texture.

It is best to use the smallest brush size possible and to work by dabbing rather than making large brush 
strokes. If you dab with the Retouch Brush and don’t like the results, use the Undo command and try using 
a smaller brush or vary your brush stroke and try again. The Retouch Brush is also great for retouching skin.

Retouch Brush Options

• Brush Size: This adjusts the overall size of the brush.

• Brush Feather: This adjusts the hardness of the brush. It works best to use a feather larger 
than 50 to blend and look natural.

• Brush Opacity: This adjusts how strong the retouching is. Use 100% to completely remove an 
imperfection. Use a lower opacity to soften them.

• Visualize Dust: Changes the view to a high-contrast overlay, to help view sensor dust spots.

• Pressure Adjusts Size (gear icon): Click on the button to activate the sensitivity controls for 
your pressure-sensitive tablet.

CLONE STAMP

Use the Clone Stamp tool to replace an area of a photo with an area from a different part. Hold 
down Option (Mac) or Alt (Windows) and click the area you want to clone from. Then click and 
drag on the area you want to clone over and it will clone from the point you selected.

Clone Stamp Tool Options

• Brush Size: This adjusts the overall size of the brush.

• Brush Feather: This adjusts the hardness of the brush. It works best to use a feather larger 
than 50 to blend and look natural.

• Brush Opacity: This adjusts how strong the retouching is. Use 100% to completely remove an 
imperfection. Use a lower opacity to soften them.

• Visualize Dust: Changes the view to a high-contrast overlay, to help view sensor dust spots.

• Pressure Adjusts Size (gear icon): If you have a pressure sensitive tablet, you can adjust the 
size of the brush according to the pressure. Click the button to activate.
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Liquify Tools
The three tools of the Liquify 
group — Push, Bloat, Pinch — have 
different warping characteristics, 
but they share the same options, 
and all adjustments made with 
the tools are non-destructive, in 
a manner similar to the Healing 
Brush. The “active” marker (the one 
currently selected) will be displayed 
as a blue square. Non-active 
markers will be displayed as gray 
squares until you click on them to 
make them active. (Press the Delete 
key to remove the current area.)

You can easily adjust the individual 
regions made by any Liquify tool 
after the fact, by moving the 
stroke, or by adjusting the Size and 
Pressure settings for each stroke. 
You can’t apply multiple strokes over the same region, however.

You can use the Liquify tools to move items in a scene slightly, and enlarge or contract elements that need 
greater or lesser prominence. Like any other adjustment, it can be easy to overdo any of these tools, and 
you might find that it takes a bit of time to find the best use for each tool, but they can be quite useful for 
many retouching and editing needs.

Liquify Tool Descriptions

The Push tool lets you reshape areas of a photo by “pushing” and warping the pixels in the region 
being brushed. The result is akin to finger painting. Of the three Liquify tools, Push is the one that 
is closest in operation to a brush, where you apply strokes to warp the area being reshaped.

The Bloat tool works to “enlarge” the area under the cursor; you can click and hold the mouse 
button (or click it multiple times) to increase the effect until it reaches the maximum limit of 
pressure. While you can apply a brush stroke with the Bloat tool, you might find that playing with 
the brush size can be more helpful when enlarging an area than creating a larger stroke.

The Pinch tool works to “shrink” the area under the cursor; like the Bloat tool, you click and hold 
the mouse button to increase the effect until it reaches the maximum limit of pressure. While you 
can apply a brush stroke with the Pinch tool, you might find that playing with the brush size and 
using multiple regions can be more helpful when trying to reduce a region with a longer stroke. 

Liquify Tool Options

The Liquify tools can be used to push, enlarge, and shrink areas of a photo to reduce flaws or reshape 
regions for emphasis. Here, we’ve used a combination of the Bloat and Pinch tools to reduce the size 
of some of the background tulips, while enlarging the prominence of the foreground one. All of the 
regions created by the tools are represented as gray squares; clicking on any of them will let you 
reshape that region or delete it.
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• Size: This adjusts the overall size of the brush.

• Pressure: Sets the strength of the warped area.

• Overlay: When set to Selected, displays only the currently selected push stroke. When set to 
Auto, it displays all of the Liquify tools’ strokes; the selected one will be highlighted in blue; 
the others will be represented as gray. 

• Show Mesh: Displays a grid overlay of the warped area made by the tool.

• Tablet Adjusts Size (gear icon): If you have a pressure-sensitive tablet you can control the 
size of the brush with pressure when this setting is turned on.

• Tablet Adjusts Pressure (gear icon): If you have a pressure-sensitive tablet you can control 
the pressure amount when this setting is turned on.

• Delete: removes the currently selected region.

The Show Mesh grid overlay can be useful as a live map of the Liquify adjustments made to an image. Areas 
of the grid that have had one of the three tools applied will be distorted, and can help determine whether a 
region needs additional refinements in either Size or Pressure.
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Masking Basics
One of Photo RAW’s most powerful features is its 
masking capabilities. Every filter in Effects, every 
adjustment panel in the Local tab, and every layer in a 
photo can have a mask associated with it. When you 
switch to the Sky AI tab, Photo RAW automatically 
generates a mask of the sky for you, and when you’re 
retouching a face in Portrait AI, that face has had a mask 
automatically generated for it.

At its simplest level, a mask shows or hides the effect 
of the filter or adjustment. Masks have no color: they 
are grayscale, and the tones range from pure white to 
pure black. A mask that is completely white displays 
the entirety of the effect being used, a mask that is 
completely black hides that effect. (A common way to 
remember it is via the phrase “black conceals, white 
reveals.”) The shades of gray are, in effect, the opacity of 
the mask. Darker shades reduce the effect, lighter shades 
let more of it through.

The beauty of the masks is that you can ‘paint’ with 
black, white or any shade in between, so you can mask 
portions of your photo so that they will not have that 
effect—or will have a reduced effect. You can also copy 
masks from one filter and past them into other filters. 
Using this feature, you can mask out the sky in one filter, 
copy the mask, paste it into another filter and invert it, 
applying a different effect to everything but the sky. 
Photo RAW even lets you create luminosity masks, which 
are masks that are solely based on the brightness of the 
pixels in the image, and depth masks, which are based on 
the depth of the scene in relation to the location of the 
camera.

While working on your images, you can press the ‘O’ 
key and view your masks, either as a red overlay or as 
the grayscale version of the actual mask, which can be 
helpful when you wish to check the content or edges of 
mask, or want to make sure an area is completely masked.

You can also create complex masks by using multiple 
tools and masking functions. For instance, you can drop a 
gradient on a photo, and use the Masking Brush to paint 
out areas where you don’t want the gradient applied, or 
you can use the Color Range function (in the Masking tab 
of the Properties window) to select portions of an image 
based on specific colors and tones. 

Three views of a mask (A-C), along with the Masking 
Options section of the Properties window, here shown 
attached to an Sunshine filter in Effects. When you first add 
a filter (or a layer), the mask is empty (A). If you click on the 
empty mask, Effects will automatically generate the mask, 
here shown filled with white (B), which means all of the 
effect will come through. When you use any of the masking 
tools, such as the Sky mask option shown here, the areas 
masked out will be shown in the filter’s mask view (C). 

Masks can be created and manipulated via the Masking 
Properties window (D), which can be displayed in a number 
of different configurations inside Photo RAW
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CREATING MASKS

There are multiple methods for creating masks inside Photo RAW, and it can be as simple as:

• Clicking on the Subject, Background, Sky, Luminosity or Depth button in the Masking 
Properties window (or the More menu), each of which build a mask with a single click.

• Choosing the Super Select AI tool, then clicking on regions in a photo to build a local 
adjustment layer or to add an Effects filter. (See “Super Select AI Tool” on page 102.)

• Using one of the other masking tools — the Masking or Quick Mask brushes, or the Quick 
Mask AI, Gradient Mask or Line Mask tools. (See “Masking Tools” on page 104.)

• Using Photo RAW’s Mask AI technology via either Effects’ Add Filter window or the Masking 
Properties window, to select specific regions in a photo. (See page 127.)

Many of the masking options can be used in conjunction with one another to create complex masks, adding 
to, subtracting from, or intersecting with the current mask. 

In addition, Photo RAW includes a group of three refine brushes—Blur, Chisel and Refine—which are 
designed to help work with edges and halos that can crop up when you have areas of strong contrast 
between a masked area and an unmasked one.

Each mask you create has a set of controls you can use to manipulate the mask to adjust it further (see 
“Masking Properties” on page 126 for more). 

When you add an Effects filter or a layer to a photo, the mask is technically hidden. You can create a mask 
by either using one of the masking tools, or by clicking the Show/Hide Mask icon in the title bar of the 
pane, to the right of the filter or layer name. The contents of the Show Mask icon will represent the mask 
on that layer. Local Adjustment layers automatically create a black layer mask, so you can ‘paint in’ the 
adjustment to the image.

Here is a local adjustment—created using the Sky masking option in the Masking Properties window—that has been applied to a photo to lighten the 
sky. The Show Mask option has been turned on, so you can see where the effect has been applied (shown in red). 
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Mask overlays

Photo RAW has two primary options for viewing the contents of a mask: either as a red overlay on top of 
your image, or a view only of the mask itself, represented as grayscale. You can turn the mask overlay on or 
off by pressing the ‘O’ key on your keyboard. 

The grayscale view can be helpful when checking edges, or when refining some of the advanced masking 

controls. These mask view options are available from the Mask menu; select Show Mask to see the mask, 
while the View Mode option lets you switch between the two modes.

When you’re viewing a mask in either overlay or grayscale modes — or even when you aren’t actually 
viewing it — you have access to all of the tools in the Edit module. You can zoom in, to view the mask in 
greater detail, can use the Refine masking tools to adjust the fine edges of your mask. You can also use any 
of the other masking control options found in the Refine Mask window, as described on page 128.

If you choose the Color Overlay when Brushing option from the Mode pop-up, Photo RAW will only display 
the overlay when you are brushing with the Masking Brush, or are modifying the Gradient tool.

You can change the default red overlay color by clicking on the color swatch next to the Opacity slider.

MASKING PROPERTIES

The Masking tab of the Properties window is the masking 
control center. It has the following contents:

A.	Mask options for one-click creation of masks, 
including subject, background and sky selection, 
as well as luminance and depth masks. The More 
button includes additional masking options, 
including all of the conventional masking tools, 
color range options, and Mask AI regions.

B.	 The Target Mask section is a grayscale 
representation of the current mask. When you use 
multiple masking tools or options, the target mask 
displays the composite mask of those additional 
mask layers. 

C.	 Mask Layers displays the different mask layers that 
make up the target mask.

These screen shots show a cross-section of the image above, with the lightened sky adjustment layer. From left, (A) the original image,; (B) a red overlay 
displayed after the sky mask was added; (C) the overlay, in grayscale mode; and (D) without overlay, the effect of brightening the sky is visible.
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D.	Overlay Options includes settings for how the mask overlay is represented. You can adjust 
the opacity of the mask (lower displays more of the underlying image, higher displays less), 
the type of overlay (Color, Color while brushing, or Grayscale), and have overlay display either 
the masked area (affected) or the unmasked area (Non-Affected). 

The Mask creation options include buttons for:

• Subject: creates a mask of the image’s subject.

• Bkgrd: creates a mask of the image’s 
background.

• Sky: creates a mask of the sky.

• Lumin: creates a luminosity mask of the image (see page 130). 

• Depth: creates a depth mask of the image (see page 129).

Clicking the More button provides additional mask creation and adjustment 
operations. In addition to the five one-click mask options, including:

• Color Range, which lets you choose a color and make or tune the mask 
based on the range of the color selected (page 131).

• The Quick Mask AI Brush for selecting regions (page 108)

• The Masking Brush (page 104).

• The Gradient Mask tool (page 106).

• The Line Mask tool (page 111).

• Mask AI regions (see below).

Additional masking options: Add, Subtract and Intersect

For all of the items accessible via the More pop-up menu, you have three masking operations — Add, 
Subtract, or Intersect — available when you choose one of the options in the menu. Each of these options 
creates a new mask layer for the current filters, adjustment layer, or photo layer.

Add creates a new mask layer. If a mask doesn’t already exist for the current filter or adjustment layer, this 
new mask is represented in both the Target Mask section as the composite mask, and as the sole Mask 
Layer. If a mask already exists, it will be added to the top of the Mask Layers section, and the Target Mask 
will updated with the new mask.

Subtract is similar to Add, but is used to remove pixels from the active mask areas.

Intersect will create a new mask layer that only applies to the masked areas that overlap between the 
current mask layers.

Using Mask AI to select regions

Mask AI is ON1’s underlying technology for AI-based object and region selection. It is what powers the 
Super Select AI tool, but it is also found inside the Masking Properties window and the Add Filter window 
in Effects (see “Applying Filters with the Add Filter Button” on page 171).

When you choose Mask AI from the More menu in Masking Properties, Photo RAW scans the photo and 
builds a list of the known regions and displays them in the new mask layer. Clicking on one or more of the 
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regions will display a mask overlay (in blue) of that region; clicking the Apply button will create the final 
mask, and you can use the Feather slider to blur the edges of the mask if needed.

Mask Options and the Refine Mask menu

If you hover over a mask’s title bar in the Target Mask section of the properties window, you’ll see a 
‘hamburger’ icon, represented by three vertical lines. Clicking on the icon will display a set of additional 
operations you can perform on the mask, including:

• The Refine Mask command, which 
gives you a set of controls for 
adjusting mask parameters.

• Invert, which inverts the current mask.

• Disable/Enable, which turns the mask 
off and on. (Label changes to Remove 
when working on a mask layer).

• Reset removes the current mask, 
turning it to white when used with a 
layer mask or a filter mask, and black 
when used with a .

• Copy makes a copy of the mask, for times when you wish to add another filter or local 
adjustment using the same mask.

• Paste pastes the the copied mask.

Copying and pasting masks is only available when working with the target (composite) mask. 

Selecting Mask AI from the More menu will create a new mask layer, with a list of the found regions in the photo. Hovering over the labels will show the 
region in blue. Clicking on one (or more) of the regions will add that region to the mask layer (above left); click Apply to generate the final mask, and use 
the Feather slider to blur the edges of the mask, if desired.
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Choosing Refine Mask from the Mask Options menu calls up the Refine Mask window, which has a set of 
controls for adjusting the mask:

• Density adjusts the overall density 
from black (100) to white (0).

• Feather blurs the edges of a mask.

• Levels adjusts the black point, white 
point and gamma of the mask.

• Shift Edge increases or decreases the 
mask in small amounts, to help reduce 
halos.

• Window creates a window of tones 
between the slider handles, and 
works well when adjusting luminosity 
masks. The set of tones with numbers 
underneath the Window slider simulate the Zone system, and is designed to help you pick the 
desired tones for refining.

The Feather and the Shift Edge sliders are good for smoothing transitions between masked and unmasked 
sections; depending on the masks and the images in question, one might work better than the other. 
Lowering the Density slider helps intensify an effect after you’ve created a mask. Think of it like a ‘reverse 
fade’: at 100, all of your mask is viewable, at 0, the mask is entirely white.

DEPTH MASKS

Depth masks utilize powerful AI models to infer 
the depth within a scene, with the capability to 
blend or apply adjustments or effects based on 
the scene’s depth. This mask type makes effects 
like lens blur and other adjustments more 
natural. 

When you click the Depth Mask icon, Photo 
RAW builds a mask based on the depth of the 
scene in relation to the camera. When you 
look the mask, you’ll see white areas are those 
closest to the camera, and black areas are those 
furthest away, with gray tone for the distances 
in between. Those areas closer to the camera 
will have more of the adustment applied, while 
those further way will have less (or none) of the adjustment applied. 

You can adjust the depth by clicking on the mask (in the Mask Layers section), and adjusting the Distance 
slider.

You can use the Refine Mask options to manipulate the mask, to add or remove tones from the effect, and 
the Invert Mask button can be used if you want to reverse the depth effect.

The depth mask for the photo above is shown on the right. Lighter tones are the 
areas closer to the camera, while darker ones are further away.
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LUMINOSITY MASKS

A luminosity mask is a specialized mask type you can create anywhere you can create a mask inside Photo 
RAW. This mask uses the brightness (or luminance) values in your image to let you target specific tonal 
ranges with an effect (or to hide the effect from those tones). It is ideal for subtle enhancements to very 
specific areas of an image. They can be used for targeted sharpening and contrast operations, highlights 
control, and much more.

To add one of these masks, click on the Lumin button in the Masking tab or choose Create Luminosity Mask 
from the Mask menu. Because luminosity masks take the brightness levels of a photo, when you view the 
mask, it will look like a grayscale version of the image. With a luminosity mask, your effect will be applied 
in an increasing amount depending upon the brightness value of the pixel underneath: if the pixel is black, 
none of the effect will be applied; if it is white, it will be entirely applied; for all other tones, the effect will 
get applied as a percentage of the pixel’s brightness, from 0 (white) to 100 (black).

You can use the Levels or Window controls to further target tones with your luminosity mask. The Levels 
setting lets you set the black (left triangle) and white (right) points of the mask, with the midpoint, or 
gamma, setting being adjusted by the middle triangle. This lets you refine the mask to focus on narrow 
bands of luminance values in an image; for example, if you wanted to focus an effect on the midtones, 
bringing the white and black points into the middle of the Levels slider, and adjusting the midpoint, will 
achieve this much quicker than you could with the Masking Brush.

The Window slider is similar to the Levels slider, in that it works like a black point slider from both sides. 
When you move the right and left triangles, all of the tonal ranges outside the points will be black, leaving 
those areas affected that are within the ‘window’ of the mask. For example, if you wanted only the shadows 
in your image to have an effect, you would move the right slider over towards the left by about two-thirds.

Viewing a luminosity mask is similar to a black-and-white version of your photo; the lighter the tones, the more the intended effect will be, and the 
darker the tones, the lesser the effect.
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COLOR RANGE SELECTIONS

The Color Range option lets you create a mask using a specific color, either one inside your image, or one 
via your system’s color picker. To use this option, click the On button next to the Color Range section, and 
click the eyedropper tool to select a color inside your image that you wish to sample. You can then use the 
slider to expand or contract your mask based on that color: lower numbers means that fewer colors (related 
to the chosen color) will be selected, higher numbers mean a wider range of colors will be selected.

The Color Range option found in the Gradient masking tools can be controlled from the Masking 
Properties. When you add a gradient mask and click on the Color Range option in the Tool Options bar, 
the color chosen is sampled from the center of the gradient control, but you can open the Masking section 
of Properties and sample a different color using the eyedropper. Note that if you do this, and move the 
masking bug, it will resample using the color from the center of the bug.

MASKING TIPS

Here are a few tips for working with the various masking options:

• You can use multiple masking tools to create, modify and refine masks. For example, you can 
start with a luminosity mask, adjust the tonal range of the mask with the Levels or Window 
sliders, and then further refine your mask by painting in or out with the Masking Brush or 
Gradient Mask. Adding a luminosity mask always overrides the current mask (as is the case 
with the Quick Mask AI brush), however, so you should start there.

• While the AI-based masking tools can be quite good when building selections, they aren’t 
perfect. You should inspect your AI masks after applying them, and use the other masking 
tools, or the Refine, Chisel or Blur masks, or the masking options to fine-tune your selections.

Here, we’ve created a mask using the Color Range option in the Mask Options section for this Color Enhancer filter in Effects. We 
clicked on a blue color in the sky to use as the base for the selection range. Adjusting the Color Range slider while viewing the mask 
lets us fine tune the selection.
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• Use the Feather slider to smooth transitions between masked and unmasked sections.

• Lowering the Density slider helps intensify an effect after you’ve created a mask. Think of it 
like a ‘reverse fade’: at 100, all of your mask is viewable, at 0, the mask is entirely white.

• Don’t forget that masks aren’t just for Effects filters and Local Adjustments; you can create 
a master layer mask that will apply your selection to the cumulative adjustments made in the 
Edit module. To do this, click on the Mask icon to the right of the layer. This can be extremely 
helpful when you’re working on multiple layers of the same photo. 

• It can sometimes be helpful to use the same mask on different filters, so use the Copy button 
to grab the contents of a mask from one filter and the Paste button to paste that onto the 
mask of another filter. The Invert command can be invaluable when you wish to apply a filter 
to the opposite portion of a photo, such as a sky and your foreground.

• Because masks are tied to the actual pixels of the current photo (or layer), they cannot be 
copied from one photo to another, or between layers in a multi-layered document.
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Presets
Presets are stored “recipes” that include sets of Edit module adjustments, and can be applied to one or 100 
images with ease, in Browse or Edit. Presets are a fast way to get consistent results when editing a group of 
images, helping you hone your own look. You can easily create your own presets, even presets that 
incorporate Photo RAW’s Mask AI and Sky Swap AI technology to apply masks automatically to regions in a 
photo (See “Creating and Using AI Adaptive Presets” on page 136).

Three different views of the Preset panel. On the left is the List view, in the center is Thumbnail view; these views display the categories of presets. (The 
view options can be set in the View > Preset Browser submenu.) On the far right is an expanded category, displaying the various presets, with a thumbnail 
of the current image with the preset applied. From there, you can apply a preset to the current image.
As you hover over a category, the Quick View Browser icon appears on the left side of the category’s name.(B&W Films is shown above in the preset 
category list.) Clicking on that icon will open a full-screen window showing your photo with that category’s presets applied to it. (See the following page for 
a screen shot of the Quick View Browser.
Photo RAW lets you create your own custom presets and categories, and you can also create subcategories of presets. (See “Managing Presets and 
categories” on page 137 for more.)
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ON1 Photo RAW 2026 comes with more than 200 built-in presets, in more than a dozen categories, ranging 
from landscapes to portraits, color grading, film looks and much more. You can create your own presets, or 
import presets from other ON1 users and photographers.

You can create presets that apply any Edit module operation: Develop adjustments, Effects settings, sky 
swaps, Portrait operations and local adjustments, and any combination of these.

Presets can also store the camera profile used, Brilliance AI settings, crop settings and retouching 
information, as well as masks created with any of the masking tools. If you apply a preset that contains 
these options, check to make sure that it returns the desired result; if not, you can reset the various 
individual operations via the Settings menu. 

APPLYING PRESETS

To apply a preset to an image, click on the Presets panel. There you 
will see any built-in presets supplied by ON1—ordered by 
category—as well as any presets you might have created or 
installed yourself. Clicking on a category name will open it and 
display any presets within that category, with a tiny thumbnail 
showing your selected image with that preset applied to it. To 
change the size of the thumbnails in the Presets panel, select the 
Browser Mode option from the View menu and choose One, Two or Three Column View.

To help you view the effects of a specific preset, Photo RAW will display a real-time representation of that 
preset over your current photo when you hover your cursor over a preset in the subcategory view. To see 
a larger representation of what 
your selected photo will look like 
with all of a category’s presets, 
click on the Quick View Browser 
icon in the category’s title bar. 
That will display a window with 
all of the presets in that category. 
(Press the Escape key to close 
the Quick View Browser.)

To apply a preset to a photo, click 
on the preset in the mini-browser 
or in the Quick View Browser. It 
is worth noting that, by default, 
presets are not cumulative; 
clicking on another preset will 
remove the previous one and 
apply the new one to your photo. 
See page 135 for information 
on how to insert a preset into a photo that already has a preset applied to it. 

NOTE: Real-time preview of presets is only available when working in the Edit 
module. To preview presets in Browse, use the Quick View Browser.

A preset category with the Quick View Browser icon 
shown.

Clicking on the Quick View Browser icon in the Panels pane (or choosing Open Quick View Browser from 
the Window menu) will open a full-screen representation of that category’s presets, giving you a larger 
representation of how that preset will look on your image.
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Once you’ve applied a preset, you can reduce its overall effect by hovering over the chosen preset. There, 
you will see a Fade slider, where you can lower the opacity of any Effects filters applied with the preset. 
(Develop, Portrait, and local adjustments are not reduced.)

After you have applied a preset, you can still make changes to any of the settings—
in Develop, Effects, and Local Adjustments—add or remove adjustments, switch to 
another preset, perform any retouching or more. 

If you don’t like a preset, clicking on another one will replace the settings of the 
previous preset with the settings of the new preset. To remove a preset entirely, 
choose one of the reset options from the Settings menu, or remove the individual 
settings from the appropriate panes in Develop and Effects. (The latter approach 
is recommended if you have created masks or local adjustments that you wish to 
preserve.)

You can save a preset as a favorite by hovering over its thumbnail in the browser, and clicking on the 
heart icon. This will add that preset to a Favorites category that resides at the top of the Presets panel. To 
remove a favorite, click again on the heart icon.

Inserting presets (Effects tab only)

When you click on a preset, Photo RAW’s default behavior is to remove 
any existing adjustments and apply the newly chosen preset to your 
photo. Sometimes, however, you would like to add a preset on top of your 
adjustments. To do this, open the Presets pane, right-click (Option-click on 
MacOS) on the preset you wish to add, and choose Insert Preset from the 
pop-up. This will add the preset’s filters above the currently selected filter 
pane and preserves edits you made in the Develop or Local tabs. 

Inserting a preset will only add that preset’s Effects filters to your 
currently edited photo. Develop adjustments and local adjustment layers will not be added.

CREATING YOUR OWN PRESETS

Once you have a group of edited settings that you 
wish to save, go to the Settings menu and select 
Save Preset. The Save Preset dialog will appear, with 
options for which module’s settings you wish to 
save, naming the preset, and adding it to an existing 
or new category. Nearly all of the Edit module 
settings can be saved as a preset, including cropping, 
retouching, text blocks and masks. To save your 
masks — AI adaptive or otherwise — check the Apply 
Masks option for each tab in the Edit module. 

If you have applied a preset to an image, and 
subsequently updated any of the edit settings (or 
add or remove adjustments), you can update the 
preset with the new settings by choosing Update 
Preset with Current Settings from the Settings 

The Fade slider reduces the 
opacity of Effects filters 
applied with a preset. To find 
it, just hover over the applied 
preset in the Presets pane.

The Inset Preset option is only available  
when working in the Effects tab.
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menu. This will only change the preset moving forward; any images that used the previous version of the 
preset will keep those settings unless you reapply the preset. (You can also update a preset by right-clicking 
on the preset in the Preset Browser.) 

If you would like to create a new preset category—which will be added to the Presets panel throughout 
Photo RAW—choose Add New Category from the category pop-up. 

CREATING AND USING AI ADAPTIVE PRESETS

When you use the Super Select AI tool, the Sky Swap AI tab, or when 
you use the Mask AI options in the Effects, Local Adjustments or in the 
Layers panel, you can save those region selections when you create a 
new preset, by clicking on the Apply Masks item in the appropriate tab. 
Then, when you apply the preset to a new photo, anything (Effects filter, 
sky swap or local adjustment) that had an AI-generated mask region — 
such as a sky — will be applied to those regions with the same name in 
the new photo. These preset types are called “adaptive,” meaning that 
they are applied to a photo based on Photo RAW’s AI models.

Here are a few tips to think about when working with adaptive presets:

• It’s best to create an adaptive preset that only uses AI-generated masks. If you save a preset 
where any filters or local adjustments have masks that have been created by the standard 
masking tools (like the Masking Brush or Gradient Mask), those masks will be regenerated 
based on the precise location of the mask in the image that was used to create the preset.

• Any changes to the mask made via the Masking options tab in the Properties window (see 
page 126) are saved with the preset.

• After you apply an adaptive preset to a photo, check the masks that the preset created. Quite 
often, you’ll find that you might need to use some of the mask refinement tools — or even the 
Masking Brush — to fine-tune your mask.

• ON1 includes a set of adaptive presets with Photo RAW 2026. Feel free to add your own 
adaptive presets to that category, or create your own category (see below for how to do that). 
It’s best, however, to name or categorize them (or both) such that you know which presets 
contain AI-generated selections.

NOTE: When you apply an adaptive preset to a photo, the named AI masks will 
be visible in the Mask AI area in the Masking Control Options section (see page 
128) of the appropriate filter or local adjustment.
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USING THE AI STYLE ADVISOR

Photo RAW’s AI Style Advisor is a special preset category of AI-generated 
presets. As you work in the Edit module, Photo RAW pays attention to the 
type of editing you perform in all portions of the app, and, over time, it will 
add and refine adaptive presets to your My Style category. 

These presets will appear based upon the type of photo and the regions 
within them: for example, a portrait photo will have AI styles that use the 
Portrait AI settings you’ve used in the past. You can view the suggested 
presets either by running your mouse over the thumbnails in the preset 
browser, or by using the Quick View Browser.

Initially, the My Styles category will be blank. After you have edited approximately 200 photos, My 
Styles will populate with suggested styles, and as you continue to work within Photo RAW, the My Styles 
category will expand and give you even better results.

To get you started, the AI Style Advisor has a collection called ON1 Team, which is a collection of AI Styles 
from the photographers at ON1.

NOTE: The AI Style presets can’t be imported or exported from within Photo 
RAW and won’t show up in the Extras Manager. If you like one of the AI Style 
presets, apply it, then save the current editing state as a standard preset. See 
“Creating Your Own Presets” on page 135 for more.

MANAGING PRESETS AND CATEGORIES

You can perform a variety of operations on presets and preset categories, including importing and 
exporting presets (individually or by category), deleting individual presets, and hiding categories.

Importing & Exporting Presets

You can import presets you have downloaded from the ON1 website or other source. Some files will be 
individual presets, while others might be preset “packs,” which will include more than one preset.

A preset will have an ‘.ONP’ extension, while a preset pack has an ‘ONPreset’ extension; all you need to do 
is double-click on the file—or choose Import Preset from the Settings menu—and Photo RAW will ask you 
to pick a category where you wish to place the preset or pack, and it will copy the presets into the app. You 
can delete the downloaded files, if desired.

To export an individual preset, click on it and choose Export preset from the Settings menu. You can also 
export an entire category of presets, via the category preset menu (shown below).

Deleting presets

To remove a preset if you no longer want to have access to it, select the preset you wish to remove in the 
Preset panel, and choose Delete Preset from the Settings menu. You can also right-click on an individual 
preset and click Delete Preset from the pop-up menu.
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You can delete any preset, including the presets that came pre-installed with ON1 Photo. If you think you 
might wish to save a preset, export it first, then delete it.

Managing categories

In addition to creating your own preset categories, which get 
displayed in the Presets pane, you can also perform other operations 
on categories, including deleting, renaming or exporting. These 
options are all available via the Preset Category pop-up menu, which 
is available when you hold right-click on a category name:

• To remove a category—and its presets—from the Presets panel, choose Delete Category.

• Choose Rename Category if you wish to change the name of the category.

• To export a category and all of the presets within it as an ONPreset pack, choose Export 
Category from the pop-up menu.

TIP: Many preset options can also be performed by right-clicking on a preset’s 
name in the Preset panel. This is helpful if you want to update, export or 
rename a preset without applying it to the current image in the Edit module.

Creating nested presets

To help manage large groups of presets, Photo RAW’s Extras Manager lets you nest preset categories. See 
“Organizing Presets” on page 11 for details on how to create and manage preset category subfolders.

CAMERA-BASED PRESETS

In addition to using presets in the Browse and Edit modules, you can also have Photo RAW automatically 
apply a preset to any new photos from a specific camera, even down to the serial number.

This can come in handy if you have created a custom camera profile or if you have converted a camera to 
infrared. Camera-based presets are automatically applied to photos in cataloged folders, imported photos, 
and any time you open a folder in Browse. It’s important to note that any photo that has already had any 
adjustments made in the Edit module will not have the preset applied to it.

So, if you always find yourself making the same basic adjustments to most photos from a specific camera, 
just make a preset and it will apply to all photos from that camera. You can also choose to have the preset 
applied to Raw or JPG photos from that camera, or both if you shoot Raw+JPG.

Setting up camera-based presets

To use this feature, first define the preset you wish to use. Because presets are applied globally to all of 
that camera’s images—except for those that have been edited previously—you probably want to keep the 
adjustments within a narrow range of categories, like a specific camera profile, Develop’s Tone and Color 
and Details settings, and minimal Effects filters, if any at all.

To connect the preset to the camera, open the Files tab of the Preferences screen (page 294). At the 
bottom of the window is the Default Processing section, which contains a list of all the cameras that Photo 

Right-click on a preset category to get the 
category pop-up menu.
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RAW knows you have shot with. The list includes the camera name, serial number (if your camera records 
that in the image metadata), preset and file types. Scroll down to the camera you wish to use and click on 
the Preset pop-up, which contains a hierarchical 
list of your presets, and select the one you wish 
to use. The default file type is Raw; if you wish 
to apply the preset to JPG files, or both Raw and 
JPG files, choose the appropriate setting from 
the File Types menu. 

When you close the window, Photo RAW will 
update your database and apply that preset to 
all of the photos created by that camera. And 
from that point on, when you add photos taken 
with that camera, Photo RAW will apply the 
preset automatically to all those photos.

Editing photos with camera-based presets

Because Photo RAW is non-destructive, any photo with a camera-based preset applied to it can be edited 
and changed in the Edit module, or have a new preset applied via Browse. However, you must either apply 
a new preset, or change the individual settings in the Edit module. You can’t choose the Reset All Settings 
option from the Settings menu, because the default settings for that camera’s images are now those applied 
by the preset.
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Copying settings and synchronizing edits
In addition to applying presets, you can copy all of the existing edits—of any operation you can perform in 
the Edit module—made in one photo and paste 
them directly onto other images. There are 
two primary methods for doing this—Copy/
Paste and Sync—but they achieve the same 
end goal: it’s more a matter of preference in 
which operation you choose.

To copy the edit settings from an image, 
click on the source file and choose Settings 
> Copy Settings. Click on the new image and 
choose Settings > Paste Settings. A window 
will appear, giving you the option of applying 
any or all of the edits on the original photo, 
or you can select which edits—everything 
from individual settings in Develop’s Tone and 
Color pane, to masks, cropping—you wish to 
paste into the new photo or group of photos.

The Copy/Paste Settings commands can be 
useful when you wish to paste settings across 
a number of photos in different folders. As 
long as your Edit session is active, Photo RAW 
will remember the last copied settings.

With the Sync Settings command, select 
the image you want to use as your source. 
Then, holding down the Shift key (if you are 
selecting an image or group that is contiguous 
with the source), or the Command (Mac) 
or Control (Windows) key, and click on the 
image(s) that you wish to apply the source 
file’s edits. Your selection should have the 
source image highlighted in blue, and the 
target images highlighted in gray. If that is 
correct, choose Sync Settings from the Settings menu. The Apply Settings window will open, and you can 
follow the same procedure to synchronize your edits.

NOTE: When you copy and paste settings or sync settings from one photo to 
another (or a group), with the Apply Mask option turned on, and you include 
AI-generated masks from the appropriate Edit tab, Photo RAW will apply the 
masks based on the regions you masked. This is similar to the way that AI 
adaptive presets are applied (see “Creating and Using AI Adaptive Presets” on 
page 136 for details).

In the Apply Settings window—accessible from either Paste Settings or Sync 
Settings—you can apply nearly all Edit module operations to another image or group 
of images. Filled circles to the left of a setting mean that the setting will be applied.
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If you’re sure that you want to sync everything from a source photo to another photo or group of photos, 
the Settings > Sync All Settings command will let you bypass the Apply Settings window. Select your 
source  and destination photos and select the command. Note that all settings—including cropping, text and 
masks—in the source image will get synced.

RESETTING EDITS

Any edits you have made with ON1 Photo RAW 2026 can be completely reset from within the Edit module. 
This includes photos you might have pasted or synchronized settings onto inside Browse, or anything done 
within the Edit module.

The Settings menu offers eight options for erasing edits made to a photo:

• Reset All Settings: This removes all adjustments made to a photo in the Edit module. (This 
option can also be accessed from the Reset All button at the bottom right of the Browse and 
Edit windows.) 

• Reset Develop Settings: Removes only the settings applied in the Develop tab.

• Reset Effects Settings: Removes only the settings applied in the Effects tab.

• Reset Sky Settings: Removes only the settings applied in the Sky Swap AI tab.

• Reset Portrait AI Settings: Removes only the settings applied in the Portrait tab.

• Reset All Retouching Tools: Resets any retouching applied anywhere in the Edit module.

• Reset Local Adjustments: Removes all local adjustment layers.

• Reset Liquify Tool: Removes all applications of any of the Liquify tools.

• Reset Crop: Returns the image to its original, uncropped size.

• Reset Text: Removes any text blocks.

You can undo any of these changes immediately after making them; otherwise resetting with the 
appropriate option will permanently reset the image.

NOTE: The Copy, Sync and Reset settings are only applicable on a layer-by-
layer basis. As such, these options are not available when you have selected a 
layered photo in Browse. When working in the Edit module, the Reset, Copy/
Paste and Sync settings work only on the currently selected layer. 

RESETTING INDIVIDUAL PANES AND SLIDERS

Any of the panes in any of the Edit module panels can be returned to their default settings by clicking on 
the Reset icon, which is represented by ‘⟲’ at the top right side of the pane.

To reset the individual sliders in any of Photo RAW’s panes to their default setting, double-click the 
setting’s label or the slider’s handle. 
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Soft Proofing
ON1 Photo RAW’s soft proofing feature lets 
you see how a photo will look when printed, 
using the color profiles that get installed with 
your printer. Soft proofing helps you determine 
where there might be issues when you print, so 
that you can adjust your tone, color and effects 
to give you a print that is closer to your editing 
vision.

Normally, when you’re viewing an image in 
Photo RAW, you are viewing it through the 
lens of your monitor’s display profile. The color 
gamut of your computer’s display is wider than 
that of most photo printers, which means that 
some colors you are able to view on-screen 
are not reproducible when you print. When 
this happens, the color profile conversion 
that happens in the print engine will cause 
substitutions of colors that the printer cannot 
print to the closest color that it can. This means 
that your image could have subtle (or broad) 
shifts in color, especially in certain color ranges.

Soft proofing is turned on by selecting Enable 
Soft Proofing from the View menu. You can 
then soft-proof various paper types by choosing 
an installed printer profile from the Profiles 
submenu. The image will change to approximate 
the color of the paper you’re profiling. You can 
also turn on an overlay that will display out-of-
gamut colors.

The primary soft-proofing options are available 
underneath the Enable Soft Proofing item in the 
View menu. The options are as follows:

• Gamut warning: When checked, this 
displays colors in the image (via a 
red overlay) that don’t correspond to 
the current printer profile being soft 
proofed.

• Profiles: The Profiles submenu lists the currently available printer profiles. Choosing one 
will change the on-screen display to use that profile. You can also import profiles via this 
submenu.

• Intent: Photo RAW offers two different rendering “intents” when soft proofing, which are 
used to convert the color from display to print. Perceptual shrinks the color gamut during the 

These three screen shots show the results of soft proofing options, as viewed in 
the Edit module. The top image is with soft proofing off (and is using the display 
color profile). The middle image is with soft proofing turned on, and using a printer 
profile for Epson’s Exhibition Matte Paper. The bottom image has the Gamut 
warning turned on; out of gamut colors are highlighted by the bright red overlay.
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conversion, which works to preserve the relationship between colors in the image. The other 
intent type, Relative, only converts colors that are outside the current color gamut, but this 
can sometimes cause two colors, one in gamut, and one outside, to be identical after 
conversion.  
	 Neither rendering intent is perfect or desired; it often is a 
matter of the makeup of the image, your editing intent, the 
paper being printed on, and so forth. Often, you’ll want to 
switch back and forth between Relative and Perceptual, 
seeing which gives you a better print.

• Simulate Paper and Ink: Turning this setting on will cause 
Photo RAW to use the white point for the chosen paper type 
(instead of the white point of your monitor), and the paper’s 
actual black density (instead of the display’s black point). 
If you’re trying to match a print, you will usually want this 
setting turned on.

Adjusting images with soft proofing is often a bit of trial and error. 
It’s easy to get caught up in eliminating out-of-gamut colors, but most 
modern photo printers—both home printers and online print services—
do a pretty good job of properly approximating colors. 

The biggest thing you want to be looking for when viewing a soft proof 
is tone, contrast and color accuracy between screen and print. When 
using a home printer, use test prints to hone in on the right mix of 
Edit module adjustments. Photo RAW’s Versions feature can be extremely helpful when you’re tweaking 
settings to get a print just right (see page 72 for more on working with Versions).

Other Edit Module Preview Options
In addition to soft proofing, ON1 Photo RAW 2026 offers a few other previewing options in the Edit 
module, which can be found in the previewing section at the bottom of the Photo RAW window. With 
these options, you can compare the before and after views of a photo—in either split-screen or full-screen 
views—and see the current mask overlay. 

CHANGING THE MAGNIFICATION VIEW 

Photo RAW includes various options for zooming in or out of a photo while you’re working on it. In addition 
to the Zoom tool and the Navigation pane (see page 103 and page 90, respectively), you can change 
the zoom view by moving the magnification slider. You can either click on the control and slide it to the 
right to zoom in and to the left to zoom out, or you can click on the boxes at the ends of the slider.

The Profiles submenu displays the installed 
printer profiles for any installed photo printer. 
You can also import your own color profiles.

The Preview area at the bottom of the main Photo RAW window includes options for adjusting the preview magnification (left side); for viewing the original 
photo, with all edits removed; for turning compare (before/after) view on or off; and for viewing the current mask overlay.
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BEFORE/AFTER PREVIEWS

As you work in the Edit module, it can be helpful to see how individual edits—via items in the different edit 
tabs—affect your photo, as well as to see the cumulative changes made to the original image. The Edit 
module’s Compare mode displays a side-by-side view of your photo, with the original version on the left, 
the edited version on the right. There is a movable slider in the middle of the screen, which lets you view 
more or less of each view; click on the box at the center of the slider and drag it to the left (to view more of 
the edited image) or to the right (to view more of the original. While working in Compare view, you can use 
the magnification slider to zoom in or out of the image.

You can also view your original image full-screen by clicking the Preview button at the far right of the 
previewing toolbar. When you click this button, the original photo is displayed with a “Preview Off” overlay. 
To return to your edited version, click the Preview button again. (You can also use the backslash key—‘\’—to 
show and hide the full-screen preview.)

SHOW/HIDE MASK

You have two options for displaying the contents of the current mask (in Effects, Local and Layers): 

• As a transparent red overlay, where the masked sections of your photo are shown in red.

• As a grayscale mask, where you do not see the photo, but see only the mask. Masked areas 
are shown in shades of gray, with pure black meaning that those pixels are completely 
masked. Gray values (from 1% to 99%) represent the opacity of the those pixels relative to 
the mask, and areas of pure white are not masked.

Edit’s Compare view displays a before/after view of your current photo, with a movable slider (circled, above) for expanding and contracting the 
different views.
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The overlays can be set in the Mask menu’s View Mode submenu while you are working in the Edit module. 
You can also, via this option, show the mask as a red overlay only when you are brushing a mask. 

You can toggle the current mask view by clicking on the Show Mask icon in the previewing toolbar, or by 
pressing the O key.

For more information on the varying aspects of masking in ON1 Photo RAW 2026, see the details on the 
respective masking tools, starting on page 104, and “Masking Basics” on page 124.

FOCUS AND CLIPPING VIEWS

Two additional previewing tools that can be quite powerful aids when you are editing photos are the 
Clipping and Focus Mask overlays. These options can be displayed in any of the Edit module tabs.

Clipping

Clipping occurs when the shadow and highlight tones in an 
image are suddenly cut off to completely white or black, 
rather than fading smoothly. (Large expanses of white pixels 
in a photo are often referred as ‘blown’ highlights, and can be 
quite distracting to a viewer.) One of the benefits of shooting 
in raw format is that, while many photos will have areas of 
pure white or black when originally viewed on-screen, there 
is still recoverable data in the raw image. The Clipping overlay 
can help determine how big a problem you might have with a 
photo, and how easy (or difficult) it will be to fix. 

To display the Clipping overlay temporarily, press the J key; 
to turn it on permanently as you move from photo to photo, 
choose View > Show Clipping, or press Alt (Windows) or 
Option (Mac) J on your keyboard.

The Clipping view overlay displays the areas that have either pure white or pure black in them. Those areas 
with a bright blue overlay indicate pure black pixels, while the areas with the bright red overlay indicate 
pure white pixels.

The two options for viewing a mask are with a red overlay (left), which shows the masked areas in red, and a grayscale mask (right), which shows only the mask, in a 
range of tones from white (not masked) to black (completely masked). Tones in gray represent varying percentages of the mask’s opacity.

Clipping view displays pure white pixels with a bright red 
overlay, and pure black pixels with a bright blue overlay.
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Focus Mask

It can often be difficult to view the sharpness in a photo 
without zooming in to 100% or more, and if you have a lot 
of photos from a shoot, it can be a bit tedious to check focus 
at that level. Luckily, Photo RAW’s Focus Mask overlay can 
help winnow your shots down to the sharpest ones.

To turn on Focus Mask, choose View > Show Focus Mask, 
or press Shift-Alt-J (Windows) or Shift-Option-J (Mac). The 
sharpest areas in your image will be represented by a bright 
green overlay. As you move from photo to photo in a folder, 
you’ll be able to tell whether you have an acceptable level of 
sharpness where you need it by the strength of the overlay. 
The mask will be displayed even as you zoom in on a photo.

Showing or Hiding Edit Module Adjustments
You can also show or hide many individual 
adjustments made throughout the Edit 
module. Most of the panels in the Develop, 
Effects, Portrait and Local tabs have a 
Show/Hide control in the upper left-hand 
corner of the panel. You can make your 
adjustments, and can click the control to 
turn the effect on or off. 

That this option is not solely for previewing 
an effect; if the adjustment is turned off, 
it will not be present in the edited image. 
This can be helpful if you’re trying different filters in Effects, for example, and you want to see if one looks 
better than another, or if you wish to see if it truly helps the photo or not. To turn the adjustment back on, 
click on the Show/Hide control so that the circle is filled.

The only adjustment inside the Edit module that cannot be turned off in this way is the Tone & Color panel 
in the Develop module. If you wish to view your photo without those adjustments, you need to press the 
Reset icon, which is represented by ‘⟲’ at the top right side of the panel. 

For a complete description of the controls in most Edit module panels, see “Filter Overview” on page 170.

Saving Your Work
Photo RAW saves your non-destructive settings for the photo you are editing when you return to Browse. 
If you would like to periodically save your settings without returning to Browse, you can use the Save 
Settings command. This saves your work in the off chance the application encounters an error. To save the 
current state of your actions, choose Save Settings from the Settings menu, or press Command-S (MacOS) 
or Control-S. 

To turn an effect or other adjustment off, click on the Show/Hide control in the upper 
left of an adjustment’s panel. If the control’s circle is empty, that effect is not 
implemented. Clicking the control will turn it back on.
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BASIC GLOBAL EDITING WITH DEVELOP

Develop is the module for performing basic global editing operations—adjusting tone and color, removing 
noise, sharpening and applying transforms to a photo. It is the perfect place to begin editing your photos. 
And, with Brilliance AI, you can get started quickly with AI-based automatic adjustments that jump-start 
your editing, letting you get right to the stylization part of your workflow. 

Develop Adjustment Panes
To edit your images, the Develop tab has four adjustment panes found in the Overall Settings panel. Unlike 
the Effects tab, which lets you stack filters in any order, the Develop tab’s adjustments are applied in the 
following order:

1.	 Brilliance AI

2.	 Tone & Color

3.	 Noise & Sharpening

4.	 Lens Correction

5.	 Transform

WORKING WITH PANES

The Tone & Color pane is at the top of the stack, followed by the Noise & Sharpening, Lens Correction and 
Transform panes. These panes are not removable from the stack, although you do not have to apply any 
of these operations to a photo. The remaining panes can be applied based upon what you wish to do with 
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your photo. Clicking on the button to the left of the pane’s name will turn that pane on or off, which can 
be helpful if you want to see the effect in the context of other edits you have made. The Reset button—
designated by the circular arrow icon at the top right of each pane—will reset that pane’s settings to their 
default state.

TIP: Each pane can be collapsed, by clicking in the pane’s title bar. If you don’t 
want to have to scroll up and down the Settings panel when you have a lot of 
open panes, choose Solo Mode from the Window menu. This will leave only the 
current pane open, and will hide all the other panes. Clicking on another pane 
will open that one and collapse the previous one.

BRILLIANCE AI

Photo RAW’s Brilliance AI is designed to help reduce some of the drudgery of the basic raw processing 
operations that we all have to do at the beginning of our editing workflow. It analyzes your photo and 
automatically fixes tonal and color issues in your photos. It can also apply noise reduction, targeted local 
adjustments on specific regions, and portrait retouching on any faces found in your photos.

Unlike older ‘auto’ buttons that did basic white and black point adjustments and some color and saturation 
enhancements, Brilliance AI uses artificial intelligence to get most of the heavy lifting done at the beginning 
of the editing process, enhancing your photos and making them look great, so you can work on stylization 
and other localized editing or composite work in Layers.

Brilliance AI’s operations are fully non-destructive: you can go in and remove or further edit any of the 
adjustments made, and you can also set the defaults for each of the possible operations in the Brilliance AI 
tab of Photo RAW’s Preferences window (see “Setting Brilliance AI defaults” on page 149).

To use Brilliance AI on a photo, click the control circle 
to the left of the pane’s title. Once on, the Brilliance AI 
pane has three sections, Amount, Local Adjustments, 
and Options:

A.	Amount/Fine Tuning: The Amount slider 
controls the strength of the overall effect. The 
Fine Tune section lets you adjust separately 
the Tone and Color portions of the effect. 

B.	 Local Adjustments: When turned on, Photo 
RAW will search for regions in the photo and 
create local adjustments for each area. These 
regions will be added as separate panes in the 
Local tab of the Edit module. 

The Options section of the pane has four settings:

C.	 Method: By default, the method is Brilliance 
AI. The other two options, AI Auto and AI 
Match, are included for photos that were 
edited with previous versions of Photo RAW.
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D.	White Balance: The default is to perform automatic white balancing, but you can set it to As 
Shot, or to any one of the standard color temperatures found in the Tone & Color pane. (If 
you don’t want Brilliance AI to adjust the white balance, leave the setting to As Shot.)

E.	 NoNoise AI: This setting determines whether Photo RAW’s NoNoise AI is applied to the 
photo. Setting it to On will run NoNoise regardless of the photo’s ISO; Auto will only run 
NoNoise if the photo’s ISO is above the amount set in the Brilliance AI tab of Photo RAW’s 
Preferences window (see page 302); Off will not run NoNoise on the photo.

F.	 Retouch Large Faces: If Brilliance AI finds prominent faces in a photo, it can automatically 
apply retouching in Portrait AI. This option can be set to on or off.

Setting Brilliance AI defaults

You can customize Brilliance AI’s default operations in the Brilliance AI tab of Photo RAW’s Preferences 
window. The tab has three main sections:

• The top portion lets you set 
how Brilliance AI adjusts 
the white balance, at what 
minimum ISO setting NoNoise 
is applied (or not at all), and 
whether to apply Portrait AI 
retouching to prominent faces. 

• The middle section is for 
customizing the main Brilliance 
AI Amount setting. If you feel 
that Brilliance AI regularly 
adds too little or too much to 
your photos, you can tune the 
settings here. You can also 
change the default adjustments 
for Temperature, Midtones, 
Vibrance and Contrast.

• Apply Local Adjustments Automatically lets you set the region-based localized editing. 

NOTE: Regardless of the defaults set in the Preferences window, you can 
use the Brilliance AI pane in the Develop tab to turn on or off any of the basic 
Brilliance AI adjustment categories for each photo or group of photos.

Editing photos that have Brilliance AI applied

Once you have used Brilliance AI on a photo, you can go into the individual Tone & Color, NoNoise AI, 
Portrait AI and Local adjustments and make further refinements. For example, you could go into each of 
the local adjustment panes and use the mask refinement tools to fine tune your masks. You could decide to 
turn one of the local adjustment panes off. You can also add filters in Effects, swap skies, and more without 
affecting the core Brilliance AI adjustments.
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If you turn the Brilliance AI pane off, Photo RAW will reset the Tone & Color pane to its initial state, and 
turn off NoNoise AI settings, any local adjustments and any faces retouched. Turning it back on will return 
your tone, color, noise, local adjustments, and portrait retouching settings to their previous state, with any 
additional adjustments you might have made while Brilliance AI was turned on. 

TONE & COLOR

This pane adjusts the tonal and color characteristics of an image, 
letting you correct and enhance exposure, contrast, detail and 
color. It is split into two sections, Tone and Color, with a Color 
Profile option at the top of the pane.

Camera Profile

Camera profiles apply alternative interpretations of the raw data 
in an image based upon different genre types or intents. The pop-
up menu displays Photo RAW’s built-in profiles: ON1 Standard, 
Landscape, Portrait, Vivid and Neutral. If your camera has its 
own embedded profiles, you will see those profiles in the list as 
well, and you can also import your own custom camera profiles 
using Photo RAW, and X-Rite’s ColorChecker and ColorChecker 
Camera Calibration software. (See page 161 for more 
information on how to create and import custom camera profiles 
into Photo RAW.)

Photo RAW’s camera profiles are non-destructive, and work 
independently of any changes you make to tone or color.

Tone

The Tone sliders control the global tonality, or brightness and  
contrast of the image. You can adjust each of the following:

• Exposure: Adjusting this slider to the right will lighten 
your image. Adjusting to the left will darken your image.

• Contrast: Increase or decrease the contrast.

• Highlights: Darkens the highlights, recovering detail.

• Midtones: Adjusts the middle tones in your photo.

• Shadows: Lightens the shadows, revealing details.

• Whites: Adjusts the white point, adding or removing 
contrast in the highlights.

• Blacks: Adjusts the black point, adding or removing 
contrast in the shadows.

• Mode: Used to convert color or black-and-white negatives. (See below for more.)

• Structure: Adjusts the detail in your image by changing the local contrast.

• Haze: When moved to the left, this will remove haze or fog from your photos; moving it right 
will enhance fog or haze.
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Color

The Color sliders control the Temperature, Tint and Vibrance. They are used to remove a color cast and 
enhance the color of the image. By default, when working with raw (or DNG) files, the color temperature is 
measured in degrees Kelvin (°K), which gives you a larger and more accurate range to make adjustments. 

The settings in this section of the Tone & Color pane include:

• Auto Button: The auto button attempts to detect and remove a color cast. It makes 
adjustments to the Temperature and Tint sliders.

• Gray Dropper: Used to remove a color cast of an image. Click the icon to activate, then click 
on an area in the image that should be gray.

• White Balance presets: This pop-up lets you change the white balance according to common 
color temperatures (As Shot, Auto, Daylight, Cloudy, Shade, Tungsten, Florescent, Flash, 
Custom). The default is As Shot, which is the color temperature that the camera recorded 
when you took the photo.

• Temperature: This slider shifts the color either cooler (blue) or warmer (yellow). When editing 
a raw file, the °K button will be blue, which means that the temperature is measured in 
degrees Kelvin. Clicking the button will change the slider to a relative color ramp. (The Kelvin 
ramp is only available when working with raw photos; other formats use the relative slider.)

• Tint: Shifts the color either green or magenta.

• Saturation: Increases or decreases the saturation of your image.

• Vibrance: Increases/decreases the color of muted tones, leaving more saturated colors alone.

• Reduce Vibrance on Skin: When turned on, adjustments made with Vibrance slider are 
reduced on skin colored areas. This allows you to increase the vibrance of clothing and the 
background without adversely affecting the skin color.

• Purity – Highlights: Reduces the saturation in the highlights.

• Purity – Shadows: Reduces the saturation in the shadows.

Negative mode

If you are digitizing film negatives using your digital camera instead of a scanner, Photo RAW 2026’s new 
negative mode can be used to invert your photos and correct 
colors automatically. 

To use the feature, open the negative in Develop, and choose 
Color Negative or Monochrome Negative from the mode, 
and Photo RAW will convert the negative to a positive. You 
can then work in Develop — and the other Edit modules — as 
you would with any normal file.

Adjusting Tone & Color settings via hotkeys

When you’re working in any tab inside the Edit module, you have the capability to adjust the basic tone 
and color settings for your current image directly from the keyboard, based on the hotkeys found in the 
Keyboard Shortcuts window. These include the following sliders: Exposure, Contrast, Highlights, Midtones, 
Shadows, Whites, Blacks, Temperature, Tint, Saturation and Vibrance.

Converting film negatives is as easy as can be with Develops 
Mode selector.
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To use this feature, first invoke the setting you wish to change with the appropriate keyboard shortcut. An on-
screen overlay label will appear, indicating that you are changing that setting. Use the Up/Down arrow keys to 
increment or decrement the chosen slider. When you’re done, 
press the Escape key, or click in the window.

This feature can be helpful when, for example, you apply 
a set of filters in Effects and feel that they caused the 
shadows to darken in your image. Using the keyboard 
shortcut for the Shadows adjustment, you can make 
changes dynamically without having to go back to the 
Develop tab.

Photo RAW has a set of pre-assigned keys for these 
adjustments in the Develop section of the Keyboard 
Shortcuts window, but you can change them easily. See 
page 103 for more. 

NOISE & SHARPENING

The Noise & Sharpening pane incorporates the two adjustments that often compete with each other when 
working on a photo, and that generally need to be balanced in order to achieve satisfactory results in your 
edits. There are four options for noise reduction and sharpening in the pane, split into tabs: 

• Classic, which offer Photo RAW’s traditional noise reduction and sharpening settings. 

• NoNoise AI, which uses AI-based machine learning to remove luminance and color noise from 
photos shot at higher ISOs. 

• TackSharp AI, another AI-based tool that can be used to deblur or sharpen soft photos. It can 
detect and remove motion blur and will even save out-of-focus shots.

• Both, which includes the NoNoise AI and TackSharp AI tabs, letting you apply AI-based noise 
reduction and focus-sharpening applications at the same time.

The Classic sliders are applied in real time on your image, while NoNoise AI and TackSharp AI are applied 
at the base image level, demosaicing each image from its raw data and applying its noise reduction and 
sharpening to the base image. Because it is applied at the raw level, you must process the image and then 
apply it, which ‘locks’ the settings to the base image, although you can adjust the settings at any point in 

You can view (and change) the hotkeys for the primary Tone & 
Color adjustments from the Keyboard Shortcuts window, which 
is found in the Edit menu.

Develop’s Noise & Sharpening pane offers traditional noise reduction and sharpening options in the Classic tab (above left); while the NoNoise AI (second from left) 
and the TackSharp AI (second from right) tabs incorporate ON1’s AI-based noise reduction and focus-enhancement and sharpening technologies. The Both tab (above 
left) lets you apply both NoNoise and TackSharp to an image at the same time. 
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time. It also takes a bit longer to process a photo with NoNoise or TackSharp than the Classic method. (See 
page 87 for details about the order in which editing operations are applied to a photo.)

For most images, you’ll want to use the Classic option first, unless you know that the images were shot at 
high enough ISOs that noise will be a problem in your final edit, or that your photo contains soft or out-of-
focus details that you wish to correct.

Using the Classic tab

For most images, you’ll want to use the Classic tab in the Noise & Sharpening pane; which is the default tab 
in the pane when you open it.

NOTE: When you are adjusting the sharpening or the noise in a photo, it is 
best to be working at 100% view. To do this, you can click on the 100 button in 
the Navigator pane, choose View Actual Pixels from the View menu, or press 
Command-Option-0 (Mac) or Control-Alt-0 (Windows) on your keyboard. 

Noise Reduction

The Noise Reduction section reduces luminance and color noise, while maintaining image detail. By default, 
Photo RAW applies a small amount of noise reduction on your photo, based on the camera type used. You 
can then further refine both luminance and color noise, as defined below:

• Luminance: Adjusts the strength of the noise 
reduction applied to the image’s luminance. Hold the 
Alt/Option key to see the luminance while adjusting 
this slider.

• Color: Controls the amount of noise reduction applied 
just to the color noise or chroma, of the image.

• Detail: Controls how much edge detail is protected for 
each type of noise reduction (Luminance and Color). 
Hold down the Alt/Option key to see the edge mask 
while adjusting this slider.

• Remove Hot Pixels: If you have any individual, blown-
out pixels in your image, turning this setting on will 
remove them, changing that pixel’s color to one that 
blends in with the surrounding pixels. This setting can 
also be helpful in reducing noise in long exposures.

• Version: This is set by default to 2020, when ON1 last 
revised its Classic noise reduction algorithms. Photos 
edited in earlier versions use the 2017 model, while newer photos will default to the new 
model. You can change any image to the other model via the pop-up. 

Sharpening

The sharpening section of the Details pane is designed to visually sharpen an image based on its initial 
state from your camera—for example, to bring back some sharpness that might have been lost. It has two 
basic controls: Amount and Threshold. Amount controls the strength of the sharpening applied, while 
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Threshold reduces sharpening in areas of low detail via a threshold mask. Hold down the Option (Mac) or 
Alt (Windows) key as you adjust the Amount slider to display your photo in grayscale, which can make it 
easier to view the degree of sharpening you’re applying.

With the Threshold slider, a setting of 0 means that the sharpening amount gets applied to every 
pixel. As you increase the amount, it focuses the sharpening only where there is a difference between 
neighboring pixels. To help you determine which edges are sharpened, you can use the same Option/Alt 
key trick mentioned above. In this view, as you adjust the Threshold slider, everything that is white will get 
sharpening applied to it; everything displayed as black will not have sharpening applied.

If you wish to apply further sharpening for printing or other output uses, you can add more targeted 
sharpening and noise reduction in the Effects tab, or the Resize module, if you wish to sharpen for output. 

Using NoNoise AI

To get started, click on the NoNoise AI tab in the Noise & Sharpening pane. When you click on the NoNoise 
AI tab, Photo RAW analyzes your image and applies ON1’s AI-driven noise-reduction technology, based on 
the contents of the image. NoNoise initially presents your image at 100% view, with a split screen 
displaying your original file on the left side, and the denoised version on the right (shown below). 

The advanced AI neural networks behind NoNoise AI work at the deep raw level. They are trained to detect 
and reduce the noise before the raw data is even converted to a photo, preventing noise from propagating 
further up in the image processing pipeline. As a result, NoNoise can clearly differentiate between what is 
noise and what are small details, helping to maintain sharper details and reduce false color.

When you open a raw image for processing inside NoNoise AI, the app will apply initial noise reduction based on the contents of the image 
and your noise-reduction preferences (High, Medium or Low). The image will be displayed at 100%, with a preview slider that can be dragged 
left or right (shown circled in red); the original image is on the left side of the slider, while the right side displays the denoised image with the 
current settings in the NoNoise AI tab.
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NoNoise AI automatically applies noise reduction based on the contents of your image and your preferred 
level of reduction, but you can adjust the amount of noise reduction and detail preservation—as well as add 
sharpening—to your taste, by adjusting the sliders in the Noise & Sharpening pane. The controls consist of 
two primary sections in the main section of the pane, and an action area on the top right side of the pane:

A.	Noise Reduction: This section adjusts the amount of Luminance (brightness) and Color noise 
reduction on the current image. Enhance Detail works to preserve details that would have 
been lost in traditional noise-reduction processes. Color is always set to 100, but the amount 
of Luminance reduction is set based on the image contents and your Auto settings level (see 
below). The Method pop-up offers four options: 2024, which is the preferred option for raw 
files; 2024 High Detail; 2023, the original NoNoise method, and 2023 High Detail, which is 
optimized for non-raw files. 

B.	 Sharpening: This adjusts the amount 
of sharpening applied to the processed 
image. The sole slider, Micro Sharpening, 
enhances small details in your image. 

C.	 Reset: The top button resets the tab to its 
default state. Click this if you would like to 
reset any changes you’ve made here. 

D.	Apply/Adjust: This button has two states: 
Apply (blue) and Adjust (red). Apply is the 
default state when you open the image: 
NoNoise has applied noise reduction, and 
you can fine tune the settings as you’d like. 
When you’re done, clicking the Apply will 
‘lock’ your settings in, changing the state 
to Adjust. To re-edit your settings, click 
Adjust, and the button will revert to Apply, 
with the current settings available.  

E.	 Auto On/Off: When you have applied NoNoise to an image with the default reductions 
settings, this button will read Auto On. If you adjust the Luminance slider, the button will 
change to Auto Off, meaning that the slider has been adjusted from the auto value. Clicking 
the button in this state will return the Luminance setting to its original value.

NoNoise’s Default Noise-Reduction Settings

We know that noise reduction is as much about personal taste as it is about technology. Some people 
prefer a light touch, while others like a much more processed result. In Photo RAW’s Preferences, you can 
configure NoNoise AI to use one of three 
automatic noise-reduction settings—Low, 
Medium or High—when you click on the 
NoNoise AI tab (or Both). This setting 
only affects the Luminance slider; the 
Color slider’s default is always set to 100, 
the Enhance Detail’s default setting is 50, 
and the Sharpening Amount is 20.

The default Auto setting is High, but you 
can change it to Medium or Low in the 

Photo RAW’s General Preferences pane has an option to configure NoNoise AI’s automatic 
noise-reduction settings—to Low, Medium or High—based on your taste. The default is High.
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General tab of Photo RAW’s Preferences window; choose the desired setting in the NoNoise AI Default 
pop-up at the bottom of the window.

Our recommendation would be to play around with a group of representative images from your library, 
looking at the types of noise reduction that work best for you, and then change your setting to the range 
that you like best.

Fine Tuning the Image

Work the Noise Reduction section of the NoNoise AI pane first, if you need to. When thinking about 
adjusting the noise reduction amounts, detail enhancement and sharpening, use the Preview window at a 
zoom level that lets you see the important details, and use the Hand tool to move you around the image. 
Then, work with the Luminance and Enhance Detail sliders to zero in on the best look. 

A good methodology, especially as you are getting to know the app and its settings, is to set the Luminance, 
Detail Enhancement, and Sharpening all to zero. Then start by adjusting the Luminance slider up, examining 
an area that has both detail and smooth areas. Adjust the Luminance until you see the desired amount of 
noise reduction in the smooth areas. Depending on your tastes, this will usually be in the 80 to 100 range.

Next, increase the Enhance Detail slider until you have the desired amount of enhancement. Values 
between 20 and 50 are common. High amounts on this slider may bring back some noise in the smooth 
regions, so you may need to balance how much you use by comparing high-detail and low-detail areas. 

Last, adjust the Sharpening Amount in the same fashion as the Enhance Detail slider. Values between 20 
and 50 generally give the best results. 

If you want to apply sharpening to the image, make sure you’re working at 100% or higher, so you can see 
the results of the three sharpening controls. Watch out for halos generated from oversharpening, and use the 
Threshold slider to keep large, smooth areas from getting sharpened; the higher the Threshold amount, the 
more your sharpening is focused on edge detail. Typically, a Threshold setting of 2-4 will give the best results.

When you’re done with NoNoise AI, click the Apply button to lock the settings. 

NOTE: Because NoNoise AI works best at the raw image level, we recommend 
that you process your images in NoNoise before you apply basic editing 
(exposure, color balance, etc.) or finish editing. Ideally, you want to work with 
the raw data as much as possible. Use the High Detail option (in the Method 
pop-up) when processing non-raw files, even high-resolution, 16-bit formats 
like PSD files or TIFFs.
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Using TackSharp AI

The TackSharp AI tab is much simpler than the NoNoise tab, consisting of two sliders and a method option:

A.	The TackSharp AI Model has 
two options: 2024, which is the 
(default) preferred setting, and 
Original, which was NoNoise’s first 
sharpening algorithm.

B.	 The Tack Sharp AI Deblur slider 
is designed to enhance focus and 
reduce motion blur. The default 
setting is 100; in most cases, you 
shouldn’t have to touch the slider, 
but feel free to do so if you feel that 
the sharpening is too aggressive.

C.	 The Micro Sharpening slider is identical to the one found in the NoNoise AI pane. It is 
designed to enhance the small details in your image. This slider defaults to 100; as you adjust 
the slider, zoom in to an area with small details, like hair or feathers, and pay attention to the 
effect. A little bit can go a long way. 

D.	Reset: The top button resets the tab to its default state. 

E.	 Apply/Adjust: This button has two states: Apply (blue) and Adjust (red). Apply is the default 
state when you open the tab. When you’re done, clicking the Apply will ‘lock’ your settings in, 
changing the state to Adjust. To re-edit your settings, click Adjust, and the button will revert 
to Apply, with the current settings available.  

When you open a raw image for processing inside TackSharp AI, the image will be displayed at 100%, with a 
preview slider that can be dragged left or right; the original image is on the left side of the slider, while the right 
side displays the sharpened image with the current settings in the TackSharp AI tab.
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Using both NoNoise AI and TackSharp AI together

The Both tab in the Noise & Sharpening pane is designed for those times when the lack of sharpness and 
increased noise are an issue in a photo. By applying both NoNoise and TackSharp technologies to your  
image simultaneously, you can work to achieve the right balance between the two. 

When working in the Both tab, the only difference you’ll find is that the Micro Sharpening slider is listed 
in the TackSharp section of the tab and is not available in the NoNoise section. Otherwise, it functions 
identically to the individual tabs. 

LENS CORRECTION

The Lens Correction pane uses the lens metadata embedded 
in a photo and searches Photo RAW’s internal lens database 
for an appropriate profile. If found, the profile will be applied 
automatically, reducing distortion, color fringing (chromatic 
aberration) and peripheral fall-off. You can also make your own 
manual lens-correction adjustments, if you prefer.

Photo RAW detects embedded lens profiles in modern lenses 
from Panasonic, Fujifilm, Canon, Nikon and Sony. The lens 
database also has hundreds of profiles for many third-party 
lenses from companies like Tamron, Sigma, Tokina, Zeiss, 
Voigtländer and others. It will automatically apply a profile when 
the camera and lens models are from the same manufacturer. 

When working with third-party lenses and your specific camera, 
you can use the Lens Profile section of the Lens Correction pane 
to find the appropriate lens profile from the database and apply 
it to your image. When you do this, you will be asked if you wish 
to apply this lens profile to any other images for that lens. If you 
say yes, the profile will be saved as a custom style in the Lens 
Correction pane, and will be applied automatically every time 
Photo RAW sees this combination.

If Photo RAW doesn’t have a built-in profile for your lens, it will 
automatically attempt to correct the image in real time, based on a comparison between the embedded JPG 
of the raw image and the raw data itself. In this case, there is no need to save the correction as a style—if 
you feel that this representation is accurate. If it needs 
tweaking, you can further adjust the correction in the 
Manual section of the pane (see below), and then save 
the correction as a style and apply it to other images 
taken with that lens and camera combination. (They will 
not be applied automatically, however.)

Applying Manual Lens Correction

To apply your own lens correction to a photo, click on 
the Manual triangle at the bottom of the pane and choose the manufacturer of the lens (or the camera 
make, if you don’t have that). The Manual section lets you adjust the following parameters:

The Lens Correction pane, with the Manual section 
expanded. Most of the time, when you’re working with 
standard lenses, Photo RAW will automatically apply the 
correct lens profile. The Manual section of the pane lets 
you further adjust distortion, color fringing strength and 
light fall-off, if you so desire..

When you pair a camera with an existing lens profile from a 
third-party lens manufacturer, Photo RAW will ask if you would like 
to use that profile on an all images than have this camera-lens 
combination. 
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• Pincushion (where lines in a photo curve inward) or barrel (lines curve outward) distortion;

• Purple or green color fringing that might occur along edges in an image shot with that lens/
camera combination; and

• The light fall-off (vignetting) that can occur at the outer edges of a lens at certain focal 
lengths or aperture. Once you’ve adjusted the sliders as needed, choose Save New Style from 
the Style pop-up to use this profile on other lenses. 

NOTE: Lens corrections are applied automatically inside Photo RAW, but you 
can turn this setting off via Default Processing section of the Preferences’ 
File tab (see page 294). If you have this setting turned off and wish to apply 
corrections to an image, you must enable the Lens Correction pane in the 
Develop module.

A list of the currently supported lens profiles can be found on the ON1 support website, via this link.

TRANSFORM

Transform applies perspective correction to your image, and offers 
rotation and scaling options as well. You can use these settings to 
make small adjustments to perspective or distortion.

The four tools at the top of the pane let you apply specific 
transforms to the current photo:

• Keystone corrects perspective in both horizontal and 
vertical projections. This type of effect is often used 
to help adjust the perspective in architectural photos. 
This option puts a box with four handles at the corners. 
Alight the handles along straight vertical and horizontal 
lines, and click on the Apply button at the box’s center.

• Horizontal and Vertical correct perspective in their 
respective projections (side-to-side and up-and-down).

• Level works in a similar fashion to the one found in the 
Crop tool (found on page 97). Click and drag across an element that should be level.

Keystoning can be helpful when you want to adjust the perspective in a photo; just adjust the four corners 
to align with an object that should have parallel lines, like a window or door, then click the Apply button. In 
addition to the above tools, the following options will apply specific transform operations:

• Amount: Works like a fade/boost slider, proportionally moving all the pane’s sliders back to 
zero when moved to the left, or boosts them proportionally when moved to the right.

• Vertical: Adjusts the vertical perspective.

• Horizontal: Adjusts the horizontal perspective.

• Rotation: Rotates the canvas up to 45° clockwise or counterclockwise.

https://on1help.zendesk.com/hc/en-us/articles/4409706974733-Supported-Lens-Correction-Profiles-ON1-PHOTO-RAW-2022-5
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• Scale: Scales your image up from the center, to 100%.

• Aspect Ratio: Stretches your image horizontally when you move the slider to the left or 
vertically whe you move it to the right.

• Skew: Slants the image horizontally or vertically without rotating or scaling.

The Grid pop-up menu at the bottom of the Transform pane lets you displays a grid overlay while you are 
adjusting the pane’s sliders. The default for the pane is No Grid, but you can also choose between 10% 
(large), 5% (medium) or 1% (fine) grid settings.

When you click Apply with any of the tools, or when you adjust the sliders, Photo RAW scales the photo 
inwards , so that the adjusted result fits within the photo’s original aspect ratio.

The Transform tool works best most of the time in small amounts. It’s not necessarily going to fix a photo 
with an extreme perspective, but it can often help with slight adjustments, especially if you fine-tune them 
with some of the Transform panel’s other controls or the Manual section of the Lens Correction panel. In 
addition, the tool does not apply a crop after an operation; if you are happy with the transform results, use 
the Crop tool to finish your work.

The Transform pane’s Keystone option can help with perspective issues in a photo. Clicking the Keystone icon gives you a box that you can use to align the four 
corners of an object that should have parallel lines (above left). Once you have the edges of the object aligned, click the Apply button in the center to create the 
transform, and apply a crop as necessary. (Sometimes, you’ll find that using the manual section of the Lens Correction pane can help reduce some of the distortion 
that the Keystone operation can create.)
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CREATING AND ADDING CUSTOM CAMERA PROFILES

As noted in the section on the Tone & Color panel (page 150), you can create your own custom camera 
profiles and import them into Photo RAW. Custom camera profiles can help improve the fidelity of color 
reproduction in your photos, and for some photographers, this can be a useful tool. 

To build a new profile, you’ll require a color profiling target and special software that creates the profile. 
ON1 worked with X-Rite Inc. during the development process to create a workflow that helps ease this 
process and ensure consistent results when building camera profiles. In addition to ON1 Photo RAW 2026, 
you’ll need a reference target, such as one of the ColorChecker series, and X-Rite’s ColorChecker Camera 
Calibration app, which is a free download for owners of the X-Rite color targets. \

The process for creating a custom profile is as follows:

• Turn off automatic white balance on 
your camera; set it to the lighting 
conditions—daylight, tungsten, flash, 
fluorescent—in which you are shooting 
the target.

• Place the color reference target in the 
center of your scene, with even light. 
Take the photo.

• Open the photo in Develop.

• In the Camera Profile section of the 
Tone & Color panel, choose the Linear 
Raw profile from the pop-up.

• Click on the dropper icon in the Color section of the Tone & Color panel (see page 151), and 
click on one of the light gray patches in the target. This will neutralize the image.

• Using the Export feature, export your photo as a TIFF, selecting the Camera Calibration color 
space from the pop-up under the file 
type option. (See page 253 if you 
need help with exporting photos from 
Photo RAW.) 

• Using X-Rite’s ColorChecker Camera 
Calibration software, open the 
exported TIFF. The app should find 
and align the target; if so, click the 
Create Profile button, and save the 
exported profile. If it doesn’t find the 
target, follow the guidelines in the 
software to help improve your chances 
with a new photo.

• In Photo RAW, go to the Develop module with a photo created with the camera you profiled. 
In the Tone & Color panel, click on the Import Profile item in the Camera Profile pop-up 
menu. Find the exported profile and choose Open. Your profile is now installed.

When you open the photo with the color target, set the camera profile to Linear 
Raw, and use the gray dropper to neutralize the photo, by clicking on one of the 
light gray targets (circled, above).

Using X-Rite’s ColorChecker Camera Calibration app, you can open the exported 
TIFF file, and create your own custom camera profile. Then, import the profile via 
the Camera Profile pop-up in Develop to use it with any photos taken with that 
camera.
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LOCAL ADJUSTMENTS
The Local Adjustment module uses Photo RAW’s extensive 
masking capabilities to create localized editing adjustments to 
portions of an photo. You can create these adjustments with 
any of the single-click masking options (Subject, Background, 
Sky, Depth and Luminance); with the Super Select AI tool or 
any of the dedicated masking tools; or Mask AI region selection 
feature. 

In addition, the Develop module’s Brilliance AI can create 
region-based local adjustments that are fully re-editable in the 
Local tab (see “Brilliance AI” on page 148 for more). 

You can create as many local adjustments as you need on an 
image by clicking in the Add Adjustment section at the top of 
the Local Adjustments panel. 

Local adjustments can be used to apply a gradient filter to 
darken a sky, for example, or to add a more complicated 
vignette to an image. Local adjustments are in essence a 
mask that is applied to a portion of your image, and you can 
manipulate those masks in powerful ways with both the 
blending modes and the luminosity options in the Local tabs.

Operations you can perform with local adjustments include 
tone (exposure, contrast, highlights and shadows, detail), color 
(white balance, saturation and vibrance) and detail (structure 
and noise). Each local adjustment layer can have completely 
different settings and work on different parts of your image. 
You can also use local adjustments to paint with color over part 
of a photo, to perform specialized tasks such as skin retouching 
or to replace the color of an object. 

Like the rest of the Edit module, local adjustments are 
independent from the Develop, Effects, Sky Swap and Portrait 
tabs; you can create a local adjustment while working in 
Develop, switch to Effects, and when you click back on the 
Local tab, your local adjustments remain intact.

CREATING LOCAL ADJUSTMENTS

To create a local adjustment, click on any of the icons in the 
Add Adjustment section of the Local tab. While the icons in 
this section look different than those in the Masking Properties 
window, all of the mask-creation options in that window are 
present in the Add Adjustment section or via the More menu. 



ON1 Photo RAW 2026 User Guide	 Part 3: Working in the Edit Module	 163

NOTE: For complete information on using the Masking Properties window to 
create and adjust masks, see page 126.

At the top of each adjustment pane is an Opacity slider, which sets the opacity of the adjustment. The 
Styles section has a number of canned styles for you to start with, including ones for lightening or 
darkening (dodging and burning), adding vibrance, fixing teeth or red eye, and many more. (You can also 
save your own styles via the More menu.)

The main section of the Local tab has all of the same options found in the Tone & Color pane in the 
Develop tab: Exposure, Contrast, Highlights, Shadows, Detail, and Color Temperature, Tint, Saturation and 
Vibrance. In addition to those settings, the local adjustment pane includes a Noise slider, designed to help 
reduce noise on a targeted level (most often seen in the shadows), as well as Structure and Haze sliders.

These controls work the same way inside the Local pane. Since a local adjustment is actually a layer that 
sits on top of your global adjustments, Photo RAW provides you with a number of blending options for 
each adjustment. Blending modes determine how the selected adjustment blend with the items below it.

TIP: You can name each adjustment layer by double-clicking on the word 
‘Adjustment’ in the pane. This can be helpful when you have a lot of adjustment 
layers and wish to remember which adjustment did what.

Click on the Blending tab in the Properties window to change the blending mode for the current 
adjustment:

• Blending Options: A pop-up list of blending 
modes. There are 24 common blending modes 
available in the list, including Normal, Screen, 
Multiply, Soft and Hard Light, and Overlay.

• Opacity: Sets the percentage strength of the 
blended adjustment, from 0% to 100%.

• Apply To: This lets you apply the blending mode 
to a specific color or tonal range. The options are; 
All (the default), Highlights, Midtones, Shadows, 
Reds, Greens, Blues, Magentas, Cyans, Yellows, 
Flesh Colors, Vivid Colors and Neutrals. (You can 
choose a color range by selecting the Dropper 
Tool and clicking on a color in your image.) 
 When you choose one of these options, the 
adjustment is only applied to the parts of the 
image with those ranges specified. The Range 
slider expands or contracts the selected option, 
and the Highlights, Shadows, and Skin sliders 
protect those settings from your adjustments.

For detailed information on how the various blending modes work, see page 175.
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Painting with Color

The Paint with Color option at the bottom of the local 
adjustment panel lets you use the Local Adjustment 
brush to select a color and paint it into your image. It 
is designed for two situations: when you wish to apply 
softening (or evening out) to portions of an image by 
blending existing color, and to replace the color of an 
existing object. 

The Paint with Color section has three options, Solid Paint, Replace Color, and Classic, and a color swatch 
for the chosen color. You can choose a color from your image by clicking on the eyedropper icon, or you 
can click on the swatch and choose a color from the system color picker. 

Solid Paint will paint over anything you brush with the chosen color; think of it as painting with a Normal 
blending mode. Replace Color will replace the hue, but not the luminosity, of the color you are brushing 
over; it is essentially painting with a Color blend mode, in which whites are preserved. 

The Solid Paint option is an ideal skin softening tool; use the eyedropper to select a midtone section of skin, 
and, using a low opacity setting, paint over parts of the skin with the brush. This option is also useful when 
you are using custom brushes to add overlays to a photo. See “Using Custom Brushes to Add Overlays” 
below for more on this.

CREATING LOCAL ADJUSTMENTS WITH THE SUPER SELECT AI TOOL

Photo RAW’s Super Select AI tool can also be used — from any tab in the Edit module — to select a region 
in a photo, apply a preset local adjustment style, and open it in the Local tab. For detailed information on 
the Super Select AI tool and how it works, see page 102.

USING CUSTOM BRUSHES TO ADD OVERLAYS TO PHOTOS

One specialized use for local adjustment layers and the Paint With Color’s Solid Paint option is to add 
overlays with custom brush shapes. You can paint in stamps, watermarks, and other shapes to create 
specialized creations or enhanced photos. For example, you could use a custom cloud brush to add interest 
to a lackluster sky, or you could create your own watermark and apply it precisely. Photo RAW comes with 
a collection of custom brushes of all kinds, and you can import any black-and-white TIF file or Photoshop-
compatible brush file (.abr) for use in the app, via the Extras Manager (see ”Extras” on page 10).

Creating basic overlays with a custom brush is easy:

1.	 Create a new, blank local adjustment layer by clicking on the Brush icon in the Add 
Adjustment section.

2.	 Choose a new brush from the Shape menu in the options bar.

3.	 Set the brush size and angle. In general, you’ll want to keep the Opacity and Flow high, and 
the Feather low (or 0), but that will depend upon the brush and the application.

4.	 From the gear menu, turn the Manual Spacing option on. Depending upon the brush type 
and the application, you’ll have to play with the Amount slider, but the general rule of thumb 
is, for stamped brushes, where you wish the shape to be applied singly, set the spacing 
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low. If you wish to apply the brush multiple times with a stroke—and have clear definition 
between the brush shapes—set the spacing higher (see the spacing chart below for an 
illustration of the different settings).

5.	 Turn the Paint With Color option on and set to Solid Paint. Choose a color for brush, and 
paint as desired on the image.

Tips for using custom brushes

• The best way to begin working with brush overlays is to practice. Use some of the default 
brushes, and play with them by adding them to a photo or blank canvas.

• Use the Brush Styles option (in the Tool Options bar) to save your favorite brushes and their 
optimal settings.

• The maximum brush size in Photo RAW is 2500 pixels.

• If you’re applying a brush as a single stamp here and there on a photo, start with a feather of 
0, and Opacity and Flow set to 100. Once you’ve set your brush size and angle, click once on 
the image.

• The Paint With Color option applies to all brush strokes made on that adjustment layer. You 
can easily change the color via the color patch in the panel. If you want to apply the same 
stamp with different colors, create a new adjustment layer for each color.

Using custom brushes, available via the Brush Shape pop-up in the Adjustment Brush’s Tool Options bar, you can easily add realistic shapes as overlays to 
your photos.
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This chart shows the effect of the Manual Spacing on a brush stroke for a star custom brush. With a spacing of 100, as 
you stroke, the stroke will be applied with plenty of space between the brush shape. With a spacing of 0, the shape will 
meld together as you apply the stroke. Depending upon the brush type, this might be acceptable for your purposes.
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STYLIZING WITH ON1 EFFECTS

If Develop is the base from which you start editing your photos, Effects is the finishing school. With 37 
filters that can be stacked in any order, and with extensive blending and masking options, Effects lets 
you create stunning, pro-level photos with ease. And, since it is built upon ON1 Photo RAW 2026’s non-
destructive editing engine, you can go from Browse to Develop to Effects and back again, preserving your 
edits, masks and more without having to worry about saving multiple versions of your files.

While Develop and Effects share the same tools, Effects is much more customizable in how adjustments—
called filters in Effects—are applied. The editing stack inside Develop is fixed, while the stack in Effects is 
extremely flexible. Here are just a few of the things you can do with an image in Effects:

• You can add filters in any order (even multiple instances of the same filter).

• Move filters up and down in the stack.

• Use blending options with all or some of the filters and set the opacity of each filter 
individually.

• Selectively apply a filter to specific portions of an image by creating complex masks using any 
of Photo RAW’s masking tools, including the AI-based tools like the Super Select AI or Quick 
Mask AI tools. Or, you can use ON1’s innovative Mask AI technology to create masks directly 
from within the Add Filter window.

In addition to creating and using presets, you can copy and paste Edit module settings from one file to 
another, or alternatively, synchronize the edits on one photo to a group of photos. These operations can 
all be performed in any of the editing modules, as well as in Browse, adding to ON1 Photo RAW 2026’s 
extreme flexibility. (See “Copying settings and synchronizing edits” on page 140 for details on how to 
copy edits between photos.)
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Effects Starting Points
New in Photo RAW 2026’s Effects module is Starting 
Points, which are a default starting preset that lets 
you jump right in with a set of filters that you use 
often, those that ON1 recommends, or ones that 
mimic editing in apps like Adobe Lightroom Classic 
or Capture One. In most of the starting points, the 
filters start as off; you only need to turn on the 
ones you want to use. You can also create your own 
starting point presets and switch to them based on 
your needs.

The Starting Points pop-up menu is accessed on the 
right side of the Effects tab, underneath the master 
Opacity slider. Starting points are sticky, meaning 
that, once you select an item from the pop-up menu, that starting point will be invoked the next time you 
open a photo and switch to the Effects module. By default, the menu is set to Blank, which means that 
there are no preset filters in the Effects stack. The menu also includes three options from ON1, all of which 
start with a group of Effects filters turned off:

• ON1 Recommends: A group of eight filters that are often used by Photo RAW users.

• Lightroom: Filters that mimic Lightroom’s Develop panel, minus the Basic pane.

• Capture One: Filters that mimic Capture One’s basic editing functions. 

The Last Used menu item will add the filters from the last time you used the Effects tab with a previous 
photo. Using this option will inherit the previous photo’s filters, and unlike the other built-in starting points, 
Effects will leave the filters on, with AI masks intact. It will also incorporate any changes made in other Edit 
module.

Starting points let you have a default set of filters every time you open the 
Effectstab with a new photo.

The ON1Recommends and the Lightroomstartin points.
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The Other submenu lists all of your presets. You can select one from the menu to be the new starting 
point, but note that, if your preset also makes changes in the other Edit modules, those will be applied to 
subsequent photos. 

NOTE: When you select an item from the Starting Points menu, all of your 
existing filters will be replaced by the new menu option.

To create your own starting point similar to the three standard ones (ON1, Lightroom, Capture One), and 
one that affects the Effects module, you should set up the Effects stack with your chosen presets, turn 
them off (if desired) and then save them as a preset, making sure that you are only saving adjustments in 
the Effects module.

See “Presets” on page 133 for complete information on creating and managing presets in the Edit module.

To create your own starting point similar to the ones provided by ON1, set the Effects stack with the filters you use most often, in the order you prefer. Turn them off 
by clicking the control circle in the filter’s title bar, then chosse Save Settings as Preset, and make sure the preset is only applied to the Effects module.
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Filters
Filters are the building blocks of Effects’ editing power. Each filter is an adjustment type, much like the 
basic adjustment panes inside Develop, but Effects filters have much more functionality than the Develop 
panes. The Effects tab has 37 filter types, added either by the Add Filter button found at the top of the 
Effects tab, via the Filters pane on the left side of the window, or via the Super Select AI tool. You can 
apply filters in any order, and you can have more than one instance of a filter in the stack. This can be 
helpful when you are creating complicated masks on an image and wish to apply the same filter differently 
in parts of the photo. And, like everything else in Photo RAW, filters can be added, adjusted and removed 
easily, and they never change the base image that you start with.

Each filter is like a movable, editable layer over the base image you are working on. You can use Effects’ 
masking tools to apply a filter to only part of an image and can change the blending mode (and opacity of 
the filter) to alter the way the filter interacts with those above and below it in the stack. And, when you 
add a filter via the Filters window, you can use Photo RAW’s Mask AI technology to select a region in your 
photo and apply the filter to that area automatically — without using any of the built-in masking tools.

FILTER OVERVIEW

Each filter pane has a different set of adjustment options 
and controls, but every filter has the same five sections:

A.	Filter on/off button (left); Show/Hide Mask 
(right); Filter Name.

B.	 Displays blending mode options (left); Resets 
filter (middle); Deletes filter from the stack 
(right). [Note: This section is only visible when 
your cursor hovers over the filter.]

C.	 Filter opacity setting.

D.	Styles sections for filter-based presets.

E.	 Control area with that filter’s specific settings 
(dependent upon the filter chosen).

The section titles for Opacity, Styles and the filter 
control area are collapsible and expandable. Click the 
gray label to hide that section from the pane.

TIP: To reset the individual sliders in any of Photo RAW’s panes to their default 
setting, double-click the setting’s label or the slider’s handle.

Overview of a filter—in this case, the Cross Process effect.
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THE FILTERS WINDOW

If you click the Add Filter button at the top of the Effects tab, the Filters window opens up, with a list of all 
37 filters in the center of the window. The filters are grouped into four categories: Essentials, Creative, 
Landscape, and Legacy. The Legacy filters are older filters that are not often used, or have been superseded 
by more recent filters.

On the left side of the Filters window is the Mask AI pane, which lets you apply the filter with a region-
based mask. On the right side is the description field, which, when you mouse over a filter in the list, 
displays a before/after thumbnail of the effect, a short description, and a list of keywords that relate to that 
filter. If you’d like to have a smaller window, you can independently turn off the legacy filters section and 
the description section by clicking the ‘hamburger’ menu on the right side of the window.

Next to each filter is a small heart icon; clicking this makes it a 
‘favorite’ filter. To view only those filters, click the heart icon in the 
search field at the bottom of the Filters window.

Adding filters

To add a filter, click once on the filter name, and it will add it to 
the stack, above the current filter. If there aren’t any filters in the 
stack, the new filter will be at the top of the stack. You can click 
and drag the title bar in any filter to move it up or down in the 
stack.

If you’re not sure what you might looking for, you can search for filters using keywords, like “monochrome,” 
“contrast,” “sharpening,” and so forth. Photo RAW will then narrow down the search to those filters that 
match your search terms.

If you’re not sure what you might looking for, you can search for filters using keywords, like “monochrome,” 
“contrast,” “sharpening,” and so forth. Photo RAW will then narrow down the search to those filters that 
match your search terms.

When you click on the Add Filter button in the Effects tab, Photo RAW displays the Filters window, which consists of the Mask AI controls 
(left), the list of filters (center), and a description (right) of the filter your cursor is currently hovering over, with a sample preview (including a 
before and after split view).

To reduce the size of the Filters window, you can 
independently turn off the Legacy filters and 
Description sections, by clicking the menu on the right 
side of the window..
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ADDING FILTERS WITH THE FILTER BROWSER

In addition to the Presets panel found 
throughout the Browse and Edit modules, 
Effects has an additional Filter panel on 
the left side of the screen. This panel lets 
you browse all of the filters inside Effects, 
and display previews of the available styles 
for that filter, and, if you hover your cursor 
over a filter style in this view, Photo RAW 
will display a preview of the filter style’s 
application in the main window. 

To choose the Filters panel, click on 
the Filters tab. A list of the filters will 
appear, and clicking on a filter will display 
thumbnails of your image with that filter’s 
available styles. To choose one, click on the 
style, and Effects will add that filter to the 
Overall Settings pane. Note that this will 
replace the currently selected filter in the 
stack; to add a new one on top of the stack, 
click the Add Filter button at the top of the 
Effects tab on the right, then choose a filter 
from the list. (You can also click and drag 
the title bar of any filter and move it up or 
down in the stack.)

If you’d like to see a larger representation 
of what your selected photo will look like 
with a filter’s styles, click on the Quick View 
Browser icon in the category’s title bar (see 
the following page for a representation of 
the Quick View Browser). That will display 
a window over the entire Photo RAW 
interface with all of the presets in that 
category. (Press the Escape key to close the 
Quick View Browser.)

To change the size of the thumbnails in 
the filter styles panel, select the Browser 
Mode option from the View menu and choose One, Two or Three Column Thumbnail View. (If you choose 
Thumbnail from the Browser Mode submenu, the Filters and Presets panels will display as thumbnails.)

If you’d like help with what the different filter operations do, click on the Info button at the top right of 
the panel. With that button checked, when you hover over a filter, Photo RAW will display a small pop-up 
window containing the same description (with before/after thumbnail) found in the Add Filter window. 
Click the Info button again to turn off this display.

The Filter Browser has a list of all the filters available in Effects (left). Clicking on a filter 
will display thumbnails of the filter’s styles using your photo (right). And, when you move 
your cursor over a filter style, in the main preview window, Photo RAW will display a live 
preview of the filter applied to your current image.
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Searching for filter styles inside the Filter Browser

To search for styles inside the Filter Browser, type in the name you’re looking for in the search field at the 
bottom of the panel. The search results will appear in a new sub-folder called search results, which will be 
selected automatically.

Saving filter styles as favorites

If you hover over a filter style’s thumbnail in either the Filter Browser or 
the Quick View Browser, you’ll see a heart icon. Clicking the icon will fill the 
heart in and add that style to your Favorites category. This category resides 
at the top of the filter list, and contains all filter styles you have selected as a 
favorite. To remove a favorite, open the Favorites category, and click again in 
the heart icon.

To apply a filter style to a photo, simply click on the style in either the Filter 
Browser or in the Quick View Browser.

WORKING WITH FILTER PANES

By default, the filter stack is empty, although, if you have applied a preset that uses filters from Effects, you 
will see those filters in the stack. Clicking on the button in the top left corner of the filter pane will turn that 
effect on or off, which can be helpful if you want to see the effect in the context of other edits you have 
made. If you don’t like the effect, click on the ‘X’ icon in the pane’s title bar to get rid of it. The Reset button, 
which is next to the Delete button, represented by ‘⟲,’ will reset that pane’s settings to their default.

The Filter panel’s Quick View Browser option works identically to the one for the Presets panel: click on the icon to the right of the filter name, and 
Photo RAW will display the current photo with that filter’s styles applied.

A filter style that has been marked as a 
favorite will be displayed in the 
Favorites category.
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To move a filter up or down in the stack, click on the pane’s title bar and drag it up or down. A heavy white 
line will appear between panes as you drag; let go of the mouse at the location you wish the filter to go.

TIP: Each pane can be collapsed, by clicking in the pane’s title bar. If you don’t 
want to have to scroll up and down the filter stack when you have a lot of open 
panes, go to the Window menu and choose Solo Mode. This will leave the 
current pane open, and will hide all the other panes. Clicking on another pane 
will open that one and collapse the previous one.

STYLES

All of the Effects filters have a set of built-in styles in the 
top part of the pane. Styles are like preset adjustments 
for a pane: they provide a group of settings to help you 
get started in the pane, or to apply a specific effect.

You use a style by clicking on the style’s icon in the pane, 
and then can adjust the sliders as desired to get the right 
effect for your photo.

You can also save your own settings as a style. Simply click on the More icon 
on the far right side of the styles list for that pane, then choose Save New 
Style from the pop-up. Name your style, and it will then be added to the top 
of the More menu (see right). To apply a saved style, choose the style from the 
More pop-up menu. To adjust the settings for a saved style, apply it, make any 
changes you would like to the sliders or other options, then right-click on the 
More pop-up and choose Update Style with Current Settings from the menu.

FILTER MASKS

Every filter has a mask associated with it, which lets you apply that filter’s effect to specific areas of an 
image, using the Masking Brush and Gradient Mask tools. By default, the mask is white, which means that 
the effect is visible in every part of the image. Using the Masking Brush, for example, you can ‘paint out’ 
the effect in areas that you wish not to be affected by the filter. Alternatively, you can invert a filter’s mask 
and choose to ‘paint in’ the filter where you would like it to be.

When you add a filter, the mask is technically hidden until you use one of the masking tools to create one, 
or when you use the Mask AI section of the Masking tab in the Properties window or in the Filter Browser 
(see “Using Mask AI to select regions” on page 127 for more).

Photo RAW has two options for viewing the contents of a mask: either as a red overlay on top of your 
image (the default) or a view only of the mask itself, represented as grayscale. These options are available 
from the Mask menu; select Show Mask to see the mask, while the View Mode option lets you switch 
between the two modes. To display the current filter’s mask, press the ‘O’ key; to turn it off, press the key a 
second time. 

Styles for the Split Tone filter.

Saved styles appear at the top of the 
More menu.
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For a full description of the masking options in the Masking Properties window, see “Mask Options and the 
Refine Mask menu” on page 128. For more details about creating and manipulating masks in Photo RAW, 
see “Masking Basics” on page 124; information on the masking tools starts on page 102. 

DELETING A FILTER

You remove a filter by selecting it and pressing the ‘X’ icon in the top right area of the filter’s pane.

FILTER OPACITY

Every filter has an opacity setting, which effectively adjusts the strength of the filter. The Opacity slider, 
which is found at the top of each filter’s pane, ranges from 0 (no effect) to 100 (full effect). What this 
means is that at 100, all of the filter is applied to the image in the stack. At 50, the filter strength is half, and 
the effect is much less strong. Playing with a filter’s opacity can often help soften an effect in a way that 
you wouldn’t be able to get otherwise.

For example, if you add a Black & White filter to an image, but would like a faded, muted color effect, 
reduce the opacity of that filter. The more you reduce the opacity, the less effect the filter will have.

By default, when you add a filter, the opacity will be set to 100. You can create presets, however, with 
whatever opacity you wish for a given filter.

BLENDING MODES

In addition to opacity, you have one other very powerful option 
for adjusting the strength and effect of a filter: blending modes. 
Blend modes determine how a filter interacts with the filters below 
it in the image stack. Blend modes can darken or lighten an image, 
depending upon the mode chosen, while others adjust contrast or 
color. ON1 Photo RAW 2026’s blend modes also let you apply a 
blend mode to specific colors or tones in your image, making them 
a very useful tool for precision editing of your images. You can 
apply sharpening, for example, only to the midtones in an image, 
which can be very helpful in a landscape image.

To see the blending modes, click on the gear icon at the top right 
of the filter’s pane (this is hidden by default, but displays when 
you hover over the pane). This will open the Blending tab in the 
Properties window. The blending option controls are:

• Blending Options: A pop-up list of blending modes. 
There are 24 common blending modes available in the 
list, including Normal, Lighten, Darken, Screen, Multiply, 
Soft Light, Hard Light, Overlay and Color.

• Apply To: This lets you apply the blending mode to a 
specific color or tonal range. The options are; All (the default), Highlights, Midtones, Shadows, 
Reds, Greens, Blues, Magentas, Cyans, Yellows, Flesh Colors, Vivid Colors and Neutrals. (You 
can also manually choose a color range by selecting the Dropper Tool in the pane and clicking 
on a color in your image.)

The Blending tab of the Properties window lets you 
set the blending mode, opacity, and what tones or 
colors the blending will apply to . You can also protect 
highlights, shadows and skin tones from the blending 
actions.
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• The Protect sliders help protect highlight, and shadow areas and skin tones from the 
application of the blending mode.

When you choose one of the options in this menu, the adjustment is only applied to that part of the image 
that is based on the lightness, hue, or saturation range specified. The Range slider expands or contracts the 
selected option, and the Highlights, Shadows, and Skin sliders protect those settings from your adjustments.

How blending modes work

At their basic level, blend modes determine how 
the pixels on one layer interact with the layers 
below it. With 24 blend modes in ON1 Photo 
RAW 2026, it might be difficult to know which 
ones to use in any given situation, but they can 
easily be grouped into Normal (the default mode) 
and five categories: Darken, Lighten, Contrast, 
Comparison, and Color/Luminosity. 

Normal is the most widely used: it simply applies 
the effect to all of the pixels in the adjustment 
(or effect), assuming the layer opacity is 100%.

The other modes apply different levels of that 
category’s effect using various mathematical 
formulas, and sometimes it can be hard to know 
which mode will work best with what photo. 
Most often, when you know how you want to 
apply an effect —by darkening, for example—
you’ll need to perform a bit of experimentation 
with the different modes in that category to determine which mode works best.

MASTER OPACITY, BLENDING AND MASK OPTIONS

Effects also has master opacity and blend mode options for the 
entire filter stack, and includes a Master mask option. The Master 
Opacity slider, found below the Effects tab, controls the strength 
of the composite filter stack against the original image—if you 
haven’t performed any other editing operations on it—or against 
the image as it has been adjusted inside the Edit module.

The Master Blend Mode options can be accessed via the gear 
icon at the top of the Edit tab. Clicking on it opens the Properties 
window. It has the same blending options found in the individual 
filter panes.

To create a Master mask, click on the mask icon next to the Save 
Preset icon in the Edit tab. This mask works on the entire effects stack. Note that this master mask does 
not have Mask AI options pop-up found in the individual filters.

In addition to masking, opacity and blend mode op–
tions for each filter in the Effects stack, you can set 
the opacity and blending modes for the entire stack. 
You can also create a master mask  for the entire 
stack.
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Filter Types
Effects has 33 filter types available for you to use inside ON1 Photo RAW 2026. Each filter has a set of 
styles in the top row, providing a range of popular or useful options for using that filter. You can also save 
your own preset styles by clicking the More pop-up at the end of the Styles row. 

TIP: The blending mode options (gear icon), reset and delete filter icons are 
hidden by default. Hovering your cursor over the filter in the Effects stack will 
display those options. Also, you can collapse or expand the various sections in 
a pane by clicking on the section label. See page 170 for an explanation of the 
various sections in an Effects filter.

ANTIQUE

The Antique filter gives your image an aged look; unlike the 
Vintage filter, this filter focuses more on a monochromatic or hand 
colored look.

• Color: Displays a list of color options that are similar in 
tone to the Split Tone filter, providing a duotone-style 
effect.

• Brightness: Adjusts the overall brightness of the image.

• Fade: Adds a white fill to the image, giving the illusion of 
a faded photograph.

• Saturation: Adjusts the color saturation. Moving the 
slider to the left decreases the saturation; moving it to 
the right increases it.

• Film Grain: Amount controls the strength and size 
dictates how large the grain appears.
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BLACK & WHITE

This pane is used to turn a color image into a monochromatic 
image, and, includes additional toning features. The styles at the 
top of the pane represent different filter types often applied to an 
image, while the Auto button selects the black and white points of 
your image automatically. To manipulate the tones manually, move 
the color range sliders to the right (increasing brightness) or the 
left (decreasing). Alternatively, you can choose the Channel Mixer 
option from the Conversion pop-up, and use the slider to choose a 
look that accentuates the color tones you are most interested in.

To change the tones directly inside a photo, choose the Color 
Response tool in the pane: click on it to select the tool, then click 
and drag in the image to increase or decrease the brightness of the 
selected color range.

Tone

The Tone section of the Black & White pane lets you adjust 
brightness, contrast, highlights and shadows, whites and blacks, 
and detail directly within the filter pane.

Toner

The Toner section of the filter is designed to approximate many 
traditional and popular darkroom-based paper toners, from sepia 
tones to platinum, selenium, coffee and more. You can choose 
from more than 20 toning options via the Type pop – up menu, 
and adjust the combination of paper (which is represented by 
the Highlights section of the pane) and silver (represented by 
the Shadows). To tune your options, you can adjust the Hue or 
Amount of each setting, and use the Swap tones icon (next to the 
Highlights color well) to swap the highlights and shadows colors. 
The Preserve Whites and Blacks button keeps the pure whites and 
pure blacks neutral, instead of taking on the color of the toner.

Film Grain

The last section of the Black & White pane is Film Grain, which, 
like the Toner section, is designed to add a classic film grain look 
to your photos. To add film grain, choose from the drop-down list 
of popular black and white films. The Amount slider controls the 
strength of the effect, while the Size slider adjusts the scale of the 
grain.
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BLEACH BYPASS

This filter is based upon an old color film processing technique 
where the bleaching step was skipped. It reduces the saturation 
and increases the contrast.

• Amount: Controls the strength or amount of the bleach 
bypass appearance.

• Brightness: Adjusts the overall brightness of the image.

• Contrast: Increases or decreases the global contrast.

• Detail: Enhances the details by increasing the micro 
contrast.

• Saturation: Adjusts the underlying saturation.

• Tint: Choose a new color by clicking in the color icon or 
by using the Hue slider.

• Amount: Adjusts the strength of the tint.

BLUR

This filter has five options for adding blur to your images: Gaussian, 
Motion, Radial, Surface and Box. Each blur has its own look:

• Gaussian: This is a simple Gaussian blur applied to your 
image. It has one slider, Amount, which controls the 
strength of the blur by adjusting the radius.

• Motion: This adds the appearance of movement.

• Amount controls the strength of the blur, 
Distance controls the blur relative to the subject 
and camera. Angle sets the blur angle, Smoothing softens lines created by the motion.

• Radial: These blurs are circular, zooming out from a central point.

• Amount controls the strength of the blur. Quality controls how noisy the blur is, with 1 
being grainy and 100 smooth. Smoothing softens the lines created by the motion.

• The Radial blur type includes a center spot selector at the bottom of the pane. Click on 
the icon, then click on the part of the image you want to make the center of the blur.

• Surface: These blurs preserve edges while blurring the rest of the image. This blur type can 
give you a “simplified” effect. The Amount slider controls the strength of the blur, while 
Threshold sets how similar colors are grouped.

• Box: A Box blur is similar in concept to a Gaussian blur, but it bases the blur on contrasting 
edges. Box blurs tend to retain edges a bit more clearly than Gaussian blurs.

NOTE: Do not use the Opacity slider when trying to reduce the strength of a 
blur; use the Amount slider instead.
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BORDERS

ON1 Photo RAW 2026 has a large collection of pre-made borders 
and edges that you can add to your photos. These borders range 
from classic film borders to viewfinders to artistic effects to 
emulsion transfers and many more.

The Borders filter also has an extensive set of controls for 
manipulating the size, color, and blending mode of the borders you 
choose.

You can also import your own borders, either directly into the 
Borders filter pane, or via the Extras Manager (available in Browse). 
Border files need to be a standard PNG file type with a large 
central transparent area

The Category and Border pop-ups at the top of the pane are used 
to select the border category and the specific borders within each 
category. There are 8 built-in categories, sorted by type. Any user-
imported borders will also appear in this list.

Once you have chosen a border to add, you can adjust its blending 
mode and opacity, and, if the border has color, you can adjust its 
hue, saturation and brightness. Alternatively, if the border is black 
or white, you can colorize it.

The Transform section at the bottom of the Borders pane lets you 
scale the border up or down in size, to help you get the look you’re 
after, and the Fit Image slider adjusts the size of the image under 
the border.

You can rotate or flip the currently selected border by clicking the buttons at the bottom of the screen.

NOTE: See “Extras” on page 10 for information on how to use the Extras 
Manager to import borders, textures and other extras, along with additional 
information for preparing files for the Borders and Textures filters.
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CHANNEL MIXER

The Channel Mixer filter adjusts the intensity and color of the 
individual red, green and blue channels in a photo. You can use it 
for black and white conversions, channel swapping for infrared 
shots, or to shift entire color ranges.

Click on the channel icons to select a specific channel, and use 
the Red, Green and Blue sliders to increase or decrease the pixel 
values for that channel. 

The Constant slider affects the luminosity of the currently selected 
channel. 

COLOR ADJUSTMENT

This pane lets you adjust specific ranges of color in your photos. 
The styles at the top of the pane are designed to help enhance 
specific scene types (Foliage, Fall, Desert, Sky).

In the pane underneath are color swatches for eight colors: red, 
orange, yellow, green, aqua, blue, purple and magenta. Clicking 
on one of the colors will let you adjust the hue, saturation and 
brightness of the selected color range. Other settings include:

• Range: This slider lets you narrow or widen the range of 
the selected color.

• Hue: Changes the hue for the selected color range.

• Saturation: Adjusts the saturation of the selected color 
range.

• Brightness: Adjusts the brightness of the selected color range.

You can also use the pane’s Targeted Dropper tool to adjust the hue, saturation or brightness dynamically. 
To do this, click on the tool and choose which parameter you would like to adjust. Then click in your image 
on a color you would like to adjust and drag the cursor to the left or right to decrease or increase the effect.
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COLOR BALANCE

This filter lets you adjust the colors in a photo’s highlights, 
midtones and shadows tones. This can be useful when you wish 
to color grade a photo, remove color casts from shadows or 
highlights, or to create duotone- or tritone-style images.

The tonal ranges are represented by color wheels. To adjust colors, 
click on the circle at the center of the specific tonal range you 
wish to adjust (Highlights, Midtones, Shadows) and drag the circle 
inside the wheel. The angle from the center represents the hue of 
the adjusted color, while the distance from the center of the wheel 
represents saturation. 

The slider underneath each wheel corresponds to the brightness of 
the tonal region.

On the outside of each wheel is a readout of the hue, saturation 
and brightness; it updates as you move the circle inside the wheel.

COLOR ENHANCER

The Color Enhancer is designed to give you complete control over 
color manipulation in your image, whether it is on a globally across 
your entire image, or by adjusting different color ranges. 

The styles at the top of the pane are designed to help enhance 
specific scene types (Foliage, Fall, Desert, Sky). To adjust global 
color in an image, work in the Color section of the top half of the 
filter pane; to work with individual color ranges, use the Color 
Range section at the bottom of the pane.

Color

The Color sliders in the top half of the pane control Temperature, 
Tint and Vibrance. They are used to remove a color cast and 
enhance the color of the image. The settings in this section of the 
Color Enhancer pane include:

• Auto Button: The auto button attempts to detect 
and remove a color cast. It makes adjustments to the 
Temperature and Tint sliders.

• Gray Dropper: Used to remove a color cast of an image. 
Click the icon to activate, then click on an area in the 
image that should be gray. The sliders will automatically 
adjust according to the sample you have selected.

• White Balance: This pop-up lets you change the white 
balance according to common color temperatures (As 
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Shot, Auto, Daylight, Cloudy, Shade, Tungsten, Florescent, Flash, Custom). The default is As 
Shot, the color temperature that the camera recorded when you took the photo.

• Temperature: This slider shifts the color either cooler (blue) or warmer (yellow).

• Tint: Shifts the color either green or magenta.

• Saturation: Increases or decreases the saturation of your image.

• Vibrance: Increases or decreases the color of muted tones, leaving more saturated colors 
alone.

• Reduce Vibrance on Skin: When turned on, adjustments made with Vibrance slider are 
reduced on skin colored areas. This allows you to increase the vibrance of clothing and the 
background without adversely affecting the skin color.

• Purity – Highlights: Reduces the saturation in the highlights.

• Purity – Shadows: Reduces the saturation in the shadows.

Color Range

In the Color Range section of the pane are swatches for eight colors: red, orange, yellow, green, aqua, blue, 
purple and magenta. Clicking on one of the colors will let you adjust the hue, saturation and brightness of 
the selected color range. Other settings in the pane include:

• Range: This slider lets you narrow or widen the range of the selected color.

• Hue: Changes the hue for the selected color range.

• Saturation: Adjusts the saturation of the selected color range.

• Brightness: Adjusts the brightness of the selected color range.

You can also use the pane’s Targeted Dropper tool to click on a section of your photo and adjust the hue, 
saturation or brightness dynamically. To do this, click on the tool and choose which parameter you would 
like to adjust. Then click in your image on a color you would like to adjust and drag the cursor to the left or 
right to decrease or increase the effect.

CROSS PROCESS

This filter simulates the effect of processing film deliberately 
with the incorrect chemistry. It creates unnatural colors and high 
contrast.

• Color: A drop-down list of cross-processing types (Blue, 
Green, Yellow, with Strong options).

• Amount: Controls the overall strength of the filter.

• Brightness: Adjusts the overall brightness.

• Contrast: Adjusts the overall contrast.

• Saturation: Adjusts the underlining saturation.
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CURVES

The Curves pane is a powerful—and advanced—tool for adjusting 
contrast, tone and color in your image. 

The main section of the pane displays the histogram of the current 
image in the background; the gradient behind the histogram is 
designed to give you a sense of how the tones will change as you 
adjust the curve. 

The center line is a linear representation of the image’s tonality, 
ranging from 0 to 255; the point at the bottom left represents the 
darkest tones in a photo (minimum of 0), while the point at the 
upper right represents the lightest tones in the photo (maximum 
of 255). By clicking along the line at the center of the pane and 
dragging it up or down you adjust specific tones by making them 
lighter (up) or darker (down). 

By default, the pane shows the composite RGB channel, but you can view and adjust each channel 
separately by clicking on the appropriate tab (Red, Green, or Blue). When looking at the individual channels, 
the background gradient will indicate what color shifts will occur when you adjust the curve. For example, 
raising the points on the curve in the Red channel will move the data more towards red, while lowering the 
points on the curve will move the data more towards green. 

Moving the line adjusts the tonality by adding control points along the line (turning the line into a ‘curve,’ 
hence the name):

• Inside the pane, clicking anywhere along the center line 
will add a point, and you can drag that point up or down 
to change the tones.

• You can also click on the Dropper tool to the left of the 
channel tabs, then click and drag inside the photo at a 
location where you would like to adjust the tonality. This 
adds a point at the precise tonal location on which you 
clicked.

You can add multiple control points to the curve, and readjust 
them at any time by clicking on the point in the pane. You can 
“slide” a point along the curve, or you can click and drag up or 
down. If you are familiar with numeric-based color values, you also 
click on a point and use the In or Out boxes to adjust the input or 
output values of the tones at that point. 

To remove a point, right-click on it and choose Remove Control Point. Note that there is always at least one 
control point selected.

Working in the individual RGB channels alters the tonality of each specific channel, but the adjustments 
are similar. To reset any curve adjustments made in a channel (or in all channels), right-click in the grid, and 
choose Reset Channel (or Reset All) from the menu.

The Style pop-up for the Curves filter has preset options, including settings for color negatives, matte-style 

Right-clicking on a control point gives you the option 
of removing that point. You can also reset curve 
adjustments made to one or all of the channels.
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looks, and more. If, for example, you regularly apply a classic S-curve to your photos, you could set the 
curve the way you like it, and then choose Save New Style from the pop-up. If you apply a style and make 
adjustments to it that you would like to save, select Update Style with Current Settings from the menu.

NOTE: The Curves section of the Tone Enhancer filter (page 197) operates in 
the same way as the Curves filter, with the sole exception being that there are 
no curve-specific style options available.

DEPTH LIGHTING

The Depth Lighting filter lets you easily darken or lighten the 
foreground and background in a photo, helping improve the 
definition between subject and background easily. 

When you add the filter, Photo RAW builds a depth mask of the 
photo. This lets you adjust the brightness of the foreground and 
background separately, as well as the temperature. 

The Foreground and Background sliders work independently of 
each other. Moving the Foreground slider to the right will increase 
make it brighter, while moving the Background to the left will make 
that area darker.

The Depth slider controls what is foreground and what is 
background in the scene; holding down the Alt/Option (Windows/
Mac) will display the depth mask ask you adjust the setting.

Transition essentially feathers the depth mask, which can improve 
the effect in some circumstances.

The temperature sliders can be used similarly to the brightness 
controls, but the settings are from cool (left) to warm (right).

TIP: Hold down Alt/Option (Windows/Mac) when adjusting the Depth and 
Transition sliders to show the mask overlay.
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DOUBLE EXPOSURE

The Double Exposure filter lets you make creative double 
exposures using your photo as a base image. It is similar in use to 
the Textures filter, in that you apply a second file that is overlaid on 
your photo, and then you use AI masks and blend modes to get the 
effect.

To get started, you can either import a photo of your own or select 
one from the Category and Texture menus. The Masking option 
defaults to no mask, but you can change it so the overlay masks 
the subject or the background. You can also set the overlay to be 
masked with either a standard depth mask, or an inverted depth 
mask. 

The Mode menu includes four blending mode options — Normal, 
Subtle, Darker, Lighter, Replace — to help you tune the final result, 
and Opacity determines how strongly the overlaid photo is applied. 

The Tone and Color section are used to adjust the brightness, 
saturation and hue of the overlaid photo, while the Position section 
lets you move the overlay with the Adjust Double Exposure target, 
scale the photo, and rotate or flip it.

The Background Adjustments section uses depth masks to brighten 
or darken the background area of the double exposure.

DYNAMIC CONTRAST

Dynamic contrast adds clarity—also known as tonal contrast—to 
your image, making it pop. It can be a strong effect, so it is often 
combined with masks to help lessen the effect in certain areas of 
an image (clouds in a sky, for example, often look surreal with too 
much Dynamic Contrast applied to them).

The top portion of the pane adjusts the contrast in areas of small, 
medium and large detail; moving the slider to the left decreases the 
contrast, while moving the sliders to the right increases them.

Because adjusting the contrast in extreme ways can affect an 
image’s tonal qualities, the bottom section of the pane lets you 
make adjustments to the highlights and shadows to recover detail, 
in the white and black areas, and increase vibrance.
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EDIT COLOR

The Edit Color is designed to precisely target a specific range of 
colors and then subtly tweak those colors. It gives you the most 
precise control over color of any filter within Photo RAW.

Use the eyedropper to select a color in your photo. The Color 
Editor will display a slice that includes the color range based on the 
selected color (which is shown by the ‘a’ symbol inside the slice).

After you’ve selected a target color, click the Eyeglasses icon; 
Photo RAW will display the photo in grayscale; only the colors 
within the currently selected range will be visible. Using this view, 
the selected color range can be further adjusted, via two primary 
options:

• To expand or contract the selected range, click and drag 
the handles at the outer edge of the circle. This increases 
or decreases the hue angle for the selection.

• To restrict colors within the range based on their 
saturation, click and drag from either the center position 
(less saturation) or the outer position (most saturation).

As you make adjustments to the color range, the colors in the grayscale view expand or contract, 
depending upon intent. The Feather slider determines how quickly the adjusted colors will change, lower 
numbers mean more abrupt changes, while larger numbers give a more gradual change in the colors at the 
edges of the range.

Once the color range has been selected, use the Hue, Saturation and Lightness sliders to change the 
selected colors. 

The Edit Color Filter is a precision tool designed for slight color shifts within a color range. For more 
extreme shifts, or to change one color to another, the Replace Color filter (see page 192) is generally a 
better option.  

There are two tools that you can use to further manipulate the color range. The first one, (left, 
above) expands or contracts the color range by clicking and dragging the handles at the upper and 
lower boundaries of the range. The second tool (middle and right) manipulates the color range 
based on saturation. 
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FILM GRAIN

The Film Grain filter is designed to add a classic film grain look 
to your photos. It operates identically to the section found in 
the Black & White filter, but lets you add grain without having to 
convert your photos to black and white. 

ON1 Photo RAW 2026 has a wide range of grain types from classic 
black-and-white negative films from Kodak, Ilford and Fujifilm. To 
add grain, choose from the Film drop-down menu.

The Amount slider controls the strength of the effect, while the 
Size slider adjusts the scale of the grain.

GLOW

This pane adds a soft-focus glow to the image, which can be 
accentuated by using different blending modes. The Styles section 
and the More pop-up include a number of different glow types. 
Adjustable settings for the Glow pane include:

• Amount: Controls the overall strength of the glow.

• Halo: Sets the radius of the glow effect; higher numbers 
create more ‘fuzziness’ to your image’s edges.

• Mode: Lets you set the blending mode for the effect.

GRUNGE

This filter is used to add a dirty or grungy look to your image. 
Settings in this pane include:

• Amount: Adjusts the overall strength of the grunge.

• Brightness: Adjusts the overall brightness of the image.

• Saturation: Adjusts the underlying saturation.

• Detail: Adjusts the amount of detail.

• Glow Amount: Adds a glow to the grunge.

• Mode: Selects the glow blending mode.

• Film Grain Amount: Adds film grain to the image.

• Film Grain Size: Controls the grain size.
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HDR LOOK

This filter recreates the HDR style of tone mapping, with 
accentuated edges and sharpening. Like the Dynamic Contrast 
filter, HDR Look will often benefit from masking or via blend 
modes. Settings include:

• Compression: Compresses the tone to reveal highlight 
and shadow detail.

• Detail: Increases the local contrast of details and edges.

• Clarity: Increases the global contrast.

• Highlights: Recovers detail in the highlights.

• Shadows: Recovers detail in the shadows.

• Vibrance: Adjusts the vibrance of muted colors.

• Glow: Adds a bright glow.

• Grunge: Adds a dark gritty look.

LENS BLUR

This filter creates a blur, based on a camera lens such as a tilt-shift 
or a shallow depth of field look. You can use the Gradient Mask to 
adjust the amount of blur through your image, or brush in or out 
the effect where you want it. The filters settings include:

• Amount: Adjusts the overall strength of the blur.

• Optic Quality: Controls the aperture shape in the inner 
and outer feather.

• Sides: Sets the number of blades in the lens aperture, 
which changes the shape of the bokeh.

• Curvature: Sets the curvature of the aperture blades.

• Blooming: Adjusts the highlight bokeh.

• Brightness: Controls the overall brightness of the blur.

• Contrast: Controls the contrast of the blurred areas.

• Noise: Adds simulated film grain to the blurred areas.

Do not use the Opacity slider when trying to reduce the strength 
of a blur; use the Amount sliders instead.
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LUTS

The LUTs filter applies a color look-up table (LUT) to transform 
the underlying color of an image. LUTs were first used with video 
applications to provide color-grading (and other) effects to film, 
and they are increasingly popular in still photography. The Styles 
section has a few default effects you can apply, and you can also 
import your own LUTs, by clicking the Import button inside the 
filter. 

Photo RAW can import common LUT file formats, including .3DL 
and .CUBE file types.

• Category: This pop-up menu lets you choose from one 
of the pre-installed LUT categories, or any categories you 
have imported into Photo RAW.

• LUT: Displays the available LUTs within the chosen category.

• Contrast: Lets you adjust the underlying contrast.

• Saturation: Adds or reduces saturation.

NOTE: See “Extras” on page 10 for information on how to use the Extras 
Manager to import LUTs into Photo RAW.

MATCH COLOR

This filter applies the color and tone from one image to another. 
This image can be from a layer in the current photo, or from a 
different file. 

The Reference pop-up contains a list of the current layers and a 
short list of recent photos worked on inside Photo RAW. You can 
also load another file from the pop-up, which will be saved for 
future reference.

The Color, Luminosity, Contrast and Saturation sliders can be used 
to tweak the tonality of the filter on the current photo.
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MOTION

The Motion filter lets you add intentional camera movement (ICM) 
techniques to your static photos. The filter’s Motion options let 
you apply an effect to a photo, and can isolate either the subject 
or the background from the effect. The three motion types are 
different effects to simulate ICM shots:

• Pan: Simulates the movement of a camera with the 
subject as the photo is being taken.

• Zoom: Simulates the zooming in or out of a lens as the 
photo is being taken.

• Twist: Simulates the twisting of a camera as the photo is 
being taken.

Within each motion type, the Amount and Angle control the 
strangth and the angle or direction of the motion. Smoothing adds 
a bit of blur to the overall photo, which can be helpful if the effect 
feels a bit fake. Zoom and Twist also have a Set Center option, to 
place the center of the effect in any region of the photo.

Use the Protect option to keep either the subject or the background from the effect. The Feather slider 
feathers the transition between subject and background.

NOISE REDUCTION

Use this pane to reduce luminance and color noise, while 
maintaining image detail. The styles section includes a number 
of different noise reduction options, based on the type of image 
you’re working on.

• Luminance: Adjusts the overall strength of the noise 
reduction applied to the luminance or detail of the image. 
Hold down the Alt/Option key to see just the luminance 
while adjusting this slider.

• Color: Controls the amount of noise reduction applied 
just to the color or chroma of the image.

• Detail: Controls how much edge detail is protected. Hold 
down the Alt/Option key to see the edge mask while 
adjusting this slider.

• Apply to: Allows you to limit the noise reduction to just a portion of the image based on 
color or brightness values. Options include highlights, shadows and midtones, as well as color 
ranges. To set a custom color range, click the Dropper icon and click on a color area that has 
the noise you wish to remove. Use the Range slider to adjust the range (or ‘fuzziness’) of the 
color range where you with to apply the noise reduction.
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PHOTO FILTER

This filter recreates traditional color lens filters used for warming, 
cooling, gradients and more. You choose the filter type from the 
pop-up menu at the top of the pane, then adjust the settings to 
your liking. Each type offers different options for selecting a filter 
color (or colors, in the case of the Bi-Color type), adding saturation 
or polarization, and more.

There are four Filter Types: Solid, Graduated, Bi-Color, and Center. 
The Solid option includes a section for choosing the single color 
you wish the filter to be, and an Amount slider for how strong 
you want the effect, as well as a Saturation slider for boosting 
or reducing overall color. The Polarizer slider adds a polarization 
effect, which can sometimes help clear haze or enhance the blues 
and greens in an image.

The Bi-Color and Graduated filter types let you choose filter color 
(or colors), feather for the filter transition, and a direction for the effect.

The Center type works much like the Graduated option, with the difference being that the filter radiates 
from the center of your image, and you can choose the center to be either clear or colored.

REPLACE COLOR

This filter lets you select a color range and replace that range with 
one of a completely different color. When used with filter masks, 
you can achieve targeted color changes in a photo with ease, while 
retaining the other colors in the image.

The top section of the filter is used to select a target color, and the 
bottom section is where you pick a replacement color. 

First, use the eyedropper tool to select a color from your photo, or 
click on the color swatch to pick one from the color wheel. Adjust 
the Range slider to add or remove colors similar to your target. The 
Amount slider is similar to an opacity setting: anything less than 
100 (the default) will blend the new color with the original color. 
You’ll see the results in real-time, so you can get a good idea of the 
selection.

In the Color Change section, click on the swatch to set a new color, or use the Hue, Saturation and 
Brightness sliders to get the color you’re after. If you have areas where you don’t want the source colors 
changed, use the masking tools to paint the effect out.
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SHARPENING

This pane helps add sharpness to your photos, to compensate 
for a moving subject or a slightly out-of-focus camera, or for an 
illustrative effect. ON1 Photo RAW 2026 offers three algorithms 
for sharpening, High-Pass, Progressive and Unsharp Mask. Which 
one you use depends upon the image or your personal preferences. 
The styles section and the More pop-up have a wide range of 
sharpening styles to help you get started.

• Type: Chooses the sharpening method. Each sharpening 
method has its own set of sliders.

• Amount (all types): Controls the overall strength of the 
sharpening for each sharpening type.

• Halo (Unsharp Mask, High Pass): Sets the radius of the 
sharpening effect. Smaller amounts keep fine detail, while 
larger amounts can exaggerate edge detail.

• Threshold (Unsharp Mask, Progressive): Controls the 
sharpening effect based on contrast in your photo. Larger settings means that smoother 
areas do not get sharpened.

• Detail (Progressive only): Controls sharpening in small details.

• Protect: protects highlight, and shadow areas and skin tones from having sharpening applied.

SKIN RETOUCHING

The Skin Retouching pane is used to reduce blemishes, smooth 
skin and reduce shine on skin. The styles at the top of the pane 
represent a range of adjustments, from subtle to strong, and the 
More pop-up menu has a number of additional styles for you to 
choose from, depending upon your image. Other settings include:

• Blemishes: Adjusts the strength of acne, pores and fine 
lines.

• Smoothing: Adjusts the strength of smoothing similar to 
makeup foundation.

• Shine: Adjusts the strength of the skin shine.

• Evenness: Adjusts skin color consistency across the 
entire face. It is great for correcting overly yellow 
highlights, shadows that may be green or reducing 
redness in noses and ears.

• Skin Color: Use the Color Dropper icon to select the skin color. Click the icon to activate it 
and single click again on the color of the skin in the image.

• Color Well: This will display the color you have chosen with the Color Dropper. Clicking on 
the well will let you choose a different color to represent the skin.

• Range: Adjusts the precision of the color selected.
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SPLIT FIELD

The Split Field filter mimics the classic glass filter of the same 
name, also known as a split diopter. It lets you magnify half of the 
scene to balance out size differences caused by wide angle lenses. 
It lets you magnify and move the background, bringing it closer, as 
if you used a telephoto lens, while maintaining the wide angle look 
in the foreground. 

The Scale option in the Appearance section adjusts the size of the 
magnified section, while Blur blurs the background.

The Position section lets you adjust where the line between the 
split occurs (Distance), the angle of the background, and the 
transition from the larger background to the normal foreground. 
The Adjust Magnified Position target lets you move the 
background into place.

The filter also has an on-screen control — similar in appearance 
to the Gradient Mask tool — that can adjust the position, the 
transition, and the angle of the effect.

SPLIT TONE

This filter applies a duotone-style effect by using a gradient map 
that tints the dark and light portions of the image in different hues. 
This can be used to age an image and give it an antique or vintage 
look. The styles section has a selection of popular split-tone 
effects, and you can create your own by manipulating the sliders to 
choose a map for the highlight and shadow colors.

To use the pane, you can use the Hue slider in each of the sections 
to choose the colors you want for highlights and shadows. The 
Amount slider controls the strength of the color, and Balance sets 
the balance between the shadow and highlight colors, letting you 
make one of the colors more dominant. You can swap the Highlight 
and Shadow Colors by clicking the button to the right of the 
Highlight color.

The Mode pop-up sets the blending mode for the split tone. The 
options you can choose from are Normal (no blending), Color, 
Lighten, Darken, Multiply or Screen.
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SUN FLARE

This filter adds realistic-looking sun flares, sun stars and bokeh 
overlays to a photo. You can resize, move and adjust the tone 
and color of the effect, and can also add toning similar to the 
standalone Sunshine filter. The Type pop-up lets you choose 
between the three options (bokeh, flare or star), and the Texture 
menu displays a range of options for the chosen type.

The Tone & Color section of the filter lets you adjust the 
brightness, saturation and hue of the current texture.

To move the position of the texture, click the icon next to the 
Transform label, then click and drag on the overlay to the desired 
spot. You can use the Scale slider to enlarge the overlay, and you 
can rotate or flip it by clicking on the icons to the left of the Fit to 
Canvas button.

The bottom of the Sun Flare pane includes a version of the 
Sunshine filter, letting you adjust the warmth and saturation of the 
overall effect. The Fade slider gives a matte look to the final effect.

NOTE: See “Extras” on page 10 for information on 
how to use the Extras Manager to import Sun Flare 
files into Photo RAW.

SUNSHINE

This filter increases the appearance of sunshine in a photo, and can 
help to make a flat, cloudy day more vivid. The controls are fairly 
straightforward, including adjustments for the strength (Amount), 
warmth and saturation. You can use the Glow slider to add a bright 
glow to your image.
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TEXTURES

The Textures filter places a texture over the image to add a stylized 
look and is similar to the Borders filter in scope and functionality. 
ON1 Photo RAW 2026 comes with an extensive set of textures 
that you can add to your photos, ranging from fabric, metal, stone, 
text and more. You can also import your own textures directly into 
the Borders filter pane, or via the Extras Manager. Texture files can 
be almost any image format (JPEG, TIFF, Raw or Photoshop).

When loading a texture file, it will be rotated automatically to 
match the orientation of your image. You can override this with 
the rotate and flip tools, and use the Transform option to scale the 
texture’s size over your image.

The Textures pane has Category and Texture pop-ups at the top 
of the pane, used to help you narrow your texture search. There 
are nine texture categories, sorted by type, and any user-imported 
textures will also appear in this list.

Once you have chosen a texture, you can adjust its blending mode 
and opacity, and, if the texture has color, you can adjust its hue, 
saturation and brightness. Alternatively, if the texture is black or 
white, you can colorize it by clicking on the Colorize button.

The Transform section at the bottom of the pane lets you scale the 
texture up or down in size. You can also rotate or flip the texture 
by clicking the buttons at the bottom of the screen, which can be 
helpful to achieve the look you desire.

NOTE: See “Extras” on page 10 for information on how to use the 
Extras Manager to import textures (and other extras), along with additional 
information for preparing files for Borders and Textures.
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TONE ENHANCER

The Tone Enhancer controls the brightness and contrast, or tone, 
of the image and lets you recover detail in the highlights and 
shadows, and adjust the white or black point. It offers similar 
controls to the Tone section of the Tone & Color pane, and also 
includes a curves dialog.

• Auto Button: The auto button sets the white and black 
points automatically, adjusting all of the primary tone 
settings to balance the histogram.

• Exposure: Adjusting this slider to the right will lighten 
your image. Adjusting to the left will darken your image.

• Contrast: Increase or decrease the contrast.

• Highlights: Darkens or lightens the highlights.

• Shadows: Darkens or lightens the shadows.

• Whites: Adjusts the white point, adding or removing 
contrast in the highlights.

• Blacks: Adjusts the black point, adding or removing 
contrast in the shadows.

• Compression: Compresses the tone to reveal highlight 
and shadow detail.

• Detail: Increases the local contrast in the image.

• Clarity: Enhances large edges to add clarity.

• Curves: The curves section is a powerful, advanced 
tool for adjusting contrast and color in your photos. For 
specifics on how to work with this feature, see “Curves” 
on page 184.
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VIGNETTE

The Vignette pane creates flexible vignettes which focus a viewer’s 
eye toward the center of the image by darkening the edges of the 
frame. The buttons at the top of the pane let you quickly apply a 
vignette and then customize the look with the advanced controls. 
Styles apply common vignette types.

• Brightness: Controls how light or dark the vignette is.

• Size: Controls the size of the vignette.

• Feather: Controls the hardness of the edge of the 
vignette.

• Roundness: Controls the shape of the vignette from 
square to round.

• Type: This menu lets you select a Normal, Subtle, or Soft 
vignette effect. The Priority option will let you preserve 
highlights when applying the vignette.

The Center Tool at the bottom left of the pane lets you to select the center point of the vignette. Click 
on the tool icon to activate and then click on the area in the image you wish to make the center of your 
vignette.

VINTAGE

The Vintage filter is for adding an aged, vintage look reminiscent of 
films and photographic papers from the mid-to-late 20th Century. 

• Color: A drop-down menu of various color styles to apply 
to your image.

• Amount: Controls the overall strength of the filter.

• Saturation: Adjusts the saturation of the original image.

• Film Grain Amount: Adds film grain to the image.

• Film Grain Size: Controls the grain size.
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WEATHER

This filter adds weather-inspired overlays to a photo. The 
Precipitation section at the top lets you add rain or snow overlays, 
by choosing a type from the Texture pop-up menu. You can adjust 
the opacity of the effect, and can scale, flip or rotate the overlay 
via the Transform section of the panel.

You can also add fog effects to a photo. To turn this effect on, 
raise the Amount slider in the Fog section at the bottom of the 
pane. The Position pop-up menu includes a number of gradients 
for applying the effect (choose All to apply the effect to the entire 
image). Choose the one that is the best starting place for your 
photo.

The Distance and Transition sliders act upon the gradient, letting 
you choose the intensity and length of the Position gradient, while 
the Rotation slider lets you adjust the angle.
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REPLACING SKIES WITH SKY SWAP AI

The Sky tab makes replacing or enhancing a dull sky a breeze, by automatically detecting the sky in your 
photo and masking it out. Once the mask has been built, you can select a replacement from one of the over 
100 skies included with Photo RAW, or you can or import your own directly from within the Sky tab. 

Photo RAW gives you full control over the mask used to blend the sky and you can use any of the other 
the masking tools to adjust it as needed. You can adjust the sky to blend better with your foreground, even 
blur the sky to simulate a long exposure. Not only does it replace the sky, but it can adjust the foreground 
lighting and color as well as add a reflection of the sky to water found in the foreground.

It’s easy to get started with swapping out a sky: in Browse, select an image you would like to put a different 
sky into and choose Edit in Sky from the File menu, or, if you’re in the Edit module, click on the Sky tab. 
Photo RAW will automatically generate a mask of the sky and open the Sky Swap AI panel. There, you can 
choose from multiple categories of sky images, ranging from sunsets, storms, night skies and much more. If 
you have your own sky that you’d like to use, you can click the Import button to add it.

Once your original sky has been masked, and you’ve added a replacement that you like, you use the 
controls in the Sky Swap pane to fine tune the placement, intensity foreground, lighting (and reflection, if 
desired). If there are portions of the mask that you’d like to work on, all of Photo RAW’s masking tools—
with the exception of the Quick Mask AI, which overwrites any mask—are at your disposal.

Lastly, if you would like to continue to work on the sky and foreground separately, just copy the Sky Swap 
AI mask and paste it into an Effects filter mask, new layer, or local adjustment.

Replace a lackluster sky (above left) with a beautiful replacement (right) in the Sky tab of the Edit module.
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Inside the Sky Swap AI Pane
When you click on the Sky tab, Photo RAW automatically 
generates a mask of the sky in your current photo and 
opens the Sky Swap AI pane, which consists of the 
following sections:

A.	Pane controls: on/off button (left) turns the 
replacement on or off; Mask view (right) opens 
the Mask options section for fine-tuning the 
mask. (See “Mask Options and the Refine Mask 
menu” on page 128 for more.)

B.	 Reset button: returns the Sky pane to its 
original state. (Hover over the pane to display.)

C.	 Opacity: Sets the overall opacity of the sky 
replacement.

D.	Styles section: for choosing a specific preset 
sky from within one of the categories, or create 
and apply your own style via the More menu.

E.	 Sky selection area: includes pop-up menus for 
the different sky categories, and the skies that 
are part of the currently selected category.

F.	 Import button: launches the Extras Manager 
(see page 10) for importing skies directly 
into Photo RAW.

G.	Position: lets you choose one of two sky swap 
methods (A or B), shift the horizon line of the 
new sky; set the opacity of the sky; fade and 
shift the edge of the mask; scale the size of the 
new sky to better fit the final image; and apply 
a leveling adjustment to the new sky.

H.	Appearance: sets the warmth and brightness 
of the replacement sky, applies dehaze, and 
lets simulate motion by blurring the clouds and 
setting the blur angle.

I.	 Foreground Lighting: lets you adjust the 
intensity and color of the light on the 
foreground.

J.	 Reflection: when working with images that 
have bodies of water in the foreground, 
you can add a reflection, adjusting both the 
blending mode, the amount (strength) of the 
reflected sky, and apply a vertical shift. 

THE POSITION SLIDERS
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After you’ve chosen your sky from the Category and Sky pop-up menus, use the Position section to adjust 
the placement and the blending of the new sky. You can flip the sky horizontally—which can be helpful 
when you wish to change the direction of the light in the sky to match the foreground—by clicking on the 
triangles to the right of the Position label. The Shift Horizon slider will move the imported sky up or down 
inside the masked area, while the Fade Edge and Shift Edge sliders can be used to blend the new sky more 
realistically with the foreground. The Opacity slider will default to 100, which means that none of the 
original sky will show through, but you can lower the opacity to blend the new sky into the image as well. 

The Scale slider will enlarge the new sky’s size inside the mask, which you might do because you want to 
add some drama with larger clouds, or want to emphasize a specific group of clouds, or because the size of 
the size of imported sky doesn’t quite meet the boundaries of your original image.

Method setting

Photo RAW has two types of algorithms that it uses to select skies, Method A and B. For most photos, 
the default option, Method A, will offer the best results, but you might find that there are some instances 
where that option gives you less than optimal results. In those situations, try Method B; Photo RAW will 
re-analyze the scene and will create a new mask.

THE APPEARANCE SLIDERS

The sliders in the Appearance section adjust the look of the replacement sky to help better match the sky 
with the existing foreground, and their purpose is straightforward. The Warmth slider lets you apply a 
warmer or cooler look to the new sky, while Brightness adjusts the luminance of the sky, making it brighter 
or darker. Moving the Haze slider to the left removes haze or fog from the sky (by adding contrast), while 
moving it right will enhance it. 

The Blur Amount and Blur Angle sliders let you apply a motion-blur-style effect to the clouds in the 
replacement sky, to simulate a long exposure. 

THE FOREGROUND SLIDERS

As the name of the section implies, the Foreground Lighting and Reflection sliders apply their settings to 
the foreground and help further 
blend the new sky realistically into 
the scene. To turn on one of the 
groups, click the on/off button to the 
left of the Lighting and Reflection 
labels.

The Lighting sliders attempt to 
apply some of the color of the 
light in the replacement sky to the 
foreground. By default, when you 
turn the Lighting section on, Photo 
RAW will automatically sample a 
color from the sky and apply a slight 
color fill effect to the foreground. If 
you’d like to change the color, click 
on the eyedropper icon next to the 

The Reflection option in the Foreground section of the Sky Swap AI pane is designed to add a 
reflection of your replacement sky to water in the foreground (shown on the right above in 
split-screen preview mode), even if it’s not completely calm.
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color patch, and choose another. The Amount slider sets the intensity of the light, while the Distance slider 
adjusts the effect to fill more or less of the entire foreground, almost like a gradient.

There are two blend mode options you can use when adjusting the lighting: Multiply and Screen. Multiply 
will darken the lighting effect, while Screen will lighten it. 

The Reflection group is designed for those times when you have a body of water in the foreground, and 
wish to blend in a slight reflection of the sky into the foreground. 

This option includes a few more of Photo RAW’s blending modes, and you’ll find that different modes work  
better than others, depending upon the scene. (See “Blending Modes” on page 175 for more information 
on the various blending modes used in Photo RAW and their usage.

The Amount slider adjusts the intensity of the reflection, while the  Shift Vertical slider works in a manner 
similar to the Shift Horizon slider does in the Position section of the Sky Swap pane: it moves the reflection 
of the replacement sky up or down across the foreground area.

Generating Realistic Sky Replacements
Adding a new sky to an image is easy, but getting a sky that looks like it belongs in the image is another 
thing. Here are a few tips for creating realistic-looking sky replacements:

• Quite often, the biggest issue in replacing a sky is matching light, whether it be the direction 
of the light cast by the sun, or the time of day. As you work through the list of skies looking 
for a replacement, ask yourself if the movement of light makes sense in the blended pair. 
Sometimes, you can use the Flip Horizontal toggle in the Position section of the Sky Swap 
pane to fix a directional issue; other times, the potential replacement sky, as much as you 
wish it to work, will just look out of place.

• It will be rare that you pop a sky into an image and that it works perfectly. If the light does 
seem to fit, play with the controls in the Position, Appearance, and Foreground sections to 
get a better sense of how the sky works in the scene.

• As you play with different skies and are trying to get a sense of how one works better than 
another, make use of Photo RAW’s Undo capability; better yet, work with the History pane 
(see page 91) to jump back and forth between different places during your editing session.

• Don’t forget to pay attention to the mask. While the Sky Swap AI technology is excellent, it 
won’t be perfect in every instance. Use Photo RAW’s masking tools to refine and adjust the 
mask in places where your sky might intrude into the foreground or vice versa. 

• Use the mask! Copy the mask and use it in your finish editing elsewhere in Photo RAW. For 
example, you might want to apply a Dynamic Contrast filter to your foreground, but know 
that the filter will not look great on the sky. Copy the mask from the Sky Swap AI pane by 
choosing Copy Mask from the Mask menu, then open the Dynamic Contrast filter in the 
Effects tab and choose Paste Mask from the Mask menu. Because the mask’s contents are 
set to the sky, you’ll want to also choose Invert Mask from the menu. Once you do that, the 
filter’s settings will only be applied to the foreground. You can copy, paste and invert the 
mask as many times as you’d like.

• Shoot your own skies and import them via the Extras Manager. When you’re out and see a 
gorgeous sky, photograph it with as much of the sky as you can catch. Because you’ll have 
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shot the sky, you’ll have a better idea of the lighting direction and time of day, which will be 
quite helpful when you are trying to match a sky.  

• Finally, remember that, like all other aspects of Photo RAW, everything done in the Sky tab is 
non-destructive and re-editable. If you don’t like your replacement, or need to tweak its 
settings as you apply other edits, click on the Sky tab and your work will still be there. (And 
you can always get back to your original image’s sky by resetting the Sky Swap AI pane.)

Paying attention to light, and its direction, is one of the keys to getting realistic-looking sky replacements. As pretty as the as the sunset sky is (top 
left), the direction of the light in the foreground (from behind and to the left) is all wrong for the sunset. The sky on the top right is a bit better fit, 
but the light is coming from the right, clashing with the foreground. Flipping that sky (bottom left) feels more integrated, but it still feels dark for the 
scene, even when adjusting the Brightness slider. Choosing a sky taken at roughly the same time of day (bottom right) feels more harmonious with 
the foreground, and, with a little bit of adjustment, ends up looking fairly realistic.
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RETOUCHING WITH PORTRAIT AI

Portrait AI was designed to help you retouch faces quickly and naturally, and with as little user intervention 
as possible. When you open a photo in the Portrait tab, Photo RAW automatically finds each face in your 
photo, analyses it individually, and adds just the right amount of retouching, based on your preferences.

Despite all the automation, you have full control over all aspects of retouching and finishing. Each face in 
your photo has independent settings and adjustments. You can manually adjust eye and mouth positions in 
each face, paint to refine the skin mask and use brushes to remove blemishes.

Portrait AI’s skin retouching uses frequency-separation techniques, which help to maintain natural skin 
texture while reducing color and tonal changes across the skin. It creates flawless, natural-looking skin.

In addition to skin smoothing and blemish removal, you can use Portrait AI to correct common errors in lens 
choice and lighting by adding fill-light to brighten the face or resculpt the face to thin the jawline. You can 
even adjust the eye size on each individual face.

The whites of eyes can be brightened and the iris can be sharpened, and there are automatic red eye 
removal options as well.  You can easily brighten the smile and adjust the color and saturation of the lips.

Portrait AI is easy to use: The Masking Brush can be used to paint skin in or out—and the Portrait pane that 
contains settings for adjusting the skin, eyes and mouth in a face. Each face in your photo has its own pane, 
so you can adjust each face on an individual basis. 
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Inside the Portrait Pane
Each face in a photo will have its own Portrait pane, which 
contains the mask for the face, and settings for smoothing 
the skin, and adjusting aspects of the face, eyes and 
mouth.

You can view a face’s pane by clicking on the appropriate 
photo at the top of pane. (You can change the name of 
each pane by double-clicking on the ‘Portrait AI’ label at 
the top.) The top of the pane has the following items:

A.	Face selection: This includes the Add Face 
button and any faces found (or added) in your 
photo. Clicking on the face will select that face’s 
portrait pane.

B.	 Face and mask icons: The first icon is a small 
representation of that pane’s face, to help with 
identification in photos that have many faces in 
them. The mask is for that person’s face. To turn 
off all of the settings for that pane (to preview 
that face before and after, for example), click the 
control circle to the left of the face. If the circle 
is empty, it means that the adjustments are not 
currently applied.

C.	 Blending options, Reset and Delete: These 
icons are for changing the blend mode, to reset 
the pane to its original state, or to delete that 
portrait layer altogether. (Hidden by default; place 
your cursor over the pane to display.)

D.	Opacity: Sets the overall opacity of the pane’s 
settings.

E.	 Style: Pop-up list of preset settings for that 
pane. The Default style uses Portrait’s Auto 
AI technology applying either Subtle or Strong 
retouching. (Subtle is the default AI approach, 
but this can be changed to Strong in the General 
Section of the Preferences window.) You can 
also save your own styles, based on individual 
preferences.

The bottom part of the Portrait pane includes four 
sections: Skin, Face, Eyes and Mouth. Each section has an 
on-off control circle immediately to the left of the label, 
which can be helpful if you don’t need to retouch the skin 
or the eyes, for example. The Skin section settings include:

F.	 Retouching: The amount of skin retouching, based on Portrait’s AI analysis of the face.
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G.	Blemishes smooths facial elements, like fine lines and wrinkles. 

H.	Detail brings back some detail that might have been lost in the smoothing process. 

I.	 Smoothing applies additional skin smoothing.

J.	 Texture controls the amount of artificial texture applied as an overlay to the face.

K.	 Shine lessens hot spots, evening out the skin’s tones. 

NOTE: The Method pop-up contains two options, Frequency Separation and 
Surface Blur. The Surface Blur option is based on previous versions of ON1 
Photo RAW, and is solely included to provide backward-compatibility with 
presets created for those versions.

The Face section has four adjustments:

L.	 Brightness: Adds to or removes brightness from the current face. 

M.	Slim Face: Resculpts the face, slimming it along the jawlines.

N.	Left Eye Size: Increases overall the size of the left eye.

O.	Right Eye Size: Increases overall the size of the right eye.

The Eyes section has five adjustment options:

P.	 Brightness: Brightens the entire eye area; can be helpful when your subject is wearing a hat.

Q.	Whitening: Whitens the eyes.

R.	 Detail: Adds sharpness to the pupils.

S.	 Dark Circles: Brightens circles and/or bags under the eyes.

T.	 Brow Enhance: Darkens the eyebrows.

U.	Auto Red-Eye Removal: Clicking this button will apply red-eye removal to the eyes.

Clicking the icon to the right of the Eyes label will display an overlay with the eye control points when you 
move your cursor over the face. (See page 210 for information on adjusting the eye overlays.)

The Mouth section has four settings:

V.	 Teeth Whitening: Whitens the teeth.

W.	Lip Vibrance: Increases the color in the lips.

X.	 Lip Brightness: Adjusts the brightness of the lips.

Y.	 Lip Hue: Adjusts the hue of the lips.

Clicking the icon to the right of the Mouth label will display an overlay with the mouth control points when 
you move your cursor over the face. (See page 210 for information on adjusting the mouth overlay.)
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Portrait AI Workflow
Portrait AI was designed to automatically give you perfect retouching every time you open an image. As 
such, the basic workflow, for most images you will work with, is relatively simple:

1.	 Perform basic global edits in Develop. This includes tone and color adjustments, as well as 
any noise reduction and lens correction. Leave sharpening to the final stages of editing.

2.	 Go to the Edit module and click on the Portrait tab, or, when using as a plug-in, choose 
Portrait AI from the appropriate menu in your editing app.

3.	 Go through each individual’s portrait pane and adjust individual settings as desired.

4.	 Use the retouching tools to remove or repair blemishes.

5.	 Apply manual adjustments to the skin mask and reshape the eye/mouth overlays, if needed.

SUBTLE VS. STRONG PROCESSING OPTIONS

When Portrait AI applies its automatic retouching to a face in a photo, it uses one of two AI-based 
processing options, Subtle and Strong. As its name implies, the Subtle setting—which is the default 
option—opts for a lighter touch when retouching. Strong applies a bit more processing than Subtle, but it 
still shouldn’t be over the top. Some situations might call for the Strong setting, or you might find that you 
prefer that setting. To change the default option, go to the General tab of the Preferences window, and 
choose the option you wish to use in the Portrait AI Default pop-up (see page 291).   

WORKING THE INDIVIDUAL PORTRAIT PANES 

Once Portrait has found the faces in your photo, select each face in turn by clicking on it in the face section 
at the top of the Portrait AI panel, or click on the pane itself. Work your way down the pane from the Skin 
section at the top, down to the Face section, and on to the Eyes and Mouth at the bottom. Making broad 
movements of the different sliders can give you an idea of how a setting gets applied, but be careful in 
making adjustments too strong, which can give your models a plastic look. Work in 100% view, so you can 
see the effects of your changes up close.

Portrait AI generally will do a good enough job in the basic skin smoothing and retouching that you 
shouldn’t have to dig into the Details section; adjusting the Retouching slider left or right should often be 
all you need to do to fine tune the skin.  

NOTE: When working with multiple faces, you can name each Portrait layer 
individually by double-clicking on the word ‘Portrait’ in the title bar. 

USING THE RETOUCHING TOOLS

If you have portions of a face that have specific retouching needs (blemishes and other marks), use the 
Perfect Eraser, Retouch Brush, Clone Stamp or Healing Brush to make those changes. (See the Retouching 
Tools section, starting on page 117, for detailed information using on working with these tools.)
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MAKING MANUAL ADJUSTMENTS IN PORTRAIT AI

Portrait uses sophisticated technology to find faces, but it’s not always perfect. Luckily, you have some 
tools to use to make further enhancements or adjustments beyond the controls in the Portrait pane. These 
include adjusting a face’s mask, to add or reduce the area that the retouching applies to, or making small 
adjustments to the areas around the eyes and mouth. In some very rare instances, you might find a ‘face’ 
that really isn’t a face, or that Portrait was unable to find a face. 

Fine-tuning a face’s mask

To keep Portrait’s retouching localized to each face, the app builds a mask for the face. Only inside the 
contents of the mask are the parameters of that face’s portrait pane applied. The rest of the image is 
‘masked out,’ meaning that the adjustments don’t apply to those pixels. The mask is represented by the 
mask icon at the top of each pane.

When building a face mask, Portrait AI looks closely for the general contours of the face, but doesn’t 
include other skin. You might want to smooth some skin under the chin or on the neck, or you might want 
to paint out some areas—hair over the forehead—from the mask, so that they won’t be softened. 

You can view the mask for each face by selecting the appropriate pane and clicking the Show Mask icon at 
the bottom of the main Portrait AI window (to the right of the Before/After button). This will display the 
mask for the face, with a red overlay representing the area untouched by that pane’s settings. It will also 
select the Portrait AI brush, which you can use to ‘paint in’ more skin (enlarge the area), or ‘paint out’ areas 
that you might not want to have retouching applied. 

You can fine-tune a face’s mask retouching by painting skin in or out on your model as necessary with the Masking brush or any of the 
refinement masking tools. To view the mask, click the View Mask icon at the bottom of the window, or press the ’O’ key.
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Next, you set the painting mode (Paint In/Paint Out), brush size, feathering, and opacity to make the 
changes to your mask. Performing your brushing with the mask view turned on helps show your progress. 
Use the Option key (Mac) or Alt (Windows) to change the brush mode in real time, to paint in and out with 
ease.

Adjusting the skin mask works best with the view mode on, and at 100% view (or larger, in some instances). 
When you’re done refining the mask, choose another tool and click the View Mask icon at the bottom of 
the screen to turn the mask off. 

Working with eye and mouth overlays

Portrait AI does an excellent job finding the eyes and mouth for each face in a photo, even three-quarter 
and side shots. For each feature, Portrait creates an overlay that functions similarly to the face mask. The 
eyes (or eye, if only one is in the photo) and mouth overlays define the boundaries of those features, and 
only the controls in the respective sections of each face’s pane are applied to those areas.

To view the different overlays on a face, click on either the Eye or Mouth icon to the right of that section’s 
label. When you move your cursor over the face, you’ll see the overlay for that feature.

Each overlay consists of a nodal point (in blue) and control points that define the boundaries of each 
feature. You can rearrange or modify the overlays: clicking and dragging the point lets you adjust the center 
of the overlay; clicking and dragging on any control point lets you readjust the boundaries of that area.

The mouth overlays are a bit more complex than the eye ones; they include control points for the top and 
bottom of each lip, which lets you adjust for the teeth. In most cases, you won’t need to adjust the overlays, 
but if you feel that you could get a better mask for either the eyes or the mouth, it’s best to zoom in fairly 
close, so you can adjust the overlay precisely.

Dealing with missing or ‘ghost’ faces

In the rare instance when Portrait doesn’t find one of the faces in your photo, click the Add Face button 
at the top of the Portrait tab. Then, position and size the box around the face you wish to add, press the 
Return key, and the portrait pane will be created (and selected). When adding a face in this manner, you’ll 
need to manually add the eyes and mouth, and enable the different sections of that face’s pane. 

To add the eyes, click on the Eye icon to the right of the label. Then click the cursor in the center of 
each eye. When you’re done, Portrait will create the overlay for each eye, and you can readjust them as 
necessary. 

Clicking the icon to the right of the Eye or Mouth label in a portrait pane will display the overlay for that feature. You can 
adjust the control points for each overlay by clicking and dragging them to reshape the area.
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Adding the mouth is similar; click on the icon to the right of the Mouth label, and click on the corners of 
the mouth. Portrait will create the overlay, and you can adjust the control points to fit the contours of the 
mouth as needed.

Once you’ve added the eyes and mouth, you can work through the pane in the same manner you would 
with an automatically generated face.

Sometimes, you’ll find a pane that’s been generated for something that clearly is not a face. If you find one 
of these ‘ghost’ faces, right-click the ghost icon at the top of the Portrait AI panel and choose Delete Face.
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PART 4: COMBINING PHOTOS WITH ON1 
PHOTO RAW 2026

For many photographers, editing in post-production doesn’t just mean working on a single image at time. 
When shooting out in the field they might capture multiple shots of a scene, to blend them later to achieve 
a greater dynamic range, to create expansive panoramas, or to build a perfectly focused scene from front 
to back. Or, they might be interested in creating sophisticated composites that can only be created within a 
layered workflow. For those photographers, ON1 Photo RAW 2026 includes a full set of combination tools 
to help them achieve their photographic vision with ease: 

• Layers: Photo RAW’s Edit module offers a full layered workflow, letting you create collages, 
perfectly blended composites from multiple images, and much more. (See page 213.)

• Panorama: The Panorama feature can create amazing, expansive views of a scene from two 
to 25 photos blending them together into a seamless whole. It can even create great panos 
from a handheld set of shots. You can even batch process a group of panorama shots. (See 
page 222.)

• HDR: This feature takes a group of photos shot at different exposure values and blends 
them to create photos that include a wider range of tones—from deep shadows to bright 
highlights—than can be achieved with a single shot. Like panoramas, Photo RAW’s HDR 
feature supports batch processing. (See page 225.)

• Focus Stacking: Like the HDR feature, Focus Stacking takes multiple shots of the same scene, 
each shot with a different focus point, and blends them together into a perfectly focused 
final result. (See page 228.)

• Time-Lapse: Create beautiful, flicker-free time-lapse videos from sequences of still photos. 
(See page 230.)

As is the case with all of the editing functionality in ON1 Photo RAW 2026, these features work non-
destructively. Your original photos are not changed, and the resultant, blended photos have all the re-
editability found throughout Photo RAW.
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WORKING WITH LAYERS

The Layers functionality inside ON1 Photo RAW 2026’s Edit module lets you create quick composites, 
blend multiple images together, paint in new skies or backgrounds, add text, align layers based on their 
content, and much more. And, because Layers is tightly integrated within the Edit module, all of your work 
remains re-editable at all times: you can go back and add, change or update any setting made inside the Edit 
module, on any layer.

You can combine multiple photos or copies of the same photo as layers. Each layer can be moved, sized and 
masked on its own, and each layer has its own non-destructive settings—just like any photo in Photo RAW, 
all the way back to the original raw data. That means you can use all of Photo RAW’s editing features—basic 
exposure changes, camera profiles, portrait retouching, Effects filters and more—as part of a layered photo.

When you add a layer to a photo, Photo RAW automatically creates a new document with an .onphoto 
extension, leaving your original photo intact. 
This document type, which is visible inside 
Browse, contains all the layer information 
and non-destructive editing operations made 
inside Photo RAW. (For information about the 
implications of using layered files with ON1 
Cloud Sync, see page 221.)

Layers can be as simple as copies of the current photo, to apply more complex adjustments to portions of 
an image than you could with local adjustments. You can also add other documents as a layer inside the 

The Layers feature inside ON1 Photo RAW 2026 is fully non-destructive. This means you can use all of the Edit module’s tools, tabs and filters, along with 
layer-independent masking capabilities, and still preserve your original photos—and can come back at any time to further enhance your creations. 
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current document, for replacing skies or other backgrounds, for adding textures, or for when you wish to 
create complex collages. Photo RAW supports up to 14 layers in a document.

Once you have added a layer, the entire Edit module is available for that layer. When you click on a layer, 
you can add any adjustment from the four edit tabs, create masks, and more. You can use the Transform 
tool to move, rotate, and scale the contents of a layer independently from the complete document. 
(Because the Crop tool works at the document level, you can’t crop individual layers.)

CONFIGURING THE LAYERS PANE’S LOCATION

Like the Properties window, the Layers pane can be configured so that it resides in either the right or left 
panel on the screen, or works as a floating window. You can also hide the pane completely in any of the 
configurations. 

You set up the Layers pane location and visibility via the Window > Layers menu. There you can nest the 
pane on either the right or the left side; unchecking both items will turn the pane into a floating window. 
Show will display the pane in all configurations, while Auto 
Collapse will reduce the pane to the title bar whenever 
you move the cursor away from it, and show it when you 
mouse over the pane (or window). 

ADDING A NEW LAYER

The easiest way to add a new layer to an existing image is to choose ‘Add Layer from File’ in the Layer 
menu. This will open the Add Layer window, which has two tabs: Extras and Folders. The Extras tab will 
display ON1 Extras and My Extras. The ON1 folder will include all of the Extras installed with your copy of 

The Layers pane can be configured so that it resides in either the left or the right side panels of the Edit module. If you want a floating window, 
uncheck the Left Side and Right Side options in the Window menu.
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Photo RAW, including backgrounds, textures, borders, skies, and more. The My Extras folder will include 
any similar files you have added to Photo RAW via the Extras Manager (as described on page 10).

If you wish to open a different file, click on the Browse button at the top of the Add Layer window, which 
will open your computer’s file selection dialog box, where you can navigate to the specific file. Any file 
compatible with ON1 Photo RAW 2020 can be opened and added as a layer.

NOTE: You can also copy and paste pixel-based image data from other apps 
into Photo RAW while working in the Edit module. Choosing Paste will create a 
new layer with the copied pixels.

Opening a layered Photoshop file

ON1 Photo RAW 2026 can open most layered Photoshop files in the Edit module. What happens depends 
upon the composition and type of layers in the document:

• If the layered document has basic Photoshop layers and masks, Photo RAW will open the 
document inside Edit, with each layer and mask visible in the Layers pane. 

• If the Photoshop file has specialty layers—smart objects, text layers, layer styles—Photo RAW 
will flatten the visible layers and will open the file as a composite image, with a single layer.

In either case, Photo RAW will convert the file to an .onphoto file, preserving your previous document.

When you choose Add Layer from File, a window appears with Extras and Folders tabs. The Extras tab contains backgrounds, textures (shown above) 
and borders supplied by ON1 with Photo RAW, as well as any extras you might have added via the Extras Manager. Clicking on the Folders tab (or the 
Browse button at the top right of the window) will let you browse your computer for photos and other supported files.
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Creating an empty layered file

You can also start with a blank canvas, in either 
the Browse or Edit modules. Choosing New 
Canvas from the File menu opens a dialog box 
for creating a new file at whichever custom 
size you choose. You can select from a number 
of presets in various categories, including 
common paper and photo sizes, square, and 
video formats. In addition, you have options 
for naming the new file, as well as the color or 
transparency of the background. 

When working in Browse, you can also create 
a new layered file with selected photos, by 
choosing the Selected Photos option from the 
Background Contents pop-up menu. When this 
option is selected, a Fitting menu lets you add 
the selected photos as Unscaled, Fit (fits the 
photos inside the confines of the canvas), or Fill 
(scales the photos to fill the entire canvas). Background Contents also has an option to paste whatever is on 
the system clipboard as a new layer, with the same Fitting options available. (The clipboard must have an 
image on it that is compatible with Photo RAW (see “Working with Files” on page 7).)

When you click OK, Photo RAW creates a new .onphoto file with a single layer in it. You can then use any 
of the options detailed below to add photos and other extras to the file. (You can change the size of an 
existing canvas by choosing Canvas Size from the File menu inside the Edit module.)

Creating Text layers

The Text layer type lets you add blocks of text to your photo or composite, for everything from simple 
watermarks to more complicated text-based layouts. Within each text block you have complete control 
over the size of the block, the font, type size, line spacing, letter spacing, color and alignment of the text. 
You can also add a background fill color and can set the opacity of each text block and background.

To add a text block, choose Add Text Layer from the Layer menu, or click the text icon in the Layer pane’s 
toolbar (see page 218). A new text layer is added, with placeholder text selected, and the Text tab of the 
Properties window opens. You can start typing, or adjust the font, sizing and other options you wish to use 
in the Properties window. To add another text block, create a new text layer from the Layer menu.

You can move and resize the text blocks around by clicking outside the block. Clicking the corners of the 
block to resize it, or click and drag inside the block to move it around. Double-clicking inside the block will 
let you re-edit the text.

To edit an existing text block, choose the Text layer, and double-click in the block, then make your changes. 
If you would like to remove an existing layer, click on the layer in the layers pane and choose Delete from 
the Layer menu.

Photo RAW will remember the last settings you used, which can be helpful if you like to use a specific font 
and size—in text for a watermark, for example.
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TIP: The Text tool also lets you add some embedded metadata information 
from for the current photo into a text block. To do this, type metadata field 
name, contained within left and right curly braces —’{‘ and ‘}’ — into the block, 
like this: {Aperture}. When you click outside the block to see the final text. The 
metadata fields available are: Name, FileName, Date, Time, Shutter, Aperture, ISO, 
Camera, Lens, Focal, Description, Author, Copyright, Path.

Creating a Color Fill Layer

In addition to opening other document types, Photo RAW can create a layer filled with a solid color, which 
can be quite useful when working with sophisticated composites or blend modes. Choosing Add Color Fill 
Layer from the Layer menu (or clicking on the Color Fill icon in the Layers tool bar) will open the system 
color picker, where you can choose a color for your new layer. You can change the color of any color fill 
layer by selecting it in the Layers pane and choosing Edit Color Fill from the Layers menu.

When you add a Text layer to a document, Photo RAW will create a block with sample text, and open the Text tab of the Properties window, 
which lets you adjust the parameters (color, font, size, and so on). To have multiple text blocks, add a new text layer.
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WORKING WITH THE LAYERS PANE 

The Layers pane has three sections:

A.	Layer Blending and Opacity: Lets you 
set the blending mode and the opacity 
of the currently selected layer.

B.	 Layers: All of the layers in the current 
document, with a thumbnail of the layer 
contents and the layer mask (if there is 
one); the currently selected layer has a 
slightly different background tone than 
the other layers. Layers can be renamed 
by double-clicking on the title.

C.	 Layer Tools: The toolbar at the bottom of the Layers pane includes buttons for performing 
basic layer operations (described in more detail below). 

Layer Visibility 

A layer’s visibility can be turned on or off by clicking the button to the left of the layer thumbnail. When 
turned off, the layer has no effect on the composite image. 

Changing Opacity 

The opacity slider controls how opaque or how strong the selected layer is. The default is 100%. At lower 
settings, the layer will blend with the layer(s) under it. Altering the blending mode and opacity of a layer can 
create a wide range of color and tone effects. 

Changing the Layer Order 

You may change the order of layers by dragging and dropping layers into the order you prefer. 

Renaming Layers 

You can rename a layer by double-clicking on it. The name turns into an editable field. Type in your 
preferred name and press Enter. 

Layer pane toolbar

All of the layer commands in Photo RAW can 
be accessed via the Layers menu and a pop-up 
menu that you get when you right-click on any 
layer. The toolbar at the bottom of the Layers pane contains the basic commands you need when working 
with layers. From left, the icons represent:

• New Layer: Adds a new layer, opening the Add Layer from File window.

• Duplicate Layer: Makes a duplicate layer, including any Edit module adjustments made in the 
original photo.

• New Color Fill Layer: Creates a new color fill layer.

The Layers pane in Photo RAW. This photo has three active layers.
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• New Text Layer: Creates a new text layer.

• Delete Layer: Deletes the currently selected layer.

• Merge Layer: Merges the currently selected layer with the one directly beneath it.

Other layer commands, available via the Layer menu or pop-up, include:

• Reset Layer Properties: Deletes any layer masks or transform 
operations you have made to the current layer. To reset Develop, 
Effects, or Portrait settings or local adjustments made to a layer, click 
the Reset Layer button at the bottom right of the main window.

• Merge Visible: Unlike the Merge Layer command, this will merge all of 
the visible layers—ones with the layer visibility status set to on—in a file 
into a single composite layer, with all of the merged layers’ effect applied.

• New Stamped Layer: When you have the top layer in the stack 
selected, this option will create a new composite layer at the top of the 
stack, with all of the layers’ effect applied.

• Align Visible Layers: This will align the visible layers, based on the content of the layers. See 
page 221 for more information. 

Changing Blending Modes 

Blending modes determine how the selected layer blend with the layer(s) below it. The default blending 
mode is Normal. This maintains the full opacity of the upper layer. Layers also supports many other 
blending modes which can be used to alter the brightness, contrast and color of the image. Blend modes 
are changed via the Blending tab of the Properties window. See “Blending Modes” on page 175 for 
detailed information on adjusting the blend modes. 

Layer Masks 

If you use any of the masking tools — including the AI-based Super Select AI and AI Quick Mask tools — a 
layer mask will be created automatically. Clicking on the layer’s mask icon will display the standard Photo 
RAW mask options, and you can use all of the Edit module’s masking tools to create or modify layer masks, 
including the Mask AI feature used in the Effects and Local Adjustments tabs. You can also copy and paste 
layer masks—including masks from Effects filters—via the Mask options section or via the Mask menu. See 
“Filter Masks” on page 174, “Using Mask AI to select regions” on page 127and “Masking Tools,” starting 
on page 102 for more on using Photo RAW’s masking tools.

Adding layers via Filmstrip view

In addition to the Add Layer options detailed above, if you are in Filmstrip view inside the Edit module, you 
can also drag photos from the strip at the bottom of the screen into the main window. This will create a 
new layer with that photo on it. (See “Working in Filmstrip View” on page 30 for more.)

NOTE: If the file added is different than the pixel dimensions of the document, 
use the Transform tool to resize it as desired. If you wish to preserve the 
original aspect ratio of the placed file, use the Shift key to resize it. 

Right-clicking on a layer 
brings up a list of available 
Layers operations.
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VIEWING EDIT MODULE SETTINGS FOR A LAYER

Each layer in the Layers pane has a hidden list that shows 
all of the operations from the Edit module that have been 
applied to the current image. To view the list, click once on 
the layer’s title. This will drop down the settings view for 
that layer. 

The list will show every tab in the Edit module that has 
had adjustments made to it, and you can drill down further 
into the Develop, Effects, Portrait, Sky Swap and Local 
Adjustment tabs to see which adjustments were made to 
an image. 

Double-clicking on any of the available items inside the 
Settings Applied area will jump to that setting inside the 
Edit module, where you can adjust it easily.

NOTE: This feature replaces the Settings Applied option found in the Info pane 
in previous versions of Photo RAW.

USING THE TRANSFORM TOOL WITH LAYERS

Use the Transform tool (see page 100) at the top of the Toolbar to manipulate layers. A layer may be 
repositioned, sized or rotated using the tool. When selected, transform handles will appear on the edges of 
the selected layer. You use these transform handles to manipulate the image. You can only transform one 
layer at a time. 

Repositioning a Layer 

To reposition a layer, simply click and drag inside the transform box. You can also use the keyboard arrow 
keys to nudge a layer one pixel in any direction. 

Resizing a Layer 

To resize a layer, click and drag on any of the transform handles. Clicking on a corner handle allows you to 
adjust two sides simultaneously. Clicking on a side handle allows you to adjust that side. If you hold the 
shift key down while adjusting the size, the proportions of the layer are maintained. If you hold down the 
Option (MacOS) or Alt (Windows) key while resizing, your image will resize from the center instead of from 
the edge. You can hold down Shift-Option (or Shift-Alt) to resize proportionally from the center. 

You can type in the size you desire in the Tool Options bar in the width and height fields. You can also size a 
layer to fill the canvas automatically by pressing the Fill button in the Inspector. 

Rotating a Layer 

To rotate a layer, move the Transform tool just outside a corner transform handle. Notice that the tool 
cursor changes to a rotate cursor. Now click and drag to rotate the layer. You can also use Option/ 

Clicking on a layer’s title will display the Edit module settings 
that have been applied to that layer. Double-clicking on one 
of the items will open that specific pane in the Edit module 
tab. Click on the layer name once more to close the settings.
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Alt with the left or right arrow keys to rotate a layer when the Transform tool is selected. To rotate the 
layer quickly in 90 degree increments, you can use the rotate left and right buttons in the Tool Options bar. 

Flipping a Layer 

You can flip a layer either horizontally or vertically by pressing the flip buttons in the Tool Options Bar. 

When you have completed your transforms you need to commit the changes. You can do this by pressing 
the Apply button that appears in the Tool Options Bar or by pressing the Enter key. You can cancel a 
transform by pressing the Cancel button in the Tool Options Bar or by pressing the Escape key. 

ALIGNING LAYERS

One of Photo RAW’s most advanced features is the ability to align multiple layers based on content. This 
can be a great aid when you’ve hand-held a group of shots, and want to blend portions of one image onto 
another, to use a better sky, for example. 

To align layers, open them in the Layers pane, and choose Align Layers from the Layer menu or pop-up 
menu. Photo RAW will then analyze the contents of the layers, and aligns them to the one with the most 
commonality. When you look at the individual layers after aligning them, you’ll see that some layers have 
been moved or rotated slightly to match the content. You can then use Photo RAW’s masking tools to hide 
or show various aspects of the aligned layers. 

USING LAYERS WITH SYNCED ON1 CLOUD FILES

If you wish to create a layered file with ON1 Photo RAW 2026 using a synced photo that resides on device 
other than the current device, you should be aware of two restrictions. 

First, because Layers requires the creation of a new file in ON1’s proprietary .onphoto format, this new file 
must be saved to the device it is being edited with. If you save this new file to a published folder or album, 
it will be synced. You will be able to edit the layered file on another computer running ON1 Photo RAW 
(see the section on working with existing layered files below for more).

Second, if the synced photo you wish to use is synced as an editable preview, Photo RAW will warn you 
that you will be working with a photo that has less fidelity than the original (see the dialog box on the 
right). For some uses, working with the preview might be good enough, but if you want to be sure that you 
are using the highest-quality base layer, either copy the file to your current computer, or change the sync 
option for the photo’s folder or album to Originals, and download that from ON1 Cloud Sync.

For more information on these settings, see “Managing Sync Options in Photo RAW” on page 78.

Using Existing Layered Files with ON1 Cloud Sync

If you create a layered file inside ON1 Photo RAW 2026 and sync it to the ON1 Cloud in any manner (folder 
or album, preview or original), that layered .onphoto file is fully editable on another synced device running 
Photo RAW. Any Edit module changes you make to that layered file on that device (on any existing layer), 
with the exception of adding or removing layers, will be synced back to the original file. If you add or remove 
layers, you will be prompted to save the newly edited file to the current computer.

Layered photos that have been synced to the ON1 Cloud are not editable on mobile devices using ON1 
Photo Mobile; they are viewable, however.
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STITCHING PANORAMAS
ON1 Photo RAW 2026 lets you stitch multiple images together to create a panorama, directly 
from within Browse. You can even batch process a group of panoramas. 

Panoramas are composite photos created from multiple individual frames of a scene (also 
known as ‘slices’). While they’re often thought of as wide, narrow images, panoramas can be 

horizontal or vertical, wide or compact. They give you a much higher quality final image, with added detail 
and a greater point of view. Photo RAW can create a panorama with as few as two images or more than 25. 

To create a panorama with Photo RAW, go to Grid view in Browse and select the images you wish to 
use—or select a folder that contains the frames you wish to build into a panorama—and choose Merge to 
Panorama from the More menu in the left bumper (or choose Create Panorama from the File menu). 

Photo RAW will then display the Create Panorama window, which has two components: the Preview area, 
which displays the merged panorama, and the Options panel, which lets you adjust the type (spherical or 
collage) and the edges of your panorama; choose an output size (either 100% or 50% of the stitched file 
dimensions); choose a module to open the panorama after merging, and add panoramic metadata.

With most landscape-oriented panoramas, you will want to use Auto or Spherical projection type, which 
merges the photos as if they were mapped on the inside of a sphere. The Collage projection type lays 
merged photos flat (as opposed to mapping them on a curved surface), and is often called “scrapbook style.”

There are three cropping options available in the Edges pop-up menu: None, Crop and Warp to Fill:

• None will merge the panorama without cropping the finished image. 

• Crop trims the edges of your panorama to fit the best rectangular crop. 

ON1 Photo RAW’s Create Panorama window displays the projected panorama, and includes options for the type of merger, cropping options, file size and adding 
panorama-specific metadata. You can also specify which Photo RAW module in which you wish to open the finished panorama.
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PHOTO RAW PANORAMA EDGE OPTIONS

These panoramas demonstrate the three different edge options available via the Create Panorama feature. 
The top panorama was set to None, the middle to Crop, and the bottom the Warp to Fill. Because the scene 
included skies and grasslands at the edges, the Warp to Fill was able to add enough pixels to fill out the top 
of the panoramic frame.
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• Warp to Fill uses ON1’s content-aware fill technology to stretch the edges of your scene to 
fill as much of the entire frame as it can, giving you bigger cropped area. 

Remember that no content-aware technology is perfect: If you use Warp to Fill option, make sure to check 
the edges of the frame after the panorama is built, making sure that there aren’t any smudged areas or bad 
fills. (It often works best on scenes with skies and large vistas, and less so on scenes with lots of detail at 
the edges.)

The Open In section of the Options Bar lets you choose what to do when your panorama has been built. 
You can stay in Browse, or open your finished panorama in either the Develop or Effects tabs.

The Add Panoramic Metadata option, when checked, will take advantage of the exploration features found 
in panorama-aware websites—like Facebook and Google—and apps, letting users click and spin around your 
panorama in real time.

When you click Save, Photo RAW will build your panorama, blending the exposures as necessary, saving 
the resultant file as an .onphoto file; it will then open it in the module of your choice (as determined by the 
Open In menu in the Panorama window.)

BATCH PROCESSING PANORAMAS

Processing a group of panoramas inside Photo RAW is easy: create a separate folder for each panorama 
you wish to build, putting the slices for that panorama in the folder. Then, in Browse, select the folders you 
wish to build, and Photo RAW will automatically go through each folder, building the panoramas using the 
default options: Auto, with edges cropped and built at 100% size. 

Each completed panorama will be placed in the same folder as the component slices.

TIPS FOR CREATING GREAT PANORAMAS

Creating panoramas can be a lot of fun, and can capture the grand vistas in a way that a single capture 
cannot. There are certain best practices that will help ensure you can create a great panorama:

• Use a tripod, and ensure that it—and your camera—are level throughout the entire arc of your 
scene.

• Lock your metering and your focus before you shoot: use the same aperture, shutter speed 
and ISO for all of the shots in your panorama.

• Overlap each shot by 50 percent, to give you plenty of data for which to build your final 
panorama.

• If your panorama isn’t quite what you had hoped for—especially in terms of exposure—
and you have enough overlapping frames, try removing a few frames and rebuilding the 
panorama.

• Once you’ve got your images in Photo RAW, perform basic edits on them in Develop and turn 
Lens Correction on. (Save styling for after your panorama has been merged.)
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BLENDING HDR IMAGES
In addition to panoramas, ON1 Photo RAW 2026 has a second photo-merge feature: high 
dynamic range (HDR) photo creation. This feature lets you take multiple shots of a scene, at 
varying exposure levels—accurately capturing shadows, midtones and highlights in different 
frames across the series—and then blend them together to create a final image that has a 
much wider tonal range than a single shot could do. And, as is the case with the panorama 

feature, you can create multiple HDR composites via Photo RAW’s batch processing option.

To create an HDR image, go to the Grid or Filmstrip view in Browse and select the set of images that you 
wish to blend. Then choose Merge to HDR from the More menu in the left bumper (or choose Create HDR 
from the File menu). You will then see the Create HDR window, which has the following options:

A.	The Preview window displays a rendition of your merged HDR image (and is resizable).

B.	 The Options bar has settings for adjusting ghosting, choosing a default look, and which 
module you wish the resultant image to open in.

C.	 The Reference panel includes the images used to build the HDR, with their exposure values 
relative to the base image. The image with the outline is the base version used for deghosting; 
the base image for exposure is represented by the lens aperture icon next to the checkmark.
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D.	The Tone & Color pane from Develop (see page 150) and the HDR Look pane from Effects 
(page 188) are present to help you tune your image.

E.	 Save/Cancel buttons.

Once the Create HDR window is open, you can use the various options to tune your image. You can adjust 
the base image: clicking on the different frames in the Reference panel will choose a different base image 
for deghosting; to select a different base exposure image, click on the small lens aperture icon in a different 
image of the series. (By default, Photo RAW chooses the image it felt was closest to the middle of the 
series for both exposure and deghosting.)

The Default Look options are also designed to help get you started, corresponding to style options in the 
HDR Look panes. Natural and Surreal use those styles from the HDR Look pane. They are only designed to 
be a starting point: You can override any of the options by adjusting the settings in the two editing panes.

The deghosting section of the Options bar has options to blend portions of the frame that might have 
shifted during the image series (things such as clouds, flowing water or moving branches). Depending upon 
the amount of ghosting, you can choose from four levels of deghosting (or none). If you wish to see those 
areas in your image that will need deghosting applied to them, click the Show Ghosting button. Those areas 
that have ghosting issues will be shown with a red overlay. Depending upon how much movement there 
was in your scene, you can then choose the appropriate level of deghosting, or, in some instances, cancel 
and choose a different set of images to blend into an HDR.

The Align button in the Options bar is on by default, which means that, during the HDR generation process, 
Photo RAW will attempt to automatically align the images, based on their contents. Turn the Align button 
off when the alignment process results in a bad composite, or when you don’t want Photo RAW to align the 
images (when working with star photography, for example). With the Align feature off, Photo RAW will use 
the selected base image for the HDR process.

The Open In section of the Options Bar lets you 
choose what to do when your merged HDR file 
has been built. You can stay in Browse, or open 
your finished panorama in either the Develop or 
Effects tabs.

Once you have your settings adjusted to the 
way you’d like them, you can click Save and 
Photo RAW will build your HDR, saving it in 
the .onphoto file format and opening it in the 
module of your choice. The beauty of Photo 
RAW’s HDR engine is that any of the edits 
you make to your image in the Create HDR 
window are reflected in the Tone & Color pane 
in Develop and the HDR Look pane in Effects. 
Because ON1 Photo RAW is non-destructive, you can re-edit your HDR to fit your wishes. If you decide 
that you wish to use a different HDR Look style, or want to add additional effects to your photo, you simply 
open the image in the appropriate module and edit.

The Create HDR preview window, with the Show Ghosting option turned on. 
Areas that have ghosting issues will be shown with a red overlay.
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BATCH PROCESSING HDR IMAGES

The HDR batch processing option lets you take a folder containing multiple sets of bracketed shots from 
a shoot, and automatically turns them into HDR photos ready for editing. The process creates separate 
.onphoto files that can be opened directly in the Edit module. 

To do this, create a separate folder for each HDR composite you wish to build, putting the different 
exposures into that folder. Then, in Browse, select the folders, click the HDR button and Photo RAW will 
automatically go through each folder, building the HDR composite using the default options. Each 
completed HDR image will be placed in the same folder as the component photos.

To batch process a group of different bracketed shoots for HDR creation, put the bracketed images into separate folders, and in Browse, select the 
group and click on the HDR button.
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FOCUS STACKING
When working in the field, achieving perfect focus in a photo from the foreground to the 
background can be difficult, if not impossible to achieve. With ON1 Photo RAW 2026’s Focus 
Stacking feature, you can blend a series of photos taken at different focus distances, giving  
you more depth of field than any single photo. And, you can adjust the focus in real-time, just 
like changing the focus on your lenses. Think of it like HDR, but for focus instead of exposure.

Like the Panorama and HDR features, you generate a focus-stacked photo in the Browse module. Simply 
select the photos that you wish to blend and choose Merge to Focus Stack from the More menu. This will 
launch the Focus Stacking dialog, which has the following components:

A.	The resizable Preview window displays a rendition of your blended focus-stacked photo.

B.	 The Options bar has settings for aligning photos; an option to create a final layered file (with 
masks); which module you wish the resultant image to open in; adjusting the depth of field; 
and for fixing problem areas between the base photos in similar areas.

C.	 The Reference panel includes the images used to build the focus-stacked image, with their 
focus values (taken from the photo’s metadata, if available). Clicking the check box on an 
image removes it from the focus operation.

D.	Save/Cancel buttons.
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If there is focusing metadata in the source images, Photo RAW will display the sources from closest to 
furthest, with the focus distance listed, and the Preview window will show the suggested final photo. Photo 
RAW will automatically try to create the greatest amount of depth of field possible, but you can use the 
Depth of Field slider to constrict the depth of field in the blended result. For example, if you wanted less 
sharpness in the areas that are closer, move the left slider; for less sharpness in the distance, move the right 
slider in. To get back to the maximum focus, click on the Max button.

The Despeckle slider can be used when you have some movement in parts of a scene between your base 
images, such as movement of leaves in a stand of trees. Increasing the Despeckle amount can sometimes 
help in removing ghosted elements or distractions.

The Threshold slider reduces noise in smooth areas of the image set, although it may knock out subtle 
detail if driven too hard. Sensitivity biases the decision of final “winner” (which image is declared sharpest) 
for each pixel. Low values rely more on low-frequency portions of the image, where high values leverage 
high-frequency aspects of the image and may help reduce noise. Adjusting these are similar to adjusting 
noise reduction, you are looking for the best compromise of the the two.

When you have the result you desire, click the Save button, and Photo RAW will blend your source photos 
together and create a new photo saved in the .onphoto format. Depending upon your choice in the Open In 
portion of the Focus Stacking window, the photo will open in Browse or the Develop or Effects tab. If you 
chose the Layered Results option, all of the separate images will be displayed in their own layer, with the 
layer masks attached. 

Like all other image types inside Photo RAW, you can edit focus-stacked photos non-destructively in any of 
the Edit module tabs.
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TIME-LAPSE
ON1 Photo RAW 2026’s Time-Lapse feature lets you take a series of still images and turn 
them into stunning, flicker-free HD or 4K movies with the click of a few buttons, from directly 
in Browse. You can preview your results right in the dialog and create quick proof versions or 
high-quality final results. 

When processing a time-lapse sequence, Photo RAW can detect when the camera is bumped and will filter 
out misaligned frames. It can also detect changes in exposure and even them out automatically during 
processing, letting you create you “holy grail” style day-to-night videos. You can even increase or decrease 
the speed of the final videos to stretch out short sequences into longer, smooth videos.

To use the Time-Lapse feature, go to Grid view in Browse and select the photos to be used in the time-
lapse sequence, then choose Merge to Time-Lapse from the More menu. This will bring up the Time-Lapse 
window, shown below: 

A.	Title bar: Includes the number of frames in the sequence, and the estimated length of the 
generated time-lapse movie at the current Speed setting.

B.	 Preview area: Displays a small preview of the movie to be generated from the sequence. Use 
the Frame slider to scrub through the sequence.

C.	 RAW Input: Lets you set the type of proxy file used to generate the time-lapse movie. 
Options are Embedded JPEG (Fastest), Fast RAW (uses Detail view from the Browse cache), 
and Full RAW (uses the full raw file).

D.	Size: Settings for the final movie size—HD 720p (1280x720), HD 1080p (1920x1080), 4K 
(3840x2160), and 4K (4096x2304).
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E.	 Movie generation settings: Adjust the codec used to process the final movie (H.264 or 
ProRes), quality (High, Medium or Low), and the frame rate (FPS).

F.	 Speed: Slider to compress or expand the movie length.

G.	Options: Detect Camera Movement will look for misaligned frames, removing them from 
processing; Reduce Flicker will adjust exposure settings on the fly during processing.

H.	Create Video/Cancel/Process in the Background buttons.

When you click Create Video, Photo RAW will build your time-lapse video from the sequence using the 
settings in the Time-Lapse window. When the movie file has been created, the video file will be saved 
in the same folder that the sequence resides, and will be visible in Browse. Double-clicking on the file in 
Browse will launch your computer’s default video-playback app.

BUILDING EFFECTIVE TIME-LAPSE MOVIES

Unlike Photo RAW’s other image-combination tools, you’ll want to perform your finish editing on the 
sequence before you click on the Time icon. For some sequences, you can finish edit the first image in 
the sequence—or a representative image in the sequence—in the Edit module, and use the Sync Settings 
command to synchronize all of the edits across the sequence (see “Copying settings and synchronizing 
edits” on page 140). Then, turn the Reduce Flicker option on to let Photo RAW to adjust the frames’ 
exposure settings during the time-lapse generation process.

With more complex sequences, you might want to think of the sequence as different subgroups of 
exposure settings, edit a select frame from each group and sync that group’s settings throughout the 
sequence. You’d still want to use the Reduce Flicker setting, but in some instances, doing a little bit more 
subtle processing across a long sequence can help you create a better final product.

The settings in the Time-Lapse window have been designed to give you great flexibility when building 
time-lapse movies. When you go to create your initial movie from a sequence, think about creating ‘proof’ 
versions to check your movie’s settings and results. For example, use the Embedded JPEG or Fast RAW 
setting in the RAW Input pop-up, along with a smaller 720p or 1080p output size, for those first time-lapse 
movies. They’ll generate much more quickly, and you can get a good idea about your sequence and your 
final edits before producing that 4K masterpiece from the full set of raw files.
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PART 5: OUTPUT AND SHARING
While editing and organizing your photos are probably the most important tasks you’ll do on a regular basis 
inside ON1 Photo RAW 2026, there will be times when you want to “do something else” with your photos. 
Whether it’s enlarging photos for high-quality prints, sharing your photos with others or on social media, or 
printing to your desktop printer, Photo RAW has all the functionality you’ll need to get your photos where 
you want them to be. 

In this section, you’ll find detailed information on the following topics:

• Resize: The industry standard for image enlargement and printing. (See page 233)

• Export: The power of Resize in a quick and easy-to-use panel, letting you export your photos 
with flexibility, ease and control. (See page 253)

• Print: Print your photos in any size, as individual photos, or in contact sheet form. (See page 
264)

• Share: A quick way to share your photos, including via SmugMug. (See page 270)

• Send To: Edit photos in other photo apps. (See page 271)

• Other Sharing Options (MacOS only). (See page 272) 
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RESIZE AI
Photo RAW 2026 incorporates the latest version of Resize, ON1’s professional-quality resizing 
tool. The new version adds a state-of-the-art generative AI model to create the highest-quality 
photo enlargements of any resizing tool on the market. It uses diffusion technology to recreate 
new details and sharpness that the original photo lacks. It is perfect for low-resolution photos, 
AI-generated art, and tightly cropped photos. 

Existing enlargement methods create new pixels or resolution by copying those around them, leading to 
photos with less detail, soft edges, and more noise. Resize’s super-resolution technology enlarges photos 
while maintaining and recovering detail and sharpness. Its primary features include:

• Create large prints. Resize excels at making stunning poster-sized prints. Easily crop to a 
specific paper size, resize the photo with the ultimate detail, and then print it directly or save 
the file to send to a photo lab.

• Crisp details. Resize upscales your photo to any size and sharpens the final details incredibly 
well. You can even crop a portion of your photo and still have amazing quality and detail. It 
can equate to having a longer lens without the expense or weight.

• Breathe new life into old photos. The size and quality of old digital photos don’t compare to 
that available today. Now, remaster old images, making them bigger, sharper, and cleaner.

• Face recovery. Resize uses an advanced machine-learning model that detects small faces and 
enhances them with realistic detail. It can virtually reconstruct a face from modest details, 
adding realistic features and textures. 

• AI-based noise reduction. For original photos with high levels of noise — or photos with JPG 
artifacts — you can Resize’s built-in noise reduction, powered by ON1’s NoNoise AI, to reduce 
noise and artifacts during the resizing process, which leads to higher quality enlargements.

• Gallery Wraps. Resize’s gallery wrap feature can add reflected or stretched wings to the edge 
of your photo so you can make a canvas gallery wrap without losing image area.

• Tiling. Divide the photo into tiles or strips to make it easier to print a mural. You control the 
size of the tiles and how much they overlap for trimming.

• Batch processing and export. The powerful batch-processing engine in Resize lets you 
enlarge a group of photos all at once and save them using Photo RAW’s Export function. You 
have full control over how files are named, where they are saved, their file type, and much 
more. You can even add custom graphic- or text-based watermarks in the process.

• Print presets for easy automation. When it comes to preparing photos for print, knowing 
the proper resolution for your printer and the correct amount of sharpening for your paper 
choice can be daunting. Resize’s built-in presets make this a breeze. Just pick the kind of 
printer, the type of paper, and the size. 

• Complete printing support. You can print directly from Resize module, and can even use 
Photo RAW’s soft proofing feature to see how your photo will look when printed using 
specific printer and paper profiles.

NOTE: A fuller discussion of resolution and print size can be found in “How Big 
Can I Print?” and “How Much Resolution Do I Need?”, starting on page 251.
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Resize Main Screen Overview

Below is an overview of the main sections of the ON1 Resize window:

A.	Tool Well: Icons for the Crop and View tools, and for returning to Browse and Edit.

B.	 ON1 Cloud Sync Status/Close Left Panel: Top button opens ON1 Cloud status; the button at 
the bottom shows/hides the Presets pane.

C.	 Presets: Contains a library of presets for different printers, paper types and print sizes.

D.	Search: Lets you search for presets by name.

E.	 View Selector Pop-up: Switches between Detail and Filmstrip views (used to batch-process 
groups of photos or work on images within the same folder).

F.	 Preview Window: This is the main section where you preview and work on images.

G.	Preview option toggles: Magnification slider for current image, and buttons for comparing 
before/after views side by side and for previewing the original and edited versions on-screen.

H.	Navigator/Levels/Info Pane: Navigator, levels (histogram) and general photo information.

I.	 Photo Size: Displays the pixel dimensions of your photo.

J.	 Resize to: Lets you adjust the dimensions for the resized image.

K.	 Settings: For selecting the resizing method and adjusting smoothness in the final image.

L.	 Noise Reduction: Applies noise reduction during the resizing process. 

M.	Sharpening: Sets sharpening options for the resized photo.
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N.	Face Recovery: Enhances the details in small faces in a photo. 

O.	Film grain: Adds realistic film grain to the final image. 

P.	 Tiling: Lets you tile the finished image into a series of individual files for assembling into a 
mural or other oversized print piece. 

Q.	Gallery wrap: Sets a custom border on the finished image for use when printing on canvas.

R.	 Reset bar: Reset all settings (returns to original state); Sync copies the current image’s Resize 
settings with selected images (when in Filmstrip view); Cancel closes the current image and 
returns to Browse without saving your changes; Done saves the current image (when working 
in Detail, or single-image, mode) or opens the Export window (when working in Filmstrip 
mode). 

Basic ON1 Resize AI Workflow
The power of Resize is in the concept of resolution on demand;  Resize should be used as one of the last 
steps in your workflow before printing. You can work with a modest size file, which makes your editing 
faster and takes less hard drive space and memory. Then when you are ready to output your file, enlarge 
it with Resize to the desired size and sharpen it for output. This means you don’t have to keep multiple 
versions of a file at different print sizes; you just create what you need on the fly. 

You can access Resize from anywhere within Photo RAW by clicking on the Resize icon in the module 
selector: you can select an image—or group of them—from within Browse, or move directly to Resize while 
you’re working on an image in the Edit module.

Once you’re in the Resize module, you have multiple options for resizing:

• You can use the Crop tool to crop to a specific paper size (see page 237 for details);

• You can adjust the output size (with or without cropping) by using the Photo Size pane at the 
top of the Resize panel (see page 240); or

• You can use Resize’s built-in presets to crop and resize images to a specific printer, paper 
type and print size. Presets can include everything from specific crop and paper sizes, output 
sharpening parameters, film grain settings and more (see page 247).

All of these methods can be edited and changed as you work. Once you’ve set your output dimensions, 
use the Sharpening, Film Grain, Tiling or Gallery Wrap panes as needed. The Preview window updates as 
you adjust your settings, and you can go back and forth between the original and edited versions of your 
image as you work, either in a direct before/after view (by clicking the Preview button at the bottom of the 
screen), or in an adjustable split-screen view (via the Compare button in the same section).

When you’ve finished making your adjustments on your photo, pressing the Done key will prompt you 
to save your image (with a name and file format) and return you to Browse. You can also use the Export 
window to fine-tune the file format or to export different versions of the current photo.

If you’re working with a group of photos, either to batch-process them identically, or to work on them 
separately, the workflow is slightly different. Clicking Done will automatically open the Export window for 
saving the currently selected photos and will then return you to Browse. (See page 248 for information on 
working with multiple images.)
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USING RESIZE WITH ON1 CLOUD SYNC FILES

To use Resize with a file that resides on device other than the current device, you should be aware of two 
restrictions. First, Resize requires the creation of a new file, and this new file must be saved to the device it 
is being edited with. 

Second, if the synced photo you wish to use is an editable preview, Photo RAW will warn you that you will 
be working with a photo that has less fidelity than the original. If you want to be sure that you are using the 
highest-quality base layer, either copy the file to your current computer, or change the sync option for the 
photo’s folder or album to Originals, and download that from ON1 Cloud Sync.

For more information on these settings, see “Using ON1 Cloud Sync with Photo RAW” on page 75.

Navigating the Preview Area
The Preview area is the main section where you preview and work on images. You can use the View tool for 
navigating this window. This tool adjusts the magnification of the image in the Preview window. With the 
Zoom tool selected, click in the Preview window to zoom in and center the image at the location clicked. 

Hold down the Option/Alt key to pan around the magnified image. You can also double-click the View tool 
in the Tool well to set the image to 1:1 (or 100%) magnification view, which shows every pixel. This is best 
when examining small details, and when previewing Resize’s sharpening and resampling on your photo. 

As you adjust settings in the Resize panel on the right side of the screen, the preview will be updated in real 
time. If you’re performing a significantly large resize operation, it can take a few seconds for the preview to 
be updated completely. 

You can use the Split Screen control at the bottom of the main window to split the screen into two panes: 
the one on the left will display the original image; the one on the right will display the image with Resize 
settings applied. You can use the square in the center of the screen to make one of the panes larger, and 
can use the Zoom and Hand tools to view more detail or scroll around the image. (Click the Split Screen 
button at the bottom of the window to turn it off.)

NAVIGATOR, LEVELS AND INFO

At the top of the control panel on the right of the main window are the Navigator, Levels, and Info panes. 
These panes can be useful for inspecting and viewing details in your image.

The Navigator Pane

This gives you a birds-eye view of your image, with the 
region of the current zoom level represented by a white 
square. You can pan the current view by clicking and 
dragging inside the white box. 
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The Levels Pane

This gives you a color chart of the shadow, midtone and 
highlight areas based on the image RGB values (often 
called a histogram). This is useful to show areas within 
the image that may be clipping. Clipping is when your 
image contains pure blacks or white and can signify loss 
of highlight or shadow detail.

The left side of the histogram represents the shadows, 
while the right represents the highlights. At the top of 
each end is a triangle. If the triangle is lit, there is clipping on that side of the histogram. If you click on the 
arrows, you will activate the clipping overlay on your image. The areas of your image with a blue overlay are 
pure black, while the areas with the red overlay are pure white. You can turn the clipping view off again by 
clicking on one of the triangles. You can also temporarily enable clipping view by holding down the J key at 
any time. The clipping view is useful when you are making adjusts to the brightness and contrast of your 
image.

The Levels pane also displays the RGB values under the cursor at the bottom of the pane.

The Info Pane

The info pane displays photo metadata, including:

• Camera type

• File type

• Focal length and lens information

• Date and time captured

• Exposure information

• ISO

• Shutter Speed

• Aperture

• Exposure Value

• Filename

• Color Space

• Dimensions

• File Size

CROP TOOL

The Crop tool is used to crop and resize the entire image for output. Unlike the Crop tool in the Edit 
module, Resize’s Crop tool is destructive, and it does not support the Generative Crop feature—it removes 
pixels outside the crop box and changes the canvas size at the same time.
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To crop the image, select the Crop tool. Then adjust the corner handles of the crop tool overlay. The area 
outside the crop box appears darkened for guidance. You can resize and move the image inside the crop 
box. When you are satisfied, press the Apply button in the Tool Options bar or press Enter.

Working with the Crop Tool Overlay

• Moving the Image: To move the image inside the crop box, click and drag inside the box. You 
can also nudge the image using the arrow keys on your keyboard.

• Resizing: To resize the crop box, chose a preset from the pop-up, and click and drag on any of 
the resize handles. The box will resize based upon the print size you have selected in the Tool 
Options bar. To rotate the crop box, move outside a corner until the tool changes to rotate.

Crop overlays

When you select the Crop tool, Resize has the option to display guidelines as an overlay on top of your 
photo. These overlays can be used as compositional aids for cropping. There are a number of overlays that 
you can display during a crop session, and they can be accessed from the overlay pop-up menu in the Tool 
Options bar when the Crop tool is active. There are seven options — Rule 
of Thirds, Grid, Diagonal, Triangles, Golden Ratio, Golden Spiral, and None 
— and you can easily go back and forth between them as desired while 
cropping. 

In addition to overlay type, there are two other sets of options in the pop-
up menu: 

• You can choose to have the overlay displayed all the time during a 
crop session, or to only display the overlay when your cursor is in 
the preview area of the workspace.

• When working with the Triangles or the Golden Spiral overlays, 
the Flip Overlay options will be visible, letting you flip the 

The Crop Overlay in Resize.

The Crop Overlay pop-up includes 
seven options for setting and 
displaying overlays.
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orientation of the overlays horizontally (Golden Spiral only) or vertically (Golden Spiral and 
Triangles).

Crop Tool Options Bar

• Overlay pop-up: Selects a crop overlay, sets overlay visibility, and flips the overlay.

• Preset pop-up: Pop-up controls the crop tool mode as well as aspect ratio and document size 
presets. The Custom option lets you create your own preset crops.

• Width: Sets the width of the crop box.

• Swap Dimensions: Swaps the width and height. Handy for rotating the crop box.

• Height: Sets the height of the crop box.

• Units: Determines the unit of measure: Pixels, inches, centimeters, etc.

• Leveling tool: Click and drag this tool across an element in your image that should be level.

• Angle: See and adjust the angle of rotation.

• Rotate: Rotates the image 90 degrees.

• Cancel: Resets the crop tool.

• Apply: Applies the crop and resizes your photo.

Crop Tool Modes

The Crop tool works in three modes, which are all accessible via the Preset pop-up in the Tool Options bar:

• Freeform: In this mode you can adjust the crop box any way you like. The image will not be 
resized. Any area outside the crop box will be trimmed off. Use this mode if you just want to 
change the shape or recompose your image for general use.

• Aspect Ratio: You can lock the crop box to an aspect ratio. This makes sure the crop box 
shape doesn’t change, just the size. Use this option to trim existing pixels while maintaining a 
ratio without resizing the image.

• Document Size Presets: These let you crop and resize your image at the same time. If you 
know your intent is to print the image at a certain size you can crop and resize the image at 
the same time. Many common sizes are included plus you can create your own.

Leveling the Image

The Crop tool has a Leveling tool for applying rotation to your image to make it level. To access it, first 
select the Crop tool, then perform the following:

• Select the Leveling tool from the Crop Tool Options bar. Your cursor will change to the 
Leveling tool.

• Click and drag a line across your image that should be level, either horizontally or vertically. 
When you release the mouse the image will be rotated automatically to the correct angle.
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Creating custom document sizes

You can create document sizes by choosing the Custom option at the bottom of the preset pop-up. Resize 
comes with many commonly used print, paper and video document size presets but you can also create 
your own:

• From the Preset pull-down, select Custom > Manage Custom Sizes. This opens the Custom 
Document Size Presets window.

• Click on the Add button.

• Double-click on the highlighted untitled name and name your preset.

• Double-click on the width and height and fill in the proper values.

• Click on the units and select the proper unit.

• Click on the OK button.

PHOTO SIZE PANE

The Photo Size pane is the core of the Resize engine. It 
has two sections. The top portion displays the file size and 
pixel dimensions of the photo as you edit it. The bottom 
section provides multiple options for resizing your photo.

When you first open an image, the information in the top 
section of the Photo Size pane will be that of the original 
file; as you adjust the resizing options — via a preset, 
the Crop tool or the ‘Resize to’ portion of the Photo Size 
pane — that information will change, reflecting the size 
and dimensions of the resized image. (The original pixel 
dimensions and file size for the current image can be 
viewed in the Info pane.)

The ‘Resize to’ section of the Photo Size pane has seven options for resizing your images: Dimensions, Long 
Edge, Short Edge, Width, Height, Megapixels and Percentage. Most of the ‘Resize to’ options will scale your 
image proportionally; the Dimensions option is the only one that will open the Crop tool, because you are 
choosing a specific output/paper size for the resized file. 

Here are the specifics for the different scaling options in the ‘Resize to’ pop-up:

• Dimensions. Similar to the document size preset pop-up in the Crop 
tool’s Options Bar (see page 239), Dimensions lets you size your 
image to common paper and photographic print sizes, as well as any 
custom sizes you have created via the Custom Document Size Presets 
window. When you chose an option from the Common Sizes pop-
up, Resize will open the Crop tool, so you can crop your image to the 
appropriate paper size.

• Long Edge and Short Edge. These options are useful when you want 
to lock one edge to a specific length or width and don’t care about the 
sizing of the other edge. Simply choose which option is the important one for your photos, 
and enter the desired amount in pixels, inches, centimeters or millimeters. These options can 

The ‘Resize to’ pop-up menu.
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be helpful when batch-processing a group of photos that have different orientations, and you 
want them all to have the same dimension on the long or short edge.

• Width and Height. Using this option will scale the current image based on your choice of 
either the width or the height metric. 

• Megapixels. Scales the current image to a specific megapixel count.

• Percentage. This option enlarges or reduces the size of the exported 
images based on specific percentages. Numbers below 100 will reduce 
the image, while those above 100 will enlarge the image.

All of the options in the ‘Resize to’ menu include a Resolution section, 
represented either as pixels/inch or pixels/cm. To the right of the field is a pop-
up menu with common settings for various printers and other output formats. 
(See “How Much Resolution Do I Need?” on page 252 for more information on 
choosing the proper resolution and sizing for your photos.)

You can readjust any of the options in the resizing section at the bottom of the Photo Size pane. You can 
move between options, use the Crop tool, or even choose a preset, and Resize will recalculate based on 
your new choices.

SETTINGS PANE

The Settings pane contains the controls for selecting the resizing method (or algorithm) and its settings. 
At the top of the panel are shortcuts for both of the 2026 models, Standard and Highest Quality. These 
options can also be slected via the Model pop-up menu, which includes four options:

• 2026 Standard. This model performs 
extremely well when working with most 
photos, including low-quality, noisy, and 
artifact-ridden input, while maintaining 
performance for batch processing, large 
output, or with older GPUs.

• 2026 Highest Quality. This state-of-
art generative AI model produces the 
highest quality results available. It uses 
diffusion technology to recreate details 
and sharpness that the original photo 
lacks. It also removes noise and other 
artifacts. It is perfect for small, lower-quality input, AI-generated art, and extreme crops. It 
is more time-consuming than the Standard model, but the results are often worth the extra 
wait.

• Genuine Fractals. This is the classic, patented, fractal-based algorithm used in Perfect Resize. 
It is included solely for backward compatibility with previous versions of ON1 Resize.  

• Bicubic. This option is for downsizing images. It has no settings.

The Tile Reduction setting should rarely be changed. On some photos with a very smooth background, you 
might be able to detect where tiles overlap. Changing that control to High will help reduce that, but at a 
processing time cost.

The Resolution pop-up has 
common print resolutions.
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Genuine Fractals settings

As noted, the Genuine Fractals resizing method is included solely for backward compatibility with previous 
versions of ON1 Resize. If you wish to use it, there are three sliders for adjusting the resizing parameters:

• Texture. This controls the amount of detail in flat, non-edge areas of an image. Smaller 
numbers (1-2) are good for images with large areas of continuous tone, while larger numbers 
(3-5) are good for images with lots of small detail. Settings beyond 5 will often introduce a 
bumpy noise pattern; it works best when your original image was from scanned film.

• Threshold: This controls the amount of hard edge detail that is enhanced. The default 
setting is 25. Decreasing the threshold will focus the Genuine Fractals algorithm on edge 
information. This may be useful for portraiture or for reducing noise in your image. Settings 
higher than 25 will increase the amount of small detail in flatter areas of the image. Settings 
as high as 100 are useful for highly detailed images (hair or feathers). 

• Smoothness: The smoothness slider is used to reduce artifacts along hard curved edges. Use 
the lowest setting needed.

SHARPENING PANE

The Sharpening pane contains the controls to add additional 
sharpness to your image. ON1 Resize features three 
sharpening methods:

• Unsharp Mask: Good for general sharpening. 
Similar to Photoshop’s Unsharp Mask function. 
Resize’s sharpening is different in that it is only 
applied to the luminance of the image, to prevent 
color artifacts.

• High Pass: High Pass sharpening is helpful when 
the original image is not sharp.

• Progressive: Similar to Unsharp Mask, except it 
sharpens different amounts depending on the 
size of the details in the image. Small details are 
enhanced more than large ones.

Using the Sharpening controls can save you the workflow 
step of adding additional Sharpening before printing and can 
help compensate for loss of sharpness due to dot gain from 
your printer. Sharpening should only be applied at the end 
of your workflow just before printing. If you plan to do additional retouching or compositing work after 
resizing your image, you should disable the Sharpening controls.

To sharpen your image for output, use these steps after you have adjusted the Document Size pane 
controls:

1.	 Zoom in on your image to 1:1. You can do this easily by using the 1:1 Zoom preset located in 
the Navigator pane.

2.	 Enable the Sharpening controls by toggling the on/off control in the pane’s title bar.
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3.	 Select the sharpening method that will provide the best results for your image. You may 
need to experiment to determine this.

4.	 Adjust the amount slider to determine the amount of sharpening desired.

5.	 Use the Highlight and Shadow sliders to limit the sharpening from being applied to the 
darkest and lightest areas of the image which can prevent sharpening of noise.

6.	 Similarly, adjusting the Skin slider can help protect skin tones from being oversharpened in 
the resizing process.

FACE RECOVERY PANE

ON1 Resize’s Face Recovery feature is designed for times when 
you have a photo with a group of people, and some of the 
smaller faces in the photo have less detail in them. Previously, if 
you used any resampling technology to upscale such a photo, 
those less-defined faces could appear even softer than the 
original photo. With ON1’s face-recovery technology, you can 
resize these types of photos and have those faces 
appear with more realistic features and textures.

To use Face Recovery, click the button to the left of 
the pane’s label to turn on the setting. Resize will 
analyze the photo, recognize the faces in it, and apply 
the resampling algorithm to the smaller-sized faces 
(ones less than 512 pixels square in the original) in the 
photo, using the Strength slider’s setting. 

To view the faces in the image, click on the Select 
Faces button at the bottom of the Face Recovery 
pane. This will display a box around each found face 
in the photo. If the face is standard-sized, the box 
will be white, and that face will not have the recovery 
algorithm applied to it. All smaller-sized faces in 
the photo will have a green box around them, and 
those faces will have recovery applied, at the level 
determined by the Strength slider. (The Strength 
setting is applied globally to all of the selected faces; 
you cannot apply different settings to each face.) 

Here are a few tips for working with Face Recovery:

• With most photos, you should verify that the recovery algorithm is being applied to the 
selected faces, and at the correct strength for the photo. Click the Select Faces button to 
display the faces, and view them at 100% to make sure you are satisfied with the results.

• You can turn each face on (green) or off (white) by clicking inside that face’s box.

• When judging the recovery results, you should look at each face at 100% view. Adjust the 
Strength slider as desired.

When you click the Select Faces button, Resize will analyze the photo 
and put a box around every face it finds. Boxes in green indicate smaller 
faces that will be processed with the recovery technology; Boxes in 
white will not. You can fine-tune which faces you wish to have the 
recovery effect applied by clicking in the boxes. 
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• Sometimes, you might find that Face Recovery helps with larger faces in a photo (for example, 
when dealing with faces that are slightly out of focus). Toggle that face’s box on and off at 
100% to see if it improves the results.

• When you’re done with the pane, click the Done button. To work in the pane again, click the 
Select Faces button. Photo RAW remembers all of the faces selected, as well as their on/off 
state.

FILM GRAIN PANE

The Film Grain setting controls the amount of simulated Film Grain 
(noise) to your image. Adding a modest amount of grain can make 
your image appear sharper visually and can help hide imperfections 
(such as JPG artifacts).

Adding film grain can be especially useful for monochrome images, 
and should be added just before printing. If you need to do other 
retouching or compositing work in Layers after resizing your image, 
you should disable the Film Grain controls in Resize.

To add Film Grain to your image, first zoom in on your image to 1:1. 
You can do this easily by using the 1:1 Zoom preset located in the Navigator pane. Then, enable the Film 
Grain controls by toggling the on/off control in the pane’s title bar. Adjust the slider up or down until the 
desired amount of Film Grain is added.

You can preview just the effect of the Film Grain by toggling the on/off control in the pane’s title bar.

NOTE: As is the case with the Sharpening pane, if you need to do further 
retouching or compositing work in Photoshop (or other editing app) after 
resizing your image, you should not use the Film Grain pane.
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TILING PANE

The tiling feature in Resize divides an enlargement into smaller pieces so that the image can be printed 
on a smaller printer. For example, you might want to create a mural that is 8 feet tall by 12 feet wide, but 
your printer can only print 24-inch wide strips. With the tiling feature you could automatically create four 
separate files that are 24 inches wide and 8 feet tall, to create your mural in sections.

With the tiling feature all you do is specify the size of paper you have to print on and if you would like the 
pages to overlap. Then ON1 Resize will resize your image and section it down into the individual tiles.

To use the Tiling pane:

1.	 Turn Tiling on by toggling the on/off switch in 
the pane’s title bar.

2.	 Set the Width and Height fields to the size and 
orientation of paper that you wish to print on, or 
you can select the number of rows and columns 
instead.

3.	 Set the Overlap size. The overlap makes each 
tile overlap so you can tape multiple panels 
together and corrects for printer margins if you 
are not printing borderless.

The preview will show cyan guide lines for each tile that will be created. The bottom of the Tiling pane will 
tell you how many tiles will be created.

When you want to print big, but lack the big printer, Resize’s Tiling feature lets you create flexible, tiled prints on smaller paper sizes.
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GALLERY WRAP PANE

The Gallery Wrap feature is designed to help you print on canvas. When making enlargements for canvas it 
is common to wrap a portion of the image around wooden stretcher bars, commonly called gallery wraps. 
However, if you had important detail near the edges of the image, it might be lost in the wrapping process. 
The Gallery Wrap feature automatically creates extended margins by reflecting or stretching the areas near 
the edge of the image without having to sacrifice any of the original image. You can select the thickness of 
the mounting bars and use different options for creating additional margins.

To use the Gallery Wrap feature:

1.	 Turn on the Gallery Wrap feature by toggling the 
on/off switch in the pane’s title bar.

2.	 Set the Thickness control to the amount of 
margins you would like to add. A good rule of 
thumb is to use the thickness of the stretcher 
bars, plus half an inch.

3.	 Select the Type of wrap (see the list below).

4.	 If you wish to add a color overlay to the gallery 
wrap wings set the color and opacity.

The Gallery Wrap feature has several settings for adding margins and adjusting the look of the wrap:

• Reflect: Copies an area equal to the thickness setting around your image, then flips each side 
and adds it as the margins. This is a good general-purpose technique.

• Reflect Soft: Does the same as the Reflect method but softens the added margins.

The Gallery Wrap feature lets you choose from four different wrap types,with adjustable thickness and opacity settings for the wrapped edges.
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• Stretch: The Stretch method takes an area around the edge of the image and stretches it to 
add the margins.

• Stretch Soft: Does the same as stretch, but softens the added margins.

The Thickness slider controls how thick your canvas stretcher bars are. Two inches generally works well for 
most gallery wraps.

You can darken the wrap or add a solid color to the wrap area with the Overlay Color and Opacity sliders. 
(The Opacity’s default is 0, which means that there is no color overlay added.)

PRESETS

Resize has a preset system built into it, much like the one used by 
Develop and Effects, but which is designed to help you get very 
specific crops for a wide range of paper and printer types. These 
include settings for photo lab print sizes, and many Epson, Canon 
and HP large-format printers, with multiple media types.

In addition to being able to set document size and settings, and 
settings in any of the other panes, Resize presets always contain a 
Crop adjustment: any time you apply a preset, Resize selects the 
Crop tool and places the crop overlay on-screen. You can resize the 
crop, or move the overlay to a appropriate crop area.

To apply a preset, choose the category you would like to use from 
the Presets panel. The category will expand to a list of the available 
presets for that group. Click on the preset you wish to apply.

Saving a Preset

Once you have your settings that you wish to save, go to the 
Preset menu and select Save Preset, and choose a category you 
would like to save it in. If you have applied a preset to an image and 
make adjustments to any of the settings in the left panel, you can update that preset with the new setting 
by choosing Update Preset with Current Settings from the Preset menu. To delete a preset, right-click on 
the preset in the Presets Browser and choose Delete Preset.

NOTE: You can also import and delete Resize presets from within the Extras 
Manager. See “Extras” on page 10 for more.
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Working with Multiple Images in Resize
You can resize multiple images in a folder from within Resize by using Filmstrip 
view. Clicking the Filmstrip icon in the View Selector at the bottom of the 
screen (to the right of the Detail view icon) will display a strip of the photos 
contained in the current image’s folder. Once the folder is open, you can resize 
each image individually, or you can adjust the settings for one image and sync 
those settings to all (or some) of the images in the selection. When you’re 
finished with your session and click the Done button, Resize AI will save your 
resized photos via the Export window (see page 253 for more on Export).

When you are working on a group of images in Filmstrip view, each image is 
displayed with its original pixel dimensions and its resized dimensions (once 
you have applied Resize settings). You can move between images by clicking 
on them in the filmstrip or by using the arrow keys.

With the open images, you can adjust the resize parameters for each image individually, by moving from 
image to image, or you can edit one image, select any images in the filmstrip that you would like to copy 
those settings to, and click the Sync option at the bottom of the Resize window.

When you use the Sync Settings option, all of the properties of the current image — including crop and crop 
position — will be applied to the selected images in the filmstrip. The crop is re-editable on any image 
during the session. Just click on the image you wish to change, and make your changes.

Turn the Filmstrip view on by clicking 
the icon to the right of the Detail 
view. This will let you resize multiple 
image in Resize. 

When you use the Filmstrip view inside Resize AI, all of the photos in the current folder on disk will be displayed at the bottom of the main window. You can 
select all of the photos by choosing Command-A (Mac) or Control-A (Windows). The current image being worked on will have a bolder highlight around it.
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Some additional notes about batch-processing images and working with the filmstrip:

• If you are using Browse’s Filmstrip view to select multiple images and then click on the 
Resize icon in the module selector, that selection will be maintained inside Resize AI, and the 
Filmstrip mode will open automatically inside the module. If you select a group of images 
in Browse’s Grid view and open them in Resize AI, the selection will remain, but you’ll be in 
Detail (single-image) view. Click the Filmstrip view icon in order to work on other images in 
that folder. 

• To select multiple images in the filmstrip, Control-click (Windows) or Command-click (Mac) on 
each image you wish to select. To select a sequence of images, click on the first image, then 
Shift-click on the last image in the sequence. To select all of the images in the folder, use the 
Select All command (Control-A for Windows, Command-A for Mac). 

• To deselect an image from a group, use the same Control-click (Windows)/Command-click 
(Mac) mechanism. This can be helpful if you wish to sync only some images in a group, or 
remove any images from the export group (see below).

• When you click Done, only the selected images in the filmstrip will be exported. If you have made 
changes to the selection during your session, and want to export the entire group, use Select 
All.

• The Reset All command only works with the currently selected image. If you need to reset all 
of your work, either choose Cancel, which will take you back to Browse , and reopen the 
batch. Alternatively, you can click on each image, choose Reset All, and move to the next 
image.

After you have resized your photos, either individually, or via the Sync command, the new pixel dimensions for each image will be 
displayed at the bottom of each thumbnail in the filmstrip.
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SOFT PROOFING IN RESIZE

ON1 Photo RAW’s soft proofing feature lets you see how a photo will look when printed, using the color 
profiles that get installed with your printer. Soft proofing helps you determine where there might be issues 
when you print, so that you can adjust your tone, color and effects to give you a print that is closer to your 
editing vision.

Normally, when you’re viewing an image in Photo RAW, 
you are viewing it through the lens of your monitor’s 
display profile. The color gamut of your computer’s 
display is wider than that of most photo printers, which 
means that some colors you are able to view on-
screen are not reproducible when you print. When this 
happens, the color profile conversion that happens in 
the print engine will cause substitutions of colors that 
the printer cannot print to the closest color that it can. 
This means that your image could have subtle (or broad) 
shifts in color, especially in certain color ranges.

Soft proofing is turned on via the View menu, or by 
clicking on the soft proofing icon to the left of the 
Preview button at the bottom center of the main Resize 
window. The background of the main preview window 
will change to approximate the color of the paper you’re 
profiling. 

Additional soft proofing options are available 
underneath the Enable Soft Proofing command in the 
View menu. The options are as follows:

• Gamut warning: When checked, this displays 
colors in the image (via a red overlay) that 
don’t correspond to the current printer profile 
being soft proofed.

• Profiles: The Profiles submenu lists the 
currently available printer profiles. Choosing 
one will change the on-screen display to use 
that profile.

• Intent: Photo RAW offers two different 
rendering “intents” when soft proofing, 
which are used to convert the color from 
display to print. Perceptual shrinks the color 
gamut during the conversion, which works to 
preserve the relationship between colors in 
the image. The other intent type, Relative, only 
converts colors that are outside the current 
color gamut, but this can sometimes cause 
two colors, one in gamut, and one outside, to 
be identical after conversion.  

These three screen shots show the results of soft proofing options, as 
viewed in Resize. The top image is with soft proofing off (and is using 
the display color profile). The middle image is with soft proofing 
turned on, and using a printer profile for Epson’s Exhibition Fiber 
Paper. The bottom image has the Gamut warning turned on; out of 
gamut colors are highlighted by the bright red overlay.
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Neither rendering intent is perfect or desired; it often is a matter of the makeup of the image, 
your editing intent, the paper being printed on, and so forth. Often, you’ll want to switch back 
and forth between Relative and Perceptual, seeing which gives you a better print.

• Simulate Paper and Ink: Turning this setting on will cause Photo RAW to use the white point 
for the chosen paper type (instead of the white point of your monitor), and the paper’s actual 
black density (instead of the display’s black point). If you’re trying to match a print, you will 
usually want this setting turned on.

Adjusting images with soft proofing is often a bit of trial and error. It’s easy to get caught up in eliminating 
out-of-gamut colors, but most modern photo printers—both home printers and online print services—do a 
pretty good job of approximating colors properly. 

NOTE: Since you can’t edit the tones in your photo from within Resize, it’s a 
good idea to perform a soft-proof check in the Edit module before taking an 
important image into Resize. 

The biggest thing you want to be looking for when viewing a soft proof is tone, contrast and color accuracy 
between screen and print. When using a home printer, use test prints to hone in on the right mix of Edit 
module adjustments. Photo RAW’s Versions feature can be extremely helpful when you’re tweaking 
settings to get a print just right (see page 72 for more on working with Versions).

Understanding Resize AI: How Big Can I Print?
People often ask how big you can print with ON1 Resize AI. The simple answer is this: if your original photo 
is sharp, with good details and little noise, you can print almost as big as you desire. The limitations are the 
size of your printer or the capacity of your computer to work with large file sizes. In practice, however, even 
the largest prints are rarely more than 400 percent larger than the original photo. 

Historically, the standard viewing distance for photographic prints is generally considered to be twice the 
diagonal measurement of a print. For example, the ideal viewing distance for an 8x10-inch print would be 
slightly more than two feet away, while the viewing distance for an 80x100-inch print would be over 21 
feet. That last distance might seem like a lot, but that’s the kind of mural — almost 9 feet tall — you would 
see at an airport or shopping mall. (Keep in mind too that many photographers scrutinize their images closer 
than standard viewing distances; most people don’t get that close.)

Photos are perceived in color, tonality, textures, and sharpness. Other interpolation techniques maintain 
color and tonality but sacrifice textures sharpness by “inflating” the image uniformly. The image still looks 
similar, but will not be crisp. Depending on the amount of interpolation, this can be severe and noticeable 
even at standard viewing distances. ON1 Resize AI maintains the color, tonality, textures, and sharpness of 
a photo at all sizes. It can actually create new detail at the proper scale.
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How Much Resolution Do I Need?
To answer this, you need to know two things:

1.	 The size of the print you wish to make.

2.	 The resolution that your printer needs for best results.

The size of the print can be as large as you would like, although, obviously, you will be limited by the 
maximum print size of your printer (although tiling can help). 

Resolution is the density of the pixels for a given measurement, usually in pixels or dots per inch (or 
cm). Most modern inkjet printers print anywhere from 1200 to 4800 dots per inch, but what the printer 
manufacturers really mean is 1200-4800 droplets of ink per inch. A common mistake is to set the 
resolution of the file to the resolution of the printer. In all but a few specialty printer types (like dye-
sublimation) this will lead to huge files that will not print well, if at all.

The secret is that the human eye cannot see more than 250-300 pixels per inch, and the ideal resolution for 
your files should be close to this. Once you know the print size and resolution, it is easy to use Resize AI to 
scale your file to the desired output size. Simply enter the resolution and the output specifics in the ‘Resize 
to’ section of the Photo Size pane. You’ll see that the corresponding dimension is automatically computed 
by Resize AI based on the proportions of your image.

Keep the proportions in mind because the proportions of film, digital camera sensors, and paper can all be 
different. For example, most digital camera sensors are proportioned so that the height is two-thirds the 
width or 1:1.5; While the most common paper size, in the US, is the letter which is 8.5×11 inches or about 
1:1.25. These kinds of proportion mis-matches are common and require that the original image be cropped 
to fit the proportions of the paper size. If your image cannot be cropped without ruining the composition, 
then you will need to adjust your print size to a longer dimension.

Resizing an image larger than the original size requires new pixels to be created. This process is called 
interpolation or resampling. There are many mathematical ways, called algorithms, to do this. The most 
common method used by many pixel-editing apps is called bicubic interpolation. Bicubic along with its 
newer variants bicubic smoother and bicubic sharper work by averaging a small group of neighboring 
pixels to determine the color value of the new pixels to be added. While this technique is fast, it does not 
distinguish edges so there is a uniform loss of sharpness and detail across the image.

Resize AI uses a neural network trained on millions of examples of photos. It is fundamentally different 
from bicubic or other interpolation methods. It can analyze the photo and faithfully recreate textures in 
nature, at the proper scale, all while maintaining the sharp details and reducing noise and artifacts. All this 
number crunching may take a bit longer than the single pass interpolation methods like bicubic, but good 
things come to those who wait and the reward is far superior results.
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EXPORT
Export is a special function that is available throughout ON1 Photo RAW 2026, whether 
you’re working from within Browse, Edit or Resize AI. The Export window gives you much of 
the power of Resize in an easy to use panel, letting you export your photos with incredible 
flexibility, ease and control.

The Export window is separated into two panels: Export Presets and Export Options. The Options panel 
contains specific types of options—file renaming, destination folders, file type and more—that you can use 
when you are exporting images from Photo RAW. If you find that you are using a specific set of options all 
the time for your workflow, you can create a preset and apply that whenever you use Export.

The contents of the Export window include:

A.	Export Presets: The current preset (if used), will be represented with a selection box around 
it, and the filled circle to the left of the preset name means that it will be used when the 
Export button is pressed. To use the Export Options panel without any preset applied, turn 
off all of the presets in the list, and click in the current preset once.
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B.	 Save Preset: Lets you save the current set of export options as a preset.

C.	 Naming: Renames the exported file based on criteria added to the rename box in the panel.

D.	Destination: Lets you set the destination of the exported files. (required)

E.	 File Type: Sets the file type for each exported file. (required)

F.	 Resize: Adjusts the size for each image. (not available when exporting from the Resize AI module) 

G.	Sharpening: Applies sharpening to the exported images.

H.	Metadata: Adds/removes metadata from the export. 

I.	 Watermark: Lets you add a text or graphic watermark to an exported image. 

J.	 Background Export: turns on background exporting when you click the Export button.

K.	 Export/Cancel: Starts the exporting, or cancels it and returns you to Photo RAW.

 Export Options

NAMING

The Naming pane gives you extensive controls 
for creating customized filenames using tokens 
in the entry box inside the pane, as well as with 
any custom text entered directly into the entry 
box. You can use any combination of tokens 
and text in the entry box, and the Example label 
directly above the box will display what your 
new filename will look like, using the first item in 
the export group.

To use this feature, click the control circle to the left of the label in the panel. Add any custom text, or 
click the Add Token pop-up menu to add tokens based on information associated with the image, including 
filename data, date and time information, and associated metadata There are four submenus in the Add 
Token menu:

• Filename, which includes options for using the original filename, number suffix (taken from 
the image as recorded by the camera) and enclosing folder name.

• Date/Time, which includes a list of date (year, month, day) and time data that can be 
combined in various ways.

• Sequence, which adds an incremented number to each renamed file in the batch, as well as 
the total number of files in the batch, with options for leading zeros in the resultant filename. 

• Metadata, which lets you add specific EXIF and IPTC metadata to the filename.

To build a rename sequence using tokens, click on the Add Token button, and choose the appropriate token 
from the pop-up menu. The token will be added as a shaded item in the text field, and the Example item 
above the text field will show a sample of a renamed file using the current set of tokens and custom text. 
To change an existing token, click on the down arrow on the right of the token, which will display the full 
set of tokens. To delete a token, double-click on it and press the Delete key.
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Custom text can be added anywhere in the entry field. You can click the cursor at the beginning or end 
of a token (or in between tokens) and add spaces, dashes, underscores and any other text you wish to be 
included in each renamed file. Each change you make will be updated automatically in the Example label.

The Presets pop-up menu at the top of the Rename window includes a set of common batch combinations 
that you can use as a starting point. You can also create your own batch-rename presets: build the rename 
options you wish, and choose Save New Preset from the bottom of the Presets menu. You can also update 
an existing preset and delete presets from this menu.

Because the Rename process is not undoable, make sure you use the Example field to check that your text 
and token combinations give you the filenames you expect for your batch process, and adjust as needed. 
When you’re sure, click Apply, and Photo RAW will rename all of the files.

NOTE: A complete list of the tokens used in the Rename window, with 
explanations, can be found on page 261.

DESTINATION

The Destination pane is where you set the 
desired location for the exported images. At 
minimum, you must specify a destination folder 
for your export, but the pane has a number of 
options for adjusting the export location:

• The Folder pop-up menu lets you 
choose the same folder as the original 
images, another folder, or, can be set 
to ask for a destination every time, 
which can be helpful when you’re 
using an export preset.

• Checking the Put in Subfolder option 
will export the images to the folder—
or, create a new folder, if it doesn’t 
exist—specified by option’s text field.

• The Existing Photos pop-up is for 
those times when there might be a 
naming conflict within the destination 
folder. Replace will overwrite the file 
with the new one being exported, 
Skip will leave the destination file alone and not export the new file, and Keep Both will add a 
number ‘1’ to the end of the filename of the exported file, preserving both files.

• Generate Subfolders will subdivide the export based on the exported file’s metadata, 
creating subfolders as necessary—or, if the folders exist, placing the exported file into the 
appropriate subfolder. This option uses the same token-driven scheme (and presets) used in 
the Naming pane.
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• After Export lets you determine what to do when Photo RAW completes the exporting 
process. Options include displaying the image location in the MacOS Finder or Windows 
Explorer, to create a ZIP archive of the exported group, to open in another editing application, 
or to run a script.

FILE TYPE

Like Destination, File Type is the other required 
element for using Export. Photo RAW can 
export in DNG, PSD, TIFF, JPG and PNG 
formats. With the exception of DNG and PNG, 
each file format has specific options in the pane:

• Original includes options for embedding metadata and saving an ON1 sidecar file with the 
exported images.

• JPEG includes options for JPEG quality and for attaching a color profile.

• Photoshop includes options for attaching a color profile, bit depth, and whether to flatten 
any layers in the original image.

• TIFF includes options for image compression (none, LZW or ZIP), attaching a color profile, bit 
depth, and to preserve transparency.

• DNG and PNG have no additional options.

The File Type pane also includes an estimated file size for the first item in the group.

RESIZE

The Resize pane lets you adjust the finished 
dimensions of the exported photos, using the 
ON1’s Resize AI technology found in Photo 
RAW’s Resize module. It has seven options for 
export: Dimensions, Long and Short Edge, Width 
and Height, Megapixels and Percentage. Each 
option has a different range of settings, and all 
have a setting for resolution (in pixels per inch, 
or ppi), as well as a Don’t Enlarge option, which, 
when set, will not upscale a file past its native image dimensions (but will still export the file).

NOTE: The Resize pane is not available when using Export from within the 
Resize AI module, as the resizing parameters are driven by the module itself.

The Dimensions option is the most complex of the six Resize options, letting you set the exact pixel 
dimensions of the exported files, in terms of width and height. This option is best for when you are 
exporting single images, when all of your exported files have the same aspect ratio and orientation, or 
when you wish to fit the exported images to an exact size. 

The Resize pane, with the Dimensions option open.
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The Common Sizes pop-up menu at the top of the pane options lets you set the final dimensions to any of a 
broad array of common paper, photographic ratio, square and video formats. You can also create your own 
specific sizes for re-use via this menu.

Click the lock to resize the images proportionally as you enter either the width or the height, or, if you wish 
to fit the images to an exact width and height, click the lock icon to turn it off. If an exported image doesn’t 
exactly fit the dimensions you set for Width and Height, Export will do one of two things, depending upon 
whether you have Fit in Dimensions or Fill Dimensions set in the pop-up to the right of the Resolution box.

• Fit in Dimensions will fit the file inside the boundaries of the width and height settings.

• Fill in Dimensions will zoom the exported image to completely fill the boundaries of the 
width and height settings, essentially cropping the exported image. If the image’s aspect ratio 
is different from the width and height settings, the image will be filled from the center. 

The Dimensions options include one more setting, Rotate to Match Photo, which, when checked, will rotate 
an exported photo to maximize its orientation. For example, if you exported a group of images to fit a 
landscape orientation (longer width than height), any image that was in portrait orientation (longer height 
than width) would be rotated during export.

Long Edge and Short Edge are useful when you want to lock one edge to a specific length or width and 
don’t care about the sizing of the other edge. Simply choose which option is the important one for your 
photos, enter the dimension, and Export will resize your images proportionally based on the chosen setting. 
When you’re exporting a group of images with different orientations (landscape or portrait), these options 
will ensure that all images have the same long or short edge dimension.

Width and Height will resize all of the images proportionally to the width or height defined, regardless of 
orientation. Exporting photos with different orientation will result in the width or height of every image 
being the same, depending upon the setting chosen.

Megapixels will export images to a specific megapixel count, while Percentage will enlarge or reduce the 
size of the exported images. Percentages below 100 reduce the image, those above 100 enlarge the image.

SHARPENING

The Sharpening pane has two modes, Sharpen 
For and Manual. The Sharpen For pop-up 
menu lets you choose from six options, based 
upon your final intent. There are four options 
designed for print output, Glossy Paper High 
and Low, and Matte High and Low, and two 
option for display output (for social media or 
online sharing), Screen High and Low.

The Manual setting provides a bit more control 
over the output sharpening, letting you adjust the Amount (overall strength), Radius (detail) and Threshold 
(masks out areas that shouldn’t be sharpened based on contrast). 

For more specifics about the Manual sharpening options, see the Sharpening filter on page 84.
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METADATA

The Metadata pane lets you set which pieces of 
metadata are exported—or not exported—with 
the images in the export set. You can choose to 
export all Metadata or by clicking the control 
circle to the right of the All Metadata label. 
If you click that label off, you can then select 
which metadata items you wish to save by 
clicking the appropriate label.

The metadata information exported is the same 
data found in the Metadata pane in Browse, and any metadata presets you have saved will be available 
from the Presets pop-up menu. For specifics on the different types of data represented in the Metadata 
pane, see page 45. 

When checked, the Remove Unmanaged XMP button only exports metadata that is represented in Photo 
RAW’s Metadata pane; any other unmanaged image metadata from other apps will not be included. 

WATERMARK

The Watermark pane adds either text- or graphics-
based watermarks to an image, with options for 
size and positioning, opacity, font type, and more. 
You can import your own logos and save either 
watermark type as a preset for frequent use. 

The Watermark pane also gives you a representation 
of your chosen watermark (on the first image in your 
export group), so you can adjust the parameters of 
the watermark precisely.

To create a new watermark, turn on the pane by 
clicking on the control circle to the right of the label. 
Choose either a preset from the Presets menu or 
click on the Add Watermark button in the lower 
right of the pane and choose either Text or Logo 
from the pop-up menu. Once you’ve selected a type, 
the bottom of the pane will open with settings for 
the chosen option. If you change your mind, click the 
Cancel button to the right of the Logo or Text labels.

Using graphics-based watermarks

The Logo section of the Watermark pane lets you 
use either watermark files imported via the Extras 
Manager (see page 10), which will be displayed 
in the File pop-up at the top of the Logo section, or 
by clicking on the Import button to the right of the 
menu (which will add them to the menu). 
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Use the Position grid at the bottom of the pane to place your watermark, and use the Size and Inset sliders 
to move it within the area chosen. The Opacity slider adjusts the transparency of the watermark on the 
final image.

The Repeat Image button will repeat the logo graphic rightward across the image from the location chosen 
in the Position grid. If you wish to repeat the watermark across the entire image, choose one of the sections 
on the left side of the Position grid.

When working with graphics-based watermarks, make sure your watermark file is sufficiently large for 
your usage. For example, if you want it to appear 2 inches wide on a 300-ppi image, your watermark needs 
to be at least 600 pixels wide. Or if you want it to appear across an entire photo—such as when posting 
to social media—it needs to be the same size as what you are exporting for the web, typically over 1000 
pixels. Using a watermark file that is too small will create a pixelated watermark appearance. And, because 
most watermarks are overlays on top of an image, these files are usually PNGs with areas of transparency, 
although JPGs can also be used, depending on the logo.

Using text-based watermarks

When creating text-based watermarks, the Text 
section of the pane has an entry box for your 
watermark text, a font selection area, and the same 
Appearance and Position options found in the Logo 
section.

The text entry box can contain multiple lines of 
custom text, and has the same token-based naming 
options found in the Naming pane (discussed on 
page 254), which can be helpful when exporting 
informational slides or for other data-driven uses.

You can set the font from the pop-up menu, and 
the font color by clicking the swatch on the left side 
underneath the font name. The text style can be 
set to bold, italic or underline, and the alignment to 
left, center or right. If you’d like to add a background 
color to the text box, turn on the Color Fill button 
on the right side of the pane.

Use the Position grid at the bottom of the pane 
to place your watermark, and use the Size and 
Inset sliders to move it within the area chosen. 
The Opacity slider adjusts the transparency of the 
watermark on the final image.

Saving watermark presets

Both watermark types can be saved as a preset 
for re-use later. To save a preset, adjust your Logo 
or Text settings as desired, and choose Save New 
Preset from the Presets menu. If you wish to adjust 
an existing preset at a later time—with a new logo 
file, for example—choose the appropriate preset from the Presets menu, make your changes, and choose 

With text-based watermarks, you can not only create simple, single-line 
watermarks showcasing your business, but you can also create data-driven 
watermarks (using tokens) for presentations and the like.
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Update Preset with Current Settings from the Presets menu. You can also rename and delete watermark 
presets from this menu.

Exporting and Export Presets
The Export window has been designed to offer as much or as 
little complexity as you would like. At its simplest, you can set the 
Destination and the File Type to your desired settings, leave all of 
the other panes alone, and click Export. Photo RAW will remember 
your last Export setting—including anything you did in the Naming 
pane—the next time you export, so you don’t have to worry about 
which settings need to be set, and which ones don’t. You can use 
the Show/Hide buttons in the title bar of each pane of the Export 
Options panel to display only those settings you want to see.

Once you have your settings the way you’d like, you can save them 
as a preset by clicking the Save Preset option in the Preset panel 
on the left. Then, when you click that item in the Preset panel, the 
Export Options will be set to the specifications of that preset.

The Export Presets panel will display a list of the currently 
available presets. If you have selected a preset, it will have a 
selection box (in the app’s accent color) around it, and if the control 
circle is filled, the preset is on, meaning that clicking the Export 
button will export using that preset. If you don’t wish to use a 
preset, click the control circles off on all of the presets in the list.

By default, each preset will have up to three lines of explanatory 
text underneath the preset name, displaying the file type—DNG, 
PSD, TIFF—and the Destination information. This can be helpful 
when you’re scanning presets for a specific destination, but you 
can also collapse the preset to its title by clicking the Hide button 
in the title bar.

When you change the settings for a selected preset, Photo RAW 
will ask you if you wish to update the preset with the new settings 
either when you click the Export button to start the process, or 
when you switch to another preset with the Export window.

It is possible to export more than one preset at a time. Every preset 
in the Presets panel that has the control circle set to On (filled) will 
be included in the export operation. This might be helpful to create backups on another disk, for example, 
or to build proxy versions for use while the original is being edited.

All presets include an informational view that lists the 
export file type, the destination folder, and resize 
information. If you don’t wish to see that, click the 
Hide button to collapse the view to just the preset 
title.
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About Photo RAW’s File-Naming Tokens
When using the Naming option in the Export window—or with Browse’s Rename File (page 57) and 
Import Photos (page 54) functions—Photo RAW includes a broad set of tokens that you can use as part 
of the strings to build complex file names, in conjunction with any custom text you wish to enter. These 
tokens draw on image metadata, including filenames, dates taken, and EXIF and IPTC metadata fields, and 
can be used in any number of combinations.

To build a rename sequence using tokens, click on the Add Token button, and choose the appropriate token 
from the pop-up menu. The token will be added as a shaded item in the text field, and the Example item 
above the text field will show a sample of a renamed file using the current set of tokens and custom text. 
To change an existing token, click on the down arrow on the right of the token, which will display the full 
set of tokens. To delete a token, double-click on it and press the Delete key.

Custom text can be added anywhere in the entry field. You can click the cursor at the beginning or end 
of a token (or in-between tokens) and add spaces, dashes, underscores and any other text you wish to be 
included in each renamed file.

There are four categories of tokens, each with their own set of options: Filename, Date/Time, Sequence, 
and Metadata. A description of each is listed below.

FILENAME

The Filename tokens use information from the filename 
or the enclosing folder that the file resides in. There 
are three options, Filename, which adds the current 
filename of the file being worked on; Filename Number 
Suffix, which takes the index (shot) number from the 
original raw file, if available; and Folder Name, which grabs the name of the folder in which the renamed (or 
imported) file resides.

DATE/TIME

This submenu consists of 17 combinations of date and time 
data, as taken from the image’s metadata. There are prebuilt 
date and time combinations (20220104, for example, for a 
year-month-date token) in the list, or your can build your 
own combinations out of the subtokens listed in this menu. 

Year data can be presented in either 4- or 2-digit numbers, 
and Month data can be presented in month number, full 
name, or 3-letter abbreviations.
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SEQUENCE NUMBER

The Sequence Number tokens come into play when 
exporting, importing or renaming a group of image files. 
There are essentially two tokens here, Sequence and Total, 
with options for padding zeros into each item. Sequence will 
take the group of images being worked on and, starting with 
the first item in the selection, will start at 1 and increment 
by one as each image is processed. The Total token will 
always be a single number—the number of items in the group 
being processed.

The combination of Sequence and Total tokens lets you 
create strings like ‘filename_07 of 22’ as part of the new filename.

METADATA

This submenu has five items, each with its own submenu. 
All of the items create the chosen token based on the 
embedded metadata for each image being renamed, 
imported or exported. The specific text pulled from the 
Camera and IPTC tokens will be visible in the Metadata 
pane’s EXIF (for camera-specific data) and IPTC (for IPTC 
data) tabs. The Ratings and Labels tokens are taken from any 
you have applied in Photo RAW. 

If there is no information in the specified Metadata token, it will be ignored during processing.

Camera

The Camera submenu includes 21 items, all of which are 
directly taken from an image’s EXIF data. Not all cameras 
capture all of the items listed, but most of them save essential 
items like exposure information, focal length and more.

To look at the available camera information of any image, click 
the EXIF tab in Browse’s Metadata pane (page 45).
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Ratings and Labels

The three tokens in the Ratings and Labels submenu pull 
information from any rating, label and like information you’ve 
made to images in Photo RAW.

The Rating token will add the number of stars an image is rated, 
while the Label token will add any color label information (red, 
yellow, green, blue, purple), and the Likes token will add Liked, Not Set, or Disliked to the image name.

IPTC Metadata Tokens

IPTC (International Press Telecommunications Council) is an industry-standard metadata format, and offers 
much more detailed metadata information than EXIF. It historically has been used by journalists and stock 
photographers to catalog and tag photos, as well as add copyright information, captions, and other data. 
There are nearly 30 different tokens in the IPTC metadata submenus, which are divided into Contact, 
Content, and Image. All of these fields are visible in the IPTC tab of the Metadata pane in Browse (page 
45), and can be added during the import process as well. 

Using IPTC information makes the most sense when you have a strict method for importing and 
categorizing image data during import (or shortly thereafter).



ON1 Photo RAW 2026 User Guide	 Part 5: Output and Sharing	 264

PRINTING
ON1 Photo RAW 2026 has a flexible print engine that can print photos at any size. You can print photos 
individually; multiple photos package style, on a single piece of paper; and contact sheets for evaluating 
images. You can print from any module at any time. 

The print window can be opened by clicking on the Print icon in the module selector, or by selecting the 
Print command from the File menu. It has the following components:

A.	Preview: Displays the photo or photos being printed.

B.	 View Selector: Lets you view the photos being printed individually, in facing-page view, or in 
grid view. The icon on the far right turns soft proofing on and off.

C.	 Filmstrip: Shows all of the photos that have been selected for printing, with check marks to 
turn printing on or off. (The Filmstrip is not visible when a single image has been selected for 
printing.)

D.	Page view: Displays the number of pages being printed, and lets you move from page to page.

E.	 Printer pane: Contains options for output—printer or PDF—as well as printer, page setup, 
page size, number of copies, resolution, and printer profile and rendering intent.

F.	 Print Area pane: Contains options for fitting and selecting the print image size.

G.	Watermark pane: For adding a watermark to printed photos.

H.	Sharpening: Options for sharpening during the print process.

I.	 Print/Cancel: Print One (current image), Print All, or Cancel.
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Printing Options
The four panes in the Print window—Printer, Print Area, Watermark, and Sharpening—each deal with a 
specific printing-related task.

PRINTER PANE

The Printer pane is where you set the printer-specific features 
for your output. It has two modes, which are chosen by clicking 
on the icon at the top of the pane: Print, which lets you print to a 
connected printer, and File, which will print the selection to a PDF. 

When choosing to output to a printer, you’ll set the specifics of 
your printer, the paper size you wish to print to, the resolution, 
orientation, and the number of copies. When choosing resolution, 
make sure that you are printing at the printer’s optimal resolution. 
Most photo printers, for example, work best with a file that 
has between 240 and 360 ppi. (Photo RAW will use its internal 
resampling engine to ensure that your photo is at the print 
resolution you choose.)

At the bottom of the pane is a section for choosing a printer-specific color profile; choose the media profile 
for the paper type you are printing to. 

The rendering intent is related to the conversion of an image’s colors to fit within the color range (or gamut) 
of the printer. The default intent, Perceptual, will change all of the colors in a photo proportionally to fit 
within the printer’s range of colors. The other option, Relative Colorimetric will only change the colors out 
of the printer’s gamut, to the closest in-gamut color. Depending upon the image, you might need to play 
with the intent settings, but Perceptual is usually the best place to start. (You can use Photo RAW’s Soft 
Proofing feature to look at out-of-gamut colors in your photos. See “Soft Proofing” on page 84 for more.)

NOTE: Photo RAW’s Print feature will work with borderless printing options 
as well. Be sure to choose your printer’s borderless options in the page setup 
pop-up. Different printers will have specific borderless settings, so check the 
manual to see how to turn borderless printing on.

Printing to a file

In addition to sending images to a printer, you can also choose to export the current print job to a file. This 
can be helpful if you are submitting prints to an online service or to print remotely.  To use this option, click 
on the File icon at the top of the pane. Photo RAW will ask you for a filename and a location to save the 
file. Choose a page size for the file from the Page Size pop-up, and adjust your print area settings. When 
you choose Print, Photo RAW will create a PDF of the photo (or photos) and save it with the name and 
destination you specified earlier.

The Printer pane sets printer-specific options for the 
current print job. You can also choose to render the 
print job to a PDF file.
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PRINT AREA PANE

The Print Area pane is where you set the options for the size of the 
print, and how you wish your photos to be printed. You can also 
choose whether to print photos individually, package-style, or to 
create a contact sheet for evaluative purposes. 

The top of the pane includes preset styles for either fitting the 
current photo inside the print size, or filling the entire print size;  
options for printing at common print sizes, including 8x10, 5x7, 
4x6; and options for printing to a contact sheet. You can also 
create custom print sizes via the Custom section at the bottom 
of the pane; just set the width and height of the print size, and 
whether you wish to fit the image to the print size, or to fill the 
frame with it. If you would like to save this print size as a style, 
click on the More pop-up at the top of the pane, and choose Save 
as New Style from the menu. You’ll then be able to recall that style from the More pop-up whenever you 
print.

If you are printing multiple photos, Photo RAW will attempt to put as many photos at your chosen print size 
on the paper size as defined in the Printer pane. To print only one photo per page, click that option at the 
bottom of the Print Area pane.

Page size vs. print size

It’s worth understanding the distinction between the page size and the print size. In some cases, the two 
will be identical. For example, if you wish to print on 4x6-inch photo paper, you would choose that option 
in the Printer pane’s Page Size pop-up, and then 4x6 in the Print Area’s Custom pop-up. Depending upon 
the aspect ratio of your photo, you then might need to choose Fit or Fill to get the proper crop. Fit does 
exactly what it sounds like: it will fit the entire photo within the bounds of the photo’s dimensions, which 
means that there could be some extra white space around the final print. Fill will resize the photo to fill the 
dimensions of the chosen print size, centering the image. 

In our example, a 4x6-inch print has an aspect ratio of 2:3. If the photo you are printing has that aspect 
ratio, then Fit and Fill do the exact same thing: the photo will fill the print area without any cropping.

For package printing, where you wish to generate multiple prints on a larger sheet of paper, you’ll set the 
specific size paper you are printing to in the Printer pane, and then set the appropriate print size for each 
photo in the Print Area pane.

The Print Area pane is for setting the actual print size 
of the photo or photos you are printing.
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WATERMARK PANE

The Watermark pane adds an overlay to the printed image, and is 
most often used for your logo, signature or copyright. Watermarks 
generally need a transparent background, so make sure your 
watermark file is a PNG or PSD.

The module has the following options:

• Choose: Click the Choose button to select the file you 
wish to use as your watermark. Once you’ve added a 
watermark file, it will be saved to the Logo File pop-up.

• Size: This slider controls the size of the watermark file.

• Inset: This will determine the percentage in which the 
file is inset from the edge, based on the Position (see 
below).

• Opacity: This sets the opacity of the watermark.

• Position: This grid sets the location of the watermark. 
Click on the square of the location you desire.

When working with watermarks, make sure your watermark file 
is sufficiently large for your usage. For example, if you want it to 
appear 2 inches wide on a 300-ppi image, your watermark needs to 
be at least 600 pixels wide. Otherwise, it could appear pixelated on 
the print.

SHARPENING PANE

In most cases, and depending upon the media type you print 
to—glossy papers often benefit from additional sharpening, for 
example—you’ll need to add an additional sharpening step when 
printing. This is an additional level of sharpening beyond anything 
you might have applied in the Edit module. 

The Sharpening pane lets you select a type of sharpening that will be applied to your photos during 
the printing process. The pop-up menu has a set of options for general sharpening, including ones for a 
standard print, glossy papers, details, high-pass sharpening, and many more. Depending upon the image, 
you might need to play with the settings here; performing test prints on small sections of a photo can often 
be quite helpful in determining the proper level of sharpening in a print.

Basic printing with Photo RAW
Printing is available throughout the ON1 Photo RAW 2026 interface. If you are viewing a photo in either 
the Edit or Resize modules, or if you have an image selected in Browse’s Grid or Detail views, clicking the 
Print icon will open the Print window with that image. There, you can set any of the options in the four 
panes on the right, and click the Print button to output your photo. 

Use the Sharpening pane to add additional sharpening 
to your printed` image.
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If you wish to get an on-screen proof of the final image before you print, using the chosen color profile for 
the media type you are using, click the soft proofing icon underneath the preview area.

PRINTING PHOTOS FROM ON1 CLOUD SYNC DEVICES

Any photo that can be displayed on your computer can be printed, even proxies of photos that reside on 
one of your ON1 Cloud Sync devices. In most cases — especially at smaller print sizes (8x10 and under), the 
proxy photo will have more than enough resolution to print at high quality. If you are printing at larger sizes, 
or wish to use all the available image data for your photo, either copy the file from your synced device to 
your computer, or change the sync setting for the photo’s enclosing folder on the synced device, so that the 
original is in the ON1 Cloud.

PRINTING MULTIPLE PHOTOS

To print multiple photos—as a package or contact sheet—select the images you wish to print from the Grid 
or Filmstrip views (in Browse or Edit), and click the Print icon. The photos you’ve selected will be displayed 
in the filmstrip at the bottom of the window, and the preview area will display the current page (at the 
printer’s page size) and print size settings. If you are printing a lot of photos at one time, you can flip from 
page to page via the Page View buttons under the preview. To see more pages,  click on the Facing Pages or 
Show All Pages icons at the bottom left of the window.

The Print feature gives you extensive options for printing multiple pages package style. Here, we have selected 32 photos to print at 5x7 inches on a 
letter-size sheet, on an Epson P600 printer. Clicking on the View All Pages button underneath the preview window, you can see all of the photos to be 
printed. Clicking Print One will print the currently selected page; clicking Print All will print the collection.	
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If you decide that you don’t want to print a photo, click the checkmark for that photo in the filmstrip. To 
print all of the photos currently selected, click Print. If you would like to try a test print, with a single page, 
click on the Print One button, which will print the currently selected page, as found in the Page View listing.

Printing contact sheets

When you wish to evaluate a group of images but don’t want to waste larger sheets of photo paper, use the 
Contact Sheet feature in the Print window. Select the photos you wish to print, set the paper size in the 
Printer pane, and click on the Contact icon in the Print Area pane.

When you switch from Package to Contact mode, you have two options, as found in the Custom section of 
the Print Area pane:

• Columns: lets you set the number of columns across the page width. The smaller the number 
of columns, the larger the individual cells.

• Captions: Currently, Photo RAW lets you add the filename as a caption underneath the 
printed photo. Click the button to the left of the label to turn this on or off. (We will be 
adding additional caption options in future releases.)

You can use the Page View controls underneath the preview area to move between pages, and, when 
you’re ready to print, click the Print All button to print the contact sheets.

The Contact Sheet option lets you evaluate a large group of photos in a high quality print, with captions.
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SHARING TO SMUGMUG
If you are a member of the SmugMug photo sharing and hosting service, ON1 Photo RAW 
2026 offers an easy to use mechanism for posting one or multiple photos to the service. This is 
accessed via the Share menu, which is found throughout Photo RAW in the lower right section 
of the Module selector. On Windows, the Sharing button’s pop-up contains only the SmugMug 

option; on MacOS, there are additional sharing options beyond SmugMug (see page 271 for more 
information on these options). 

You can share a the currently selected 
photo or a group of photos by choosing 
SmugMug from the Sharing pop-up menu. 
The first time you access the service, 
you’ll receive an authorization window 
inside Photo RAW; fill out your account 
information and password, and then click 
on the Authorize button. 

Once authorized, you’ll be presented with 
a window that lets you upload your photo 
or photos. The window contains a handful 
of options:

• Click the “Use photo metadata” 
control to include the photos’ 
metadata for use in the title, 
caption and keyword.

• The Gallery pop-up lets you add 
the photos to an existing gallery, 
or lets you create a new gallery. 

• The Open Gallery link to the left of the pop-up will 
open the currently selected gallery in your default 
web browser.

• The Size pop-up has three options, full-size, and 
either 4000 or 2000 pixels (on the long side).

Once you have selected the appropriate options, click the 
Share button. Photo RAW will create high-quality JPEGs of the 
chosen photos and publish them to SmugMug.

More information about SmugMug can be found at smugmug.
com.

When you post to SmugMug from Photo RAW, you can 
include metadata, choose the gallery to you want the photos 
to go into, and the size of the uploaded photos.

The first time you share to SmugMug, you’ll be asked to log in to your account, and verify 
that you want to let Photo RAW post to your galleries on the site.
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SEND TO OTHER APPLICATIONS
The Browse module inside ON1 Photo RAW 2026 can send images you are 
viewing to other applications for editing. This is done via the Send to option, 
which is available from the right-click contextual menu or the Edit menu. 
ON1 Browse automatically detects the following common photo managers 
or editors and lists the latest installed version:

• Adobe Photoshop

• Adobe Photoshop Lightroom

• Adobe Photoshop Elements

You can set up any application you want to send your photos to. Simply 
select the Send to Other Application option. Then select the application you 
want to send your photos to. The application will be remembered and listed 
with your other Send to options. (For example, if you use an email client you 
can add it to easily email photos.)

When you send an image to another application, you will be presented with 
the Edit in dialog box from ON1 Photo RAW 2026. There you’ll have the 
option to send either the edited photo or the original, unedited image. If you 
choose to send a copy, you’ll have options for choosing the file type, color 
space, bit depth and resolution. If you use the same set of options every 
time, you can check the “Don’t ask me again” box in the window, and you 
won’t be prompted again. (To change this setting, go to the File pane in 
Photo RAW’s Preferences.) The Send To... section is available when 

you right-click on a photo inside Browse 
pop-up menu. 

The Edit In dialog, with the Copy Options section expanded.
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OTHER SHARING OPTIONS (MAC ONLY)
In addition to SmugMug publishing, the MacOS version of ON1 Photo RAW 2026 includes other photo-
sharing options, including:

• AirDrop: Uses Apple’s AirDrop networking feature to share with 
local MacOS or iOS devices. 

• Mail: Creates a new email message in Apple Mail with the shared 
photo.

• Messages: Shares photo to Apple’s Messages app.

• Notes: Adds the shared photo to Apple’s Notes app. You can choose 
to create a new note, or add the photo to an existing note.

• Add to Photos: Adds the photo to Apple’s Photos app.

• Reminders: Adds to the Reminders app.

• Shortcuts: Sends to the Shortcuts app.

• Additional email apps (Mimestream): Creates a new mail message 
with the shared photo in any additional email apps registered on your Mac.  

• SmugMug: Post photos to the SmugMug service (see page 270 for details).

All of the sharing options perform the same operation: Photo RAW exports a full-size JPEG of the selected 
photo and shares it with the selected target from the list. 
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BROWSE MENUS

ON1 PHOTO RAW (MACOS ONLY)

• About ON1 Photo RAW 2026: Opens the About box, 
displays your version number. (In the Help menu on 
Windows)

• Preferences: Opens the preferences dialog. (This is in 
the Edit menu on Windows)

• Quit ON1 Photo RAW: Quits ON1 Photo RAW 2026.

FILE

• New Canvas: Creates a new .onphoto file at the 
dimensions you choose and opens it in Layers.

• Browse Folder: Opens the browse dialog where you can 
select which folder you would like to browse.

• Browse Home: Navigates to your home Pictures folder.

• Browse Desktop: Navigates to your desktop.

• Search by Text: Opens the Search Bar’s Find Text field.

• Import from device: Opens the Import window.

• Add Cataloged Folder: Lets you choose a folder to add 
to the Cataloged Folders section of the Folders pane.

• Copy to My Catalogs: Copy or move a group of selected 
photos to a specific cataloged folder.

• Remove Cataloged Folder: Removes the selected folder 
from the Cataloged Folders pane.

• Manage Extras: Opens the Extras Manager for 
importing and exporting backgrounds, presets, textures 
and more.

• Save As: Saves the currently edited image in a variety of 
files formats.

• Quick Export: Saves the current image in Photoshop, 
TIFF, JPEG or PNG format.

• Smart Organize: Opens the Smart Organize window, 
which lets you search for duplicates, and images similar 
in appearance, date, or time.

• Edit in (module): Opens the currently selected photo in 
the specified module.

• Open as Layers: Opens the selected files as layers.
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• Edit Single Photo: Opens the selected files in Edit’s 
Single Image mode.

• Fire Camera: Triggers the shutter of a connected 
camera when Tethered Shooting mode is active.

• Send to (list): Sends your image to the selected 
application in the list.

• Group RAW Plus JPG: Stacks RAW and JPG pairs 
together, reducing clutter.

• Create Panorama: Takes the selected images and opens 
the Create Panorama window.

• Create HDR: Takes the selected images and opens the 
Create HDR window.

• Create Focus Stack: Takes the selected photos and 
opens the Focus Stack window.

• Timelapse: Takes a sequence of photos and converts 
them into a time-lapse movie.

• Export: Opens the Export window.

• Export with Preset: Exports the current selection using 
a preset from the hierarchical menu, bypassing the 
Export window.

• Export with Previous: Exports the current selection 
with the last-used Export setting, bypassing the Export 
window.

• Print: Opens up the print window.

• Restore Data: Restores your ON1 Photo RAW 2026 
system settings and environment to a previous backup.

• Back up Data: Backs up your current Photo RAW 
system settings and environment.

EDIT

• Undo: Removes the last file operation.

• Redo: Redoes the undo operation. This is only available 
if the last thing you did was an undo.

• Select All: Selects all the images in the current folder.

• Select None: Deselects all the images in the current 
folder.

• Deselect: Deselects the current item.

• Copy: Copies the currently selected items.

• Paste: Pastes the items in the clipboard.

• Duplicate: Makes a physical copy of the selected file, in 
the same location as the original.
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• Rename Files: Renames the selected file or folder.

• Delete: Moves the selected files and/or folders to the 
trash.

• Add Subfolder: Adds a new empty subfolder inside the 
current selected folder.

• Keyboard Shortcuts: Lets you add or modify the 
hotkeys for many of Photo RAW’s commands.

ALBUM

• Create Album: Creates a new album.

• Rename Album: Renames the current album.

• Delete Album: Deletes the current album.

• Remove from Album: Removes selected photo(s) from 
the current album.

• Create Smart Album: Creates a new smart album, based 
on the current Search Bar criteria.

• Add to Target Album: Adds the current photo(s) to the 
Target Album.

PHOTO

• Rating: Sets star rating (0 to 5 stars)

• Color: Sets the color rating of a photo (None, Red, 
Yellow, Green, Red, Purple)

• Like: Sets a photo to Like, Reject or Not Set

• Auto Advance: When checked, any color, rating or like 
setting applied to a photo will save it for that photo, 
then move on to the following photo.

• Rotate 90 Degrees CW: Rotates an image clockwise by 
90°

• Rotate 90 Degrees CCW: Rotates an image 
counterclockwise by 90°

• Edit Capture Date: Let’s you adjust the date captured 
metadata, including a setting to take account for time 
zone changes.

• Set Location from GPS Coordinates: Looks up the place 
name information from the stored GPS coordinates and 
embeds it in the appropriate IPTC metadata fields.

• Embed Metadata: Stores adjusted metadata to the 
selected photo. (Only applicable to certain file formats.)
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• Automatically Embed Metadata: When checked, Photo 
RAW will automatically add adjusted metadata to the 
current photo.

• Read Metadata from Photo: Reads the embedded 
metadata from a raw file, overwriting any data that 
might be in the XMP sidecar files. (Useful for times 
when the metadata appears out of sync with different 
apps.)

• Save Metadata Preset: Lets you save some or all of the 
current image’s metadata fields as a preset.

• Delete Metadata Preset: Lets you delete a saved 
metadata preset.

• Refresh Preview: Rebuilds the preview of the selected 
images. (Helpful if there are issues that are causing an 
image to display incorrectly.)

SETTINGS

• Reset All Settings: Resets all the applied settings on a 
photo.

• Reset Develop Settings: Resets only the settings 
applied in the Develop tab.

• Reset Effects Settings: Resets only the settings applied 
in the Effects tab.

• Reset Sky Settings: Resets the Sky Swap AI tab.

• Reset Portrait Settings: Resets Portrait settings.

• Reset All Retouching Tools: Resets any retouching 
applied in the Edit module.

• Reset Local Adjustments: Removes all local adjustments 
made to a photo.

• Reset Liquify Tool: Resets any application of the Liquify 
tools made to a photo.

• Reset Crop: Resets the current image’s crop to its 
original state.

• Reset Text: Removes all text blocks.

• Copy Settings: Copies all of the Edit module settings 
applied to a photo.

• Paste Settings: Pastes the copied settings (with options)

• Paste Settings from Previous Edit: Applies the Develop, 
Effects and Local settings from the last-edited file.

• Sync Settings: Applies Edit settings from the primarily 
selected image (represented by the superselection) to 
the rest of the images in a selection (with options).
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• Sync All Settings: Syncs all Edit settings from the 
primarily photo to the rest of the images in a selection.

• Create Version: Makes a virtual copy of a photo, 
without duplicating the file on your hard drive.

• Save Settings as Preset: Saves the editing settings of 
the selected photo as a preset.

• Update Preset with Current Settings: If an image with 
a preset has had some settings changed, this lets you 
update the preset with the new settings.

• Rename Preset: Renames a preset.

• Delete Preset: Deletes a preset.

• Export Preset: Exports a preset as an ON1 preset file.

• Import Preset: Imports ON1 preset files.

• Get More Presets: Goes to ON1.com’s Photo Presets 
page.

CLOUD SYNC

• Configure Cloud Sync: Opens the Cloud Sync 
Preferences window.

VIEW

• Bigger Thumbnails: Increases the size of the thumbnails 
in Grid view.

• Smaller Thumbnails: Decreases the size of thumbnails.

• Zoom In: Zooms into your image in Detail, Filmstrip or 
Compare view, displaying more detail.

• Zoom Out: Zooms out, fitting more of your image in the 
window.

• Fit to Screen: Resizes your image on-screen, to fit it 
entirely in the preview window.

• Actual Pixels: Zooms in to the 100% view.

• Preset Browser Mode: Sets the Preset panel browser 
view to 1, 2 or 3 columns.

• Thumbnail View Options: Lets you  change the display 
of thumbnails in Grid view..

• Search by Rating: Filters images by star rating.

• Search by Label: Filters images by color.

• Search by Likes: Filters images by likes/dislikes.

• Sort: Sort by filename, date, rating, label and more.
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• Sort Subfolders at the Top: When sorting, puts 
subfolders at the top of the grid.

• Show Subfolder Contents: Will display/hide the 
contents of subfolders when viewing cataloged folders.

• Show Clipping: Shows the clipping overlay view, 
displaying the pure white or black pixels. (Photo, 
Filmstrip and Compare views only.)

• Show Focus Mask: Displays a green overlay on those 
portions of the current image that are in focus. (Photo, 
Filmstrip and Compare views only.)

• View Mode: Select from Thumbnail (grid), Photo (detail), 
Filmstrip or Compare views.

• Preview Quality: Select from Fast (uses embedded JPG) 
or Accurate (builds preview from the raw photo).

• Preview Background Color: Change the preview 
background color.

• Enter Full Screen: Enters full screen mode, displaying 
only the Photo RAW window, without menus.

WINDOW

• Minimize: Minimizes ON1 Photo RAW 2026.

• Zoom: Zooms your window.

• Full Screen Mode: Enters or exits full-screen mode.

• Dual Mode: Adds new browser window for use in a 
second display.

• Full Screen Preview: Displays the current photo full-
screen, without any additional interface elements.

• Quick Slideshow: Displays the current group of photos 
in a slideshow, with customizable time and transition 
effects.

• Albums: Opens/hides the pane.

• Cataloged Folders: Opens/hides the pane.

• Cloud Sync: Opens/hides the pane.

• Dates: Opens/hides the pane.

• Albums: Opens/hides the pane.

• Favorites: Opens/hides the pane.

• Local Drives: Opens/hides the pane.

• Recent: Opens/hides the pane.

• Smart Albums: Opens/hides the pane.

• Tethered Shooting: Opens/hides the pane.
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• Brilliant AI: Opens/hides the pane.

• Keyword List: Opens/hides the pane.

• Metadata: Opens/hides the pane.

• Show Browse Shortcuts: Displays Browse shortcut 
icons in the left panel.

• Search Bar: Opens and hides the Search Bar.

• Show Bumper Labels: Hides/reveals the text labels in 
the module selector.

• Show Browser Panel: Hides/reveals the Browse Panel.

• Show Photo Panel: Hides/reveals the Photo Panel.

• vHide Panels: Hides/reveals both left and right panels.

• Show Right Bumper: Hides/reveals the legacy right-side 
bumper from previous versions of Photo RAW.

HELP

• Search: Searches the menu options (MacOS only).

• Learning Hub: Opens the Learning Hub inside Photo 
RAW. 

• ON1 Photo RAW 2026 Online Help: Opens ON1.com 
support page in your default web browser.

• Video Tutorials: Opens ON1.com product training page 
in your default web browser.

• Getting Started: Opens the initial Photo RAW startup 
screens.

• Check for Updates: Checks the ON1 update server to 
see if you are running the current version; it notifies you 
about updates and will walk you through the update 
process.

• Sign-In/Sign-Out: Uses your ON1 account login 
information to authenticate your copy of Photo RAW.

• Provide Feedback: Opens the default web browser and 
goes to the feedback page of the ON1 website.

• About ON1 Photo RAW 2026 (Windows Only): Opens 
the about box with the version number displayed.

• Help Improve ON1 Products: Opens the Improve ON1 
Products dialog.

• Show ON1 Log: Diagnostic tool that can help ON1 
support when you’re having issues with Photo RAW 
2026.
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EDIT MENUS

ON1 PHOTO RAW (MACOS ONLY)

• About ON1 Photo RAW: Opens the About box and 
displays your version number. (This is in the Help menu 
on Windows)

• Preferences: Opens the preferences dialog. (In the Edit 
menu on Windows)

• Quit ON1 Photo RAW: Quits ON1 Photo RAW 2026.

FILE

• New Canvas: Creates a new layered .onphoto file at the 
specified dimensions.

• Canvas Size: Lets you change the size of the current 
layered file.

• Quick Export: Saves the current image in Photoshop, 
TIFF, JPEG or PNG format.

• Save As: Saves the currently edited image in a variety of 
files formats.

• Export: Opens the Export window.

• Export with Preset: Exports the current selection using 
a preset from the hierarchical menu, bypassing the 
Export window.

• Export with Previous: Exports the current image with 
the last-used Export setting.

• Print: Opens up the print dialog box.

• Manage Extras: Opens the Extras Manager window.

EDIT

• Undo: Removes the last file operation.

• Redo: Redoes the undo operation. This is only available 
if the last thing you did was an undo.

• Cut: Cuts the currently selected item.

• Copy: Copies the currently selected item.

• Paste: Pastes (copies) the items in the clipboard to the 
current location.

• Delete: Deletes the current image (Filmstrip mode only).

• Revert: Reverts to the photo’s original state.
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• Preferences (Windows): Opens the Preferences dialog.

• Keyboard Shortcuts: Lets you add or modify the 
hotkeys for many of Photo RAW’s commands.

LAYER

• Add Layer from File: Lets you add a new file to the 
current document as a layer.

• Add Color Fill Layer: Adds a new layer consisting of a 
solid color.

• Edit Color Fill: Lets you change the color of a selected 
color fill layer.

• Delete: Deletes the currently selected layer.

• Duplicate: Duplicates the currently selected layer.

• Reset Layer Properties: Removes any applied layer 
masks or transforms to the current layer.

• Merge Layer: Merges the current layer with the one 
beneath it.

• Merge Visible: Merges all of the visible layers into a 
new, merged layer.

• New Stamped Layer: Merges the visible layers into a 
new, composite layer, leaving the visible layers intact.

• Align Visible Layers: Aligns visible layers based on their 
content.

• Filters: Contains a list of installed Photoshop  plugins. 
Selecting an item sends the current layer to the plugin 
and returns it in a new layer. 

PHOTO

• Auto Advance: When checked, any color, rating or like 
setting applied to a photo will save it for that photo, 
then move on to the following photo.

• Rotate 90 Degrees CW: Rotates an image clockwise 90°

• Rotate 90 Degrees CCW: Rotates an image 
counterclockwise 90°



ON1 Photo RAW 2026 User Guide	 Part 6: Photo RAW Reference	 283

MASK

• Invert Mask: Inverts the mask, what was hidden is 
revealed and vice versa.

• Reset Mask: Resets the mask to plain white.

• Copy Mask: Copies the mask.

• Paste Mask: Pastes the mask.

• Create Luminosity Mask: Creates a luminosity layer 
mask based off of a photo’s black or white tonal values.

• Create Depth Mask: Creates a depth mask.

• Mask Sky: Automatically creates a mask of the sky in 
the current image.

• Create Subject Mask: Finds the photo’s subject and 
cxreates a mask of it.

• Create Background Mask: Selects the background of a 
photo and creates a mask of it.

• Show Mask: Displays the current mask either as a red 
overlay or as grayscale.

• View Mode: Sets the Show Mask mode to either color 
overlay, color overlay only when brushing, or grayscale.

SETTINGS MENU

• Reset All Settings: Resets all Edit module settings.

• Reset Develop Settings: Resets all Develop settings.

• Reset Effects Settings: Resets all Effects settings.

• Reset Sky Settings: Resets any sky replacement.

• Reset Portrait AI Settings: Resets Portrait AI settings.

• Reset All Retouching Tools: Resets any retouching 
applied in the Edit module. 

• Reset Local Adjustments: Resets all local adjustments.

• Reset Liquify Tool: Resets any application of the Liquify 
tools made to a photo.

• Reset Crop: Resets cropping made to a photo.

• Copy Settings: Copies all of the settings (Develop, 
Effects, retouching) applied to a photo.

• Paste Settings: Pastes the copied settings (with options)

• Paste Settings from Previous Edit: Applies (to the 
current photo) any Edit module adjustments made to 
the previous photo.
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• Sync Settings: Selectively applies the Edit module 
settings from the primarily selected image to the rest of 
the images in a selection.

• Sync All Settings: Applies all of the Edit module settings 
from the primarily selected image to the rest of the 
images in a selection.

• Create Version: Makes a virtual copy of a photo, 
without duplicating the file on your hard drive.

• Save Settings as Preset: Saves the editing settings of 
the selected photo as a preset.

• Update Preset with Current Settings: If an image with 
a preset has had some settings changed, this lets you 
update the preset with the new settings.

• Rename Preset: Renames a preset.

• Delete Preset: Deletes a preset.

• Export Preset: Exports a preset as an ON1 preset file.

• Import Preset: Imports ON1 preset files.

• Get More Presets: Goes to ON1’s Photo Presets web 
page.

• Save Settings: Saves the current state of your edits in 
the Edit module, in case of crash.

• New Snapshot: Creates a new snapshot of the current 
editing state.

VIEW MENU

• Zoom In: Zooms the preview window in one increment. 
This will make the preview image larger.

• Zoom Out: Zooms the preview window out one 
increment. This will make the preview images smaller.

• Fit to Screen: This sets the preview image so that the 
entire image is on screen at once. Think of this as an 
overview of the entire image. This is the setting you will 
use most of the time.

• Actual Pixels: This sets the preview image so that it 
zooms to actual pixels or 1:1 also called 100%. This 
setting allows you to see every pixel in the image. This is 
useful when making precision adjustments.

• Preset Browser: Sets the Preset panel browser view to 
1, 2 or 3 columns.

• Show Clipping: Shows the clipping overlay view, 
displaying the pure white or black pixels.

• Show Focus Mask: Displays a green overlay on those 
portions of the current image that are in focus.
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• Compare: Displays an adjustable split-screen view of 
the current image, with the Before view on the left side 
of the preview area.

• View Mode: Toggles between Filmstrip and Detail view.

• Preview Background Color: Lets you set the 
background color options.

• Enable Soft Proofing: Turns on soft proofing for the 
current image.

• Gamut warning: Displays colors that the printer can’t 
reproduce with a red overlay.

• Profiles: Displays a list of installed printer and display 
profiles; choosing a profile will apply soft proofing for 
that profile’s paper type.

• Intent: Lets you switch between perceptual or relative 
rendering intent for the current image.

• Simulate Paper and Ink: When turned on, Photo RAW 
will set the white point and black point of the display to 
account for that of the chosen profile.

• Auto Hide Tool Options bar: When checked, the Tool 
Options bar for each tool will be hidden on-screen, and 
becomes visible when you hover over the top of the 
main window.

WINDOW

• Minimize: Minimizes your screen.

• Zoom: Zooms your window to full-size.

• Full Screen: Toggles full-screen mode (hides menus).

• Dual Mode: Turns on dual-display mode

• Navigator: Hides or shows the Navigator, Loupe, 
Histogram and Info pane.

• Solo Mode: Keeps only one pane open at a time.

• Layers: Sets display and nesting options for the Layers 
pane.

• Properties: Sets display and nesting options for the 
Properties window.

• Open Quick View Browser: Opens the Quick View 
Browser overlay for the selected preset category.

• Show Bumper Labels: Hides/reveals the text labels in 
the module selector.

• Show Browser Panel: Hides/shows the Browser Panel.

• Show Control Panel: Hides/shows the Control Panel.

• Hide Panels: Hides or shows all Panels.
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• Show Right Bumper: Hides/reveals the legacy right-side 
bumper from previous versions of Photo RAW.

• Document Name: Shows the name, zoom level and bit 
depth of the open image.

HELP

• Search: Searches the menu options (MacOS only).

• Learning Hub: Opens the Learning Hub. 

• ON1 Photo RAW 2026 Online Help: Opens ON1.com 
support page in your default web browser.

• Video Tutorials: Opens ON1.com product training page 
in your default web browser.

• Getting Started: Opens the initial Photo RAW startup 
screens.

• Check for Updates: Checks with the ON1 update server 
an updated version. If there is a newer version, you will 
be notified and be walked through the update process.

• Sign-In/Sign-Out: Uses your ON1 account login 
information to authenticate your copy of Photo RAW.

• Provide Feedback: Opens the default web browser and 
goes to the feedback page of the ON1 website.

• About ON1 Photo RAW (Windows Only): Opens the 
about box with the version number displayed.

• Help Improve ON1 Products: Opens the Improve ON1 
Products dialog.

• Show ON1 Log: Diagnostic tool that can help ON1 
support when you’re having issues with Photo RAW.
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RESIZE MENUS

ON1 PHOTO RAW (MACOS ONLY)

• About ON1 Photo RAW: Opens the About box and 
displays your version number. (This is in the Help menu 
on Windows)

• Preferences: Opens the preferences dialog. (In the Edit 
menu on Windows)

• Quit ON1 Photo RAW: Quits ON1 Photo RAW 2026.

FILE

• Done: Saves the current image and returns to Browse 
(or external source).

• Cancel: Cancels any Resize operations and returns to 
Browse (or external source).

• Quick Export: Saves the current image in Photoshop, 
TIFF, JPEG or PNG format

• Export: Opens the Export window.

• Export with Preset: Exports the current selection using 
a preset from the hierarchical menu, bypassing the 
Export window.

• Export with Previous: Exports the current image with 
the last-used Export setting.

• Print: Opens up the print dialog box.

• Manage Extras: Opens the Extras Manager window.

EDIT

• Undo: Removes the last file operation.

• Redo: Redoes the undo operation.

• Cut: Cuts the currently selected item.

• Copy: Copies the currently selected item.

• Paste: Pastes the items in the clipboard.

• Preferences (Windows): Opens the Preferences dialog.

• Keyboard Shortcuts: Lets you add or modify the 
hotkeys for many of Photo RAW’s commands.
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PHOTO

• Rotate 90 Degrees CW: Rotates an image clockwise 90°

• Rotate 90 Degrees CCW: Rotates an image 
counterclockwise 90°

SETTINGS

• Reset all Settings: Resets any settings made in Resize 
(current image only).

• Copy Settings: Copies all of the Resize AI settings 
applied to a photo. (Copy is kept as long as Resize remains 
open.)

• Paste Settings: Pastes the copied settings to the current 
photo. (Kept as long as Resize remains open.)

• Paste Settings from Previous Edit: Applies any Resize 
AI adjustments made to the previous photo to the 
currently selected photo. (Only applicable when using 
Resize AI in batch-processing mode.)

• Sync All Settings: Applies all of the Resize settings from 
the primarily selected image to the rest of the images in 
a selection. (Only applicable when using Resize AI in batch-
processing mode.)

• Save Settings as Preset: Saves a new preset.

• Update Preset with Current Settings: If an image with a 
preset applied has had some settings changed, this lets 
you update the preset to reflect those new settings.

• Rename Preset: Renames the current preset.

• Delete Preset: Deletes the currently selected preset.

• Export Preset: Exports the current preset as an .onr file.

• Import Preset: Imports ON1 Resize preset files.
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VIEW

• Zoom In: Zooms the preview window in one increment. 
This will make the preview image larger.

• Zoom Out: Zooms the preview window out one 
increment. This will make the preview images smaller.

• Fit to Screen: This sets the preview image so that the 
entire image is on screen at once. Think of this as an 
overview of the entire image. 

• Actual Pixels: This sets the preview image so that it 
zooms to actual pixels or 1:1 also called 100%. This 
setting allows you to see every pixel in the image. This is 
useful when making precision adjustments.

• Show Clipping: The clipping overlay view displays the 
pure white or black pixels in the current image.

• Compare: Displays an adjustable split-screen view of 
the current image, with the Before view on the left side 
of the preview area.

• Preview Background Color: Lets you set the 
background color options.

• Enable Soft Proofing: Turns on soft proofing.

• Gamut warning: Displays colors that the printer can’t 
reproduce with a red overlay.

• Profiles: Displays a list of printer and display profiles; 
selecting a profile applies soft proofing for that profile.

• Intent: Lets you switch between perceptual or relative 
rendering intent for the current image.

• Simulate Paper and Ink: Sets the white point and black 
point of the display for that of the chosen profile.

• Auto Hide Tool Options bar: When checked, the Tool 
Options bar for each tool will be hidden on-screen, and 
becomes visible when you hover over the top of the 
main window.

WINDOW

• Minimize: Minimizes your screen.

• Zoom: Zooms window to full-size.

• Full Screen: Toggles full-screen mode (hides menu bar).

• Solo Mode: Keeps only one control pane open at a time.

• Show Browser Panel: Hides/shows the left panel.

• Show Control Panel: Hides/shows the right panel.
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• Hide Panels: Hides or shows all panels.

• Show Right Bumper: Hides/reveals the legacy right-side 
bumper from previous versions of Photo RAW.

• Document Name: Shows the name, zoom level and bit 
depth of the open image.

HELP

• Search: Searches the menu options (MacOS only).

• Learning Hub: Opens the ON1 Learning Hub. 

• ON1 Photo RAW 2026 Online Help: Opens ON1.com 
support page in your default web browser.

• Video Tutorials: Opens ON1.com product training page.

• Getting Started: Opens the Photo RAW startup screen.

• Check for Updates: Checks with the ON1 update server 
for an updated version.

• Sign-In/Sign-Out: Uses your ON1 account login 
information to authenticate your copy of Photo RAW.

• Provide Feedback: Opens the default web browser and 
goes to the feedback page of the ON1 website.

• About ON1 Photo RAW (Windows Only): Opens the 
about box with the version number displayed.

• Help Improve ON1 Products: Opens the Improve ON1 
Products dialog.

• Show ON1 Log: Diagnostic tool that can help ON1 
support when you’re having issues with ON1 Photo 
RAW 2026.
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PREFERENCES
Photo RAW has a number of system-wide settings that you can set via the Preferences window. To access 
Preferences, either click on the gear icon at the lower left side of the screen, or choose Preferences from 
the ON1 Photo RAW 2026 menu (Mac) or the Edit menu in Windows.

The Preferences window has seven tabs: General, Files, Plug-Ins, System, Services, ON1 360 and Auto 
Mark. The settings in each tab are described below.

GENERAL SETTINGS

The General settings tab adjusts basic settings for the Photo RAW workspace, including background color, 
scrolling controls and more.

Font Size

Sets the size of the text in the basic Photo RAW workspace (labels, panes and pop-up menus) to one of 
three general sizes: Small, Medium, Large. 

When changing the font size, you must quit and restart Photo RAW for the new setting to take effect.
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Preview Background Color

You may select the color of the background behind the preview image. The default color is black. There is 
options for black, white, light gray, dark gray and custom. The custom option has a color picker where you 
can select your own background color.

Accent Color

Lets you choose the display color for highlighted items in the Photo RAW interface.

Application Language

Lets you change the display language for Photo RAW. Auto will use your system’s default language.

Legacy Browse Tab

Checking this will change the separate My Catalogs and Browse panels to the single Browse panel found in 
earlier versions of ON1 Photo RAW. (See “My Catalogs, Browse and Presets Panels” on page 18.) 

Show Folder Previews

When checked, will display a thumbnail of an image from the enclosing folder in Browse.

Check for Update on Launch

Enabled by default, the product will communicate with ON1’s software update server when you start ON1 
Photo; if an update is available it will prompt you to download or skip.

Open External Files

When double-clicking a photo to edit in Photo RAW from either MacOS Finder or Windows Explorer, 
specifies whether to open the file in the Browse module (default) or the Edit module, the latter by using 
Edit a Single Photo mode (see “Edit a Single Photo” on page 21).

Double-Click in Browse

Sets the behavior when double-clicking on a photo in Browse’s Grid view. The default is to zoom in to the 
photo; the alternative is to open the photo in the Edit module.

Only Adjust Brush Size with Scroll Wheel

Turning on this option overrides Photo RAW’s default behavior, setting the app so that your mouse’s scroll 
wheel will only change the size of a brush (when an appropriate tool is selected). 

When not checked, Photo RAW uses the scroll wheel to scroll, zoom, pan and adjust brush size and 
feathering, depending upon the modifier keys being pressed. See page 16 for specifics on the default 
settings for scroll wheel options in Photo RAW. 

Default Browse Location

By default, the Pictures short cut in Browse is either Pictures (Mac) or My Pictures (Windows). You can 
change that location via this setting.
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Portrait AI Default

Sets the strength of Portrait AI’s retouching algorithms when you open a photo in the Portrait tab. There 
are two options, Subtle and Strong. The default is Subtle. (See page 208 for information on the options.)

NoNoise AI Default

Sets the strength of NoNoise AI’s noise reduction when you open a photo in the Portrait tab. There are 
three options, Low, Medium and High. The default is High. (See page 154 for information on the options.)

Enable Split Screen Compare when in NoNoise AI

Lets you set the default option for working in Develop’s NoNoise panel. When checked, Photo RAW will 
automatically switch to before/after Compare mode when you click on the NoNoise tab. When unchecked, 
you must click on the Compare button at the bottom of the screen to turn on the before/after view.
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FILES

The Files tab is used to determine what file type ON1 Photo RAW will create when opening a file in Resize, 
or when creating copies to send to an external editor from within Browse. It also lets you apply camera-
based presets.

What to Edit

There are five options in this tab:

1.	 File Format: Sets the file type you wish to create: PSD, TIFF, or JPEG. If you wish to use a 
layered workflow, you must choose PSD.

2.	 Color Space: Sets the default color space when opening a copy of a file; the list includes 
Adobe RGB 1998, Apple RGB (MacOS), sRGB, ProPhoto RGB, or ColorMatch RGB. (If you 
imported a profile, it will also be available here.)

3.	 Bit Depth: Sets the bit depth for the file when opening a copy of a file.

4.	 Resolution: Sets the resolution when opening a copy of a file.
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5.	 Show these options every time: If you do not wish to use a predefined set of file 
characteristics for opening photos from Lightroom or Photoshop, click this box.

Sidecar Options

Click this box if you wish ON1 Photo RAW 2026 to create ON1-specific ‘sidecar’ files when you are editing 
images. This is helpful if you are using the same image library with multiple computers (on an external hard 
drive, for example), and want your edits to be visible on each machine. 

Treat RAW+JPG Pairs as a Single Photo

If you shoot RAW+JPG, you can use this option to ‘stack’ both photos inside Browse. (RAW+JPG pairs are 
shown with a small icon in the lower left corner of the thumbnail.)

Default Processing

The Default processing section contains three options, for lens correction, base level raw-file corrections, 
and applying camera-based presets. The first, Apply Lens Correction Automatically, will use the lens 
correction automatically on any raw photo when you view it in Detail, Filmstrip or Compare modes. The 
Disable Base Corrections option turns Photo RAW’s basic raw-file correction settings off. This can be 
helpful for scientific/technical photography, time-lapse, and other specialized applications.

The Camera-Based Presets section at the bottom of the Files pane will contain a list of known cameras you 
have shot with. You can have Photo RAW automatically apply any preset to a specific camera by choosing 
the preset from the appropriate pop-up. (See page 138 for more about using camera-based presets.)
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PLUG-INS

The Plug-Ins tab is used to load third-party Photoshop plugins for use within Photo RAW, and, when 
running ON1 Photo RAW MAX, includes options for using that app as a plugin to other applications. 

General (Photo RAW MAX only)

Checking the “Leave ‘ON1 Photo RAW MAX 2026’ open when done will keep the app open after you’ve 
edited an image via a plugin.

Photoshop (Photo RAW MAX only)

• Apply Results to: When editing in Photoshop you can choose to have your edits added to a 
copy of your current layer or to the current layer. You can also choose to start with the last 
used settings when launching Photo RAW.

• Start with the Last Used Settings: When checked, Photo RAW will use the last settings when 
transfering a photo from Photoshop 
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Lightroom (Photo RAW MAX only)

This preference sets specific options for files opened via the Plug-In Extras menu in Lightroom:

• File Type: The file type drop-down menu determines what type of file will be created. The 
default is PSD, which maintains layers. You can also select ON1’s Smart Photo format to 
preserve re-editability from within Lightroom, and JPG or TIFF if you prefer those formats. 
The last option, ‘Same as Source,’ maintains the file type of the original file, except for 
Lightroom raw files, which are saved as PSDs.

• Color Space: Sets the working color space; Adobe RGB, sRGB or ProPhoto RGB.

• Bit Depth: Sets the file bit depth, either 8-bit or 16-bit per pixel.

• Resolution: The resolution drop-down menu determines the resolution of the file.

• Stack with Original: When enabled, the new image is stacked with the original image.

• Use Original for Single PSDs: When enabled, if you select a single PSD file, it will be edited 
directly, rather than having a copy made.

• Ask Every Time: Presents these export options whenever you chose an item from the Plug-In 
Extras submenu. Turning this option off will bypass the file-export window, using the options 
in the Plug-In Preferences window every time.

NOTE: For detailed information about the Smart Photo format and re-
editability options from within Lightroom, see page 311.

Apple Photos (Photo RAW MAX and MacOS only)

• The Enable Helper option works to ensure a smooth connection between Apple Photos and 
Photo RAW. It should remain on by default.

Third-party Plugins (all versions of Photo RAW)

To install Photoshop plugins in Photo RAW’s default location, click the Open Default Folder button and 
copy the plugin files there. You can also have a secondary plugin folder; to use this, click the checkbox, and 
then choose the folder by clicking on the Choose button.

See “Using Photoshop Plugins with Photo RAW” on page 9 for information.
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SYSTEM

The System tab adjusts performance-related characteristics of Photo RAW 2026.

AI processor

Sets the processing option for Photo RAW’s AI-based operations. By default, the option is set to 
Auto, which uses the best combination of system resources to process tasks. If you are noticing some 
performance issues with NoNoise, Sky Swap, or other AI-based tasks, you can try setting the options to 
either your CPU or your graphics card.

Memory Usage

• System Usage: Specifies the amount of RAM that is used by the application. The maximum 
(default value) is 80%.

• VRAM Usage: Specifies the amount of video memory (VRAM) used. The maximum (default) is 
80%.
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Scratch Folder Location

Lets you move or reset your memory cache, to speed editing operations while you’re running Photo RAW. 
This is helpful if your system drive has limited space and wish to use a faster external drive as a cache. This 
cache information is purged each time you quit the application.

Catalog

The Catalog CPU Usage menu sets the default level of Browse’s catalog folders processing. The options 
are Low, Normal (the default), High and Turbo. The higher the setting, the more Photo RAW uses your 
computer’s CPU as it is processing cataloged folders.

Browse Cache

ON1 Photo RAW 2026 stores thumbnails previews on disk so that the next time you browse a folder it 
loads much faster. This setting lets you adjust the memory cache size as well as empty the cache, move it to 
another location, or reset it if you are having issues with Browse.

The Preview size sets the default preview size of cached photos. The default is Small, but if can also be set 
to Large (HQ) if you prefer larger thumbnails.   

TIP: If you use cataloged folders and have a small SSD boot volume, move the 
Browse cache to another drive for performance and space considerations.

Performance

The Performance section deals with preview quality, and is designed to help you optimize Photo RAW for 
your specific setup. There are three options, Low, Adaptive (the default), and High.

Lightroom Migration Cache

If you run into problems with the Lightroom Migration Assistant, you can clear the cache here. (See 
“Moving Your Lightroom Catalog to Photo RAW” on page 317.)
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CLOUD SYNC

If you have subscribed to the ON1 Cloud Sync service, this tab lets you set the name for your device (which 
will be displayed on your other synced devices), as well as whether or not you wish to publish RAW+JPG 
pairs and your presets and imported extras.

The Reset Cloud Sync button will return your sync setup to its original state, removing all photos and 
devices. 

Detailed information about Cloud Sync can be found starting on page 75.

AUTO MARK

This tab lets you set the various criteria Photo RAW uses when using the Smart Organize feature in 
Browse.  See page 64 for details on Smart Organize, and how to adjust the Auto Mark settings to fit your 
needs.
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KEYWORD AI

This tab is for adjusting the settings of the Keyword AI feature in Browse. By default, Photo RAW scans all 
of the photos in all of your cataloged folders, and builds keywords based on the subjects in the photos.

If you don’t wish Photo RAW to use the Keyword AI feature, uncheck the Scan Cataloged Folders with 
Keyword AI option. If you do, you can tweak what parameters are used to apply keywords during the 
scanning process. These options include:

• Location lookup for GPS metadata.

• Photographic properties.

• Faces in Photos, with optional gender and age lookup.

• Objects and regions.

• Folder names.

If you are using ON1 Cloud Sync, you can set Photo RAW to sync or not sync AI-based keywords with your 
other devices.

See “Keyword AI” on page 47 for detailed information about this feature.
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BRILLIANCE AI

This tab sets the default options for the Edit module’s Brilliance AI feature.

General Settings

• White Balance Default: Determines the white balance application when Brilliance AI in 
invoked. By default, Brilliance AI performs auto white balancing, but you can set it to any of 
six standard settings. If you don’t want Brilliance AI to automatically adjust white balance, set 
the menu to ‘As Shot.’

• Apply NoNoise AI to Raw Photos Above: Sets the minimum ISO threshold for when 
Brilliance AI automatically applies NoNoise. The default is off, but you can set it to 400, 800, 
1600, 3200 or 6400.

• Apply Portrait AI to Prominent Faces: Tells Brilliance AI whether to add a Portrait AI pane for 
each larger face found in a photo. The default is ‘Off.’

Apply Local Adjustments Automatically

When checked, every time you apply Brilliance AI, it will search the photo for regions and create new local 
adjustments for those regions. 

Customize Brilliance AI

This section lets you tune Brilliance AI’s parameters for the strength (Amount), color temperature, 
midtones, vibrance and contrast.
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USING ON1 PHOTO RAW MAX 
AS A PLUGIN TO EXTERNAL 

APPLICATIONS
• Photoshop (page 304)

• Photoshop Elements (page 305)

• Lightroom Classic (page 306)

• Apple Photos (page 312)

• Corel PaintShop Pro (page 313)

• Affinity Photo (page 313)

• Capture One Pro (page 315)
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USING ON1 PHOTO RAW MAX AS A PLUGIN
Owners of Photo RAW MAX 2026 can use the app as a plugin to most major image editing apps, including 
Adobe Photoshop, Photoshop Elements, and Lightroom Classic, Apple Photos, Corel PaintShop Pro, Affinity 
Photo, and Capture One Pro. This section discusses how to use Photo RAW with each of those apps.

USING ON1 PHOTO RAW MAX 2026 WITH ADOBE PHOTOSHOP

When you edit an image sent from Photoshop to Photo RAW’s Edit module, you are editing Photoshop’s 
currently selected layer. By default, Photo RAW makes a copy of the layer, so your original layer is saved, 
unless it is a Smart Object (see below). If you’d like to change this preference, see the Plug-Ins section of 
the Preferences window on page 304.

NOTE: When resize an image using Photo RAW’s Resize AI module from within 
Photoshop, the entire image is sent.

Photo RAW 2026 is accessible from within Photoshop in two ways, from the File > Automate menu, and 
from the Filter > ON1 menu. From the Automate menu, you can access the Develop, Effects, and Portrait 
tabs of the Edit module, as well as the Resize module; from the Filter menu, you can access the Develop, 
Effects and Portrait tabs (Browse is not accessible from within Photoshop.)

There are two options for editing an image in ON1 Photo RAW MAX 2026. Which method you choose 
depends upon whether you wish to be able to re-edit your image in Photo RAW.

Editing a photo From Photoshop without preserving changes made in Photo RAW

To use Photo RAW inside Photoshop, when you do not wish so be able to re-edit your operations:

1.	 Open the image you want to work on in Photoshop.

2.	 Select the layer you want to work on. 

3.	 From the Filter menu, select ON1 and then the Edit module tab you would like to start in.

4.	 When you’re finished editing your photo, click the Done button in ON1 Photo RAW 2026. 

Editing a photo From Photoshop to preserve changes made in Photo RAW

To be able to re-edit your Photoshop images at a later point inside Photo RAW, 
you will use Photoshop’s Smart Object technology:

1.	 Open the image you want to work on in Photoshop.

2.	 Select the layer you want to work on.

3.	 Right-click on the layer and choose Convert to Smart Object.

4.	 From the Filter menu, select ON1 and then the tab that you would like 
to use.

5.	 When you’re finished editing your photo, click the Done button in 
Photo RAW MAX 2026.
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To re-edit your Smart Object layer again inside ON1 Photo RAW MAX 2026, double-click on the ON1 
module name in the edited Smart Object layer in Photoshop. Photo RAW will then launch that module, and 
let you change your previous settings or make new ones.

NOTE: Smart Object re-editibility is not possible when you add 
a layer to your photo in Photo RAW (in addition to the original, 
base layer). When you save your work, Photo RAW will flatten 
the image before it sends it back to Photoshop.

USING PHOTO RAW MAX WITH ADOBE PHOTOSHOP ELEMENTS

When you edit an image sent from Photoshop Elements to Photo RAW’s Edit module, you are editing 
Photoshop Elements’ currently selected layer. By default, Photo RAW makes a copy of the layer, so your 
original layer is saved. If you’d like to change this preference, see the Plug-Ins section of the Preferences 
window (page 304).

ON1 Photo RAW MAX 2026 is accessible from within Photoshop Elements in two ways, from the File > 
Automation Tools menu, or from the Filter > ON1 menu. From the Automate menu, you can access the 
Develop, Effects, and Portrait tabs of the Edit module, as well as the Resize module; from the Filter menu, 
you can access the Develop, Effects and Portrait tabs (Browse is not accessible from within Photoshop 
Elements.)

Editing a photo in Photoshop Elements

To use Photo RAW inside Photoshop Elements, follow these steps:

1.	 Open the image you want to work on in Photoshop Elements.

2.	 Select the layer you want to work on. 

3.	 From the Filter menu, select ON1 and then the Edit module tab you would like to start in.

4.	 When you’re finished editing your photo, click the Done button in ON1 Photo RAW MAX 
2026.

NOTE: Photoshop Elements does not support Smart Objects, so all edits done 
inside ON1 Photo RAW are final, once you return to Elements.

To re-edit a Photoshop layer in Photo RAW, 
double-click the module name in the Smart 
Filters section of the Layers palette.
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USING PHOTO RAW MAX WITH LIGHTROOM CLASSIC CC

Photo RAW can be accessed as a plugin from within Adobe Lightroom Classic CC, providing an integrated, 
round-trip editing workflow for your images. With the exception of the Browse module, all modules and 
features inside Photo RAW are available when acting as a plugin.

There are two primary ways to use Photo RAW with Lightroom, via the Edit In command in the Photo menu 
and Plug-In Extras command in the File menu. Using the Photo > Edit In menu gives you quick access to 
the Edit module and Resize, while File > Plug-In Extras gives you additional, and more powerful, options for 
editing inside Photo RAW, including: 

• Re-editability via ON1’s proprietary Smart Photos format (see page 311), which saves all the 
edits made in Photo RAW, so that you can re-edit them at a later time.

• Batch processing of multiple images for editing in Photo RAW (see page 304).

• The capability to export multiple photos as layers to Photo RAW, so that they can be worked 
on for compositing or other purposes (see page 304).

NOTE: Lightroom is a raw editor similar to Photo RAW; while both programs 
can open and edit raw files, their raw processing engines are not compatible 
with one another. Any edits made to a raw file in one program will not be visible 
in the other. For best practices, you should generally choose one program to 
be your organizational and raw editing tool. If you are a Lightroom Classic user 
and are thinking about switching to Photo RAW as your primary raw editor, see 
“Moving Your Lightroom Catalog to Photo RAW” on page 317 for detailed 
information on the process, including the different options available and which 
editing parameters are preserved during conversion.

Using ‘Edit In’

If you wish to make quick edits on a single image 
in Photo RAW, and don’t need to preserve your 
edits or work with multiple photos, use the 
Edit In submenu from Lightroom’s Photo menu, 
This is the easiest way to send a photo from 
Lightroom to Photo RAW. With this option, you 
are using Lightroom’s plugin export system to 
control the characteristics of the edited file.

To use this method, select your image in 
Lightroom, go to the Photo menu and select 
the Edit In submenu and choose the module 
you wish to work in (Develop, Effects, Portrait AI, Sky Swap AI or Resize AI). If you choose any of the Edit 
module tabs from the menu, you’ll be able to move between the other tabs—including the Local tab—during 
your editing session inside Photo RAW. You can even switch from the Edit module to Resize and finish the 
image from within that module (although you cannot travel from Resize to the Edit module in any scenario).

For quick editing of photos from Lightroom, you can choose Edit in from 
Lightroom’s Photo menu.
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File creation characteristics when using Edit In

When you use the Photo > Edit In submenu, Lightroom will ask you each time how you wish to edit the 
selected image. You have three editing options: 

• Edit a Copy with Lightroom Adjustments, which 
makes a copy of the file that includes any edits 
you have made in the photo;

• Edit a Copy, which copies the original photo 
without any changes made in Lightroom; or

• Edit Original, which sends the original version of 
the photo to Photo RAW.

NOTE: Edit a Copy and Edit Original are not 
available when selecting a raw file to send to 
Photo RAW.

In the Copy File Options, you set the file type (TIFF, 
Photoshop PSD or JPEG), the color space and bit depth for 
the resultant file. PSD is the preferred file type, especially 
if you wish to create layers inside Photo RAW while editing 
the exported image. (The layers, along with any associated 
layer masks, will be saved, and can be re-edited by choosing 
Photo > Edit In and Edit Original from the Edit Photo window.)

When you have set your options and click the Edit button, Lightroom will create a new file (or send the 
original) and launch Photo RAW. There, you can make your edits in any of the Edit module tabs—or inside 
Resize, if you chose that module from the Edit In submenu. When you’re finished, click the Done button 
to save your changes, close Photo RAW, and return the file to Lightroom. To return to Lightroom without 
saving your edits, click Cancel. 

NOTE: While you cannot create a Smart Photo PSD via Edit In, you can open 
an existing Smart Photo with Edit In. Select the Smart Photo, choose Edit In 
and the Edit module tab you wish to start in (Develop, Effects, Sky Swap AI or 
Portrait AI), and choose Edit Original in the window. Photo RAW will open the 
image in the chosen tab, with your previous edits intact. Any subsequent edits 
you make will be saved with the Smart Photo when you return to Lightroom. 
(Information about the Smart Photo format starts on page 311.)
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Using ‘Plug-In Extras’

Accessing ON1 Photo RAW MAX 2026 from 
Lightroom’s File > Plug-in Extras menu is the 
preferred way to access the app. It gives you 
access to all Photo RAW modules (except 
Browse) and has the most flexibility in how the 
files are handled. To edit an image (or group of 
images, if you want) in Photo RAW, make your 
selection in Lightroom, go the File menu’s Plug-
In Extras submenu, and choose an option. What 
happens depends upon your selection:

• If you choose Effects, Develop, Sky Swap AI or Portrait AI, Photo RAW will open in that 
tab within the Edit module, and you can move between the other tabs during your editing 
session. If you use the PSD file format as your conduit between Lightroom and Photo RAW, 
you can also create layers, which will be saved when you return to Lightroom. You can also 
move to Resize from the Edit module during your session, but when you return to Lightroom, 
the image will be saved as a flattened, resized Photoshop file.

• If you select multiple photos inside Lightroom and choose Effects, Develop, Sky Swap AI 
or Portrait AI, you will be presented with batch options in the Edit Photo window (see page 
304).

• To merge a set of bracketed photos using Photo RAW, select the bracket, and choose Merge 
with HDR 2026.

• If you choose Resize, you can only work in that module. 

• Choosing multiple files and selecting “Open as Layers” will create a layered document inside 
Photo RAW’s Edit module. 

NOTE: The Migrate Catalog to ON1 Photo item in the Plug-In Extras menu is 
designed to help you transition from Lightroom to Photo RAW as your primary 
raw processing app. For detailed information on this process, see page 317.

File creation characteristics when using Plug-In Extras

When you access ON1 Photo RAW MAX 2026 
through Lightroom’s Plug-In Extras menu, the 
default file-handling options are driven by the 
settings in the Plug-ins tab of Photo RAW’s 
Preferences window (highlighted on the left). 
These options can be configured in advance, 
based on your workflow, and can be changed 
as desired. The file export options include the 
following settings:

• File Type: This determines what type 
of file will be created. The default is 

The Plug-In Extras submenu is found in Lightroom Classic’s File menu. 
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PSD, which maintains layers, but does not support re-editability. You can also select Smart 
Photo PSD, JPG or TIFF, if you prefer those formats. One other option, Same as Source, will 
edit the original file; if that file is in the Raw format, it will be sent as a PSD file.

• Color Space: The color space menu determines which RGB working color space is used; 
Adobe RGB 1998, sRGB or ProPhoto RGB.

• Bit Depth: Sets the exported file’s bit depth to either 8 or 16 bits per pixel.

• Resolution: Determines the resolution of the newly created file.

• Stack with Original: When enabled, the new image is stacked with the original image upon 
return to Lightroom from Photo RAW.

• Use Original for Single PSDs: When enabled, if you select a single image in PSD format, the 
original file will be edited, rather than having a copy made.

• Ask Every Time: When checked, 
Lightroom will present these export 
copy options whenever you chose an 
item from the Plug-In Extras submenu. 
Turning this option off will bypass the 
file-export window inside Lightroom, 
using the options set in Plug-In 
Preferences window. 

If you have the Ask Every Time option checked, 
you’ll be presented with the Export window (shown 
on the right) inside Lightroom whenever you send 
an image to Photo RAW—or when you use the 
Open as Layers option with multiple images. The 
Export Options window lets you adjust the file 
format characteristics as needed, and is designed 
for users with variable workflow needs. If you find 
that you use the same options every time, then 
you can set those parameters in Photo RAW’s 
Preferences window by unchecking the Ask Every Time option.

Batch processing options with Plug-In Extras 

You can process multiple images for editing in Photo RAW modules via Plug-In Extras. Select the images 
you wish to work with in Lightroom’s Library module and chose a starting place via the Plug-In Extras 
submenu: Develop, Effects, Portrait AI or Resize. Then, the Export Options window will open with two or 
three batch options, depending upon the Photo RAW destination chosen from the Plug-In Extras submenu:

• Pause on First Photo: Use this option when you wish to apply the exact same editing 
operations to a group of photos. This option will open the first selected image inside Photo 
RAW. There, you can perform almost any editing option inside the Edit module (or Resize), 
including presets, retouching operations, text additions, cropping, masks, local adjustments 
and more. When you have finished with your edits, click Done. Photo RAW will then apply all 
of the edits to each image in the group, and return you to Lightroom.

• Pause on All Photos: This option lets you sequentially edit the images in the batch. Photo 
RAW will open each image in the destination tab, where you can edit it as desired. When you 

If you have the Ask Every Time option turned on in Photo RAW’s Plug-Ins 
Preferences window, whenever you send an image from Lightroom to 
Photo RAW, the Export Options window will be displayed.
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are finished editing with one photo, click Done, and Photo RAW will save that photo and 
open the next one, with the previous photo’s Edit module settings applied. (You can reset any 
or all of those settings as desired.) When you have 
finished editing the last photo in the group, clicking 
Done will save the image, close Photo RAW and 
return you to Lightroom.

• Use AI Auto for all Found Faces: This option is 
only available when Portrait AI is chosen as the 
destination from the Plug-In Extras submenu. 
Clicking OK will launch Portrait AI, automatically 
find all the faces in each photo and retouch each 
one according to the default setting—Subtle or 
Strong—set in Photo RAW’s General Preferences. 
No other editing is done, and the batched photos 
are displayed inside Lightroom when the process is 
complete.

NOTE: When using the Pause on First Photo batch processing option, most 
Edit module tools and operations are supported and carried through to the 
subsequent images in the batch. The only things that are not replicated are any 
layer operations, and any adjustments made with the Transform tool. If you 
apply edits made with these options, they will only be applied to the first image 
in the group.

Using Plug-In Extras to combine multiple photos as layers in Photo RAW

The other primary editing option you have with Plug-In 
Extras is to send a group of images to Photo RAW as a 
single file, with each photo on a separate layer. There, 
you can perform compositing and any other operations 
you can do with Photo RAW’s Layers function. 

Select a group of images in Lightroom, and choose Open 
as Layers from Plug-In Extras. Photo RAW will open them 
as a layered file inside the Edit module. 

The Open as Layers option uses the file characteristics 
set up in the Preferences’ Plug-ins tab as the final output format, with the following conditions: 

• If you chose the Smart Photo PSD format, your layers and layer masks will remain embedded 
in the file, and any adjustments made in the Edit module on each layer will be retained when 
you save the file and return to Lightroom. (See page 311for information on working with—
and re-editing—Smart Photos.)

• With the standard Photoshop PSD format, your layers and layer masks will remain embedded 
in the file, but any adjustments made in the Edit module on each layer will be lost when you 

The Batch Options window comes up when you wish to 
send a group of photos from Lightroom to Photo RAW for 
editing. (If you have the Ask Every Time option set in 
Photo RAW’s Preferences, Batch Options will be 
displayed as a section in the Export Options window, and 
you will be able to set the file copy options for the photos 
in the batch.)

When selecting a group of images in Lightroom to open as a 
single, layered file, the copy options are determined by the 
settings in Photo RAW’s Preferences. If you have Ask Every Time 
set, you can select the finished image file type from Lightroom.
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save the file and return to Lightroom. You will still be able to edit the individual layers and 
layer masks inside Photo RAW or Photoshop, however. 

• When using TIFF or JPEG as your copy format, when you are finished editing in Photo RAW 
and click Done, all of the layers, layer masks and any Edit module operations will be merged 
into a single composite layer.

For detailed information about Photo RAW’s Layers feature, see page 213. 

Working with Smart Photos

ON1’s Smart Photo technology is a variation of the Photoshop file format that has been engineered to 
preserve all editing and retouching operations made within Photo RAW’s Edit module: Develop settings, 
Effects filter operations, masks, local adjustments, portrait retouching, layers, text additions, and so 
forth. Smart Photos can only be created via the Plug-In Extras export method as discussed on page 307, 
although you can re-edit them via either the Plug-In Extras or the Edit In menu options in Lightroom.

When you choose Smart Photo PSD as an option in the Plug-In Extras submenu from within Lightroom, 
Photo RAW creates a standard Photoshop file with “Smart Photo” at the end of the original file’s name. As 
you work in Photo RAW’s Edit module tabs, all of your editing operations are saved in a ‘sidecar’ file that 
sits alongside the PSD on disk inside the same folder as your original image. When you are done editing and 
return to Lightroom, your edited photo will look as it did in Photo RAW, but is completely re-editable.

To re-edit a Smart Photo from within Lightroom, select the image, and choose the appropriate Edit module  
tab from either the Plug-In Extras from the File menu or Edit In from the Photo menu. Depending upon 
the method chosen and your Photo RAW Preferences, the Smart Photo will open automatically, or you will 
need to select Edit Original from the Lightroom export window. �   

There are a few things to know about with regards to Smart Photos and re-editability:

• Smart Photos have been specifically designed to work as a conduit between Lightroom and 
Photo RAW to preserve re-editability. If you use Photo RAW as a standalone app, you can 
open and view a Smart Photo from within Browse, and can re-edit the photo in the Edit 
module, and, as long as your sidecar file is present, all of your edits will be present. However, 
when you return to Browse, Photo RAW will create a new .onphoto file with all your edits.

• If you open a Smart Photo in Adobe Photoshop, the layers will be merged into a single, 
composite layer. If you make any edits to the photo and save it, re-editability in Photo RAW 
will no longer be available.

• Smart Photos are not available as an option when exporting from Lightroom to ON1 Resize.
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USING PHOTO RAW MAX WITH APPLE PHOTOS

ON1 Photo RAW MAX 2026 integrates with 
Apple Photos (for MacOS only) and provides a 
seamless experience for enhancing your images. 

If you have Photos on your computer when 
you install ON1 Photo RAW MAX 2026, the 
appropriate plugin will be installed, but you will 
need to manually activate it in order to use it. 
To do so, go to Apple’s System Preferences and 
click on the Extensions icon. In the Extensions 
pane, click on Photos, then check the ON1 
Photo RAW MAX 2026 option. This will let you 
send images from Apple Photos to Photo RAW 
MAX 2026. (File Sharing must also be turned on 
in System Preferences for this to work.)

To edit an image in ON1 Photo RAW MAX 2026 follow these steps:

1.	 Select the image you wish to edit in Photos.

2.	 Click on the Edit button.

3.	 On the right side of the window, at the bottom of 
the editing controls, you’ll see an Extensions pop-
up. Click that button, and choose ON1 Photo RAW 
MAX 2026. Your photo will open in Photo RAW’s 
Edit module, and you can switch between all of the 
tabs in the module during your editing session. 

Non-destructive editing with Apple Photos

When you send an image from Apple Photos to Photo RAW, any settings you apply will be saved with 
the image, so that you can send the image back to Photo RAW with your edits intact, as long as you do not 
subsequently edit that image inside Photos. To re-edit an image processed inside Photo RAW, click on the 
image in Photos and follow the same three steps above. When your image is opened inside Photo RAW, 
you will see all of the changes you made in your previous session. 

Once you make any editing changes to your image inside Photos, your Photo RAW edits will be “baked in” 
to the image. You can send the image again to Photo RAW, but your original settings won’t be visible. 

If you wish to keep your original Photo RAW edits, duplicate the image inside Photos (Image > Duplicate), 
which will create a new virtual copy of the file. You can then edit one of the versions in Photos, using the 
other one to preserve your Photo RAW edits.

After installing ON1 Photo RAW 2021 on your Mac, you must turn the Photos 
extension on via Apple’s Extensions System Preference.

In Apple Photos, click the pop-up menu next to the 
Extensions label when editing a photo and you’ll see the 
options for sending your photo to Photo RAW 2026.
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USING PHOTO RAW MAX WITH COREL PAINTSHOP PRO

When you edit an image sent from Corel PaintShop Pro (Windows-only) to ON1 Photo RAW, you are 
editing PaintShop Pro’s currently selected layer. To use Portrait inside PaintShop Pro, follow these steps:

1.	 Open the image you want to work on in PaintShop Pro.

2.	 Select the layer you want to work on. 

3.	 From the Effects menu, select PlugIns > ON1 > ON1 Photo RAW MAX 2026.

4.	 When you’re finished editing your photo, click the Done button in Portrait.

PaintShop Pro does not support nondestructive editing with Photo RAW; if you would like to work on a 
copy, before you send the photo to Portrait, right-click on the layer in PaintShop Pro and choose Duplicate.

USING PHOTO RAW MAX WITH AFFINITY PHOTO

ON1 Photo RAW can be accessed from within Affinity Photo, providing an integrated, round-trip workflow 
of your images on both MacOS and Windows. To use Photo RAW as a plugin to Affinity Photo, you must 
first activate the plugin from within Affinity Photo.

Activating Photo RAW for use with Affinity Photo (Windows)

1.	 To setup Photo RAW as a plugin on Windows, go first to Edit > Preferences and click on the 
Photoshop Plugins icon. 

2.	 Check the ‘Allow “unknown” plugins to be used’ box at the bottom of the screen.

3.	 Click on the Add button underneath the Plugin Search Folders area, and navigate to 
\Program Files\ON1\ON1 Photo RAW MAX 2026\Plug-in Files\ON1 Photo RAW MAX 
2026.plugin. 
Click OK.

4.	 When you click on the Close button, Affinity Photo will prompt you to restart the app. 
When you do this, you should now see Photo RAW listed in the Detected Plugins section of 
the Photoshop Plugins preferences.

Activating Photo RAW for use with Affinity Photo (MacOS)

Setting Affinity Photo up for MacOS is nearly identical to the Windows activation. There is only one 
additional step.

1.	 Go first to Preferences, located in the Affinity Photo menu on the top left. Click on the 
Photoshop Plugins icon. 

2.	 Check the ‘Allow “unknown” plugins to be used’ box at the bottom of the screen.

3.	 Click on the Authorize Global button at the bottom of the window. MacOS will present you 
with a dialog box that shows the root folder of your system. Click on the Authorize button in 
this box.

4.	 Click on the Add button underneath the Plugin Search Folders area, and navigate to 
Applications/ON1 Photo RAW MAX 2026/Plug-in Files/ON1 Photo RAW MAX 2026.plugin. 
Click OK.
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5.	 When you click on the Close button, Affinity Photo will prompt you to restart the app. 
When you do this, you should now see Photo RAW listed in the Detected Plugins section of 
the Photoshop Plugins preferences.

Editing a Photo in Photo RAW from within Affinity Photo

When you edit an image sent from Affinity Photo to ON1 Photo RAW, you are editing Affinity Photo’s 
currently selected layer. To use Portrait inside Affinity Photo, follow these steps:

1.	 Open the image you want to work on in Affinity Photo, and click the Develop button.

2.	 Select the layer you want to work on. 

3.	 From the Effects menu, select Filters > Plugins >ON1 > ON1 Photo RAW MAX 2026.

4.	 When you’re finished editing your photo, click the Done button in Portrait.

Affinity Photo does not support nondestructive editing with Photo RAW; if you would like to work on a 
copy, before you send the photo to Portrait, right-click on the layer in Affinity Photo and choose Duplicate.
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USING PHOTO RAW MAX WITH CAPTURE ONE

When you edit an image sent from Capture One to Photo RAW, Capture One creates a variant of the 
current photo. To use Effects inside Capture One, follow these steps:

1.	 Open the image you want to work on in 
Capture One.

2.	 From the Image menu, select Image > Edit 
With > [Photo RAW module of your choice]

3.	 Choose the file characteristics in the 
Format and Size section that you wish to 
use—File Type, Bit Depth, ICC Profile, and 
Resolution. You can also set the options 
in the Adjustments and Metadata tabs as 
desired. When you’re done, click the Edit 
Variants button to launch Photo RAW.

4.	 When you’re finished editing your photo, 
click the Done button in Photo RAW.

After you’ve returned to Capture One, your new 
variant will be visible in the current collection.

BATCH PROCESSING IMAGES IN EFFECTS WITH CAPTURE ONE

You can process multiple images for editing in Effects with Capture One. Select the images you wish to 
work with in Capture One and choose Image > Edit With > [Photo RAW module of your choice]. The Export 
Variant window will open with an additional tab, ON1 Batch, which contains a pop-up with two options:

• Pause on First Photo: Use this option when 
you wish to apply the exact same editing 
operations to a group of photos. This option 
will open the first selected image inside 
Effects. There, perform any editing option 
you wish, including adding filters, applying 
presets, retouching operations, cropping, 
masks, local adjustments and more. When 
you have finished with your edits, click Done. 
Effects will then apply all of those edits to 
each image in the group, and return you to 
Capture One.

• Pause on All Photos: This option lets 
you sequentially edit the images in the 
batch. Effects will open each image in the 
destination tab, where you can edit it as 
desired. When you are finished editing 
with one photo, click Done, and Effects will save that photo and open the next one, with 
the previous photo’s Effects settings applied. (You can reset any or all of those settings as 
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desired.) When you have finished editing the last photo in the group, clicking Done will save 
the image, close Effects and return you to Capture One.

Before sending multiple images to Effects from Capture One, you can also click on the Basic, Adjustments 
and Metadata tabs to change those options. Once you have all the options chosen, click the Edit Variants 
button and Effects will process that group based on your batch settings.
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MOVING A LIGHTROOM CATALOG 
TO PHOTO RAW

If you are a Lightroom user and you wish to make Photo RAW your primary editing application, you can use 
our Lightroom Migration Assistant to transfer most of your catalog settings and metadata from Lightroom 
into Photo RAW. You can even—with a few caveats—transfer photos that have been edited in Lightroom so 
that they appear inside ON1 Photo with corresponding (non-destructive) edits applied to them. And, it does 
this without changing any of the original files in your Lightroom catalog, or the catalog itself. Instead, we 
use machine learning to migrate the actual Lightroom edits in a re-editable, non-destructive way. 

NOTE: This tool is designed for one-time migration of catalogs. As such, the 
migration process can take a long time. You can continue to use Lightroom and 
ON1 Photo RAW 2026 during the migration period. The migration process can 
also temporarily use a large amount of disk space on the drive (or drives) where 
you store your images. Make sure you have plenty of space before you begin.

This tool performs the following tasks:

• Top-level folders in Lightroom’s Folders pane become cataloged folders in Photo RAW. All the 
photos and videos in those folders will be cataloged automatically.

• Metadata changes made in Lightroom will be migrated, and include ratings, flags, keywords, 
descriptions, GPS data, color labels, orientation, and so forth.

• Standard Lightroom collections will be migrated as well. (Smart collections are not converted.)

• Most raw processing and editing settings made inside Lightroom’s Develop module are 
migrated non-destructively—and are editable—inside Photo RAW. These operations include 
crop, retouching, local adjustments, vignettes, noise reduction and sharpening, and more. 
(See “Which Lightroom Settings are migrated?” on page 320 for exact details of which 
settings are transferred and which ones are not.)

To migrate your catalog, open it inside Lightroom, and choose Migrate Catalog to ON1 Photo from File 
> Plug-In Extras. An assistant window will open up; the first and second tabs of the window have an 

The Intro and Prepare tabs give you information about the Lightroom Migration assistant. Click the 
Learn More button to go to the ON1 website for more detailed information about the process.
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introduction about the process. If you would like to see any additional up-to-date information on the 
Migration Assistant, click the Learn More button, which will take you to a help page on the ON1 website.

Click on the Next button when you’re ready; this will take you to the Settings tab, where you can choose 
whether to have the Assistant transfer your standard Lightroom Collections (Smart Collections are not 
transferable) and any Develop adjustments made in Lightroom. Once you’ve made your selection, click on 
the Next button to go to the Copies tab.

NOTE: If you migrated your Lightroom catalog, and your photo settings in 
Lightroom are not correct, launch the Migration Assistant again, go to the 
Settings tab and click the Roll Back button at the bottom of the tab. This will 
return your Lightroom settings to the state before you started the Migration 
process. (Click the Cancel button when the roll-back procedure is complete.)

The Copies tab lets you export copies of any photos that have Develop adjustments made to them inside 
Lightroom into a new file that includes all of those edits. These copies are created based on the options 
chosen in the Copies tab, and include the following options:

• File Type: This menu determines what type of file will be created. The default is PSD, which 
maintains layers. You can also select JPG or TIFF, if you prefer those formats.

• Color Space: The color space drop-down menu determines what RGB working color space is 
used; Adobe RGB 1998, sRGB or ProPhoto RGB.

• Bit Depth: This sets the copied file’s bit depth to either 8 or 16 bits per pixel.

• Resolution: The resolution drop-down menu determines the resolution of the file.

When the Copies option is checked, any photo that has been edited inside Lightroom will have a new copy 
saved in same folder as the original image. Both images will be visible in Photo RAW after the migration 
process is complete.

Once you have set your options in the Assistant window, click the Migrate button. Once initiated, the 
following steps happen:

1.	 Using the Photo RAW plugin, small JPEG versions 
of all images in the catalog—used for comparison 
purposes during the migration—are exported to 

The Settings and Copies tab offer multiple options for the conversion operation.

Once you’ve clicked the Migrate button, Lightroom will 
begin the process of exporting catalog information to ON1 
Photo RAW 2026.
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a temporary location, as are separate sidecar files that contain metadata (.on1) and edit 
information (.on1meta) for each image. 

2.	 If you checked the Copies option, those images are also exported and saved to the same 
folder as the original. 

3.	 When the process is complete from within Lightroom, Photo RAW will launch, and the 
Lightroom catalog’s folders will show up as Cataloged Folders inside the Browse module’s 
Folders pane. (The thumbnails for the images will initially be based on the temporary JPEGs 
exported in Step 1 above.)

4.	 In the background, Photo RAW will go through the cataloged folders and, using the 
information stored in the .on1meta files, will perform a conversion process to align edits 
between the Lightroom versions and the new ON1 Photo RAW version.

5.	 When viewing migrated catalog folders inside Browse, any image that has not yet been 
converted will have a small ‘LR’ badge in the lower right corner of the thumbnail. Once Photo 
RAW has finished the conversion on that image, the badge will change to a small ‘+/-’ badge.

6.	 As Photo RAW completes the conversion on each image, the temporary files are deleted, 
and the .on1 sidecar files are updated.

NOTE: Choosing the Create Copies option will create a copy of all photos that 
have any adjustment made to them. This includes such things as lens profiling 
or default noise reduction, which some people use as an import preset when 
bringing photos into Lightroom. We recommend examining your catalog, and 
determine how you wish best to proceed with the migration. In some cases, it 
might be better to use Lightroom’s export dialog to selectively export edited 
photos into a new folder, and add them to ON1 Photo RAW as a new cataloged 
folder—or however you might wish to organize them inside Photo RAW.

The process, which, as noted, can take quite some time, although you can continue work inside Photo RAW 
once the Lightroom export component has been completed. If you quit Photo RAW and restart it later, the 
app will continue to work in the background until all of the migrated images are translated into ON1 Photo 
RAW edits.

NOTE: Migrating the Lightroom Develop adjustments does not affect either 
the original photos or their settings inside the Lightroom catalog. What ON1 
Photo RAW does is apply a ‘translation’ of the Develop settings of your 
Lightroom edits to Photo RAW’s Develop settings, and saves those edits in 
an ON1-specific sidecar file. When you open a migrated photo inside the Edit 
module, you’ll see ON1’s approximation of the edits you made in Lightroom.
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WHICH LIGHTROOM SETTINGS ARE MIGRATED?

Due to the complexities of moving editing settings from one raw development environment to another, 
not every setting in Lightroom is converted when you migrate your catalog. The following table lists key 
Lightroom features, if they’re converted, along with some notes about the specific feature mentioned.

FEATURE CONVERTED? NOTES

Folders Yes All top-level Folders in Lightroom become top-level 
cataloged folders in Photo RAW.

Photos/Videos Yes All photos/videos in the cataloged folders are added. 
This may include some photos that are not cataloged in 
Lightroom. Photo RAW only migrates available photos and 
does not migrate photos from offline volumes. 

Virtual Copies Yes Virtual Copies become Versions inside Photo RAW.
Stacks No 
Collections Yes All normal collections are migrated to albums. Collection sets 

become album sets. Smart collections are not migrated.
Crop Yes 
Spot Removal Yes Spot Removal is migrated to the Clone Stamp when used in 

Clone mode. When used in Heal mode it is migrated to the 
Perfect Eraser. The results will not be a pixel perfect match 
but will generally remove the same spots with comparable 
results. 

Basics Yes Camera Profiles are matched for Adobe® and Camera 
profiles. Other LUTs or custom profiles are not migrated. 
Clarity is called Structure in Photo RAW. Dehaze is called 
Haze and will look a bit different. 

Black & White Yes 
Tone Curve Yes Point-based curve adjustments only. 
HSL/Color Yes You will find this in the Color Adjustment filter in Effects.
Split Toning Yes You will find this in the Split Tone filter in Effects.
Detail Yes There are significant differences in the sharpening and noise 

reduction algorithms. We did our best to align them but they 
may require manual adjustments to taste before output. 

Lens Correction Yes Automatic lens correction is applied if we have a matching 
lens profile. Manual distortion settings are not migrated. 

Transform No Unfortunately, Lightroom’s Transform function is very 
different and we couldn’t find a practical way to migrate 
these settings. You can achieve similar results using the 
Transform pane in Develop in Photo RAW. 

Effects Yes Found in the Vignette and Film Grain filters in Effects.
Camera Profiles No Profiles are proprietary to the developer of the raw engine.
Red Eye No You can reduce red-eye automatically in the Portrait module. 
Graduated Filter Yes You will find these as adjustment layers in the Local module 

using the Adjustable Gradient. Range mask, Moiré and 
Defringe are not migrated at this time. 
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FEATURE CONVERTED? NOTES

Radial Filter Yes You will find these as adjustment layers in the Local module 
using the Adjustable Gradient. Range mask, Moiré and 
Defringe are not migrated at this time. 

Adjustment Brush Yes You will find these as adjustment layers in the Local module 
using the Adjustment Brush, including the Auto Mask 
function. Range mask, Moiré and Defringe are not migrated 
at this time. 
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BACKING UP YOUR WORK IN PHOTO RAW
To safeguard your peace of mind in the event of computer failure—or help you get set up quickly when 
you move to a new computer—ON1 Photo RAW 2026 includes a back-up and restore function. While 
this feature will not back up your photos, it will back up the following items related to your Photo RAW 
installation:

• All preferences, references to cataloged folders and other basic settings for Photo RAW.

• Albums created in Browse.

• Metadata changes made to images in Browse, including keywords, ratings, labels, and any 
data added via the Metadata pane. 

• All presets and styles used in Photo RAW.

• All Extras, including any you have imported.

• All of the edits made on any image in the Edit module.

To back up your Photo RAW system, choose Back Up 
Data from the File menu in the Browse module. The 
Back Up Data window will let you choose a location for 
your backups, and also let you set a reminder schedule 
(daily, weekly, monthly, or no reminder) for backups. 
When you click the Back Up button, Photo RAW will 
create a .onbackup file in your chosen location, with the 
date and time embedded in the filename.

To restore your system to the latest backup, choose Restore Data from the File menu in Browse. 
(Depending upon the situation, you might need to reinstall ON1 Photo RAW 2026 first.) The Restore Data 
window will prompt you for the location of your backups, and will choose the most recent backup to 
restore from. (If, for some reason, you would like to use 
an earlier backup, just move the most recent one to 
another location on your hard drive.)

Clicking Restore will pull the information from the 
backup and apply it to your Photo RAW setup. During 
the restoration process, if Photo RAW can’t find the 
proper folders with your photos, it will present the 
Missing Folders window, with a list of each folder that it 
can’t find. You can click the Locate button to reconnect the folder, or you can click the ‘X’ to the left of the 
folder name in the window to remove it from Photo RAW’s database. 

NOTE: Photo RAW’s back-up feature will not back up your photos; you should 
use other methods to ensure that your photos are backed up in a safe place.
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Windows macOS
Change Modules/Tabs

Browse G
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Effects S

Portrait I

Local Adjustments A

Resize Y

Preview Nagivation

Zoom-in ⌃ + ⌘ +

Zoom-out ⌃ — ⌘ —

Fit to Screen ⌃ 0 ⌘ 0

Zoom to 100% (1:1) ⌃ ⎇ 0 ⌘ ⌥ 0

Pan Photo hold space

View & Window Modes

Grid View G

Photo View E

Filmstrip View F

Compare View (Browse) C

Fullscreen n/a ⌘ ⌃ F

Hide Right Panel ⌃→ ⌘ →

Hide Left Panel ⌃← ⌘  ←

Hide Both Panels ⇥
Split-Screen Compare (Develop/Effects) ⌃ Y ⌘ Y

Preview and Masking Views

Original View (Preview Off) \

Show Mask O

Show Clipping hold J

Enable Soft Proof ⎇ S ⌥ S

Browse

Change Thumbnail Size + /—

Browse a Folder ⌃ B ⌘ B

Select All ⌃ A ⌘ A

Select None ⌃ D ⌘ D

Deselect /

Set Rating 1-5

Set Label 6-0

Dislike X

Like P

Clear Like/Dislike U

Delete ⌦

Advanced Search ⌃ F ⌘ F

Presets

Open Quick View Browser ⎇ ↑ ⌥ ↑

Insert Preset ⎇ click ⌥ click

Windows macOS
Photo Settings

Rotate 90 ⌃ ] ⌘ ]
Rotate -90 ⌃ [ ⌘ [
Reset All Settings ⇧ ⌃ R ⇧⌘ R
Copy Settings ⇧ ⌃ C ⇧⌘C
Paste Settings ⇧ ⌃ V ⇧⌘ V
Sync Settings ⇧ ⎇ S ⇧ ⌥ S
Create Version ⌃’ ⌘’
Save Settings ⌃S ⌘ S 

Brushing
Bigger Brush ]
Smaller Brush [
Increase Brush Opacity ⎇ ] ⌥ ]
Decrease Brush Opacity ⎇ [ ⌥ [
Increase Brush Feather ⇧ ]
Decrease Brush Feather ⇧ [
Rotate Brush Clockwise ⇧⎇ ] ⇧⌥ ]
Rotate Brush Clockwise ⇧⎇ [ ⇧⌥ [
Set Brush Opacity ⎇ 1-0 ⌥ 1-0
Toggle Perfect Brush ⌃ R ⌘ R
Hold Perfect Brush Color hold ⌃ hold ⌘
Toggle Paint-in/Paint-out ⇧ X or hold ⎇/⌥
Invert Mask ⌃ i ⌘ i
Draw Straight Line ⇧ click

Misc
Quick Export ⇧ ⌃ S ⇧⌘ S
Print ⌃ P ⌘ P
Undo ⌃ Z ⌘ Z
Redo ⇧ ⌃ Z ⇧ ⌘ Z

Tools
Crop C
Adjustment Brush ⇧ K
Adjustable Gradient ⎇ K
Spot Healing Brush Q
Perfect Eraser ⇧Q
Retouch Brush R
Clone Stamp S
Super Select K
Masking Brush B
Gradient Mask/Masking Bug M
AI Quick Mask W
Line Mask ⇧P
Refine Mask N
Zoom/Pan Z
Move/Transform V
Text T
Portrait ⇧ I
Chisel H 
Blur L 

⌃ Control         ⌘  Command         ⎇  Alt       ⌥  Option        ⇧  Shift       ⇥  Tab

ON1 PHOTO RAW 
Common Keyboard Shortcuts
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